
Міністерство освіти і науки України 

Чернівецький національний університет  

імені Юрія Федьковича  

 

 

 

Гавриляк М.С. 

 

 

Теорія кольору і кольороутворення 
 

 

 

 

 

 

 

Навчальний посібник 

 

 

Чернівці 

Чернівецький національний університет 

2022  



2 

 

 

 

 

 

     

  

 

 

 

 

 

  

 

 

 

 

©  Гавриляк М.С., 2022 

© Чернівецький національний    університет, 2022 

 

 

 

  

УДК 655.3

Гавриляк М.С.

Теорія кольору і кольороутворення / автор.:, М.С. Гавриляк– Чернівці: Чернівец. нац. ун-тет, 
2022, с. 263

Навчальний посібник призначений для формування у студентів системи теоретичних знань, 
прикладних умінь та практичних навичок щодо використання базових принципів, підходів і 
методів роботи із кольором для забезпечення організації й підтримки якості представлення та 
відображення  видавничо-поліграфічної  продукції  у  рамках  технологічного  процесу  її 
виробництва. Навчальний  посібник  призначений  для  студентів  вищих  закладів  освіти  за 
спеціальністю № 152 Метрологія та інформаційно-вимірювальна техніка.

УДК 655.3



3 

 

 

Зміст 

Вступ............................................................................................................. 3 

Розділ 1. Теоретичні основи організації та представлення кольору......... 5 

1. Основні поняття теорії кольору........................................................ 5 

2. Гармонія колірних сполучень ......................................................... 31 

3. Адитивні та субтрактивні системи цифрового представлення кольору.....64 

4. Графічні формати файлів............................................................... 93 

Розділ 2. Цифрове опрацювання зображень та синтез кольору в процесах 

друкарського кольоровідтворення ................................................................... 110 

5. Вимірювання та управління кольором у кольорометричних системах..110 

6. Комп'ютерне кольоровідтворення............................................................128 

7. Друкарське кольоровідтворення…….......................................................147 

Розділ 3. Лабораторний практикум…………………………………………...156 

Лабораторна робота №1. …………………………………………………………156 

Лабораторна робота №2. …………………………………………………………182 

Лабораторна робота №3. …………………………………………………………217 

Лабораторна робота №4. …………………………………………………………230 

Лабораторна робота №5. …………………………………………………………238 

Лабораторна робота №6. …………………………………………………………248 

 

  

  

Список використаної літератури........................................................................... 262



4 

 

Вступ 

 

В посібнику наведено матеріал, що допомагає засвоїти всі лекційні теми 
навчальної дисципліни. Подано велику кількість ілюстративного матеріалу у вигляді 
відповідних діалогових вікон, рисунків і прикладів; більшу частину рисунків наведено в 
графічному вигляді, що істотно полегшує розуміння досліджуваних питань з побудови 
гармонійних колірних сполучень, використання колірних моделей, налаштування 
системи керування кольором, застосування колірних профілів, виконання 
кольорокорекції та кольороподілу тощо. Наведено приклади, спрямовані на 
підвищення ефективності процесу здійснення комп'ютерного та друкарського 
кольоровідтворення. Окремим розділом представлено лабораторний практикум, що 
призначений для закріплення теоретичних знань шляхом виконання конкретних 
практичних завдань. 
 
Мета навчальної дисципліни: формування у студентів системи теоретичних знань, 
прикладних умінь та практичних навичок щодо використання базових принципів, 
підходів та методів роботи із кольором для забезпечення організації й підтримки якості 
представлення та відображення видавничо-поліграфічної продукції в рамках 
технологічного процесу її виробництва. Дисципліна логічно поєднана з курсами: 
«Видавничо-поліграфічні технології», «Опрацювання графічної інформації», «Основи 
поліграфії». 
Студент повинен набути наступних компетентностей та практичних навичок:  

Здатність    застосовувати    принципи    оброблення, реєстрації,   формування,   
відтворення,   зберігання   текстової, графічної,  звукової  та відеоінформації  та  
особливостей  її використання  для  виготовлення  друкованих  і  електронних видань, 
пакувань, мультимедійних інформаційних продуктів та інших видів виробів 
видавництва та поліграфії. 

Здатність проектувати структуру, конструкцію та дизайн друкованих  і  
електронних  видань,  пакувань,  мультимедійних інформаційних  продуктів  та  інших  
видів  виробів  видавництва та  поліграфії,  використовуючи  сучасне  програмне  та  
апаратне забезпечення,  з  урахуванням  вимог  до  результату,  наявних ресурсів та 
обмежень. 

Застосовувати  теорії  та  методи  математики,  фізики, хімії,  інженерних наук,  
економіки  для  розв’язання  складних задач і практичних проблем видавництва і 
поліграфії. 

Знаходити, оцінювати  й  використовувати  інформацію  з різних   джерел, 
необхідну   для   розв’язання   теоретичних   і практичних задач видавництва і 
поліграфії. 

Розуміти   принципи   і   мати навички   використання технологій додрукарської    
підготовки,    друкарських    та післядрукарських процесів, теорії кольору, методів 
оброблення текстової та мультимедійної інформації; 

Забезпечувати  якість  друкованих і  електронних  видань, пакувань, 
мультимедійних  інформаційних  продуктів  та інших видів виробів видавництва та 
поліграфії. 
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Розділ 1. Теоретичні основи організації 

та представлення кольору  

 

1. Основні поняття теорії кольору  

 

Основна ідея 

 

Наведено аналіз багатогранності трактування поняття "колір", виз-

начено змістовне наповнення його властивостей, розглянуто історичні 

передумови виникнення колірних моделей, проаналізовано особливості 

сприйняття кольору. 

 

Ключові поняття: колір, теорія кольору, властивості кольору, 

сприйняття кольору, колірний спектр. 

 

Основні питання 

1.1. Колір та його основні властивості.  

1.2. Колірні моделі та схеми.  

1.3. Особливості сприйняття кольору. 

 

Цілі вивчення 

 

Метою є аналіз змісту поняття "колір" та визначення його власти-

востей, дослідження феномена кольору з позиції еволюції колірних моде-

лей та розгляд фізіології і фізичних шляхів утворення кольору. 

Інформація, подана далі, надає студентові можливість сформувати 

такі компетентності: 

знання: 

змістовного навантаження поняття "колір" та розділів теорії кольору; 

основних властивостей кольору; 

характеристик кольору; 

історії розвитку моделей представлення кольору; 

особливості візуального сприйняття кольору; 

фізіології й фізичних шляхів утворення кольору; 

основ вимірювання кольору; 
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вміння: 

оперувати властивостями кольору; 

використовувати невласні характеристики кольору; 

встановлювати зв'язок між кольором та формою об'єкта; 

досліджувати характер колірного сприйняття та деталізувати (за 

елементним складом) процес виникнення зорового колірного відчуття; 

комунікації: 

консультації працівників додрукарського відділу поліграфічного під-

приємства стосовно доцільності застосування ефекту колірних оптичних 

ілюзій у процесі розроблення колірного рішення поліграфічної продукції; 

надання допомоги у встановленні зв'язку між кольором та формою 

об'єкта; 

автономність і відповідальність: 

самостійний вибір доцільної групи невласних характеристик кольору; 

ухвалення рішення про доцільність застосування колірних ілюзій; 

професійна підготовка осіб, що беруть участь у процесі підвищення 

якості сприйняття кольору. 

 

Вступ 

 

У процесі розроблення колірного рішення поліграфічної та муль-

тимедійної продукції треба оперувати багатьма властивостями кольору. 

Для цього необхідно знати природу формування кольору та склад його 

властивостей, у якості яких виступають тон, хроматичність, насиченість, 

яскравість, контрастність, відтінок та ін. Бути обізнаним у питаннях еволю-

ційних змін визначення кольору в рамках колірних моделей. Знати, яким 

чином відбувається утворення кольору та які особливості притаманні про-

цесу візуального сприйняття кольору. Наведені знання є важливими для 

розуміння природи кольору та того, що вивчають такі розділи дисципліни 

"Теорія кольору", як фізіологія, фізика, психологія та метрологія кольору.  

 

1.1. Колір та його основні властивості  

 

Колір є складним явищем, що має таке змістовне навантаження: 

а) колір – це форма світлової енергії, переданої у вигляді хвиль; 

б) колір – це властивість спектрального складу випромінювань, що 

не розрізняються візуально;  
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в) око людини, як правило, є винятковим інструментом порівняння 

кольорів. Дія на органи зору випромінювань, довжини хвиль яких перебу-

вають у певному діапазоні, приводить до виникнення зорових відчуттів. 

Ці відчуття розрізняються кількісно та якісно. Їх кількісна характеристика 

називається світлотою, якісна – кольоровістю. Початкове представлення 

про світлоту й кольоровість можна проілюструвати, помістивши пофар-

бовану поверхню частково на пряме сонячне світло, а частково – у тінь. 

Обидві частини її мають однакову кольоровість, але різну світлоту. Сукуп-

ність цих характеристик і позначається терміном "колір"; 

г) коли люди думають про колір, вони схильні під час цього уявляти 

фізичні об'єкти, такі, як зелена трава, чорний мерседес, блакитне небо  

й ін. Те, що люди розуміють як колір, у дійсності, є наслідком поглинання 

й відбиття хвиль, які впливають на "датчики" всередині ока, і в результаті 

цього впливу в мозку виникають певні асоціації. Наприклад:  

червоний – асоціюється з почуттями, які є енергійними, з почуттями 

хвилювання, любові. Більшість кольорів несуть і позитивні, і негативні зна-

чення. Зворотна сторона червоного викликає агресивні почуття, гнів; 

жовтий – колір радості, сонячного світла. Цей колір оптимістичний, 

сучасний, наприклад, жовтий соняшник може підсилити святковість, радіс-

ність і теплоту сайта тропічного курорту, однак цей же колір може негативно 

вплинути на репутацію сайта юридичної фірми, оскільки ще одне значення 

жовтого – невпевненість;  

зелений – у позитивному значенні він означає натуральні, природні 

стани (рослинний світ, ліси), життя, стабільність, спокій, природність.  

З іншого боку, зелений у деяких своїх відтінках або в деякому нетради-

ційному контексті (типу зеленої шкіри у коміксах) може асоціюватися  

з токсичністю, штучністю тощо. 

Таким чином, під кольором розуміють відчуття, що виникає у сві-

домості людини, під час впливу на її зоровий апарат електромагнітного 

випромінювання з довжиною хвилі в діапазоні від 380 до 760 нм (770 нм). 

Ці відчуття можуть бути викликані такими причинами, як знання, досвід, 

життєвий випадок, хвороба, удар, галюцинації й ін.  

Інакше кажучи, колір – це оптичне явище, почуттєве відчуття, ство-

рюване оком і мозком. Колір не є фізичною змінною й, отже, не має 

фізичних одиниць вимірювання. Власне предмети не є кольоровими: 

відчуття кольоровості виникає як результат впливу світлових випроміню-
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вань (рис. 1.1). Видиме сонячне світло, що сприймається як біле, висвітлює 

предмет і частково відбивається. Отже, об'єкт, що перебуває в червоній 

зоні видимого спектра, сприймається пофарбованим у червоний колір. 

Об'єкт, що повністю відбиває випромінювання всього видимого спектраль-

ного діапазону, як правило, здається білим, а об'єкт, що повністю поглинає 

випромінювання, – чорним. 

 

 
Рис. 1.1. Поняття кольору об'єкта 

 

У зв'язку з роллю колірних відчуттів у житті й діяльності людини 

виникла наука про колір – теорія кольору або кольороведення. Вона 

вивчає коло питань, пов'язаних з оптикою й фізіологією зору, психологією 

сприйняття кольорів, а також теоретичні основи й техніку вимірювання і від-

творення кольорів. Теорія кольору як наука містить ряд розділів (рис. 1.2). 

 

 
Рис. 1.2. Розділи науки "Теорія кольору" 

 

Об’єкт, що пропускає 

Об’єкт, що відбиває 

        Об’єкт, що випускає 

Проникаюче, відбите або випущене 
світло складає те, що називається 

кольором об’єкта  

Колір 

Теорія кольору  

Фізика 
кольору  

Фізіологія 
кольору  

Психологія 
кольору  

Метрологія 
кольору  
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Слід розглянути змістовне навантаження кожного розділу. 

Фізика кольору розглядає властивості світла, в основному – розподіл 

світлового потоку за спектрами випущення й відбиття, а також способи 

одержання цих спектрів, апаратуру й приймачі випромінювання. 

На зовнішній вигляд конкретного кольору впливають три фізичних 

фактори:  

джерело світла; 

інформація про навколишні предмети; 

зоровий апарат людини. 

Дія випромінювань на око, причини виникнення зорового відчуття, 

зоровий апарат і його робота – зміст частини, яка називається фізіологією 

кольору. 

Співвідношення між фізичними характеристиками випромінювання 

й відчуттями, які викликаються діями випромінювань, становлять предмет 

психології кольору. 

Метрологія кольору (або колориметрія) – це розділ теорії кольору, 

що вивчає методи вимірювання кольору. Метрологія встановлює способи 

чисельного вираження кольорів, основи їх класифікації, методи встанов-

лення колірних допусків. Колориметрія використовує два способи кількіс-

ного опису кольорів: 

1) визначення їхніх колірних координат, тобто суворих чисельних 

характеристик, за якими їх можна не тільки описати, але й відтворити. 

Системи вимірювання кольору називаються колориметричними; 

2) знаходження у деякому наборі еталонних кольорів зразка, тотож-

ного даному. Сукупність зразків становить систему, яка називається сис-

темою специфікації.  

Закономірності, знайдені фізикою, фізіологією, психологією й метроло-

гією кольору використовуються в теорії відтворення кольорового об'єкта. 

Вона є основою техніки одержання кольорових зображень у поліграфії, 

кінематографії й телебаченні. 

Теорія кольору є самостійною наукою, що застосовує досягнення 

інших наук, переносячи їх у свою предметну область. 

Властивості кольору 

Існуючі в природі кольори за колірними властивостями можна роз-

поділити на дві групи: 

ахроматичні (безколірні); 

хроматичні (кольорові). 
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Білий, чорний і цілий ряд проміжних сірих тонів належать до ахро-

матичних. Різниця в зорових відчуттях під час дії на око ахроматичних 

випромінювань залежить тільки від рівня подразнення рецепторів. Тому 

ахроматичні кольори можуть бути задані однією психологічною величи-

ною – світлотою.  

Чим більше світла відбиває предмет, тим він здається білішим, і чим 

більшу кількість світла предмет поглинає, тим він здається чорнішим. Між 

найяскравішим (білим) і найтемнішим (чорним) існує безліч відтінків 

сірого кольору. Людське око розрізняє близько 300 ахроматичних відтінків. 

Якщо рецептори різних типів роздратовані неоднаково, то виникає 

відчуття хроматичного кольору. Хроматичні кольори – це кольори та їх 

відтінки, які людина розрізняє в спектрі. Група хроматичних колірних 

тонів складається із червоних, жовтогарячих, зелених, фіолетових тощо 

та безлічі проміжних тонів. Для їх опису потрібні вже дві величини: світ-

лота й кольоровість. 

Хроматичні кольори володіють трьома основними властивостями: 

колірним тоном, світлотою (або яскравістю) та насиченістю. 

Колірним тоном називають таку властивість кольору, що дозволяє 

оку людини сприймати й визначати червоний, жовтий, синій та інший спек-

тральний кольори. Він необхідний для розподілу за зображенням світлих  

і темних значень. Колірний тон означає окремий колір, наприклад, червоний. 

Колірний тон кольору – це та його властивість, що мають на увазі 

в повсякденному житті, коли називають колір предмета. Незважаючи на 

очевидність поняття, загальновизнаної дефініції колірного тону немає. 

Одна з них дається, наприклад, в такій формі: колірний тон – це характе-

ристика кольору, що визначає його подібність до відомого кольору (неба, 

зелені, піску тощо), що виражається словами синій, зелений, жовтий і т. д.  

Якщо колірне відчуття формується в результаті однакового подраз-

нення рецепторів двох типів у разі меншого внеску третього, то виникає 

колір проміжного тону. Так, блакитний колір відчувається за умови однако-

вих реакцій зеленочуттєвих і синьочуттєвих оболонок. 

Колір описують у термінах тональності, що означає світлоту кольору 

або частку білого чи чорного. Білий колір, що додається наростаючими 

частками до кожного з 12 кольорів спектра, створює світлі поєднання, що 

називають тонами, наприклад, рожевий колір є тоном червоного кольору. 

Додавання чорного або сірого до кожного з базових кольорів приводить 
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до появи колірних поєднань, які називають відтінками, наприклад, відтін-

ком червоного буде колір каштана. 

Світлота – це властивість кольорової поверхні відбивати більшу 

або меншу кількість падаючих променів світла. У разі більшого відбиття 

світла людина сприймає колір поверхні як світлий, у разі меншого – як 

темний. Це загальна властивість для хроматичних і ахроматичних кольорів, 

тому за світлотою можна порівнювати будь-які їх тони. 

Насиченістю хроматичного кольору називають ступінь відмінності 

цього кольору від ахроматичного сірого, рівного йому за світлотою. На-

приклад, якщо до жовтого додати небагато сірого, рівного йому за світло-

тою, то отриманий жовтий колір буде помітно відрізнятися від початкового – 

він посіріє, стане менш жовтим, але світлота колірного тону не зміниться. 

Насиченість означає інтенсивність кольору.  

Зниження насиченості колірних тонів досягається додаванням не 

тільки сірого тону, але й будь-якого ахроматичного – від чорного до білого. 

У разі додавання чорного одержують темно-зелені, темно-сині, а білого – 

блідо-зелені, рожеві тони.  

За умови поступового додавання білого одночасно зі зменшенням 

насиченості зростає світлота. 

Колірний тон, світлота й насиченість кольору залежать не тільки від 

спектрального складу випромінювання, але й від умов спостереження, 

стану спостерігача, кольору фону об'єкта й інших факторів. Найменша 

зміна однієї із цих величин спричиняє зміну кольору. 

Хроматичні кольори, які в оптичному змішуванні дають ахроматичний 

колір називаються взаємодоповнювальними. 

Додатковими властивостями хроматичних кольорів є: колірна яскра-

вість, освітленість та контрастність. 

Колірна яскравість – це інтенсивність кольору або наскільки світлим 

чи темним він виглядає. У разі менших значень яскравості колір затем-

нюється, створюючи те, що нами сприймається як темний відтінок. 

Освітленість – це наскільки колір є яскравим. 

Контрастність – це взаємовідношення між світлою й темною 

інформацією. Чим більша різниця між двома тонами, тим вища контраст-

ність. Розрізняють загальну й спеціальну контрастність (між сусідніми 

пофарбованими областями). Наприклад, світлий тон, що перебуває поруч 

із темним, здається ще світлішим, а темний, що перебуває поруч зі світлим – 

ще темнішим. 
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Розрізняють два види колірного контрасту:  

світлотний; 

хроматичний. 

Світлотним контрастом (контрастом за світлотою) називається 

зміна світлоти під дією сусідніх кольорів. Одночасний світлотний контраст 

виникає за наявності між двома кольорами тональної різниці. Коли дані 

кольори існують у парі, то вони підвищують яскравість один одного. 

Наприклад, якщо три сірих квадратики однакової світлоти помістити один 

на чорний, інший на білий, а третій на сірий фон, то можна побачити, що 

всі три сірих квадратики будуть виглядати неоднаково, будуть мати різну 

світлоту, а саме: сірий квадратик на чорному фоні буде виглядати світліше, 

ніж на білому, а на сірому – не зміниться (рис. 1.3).  

 

 
 

Рис. 1.3. Світлотний контраст 

 

Таким чином, суть одночасного світлового контрасту (ахроматичного) 

полягає у тому, що світлий об'єкт на темному фоні здається світлішим, 

ніж є насправді, а темний на світлому – темнішим (чим він менший, тим 

темнішим здається). Зміну лінійних розмірів фону й об'єкта, поміщеного на 

даний фон, називають іррадацією. Наприклад, чим менший об'єкт, тим 

він здається темнішим і навпаки. 

Хроматичним контрастом називають зміну колірного тону або наси-

ченості кольору під дією сусідніх хроматичних кольорів. Наприклад, якщо 

однакові квадратики сірого паперу покласти на різні хроматичні фони, то 

на червоному фоні сірий тон буде здаватися зеленуватим, на жовтому – 
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синюватим, на синьому – жовтуватим, на зеленому – рожевим. Таким чином, 

відбувається зміна тону сірих квадратиків під впливом різного фарбу-

вання фону й сірий тон здобуває відтінок додаткового кольору стосовно 

фону (рис. 1.4). 

 

 
 

Рис. 1.4. Хроматичний контраст 

 

Наслідки хроматичного контрасту:  

1) якщо кольорова фігура оточена хроматичним фоном, то її колір 

змінюється ближче до кольору, додаткового до кольору фону; 

2) якщо фігури й фон пофарбовані в додаткові кольори (наприклад, 

фігура пофарбована в зелений колір, а фон – у червоний, то зелений колір 

фігури не змінює свого колірного тону, а навпаки, здається ще більш 

зеленим, тобто стає насиченішим). Отже, колір, перебуваючи на фоні свого 

додаткового кольору, зберігає свій колірний тон, здобуваючи більшу 

насиченість; 

3) будь-який колір, перебуваючи на фоні однакового з ним колірного 

тону, але більшої насиченості, втрачає частину своєї насиченості. 

Колірний контраст за насиченістю особливо помітний під час зістав-

лення ахроматичних кольорів із хроматичними (на чорному фоні будь-який 

колір знижує свою насиченість, а на білому або світло-сірому – підвищує). 

Даний ефект використовують, коли потрібно підсилити чистоту певного 

кольору.  

Особливості кольору 

Виділяють категорію невласних характеристик кольору, які вини-

кають внаслідок емоційної реакції під час його сприйняття. Так, кольори 

бувають виступаючі й відступаючі, гарячі й холодні, світлі й темні тощо – 

ці характеристики важливі поліграфістові для коректного формування  

стає зеленуватим стає синюватим стає жовтуватим стає рожевим 

червоний фон жовтий фон синій фон зелений фон 
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та представлення вигляду поліграфічної продукції з метою передбачення 

й управління реакцією реальних (або латентних) споживачів даної продукції. 

Серед ахроматичних тонів світлі сприймаються як такі, що набли-

жаються, а темні – як такі, що віддаляються. 

Теплі кольори здаються більш близькими (виступаючими), а холодні – 

більш далекими (відступаючими). З насичених кольорів хроматичного 

ряду найбільшою здатністю наближати поверхню володіють жовтогарячий 

і жовтий кольори, а найбільшою здатністю віддаляти поверхню – синій 

колір і, в дещо меншому ступені, бірюзовий. Так, жовтогарячий із білим 

здається більш близьким, ніж насичений жовтогарячий, синій із білим – 

менш віддаленим, ніж насичений синій. 

Основними групами невласних характеристик кольору є:  

гарячі/холодні кольори; 

теплі/прохолодні кольори; 

світлі/темні кольори; 

приглушені/яскраві кольори. 

Гарячі кольори здаються такими, що виступають за площину зобра-

ження, їх часто використовують у графічних зображеннях і дизайні. Гарячі 

кольори сприяють підвищенню кров'яного тиску й стимулюють нервову 

систему. До таких кольорів належить червоний. До холодних кольорів 

належить насичено синій. Він дає відчуття сили, заспокоює. Розміщені 

поруч один із одним гарячий і холодний кольори створюють ефект вібру-

вання поверхні зображення. Під час зіставлення холодних кольорів конт-

раст сильніший, ніж у разі зіставлення гарячих. 

Усі гами, які містять червоний, створюють відчуття тепла. У разі 

зіставлення жовтого із червоним виявляється відмінність теплих кольорів 

від гарячих. До теплих кольорів належать: червоно-жовтогарячий, жовто-

гарячий і жовто-жовтогарячий. Вони комфортні, імпульсивні й привітні.  

В основі прохолодних кольорів лежить блакитний. Додаванням у прохолодні 

кольори жовтого утворяться жовто-зелені, зелені й зелено-блакитні кольори. 

Існують прохолодні кольори, такі, як блакитний туркіс або зелений вердан. 

Прохолодні кольори дають відчуття відновлення, глибини й комфорту. 

Умовно прийнято вважати частини спектра від зеленого до черво-

ного – теплими, від блакитного до пурпурного – прохолодними, але пурпур-

ний колір є проміжним. Теплі та прохолодні кольори пов'язані з моделю-

ванням форми та трактуванням простору. 
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Група світлих кольорів базується на палевих пастельних тонах. Колір 

ледь позначений, відтінки здаються повітряними й легкими. Світлі кольори 

викликають відчуття заспокійливості, розслаблення й спокою. До темних 

кольорів належать ті колірні комбінації, в композиції яких міститься чорний 

колір. Вони, ніби закривають простір і роблять його меншим. Ці кольори 

позначають серйозність і концентрацію.  

Група приглушених кольорів містить колірні комбінації, в композиції  

яких наявно приблизно 65 % білого кольору. Вони мають приглушений 

характер, завдяки цьому ці кольори називають м'якими, романтичними. 

До приглушених кольорів належать: колір слонової кістки, світло-блакит-

ний, рожевий й ін. 

Кількість чистого кольору в гамі вимірюють його яскравістю. Світлість 

яскравих кольорів досягається за рахунок відсутності сірих і чорних фарб. 

Блакитні, червоні, жовті й жовтогарячі – це інтенсивні кольори. Яскраві 

кольори привертають увагу, вони підходять для використання в упакуван-

нях і рекламі. 

Кожен колір має особливу властивість – щільність (вагу). Темні 

кольори, звичайно, важче світлих. Так, лабораторні досліди, що проводи-

лися ще в 1907 році, показали, що люди сходяться на думці щодо умовної 

ваги кольорів. Червоний був визнаний найважчим, за ним ішли рівні за 

вагою жовтогарячий, синій і зелений, потім – жовтий і останнім – білий. 

Колір змінює уявлення про дійсні розміри предметів, причому кольори, 

що здаються важкими, зменшують ці розміри.  

 

1.2. Колірні моделі та схеми 

 

У цілому колірні схеми можна розподілити на два типи: схеми пред-

ставлення кольору від випромінюваного й відбитого світла. Усі об'єкти 

видимі для людини, оскільки вони самі є джерелом світла, або світять від-

битим світлом. Базуючись на запропонованих схемах, було проведено 

ряд наукових і прикладних досліджень та сформовано відповідні моделі 

колірного представлення. 

Історія розвитку моделей представлення кольору починається з XVI ст. 

На рис. 1.5 запропоновано найбільш вагомі (з позиції еволюційного впливу 

на сьогоднішнє розуміння кольору) моделі. 
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Рис. 1.5. Найбільш інформативні моделі зображення кольору 

 

Колірні моделі були задумані й удосконалені протягом сторіч такими 

вченими, як Ісак Ньютон, організаціями такими, як Міжнародна комісії  

з освітлення (CIE – Commission Internationale de l'Eclairage), Національним 
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комітетом з телевізійних стандартів, фірмами-виробниками програмного 

забезпечення й ін.  

Більшість цих моделей прив'язувало колірну гаму до основних гео-

метричних фігур. Кола, які пізніше стали сферами, були найбільш популяр-

ними. Також досить часто зустрічалися трикутники, які потім перетворилися 

в конуси й піраміди. Однак згодом для відображення видимих кольорів  

у теорії стали все частіше використовувати квадратні й кубічні моделі. 

Першим систематизував кольори І. Ньютон, коли, пропускаючи соняч-

ний промінь через тригранну призму, спостерігав утворення спектральної 

смужки, що складається з гами різних кольорів (рис. 1.6). 
 

 
Рис. 1.6. Поділ білого кольору на складові компоненти 

 

Замкнувши її, він отримав коло із семи кольорів (рис. 1.7). 
 

 

 

 

 

 

 

 

 

 

Рис. 1.7. Колірне восьмисекторне коло І. Ньютона 
 

На стику червоного кольору з фіолетовим кольором утворюється 

восьмий (неспектральний) колір – пурпурний. 

Відкриття, зроблене І. Ньютоном, полягає у такому: забарвлення будь-

якого об'єкта залежить від того, яке світло йде від нього до ока спостері-

гача. Це, у свою чергу, залежить як від характеру світла, яке падає на об'єкт, 

так і від поверхні об'єкта, що відбиває, поглинає та пропускає окремі 

жовтий 

жовтогарячий 

червоний 

пурпурний 

зелений 

блакитний 

синій 

фіолетовий 
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промені спектра. Якщо у світлі, що падає на поверхню, відсутні деякі 

кольори, їх не буде й у світлі, відбитому від цієї поверхні. Білий колір син-

тезується, коли збірна лінза возз'єднує промені спектра. Однак якщо пере-

городити шлях частині спектра, суміш зафарбується в додатковий колір. 

Наприклад, коли шлях перегороджено зеленому променю, то одержуване 

світло має забарвлення пурпурного кольору, що є додатковим до зеленого. 

Серед інших колірних моделей, на яких варто зупинитися, виділяє-

ться сфера Munsell-а (Munsell Spheres) (див. рис. 1.5), яка є одним із тих 

стандартів, за якими зараз вимірюються кольори. Колірна сфера (або,  

як її ще називають, колірне коло) Munsell-а призначена для показу колір-

ного охвату поліграфічним способом відтворення.  

Художник-практик Альберт Манселл урахував, що кольори, і тим паче 

реальні фарби, для систематизації яких він і запропонував відповідне 

колірне коло, не можуть бути однакової градації світлоти у разі макси-

мальної насиченості. Тому найбільш насичені кольори повинні лежати  

на різних рівнях, а на екваторі розташовані кольори однієї світлоти. У цьому 

разі кількість світлотних градацій для кожного кольору неоднакова, век-

тори світлоти мають різну довжину. У результаті колірне коло Munsell-а 

має складну, несиметричну форму. На рис. 1.8 показано вид колірного кола 

та його колірний (екваторіальний) розріз. 
 

 
 

 а) вид колірного кола  б) колірний (екваторіальний) розріз 

 

Рис. 1.8. Колірне тіло Munsell-а 
 

Базуючись на представленні колірних моделей з позиції еволюції їх 

вигляду (див. рис. 1.5), можна дати таке визначення сучасного поняття 

"колірна модель". 

Колірна модель – це математичне визначення колірного простору.  
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Колірна модель визначає діапазон кольорів, які в зображенні можна 

показати на екрані або одержати під час кінцевого друку. 

У цьому просторі кожне значення є певною точкою – кожен колір існує 

у вигляді набору числових координат. Цей метод дозволяє передавати 

колірну інформацію між комп'ютером, спеціальними програмами й пери-

ферійними пристроями. 

На сьогоднішній день для створення та оброблення повно-кольо-

рових зображень використовуються такі колірні моделі: RGB, CMY, HSB, 

Lab та ін. Зміст та особливості використання даних моделей докладно 

будуть розглянуті далі. 

 

1.3. Особливості сприйняття кольору 
 

Сприйняття кольору прийнято визначати як почуттєве відчуття, 

ініційоване кольором у свідомості людини. 

Через те, що оптичний кут чіткого зору ока вкрай малий (усього 1,5 

градуса), око перебуває в постійному русі, систематично обстежуючи окремі 

деталі об'єкта спостереження, з метою відтворення загального, цілісного 

образу. 

Особливість візуального сприйняття полягає в тому, що сприймаюча 

система (зоровий аналізатор) має тенденцію групувати зорові елементи 

в прості поняття. Людина підсвідомо групує сенсорні дані в готові об'єкти, 

шукає й відкриває закономірність у випадковому. Широко відомі експери-

менти із чорнильними плямами, які прочитувалися випробуваними людьми 

як силуети знайомих предметів. Кожна людина проводила підсвідомо над 

собою такий же експеримент, розглядаючи, наприклад, малюнок на шпа-

лерах або відшукуючи у формі літніх хмар силуети знайомих предметів, 

профілі людей і тварин? На рис. 1.9 (оптичні ілюзії на прикладі викорис-

тання ахроматичних кольорів) зображені фігури, які залежно від психоло-

гічної установки людини на сприйняття можуть сприйматися по-різному: 

а) залежно від того, що усвідомлюється людиною як фігура, а що – 

як фон (світле або темне), можна бачити або вазу, або два профілі 

(рис. 1.9 а, б); 

б) глядачеві незрозуміло, у якому ракурсі сприймати малюнок 

прозорого куба (так званого куба Неккера) (рис. 1.9 в). Заштрихована по-

верхня прозорого куба залишає тільки два варіанти сприйняття ракурсу: 

якщо заштрихована поверхня сприймається як ближня, то куб видний 

ледве зверху, а якщо як далека, то знизу; 
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в) незважаючи на те, що обидва відрізки мають однакову довжину, 

верхній здається коротше, ніж нижній (рис. 1.9 г); 

г) на рисунку ліворуч центральне коло здається більше, ніж на рисунку 

праворуч, хоча в дійсності вони однакові (рис. 1.9 д); 

д) можна чітко розрізнити два трикутники. Завдяки повному або дос-

татньому контрасту між білим трикутником і чорними кружечками, відчу-

вається, що білий трикутник перебуває зверху, тобто ближче до нас, ніж 

трикутник, змальований темною лінією (рис. 1.9 е). 
 

  
 

  
 

  
 

 

Рис. 1.9. Оптичні ілюзії на прикладі використання 

ахроматичних кольорів 

 

Різне розуміння цих малюнків – ілюстрація того, що сприйняття не 

визначається тільки сукупністю силуетів, швидше це динамічний пошук 

найкращої інтерпретації одержуваних сенсорних даних. Зорова система 

людини влаштована таким чином, що вона може побачити те, що хочемо 

побачити, а не те, що потрапляє в поле зору. Сприйняття кольору обумов-

лене не тільки стимуляцією ока певною довжиною хвилі й величиною 

інтенсивності світла. Необхідно розуміти, чи зображує сукупність колірних 

а) оптична ілюзія світла б) оптична ілюзія темна 

в) куб Неккера г) однакові відрізки 

д) ілюзія центрального кола е) ілюзія з трикутниками 
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плям на сітківці який-небудь пізнаваний предмет, і тоді вступають у дію 

вищі рівні мозкових процесів. Свідомість людини добудовує простір, 

глибину й форму. 

Зв'язок кольору й форми був доведений експериментально – на основі 

виникнення й дослідження так званого ефекту Макколлоу. Даний ефект 

показує, що на якому-небудь етапі оброблення мозком зорових сигналів 

існує зв'язок між формою й кольором. Виходячи з ефекту Макколлоу, при-

пускають, що колір і форма аналізуються одночасно якою-небудь частиною 

зорової системи.  

Зміст ефекту Макколлоу: у процесі адаптації до кольорового візе-

рунка кожна точка сітківки піддається подразненню червоними й зеленими 

променями рівною мірою. Виходить, можна допустити, що в людському мозку 

існують нервові клітини, що реагують на смуги тільки певного кольору  

й певного напряму. Уявлюваний колір похилої смуги залежить від відносної 

активності клітин, налаштованих на даний напрям, таких клітин, що розріз-

няються за сприйняттям кольору, який викликає у них реакцію. Поки спосте-

рігач дивиться на кольоровий візерунок, клітини, що сприймають, наприклад, 

зелені смуги, нахилені під кутом 45° вправо (й інші, що сприймають червоні 

смуги, нахилені під кутом 45°), стомлюються. Після цього частина чорно-

білого візерунка, нахилена під кутом 45° вправо, виглядає рожевою, тому 

що стомлені клітини посилають сигнал меншої сили. Кольори "прив'язані" 

до смуг і не йдуть за поглядом. Більше того, якщо повернути чорно-білий 

візерунок на 90°, то смуги в даній частині візерунка змінять уявлюване 

фарбування відповідно до зміни нахилу. Це показує, насамперед, що має 

значення не розміщення смуг, а центрування їх за осями. Таким чином, екс-

периментально було доведено взаємозв'язок кольору й форми. 

Базуючись на тому, що колір – це почуттєве відчуття, необхідно роз-

глянути, від чого ж залежить характер колірного сприйняття. 

Характер колірного сприйняття пов'язаний зі спектральним складом 

діючого на око світла й з властивостями зорового апарата людини. 

Кольори, які людина бачить під час розщеплення сонячного світла 

за допомогою призми, називають спектральними кольорами. Це чер-

воний, жовтогарячий, жовтий, зелений, блакитний, синій і фіолетовий. 

Цю комбінацію часто зводять до трьох кольорів: червоний, зелений і синьо-

фіолетовий, які є основними кольорами адитивної системи кольорів. 

Базуючись на тому, що колір – це форма світлової енергії, переданої 

у вигляді хвиль (визначення – а) та колір – властивість спектрального 
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складу випромінювань, що не розрізняються візуально (визначення – б), 

доцільно говорити про вплив спектрального складу на результуючий 

колір (рис. 1.10 – кольори випромінювань зіставлені із займаними ними 

спектральними інтервалами). 
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Рис. 1.10. Спектральні інтервали 

 

Деякі хвилі не можна побачити людським оком, наприклад, в інфра-

червоного світла довжини хвиль занадто великі, а в рентгенівських про-

менів – занадто малі. Між ними й перебуває видимий спектр.  

За інтервалом, займаним випромінюванням, колір можна вказати ціл-

ком однозначно: якщо тіло випромінює або відбиває в межах 565 –580 нм, 

то колір його завжди жовтий. Однак зворотний висновок буде не завжди 

правильним: за відомим кольором випромінювання неможливо впевнено 

вказати його спектральний склад або довжину хвилі. Наприклад, якщо 

випромінювання жовте, це не означає, що воно займає названий інтервал 

або його частину, тому що жовтою виглядає й суміш монохроматичних ви-

промінювань, що перебувають поза цим інтервалом: зеленого ( 1 = 546 нм) 

із червоним ( 2 = 700 нм) у разі певних співвідношень їх потужностей.  

Теорія колірного зору пояснює, чому ділянка спектра, що перебуває 

в межах 400 – 700 нм, робить світлову дію й з якої причини людина бачить 

випромінювання в діапазоні 400 – 450 нм фіолетовим, 450 – 480 – синім  

і т. д. Сутність теорії полягає в тому, що світлочутливі нервові закінчення, 

що перебувають в одній з оболонок ока й мають назву фоторецептори, 

реагують тільки на випромінювання видимої частини спектра. Око містить 
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три групи рецепторів, з яких одна найбільш чутлива до інтервалу 400 – 

500 нм, інша – 500 – 600 нм, третя – 600 – 700 нм. Рецептори реагують 

на випромінювання відповідно до їх спектральної чутливості, і відчуття 

всіх кольорів виникають у результаті комбінації трьох реакцій. 

У мозку людини видимий спектр розподіляється на три домінуючі 

області: червону, зелену й синю, а за цими кольорами потім обчислю-

ється сукупна колірна інформація (рис. 1.11). 
 

 

Рис. 1.11. Функція реакції людського зору 

на три основні колірні області (R, G, B) 

 

Білий колір є комбінацію всіх довжин хвиль видимого спектра. Коли 

світло потрапляє на несвітловий об'єкт (такий, як папір або фарба), хвилі 

деяких довжин поглинаються матеріалом, а інші – відбиваються від нього, 

і поглинені хвилі створюють видимість кольору. Проходячи через прозо-

рий матеріал (наприклад, фотоплівку) світло швидше фільтрується, ніж 

поглинається. Довжини хвиль видимого світла певним чином змінюються 

і в людини виникає враження створення нового кольору.  

Різні за якістю джерела світла, що відбивається від об'єкта, значно 

впливають на довжини хвиль, що вийшли в результаті відбиття, і, як наслі-

док, на сприйняття кольору. Наприклад, якщо махати тим самим предме-

том, що має певний колір, перед двома різними джерелами світла, ство-

рюється враження, що предмет у кожному випадку різного кольору. 

Однак залишається не вирішеним питання, яким же чином відбува-

ється процес формування колірної інформації у людини? На це питання 

дозволяє дати відповідь матеріал, що стосується фізичного шляху утво-

рення кольору.  

Під час розгляду питань сприйняття й опису кольору виокремлюють 

фізичні й фізіологічні аспекти. За допомогою колориметра можна визначити 
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фізичні характеристики кольору, але як їх інтерпретує мозок людини 

(сприйняття кольору) – можна тільки розрахувати. Багато науково-дослідних 

груп працювали над створенням моделей, що описують вимірювальний 

інструмент "око" і сприйняття кольору мозком. До останнього часу діють 

важливі для опису кольору постанови міжнародної комісії з освітлення (CIE), 

прийняті в 1931 р. Вони регламентують вимірювання кольору на основі 

введення еталонного спостерігача в колориметрію.  

Через очі надходить 78 % всієї інформації, що людина сприймає  

з навколишнього світу, інші 22 % припадають на частку слуху, дотику, 

нюху й смакових відчуттів. Причому в процесі оптичного зору всі ці почуття 

постійно включаються в роботу, підсумовуючи інформацію, необхідну 

для запам'ятовування й класифікації зорових образів. 

Основний принцип виникнення зорового колірного відчуття: коли 

світло падає на об'єкт, то частина світлового потоку поглинається пігмен-

тами об'єкта, а частина, відбиваючись, потрапляє в око, викликаючи від-

чуття кольору (рис. 1.12). 

 

 
 

Рис. 1.12. Процес виникнення зорового колірного відчуття 

 

Колбочки сітківки, тобто фоторецептори людського ока, здатні 

розпізнавати не всі кольори, а в основному такі, як червоний, зелений і 

синій. А що стосується мозку, то колір – це відповідний сигнал нейрона, 

викликаний у результаті збудження колбочок світловим сигналом. Невеликі 

генетичні розходження в цих мікроскопічних комірках пояснюють, чому 

дві людини, дивлячись на той самий предмет за тих же самих умов, 

можуть бачити його по-різному (рис. 1.13). 
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Рис. 1.13. Якісне сприйняття кольору (колірний тон, яскравість тощо) 

 

Фізичною основою кольоросприйняття є наявність специфічних 

світлочутливих клітин у центральній ділянці сітківки ока (тобто паличок і 

колбочок) із максимумами спектральної чутливості в трьох різних спек-

тральних ділянках: червоній, зеленій і синій. Велику роль у кольоросприй-

нятті відіграє процес перероблення сигналу, що надходить на сітківку ока, 

у корі головного мозку, у його потиличних долях. 

Процес сприйняття кольору: очна лінза (кришталик) дає оптичне 

зображення спостережуваного предмета, що системою нервових закінчень, 

які перебувають в одній з оболонок ока, перетворюється в сигнали (їх час-

тота збільшується із зростанням освітленості сітківки).  

У сітківці три шари нервових клітин – нейронів, пов'язаних розгалу-

женнями – синапсами, що забезпечують передачу електричного сигналу 

від однієї клітини до іншої. Нейрони, найбільш вилучені від внутрішньої 

поверхні сітківки, закінчуються рецепторами. Вони бувають двох типів: довгі 

й тонкі – називаються паличками, товсті й короткі – колбочками. Палички 

забезпечують чорно-білий зір, колбочки – як чорно-білий, так і кольоровий. 

Світлова чутливість паличок і колбочок різна. Палички працюють  

за умов низької освітленості й "вимикаються" за умов високої. Ці рецеп-

тори забезпечують так званий сутінковий зір, коли освітленість невелика. 

У напівтемряві не розрізняються кольори, погано видні деталі. Це пояс-

нюється тим, що палички розташовуються на сітківці значно рідше, ніж 

колбочки, а розрізняльна здатність паличкового апарата набагато нижче, 

ніж колбочкового.  
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Колбочковий зір називається денним. За умов високої освітленості, 

коли починають діяти колбочки, око розрізняє кольори й дрібні об'єкти. 

У результаті світлового збудження паличок або колбочок у мозок 

передаються електричні імпульси. Вони досягають потиличних долей 

головного мозку, де збуджують світлові відчуття, з яких складається зоро-

вий образ об'єкта.  

Таким чином, зоровий образ об'єкта складається зі світлових від-

чуттів, викликаних імпульсами, переданими в потиличні долі мозку. 

Здатність ока реагувати на можливо малий потік випромінювання 

називається світловою чутливістю. Вона вимірюється як величина гра-

ничної яскравості. Граничною називається та найменша яскравість об'єкта, 

наприклад світлової плями, за якої воно може бути виявлено з достатньою 

ймовірністю на абсолютно чорному фоні. 

Світлову чутливість (Sn) визначають як величину, зворотну граничній 

яскравості (Bn), за умови, що кут зору   50 : 
 

 Sn = (1 / Вn)   50 .  (1.1) 

 

Реакція ока, що виражається у виникненні світлового відчуття, зале-

жить, по-перше, від потоку випромінювання (Ф ), що впало на сітківку, по-

друге, від тієї частки потоку, яка впливає на рецептори. Ця частка є спек-

тральною чутливістю (k ). Іноді для позначення того ж поняття засто-

совують термін "спектральна ефективність випромінювання". Добуток 

k  ×  Ф  визначає характеристику потоку випромінювання, пов'язану з рівнем 

його світлової дії, яка називається світловим потоком (F ):   
 

 F  = Ф  ×  k .  (1.2) 
 

Абсолютне значення спектральної чутливості визначають відношенням: 
 

 k  = F  / Ф .  (1.3) 
 

Вступ до питання вимірювання кольору 

Людина може, дивлячись на папір і монітор (або вихідний об'єкт), 

порівнювати свої відчуття, досягаючи їх ідентичності, однак комп'ютер 

працює тільки з числами. Це означає, що виникає безпосередня потреба 

у вимірюванні колірних відчуттів. 

Фотографи, художники, дизайнери, поліграфісти зобов'язані яким-

небудь чином оцінювати якість світла, щоб користуватися стандартними 

постійними значеннями. Це робиться вимірюванням температури джерела 
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світла, тобто його хроманичності. Фахівці з кольору використовують шкалу 

Кельвіна, що починається з абсолютного нуля. Щоб перевести кельвіни  

у величину, виражену за шкалою Цельсія – від першого числа віднімають 

273 (отримують -273°К – температурну точку, за якої припиняється будь-

який рух молекул). Ідея використання шкали Кельвіна може здатися на 

перший погляд дивною. Можна розглянути для прикладу нагрівання ста-

левого дроту. У міру збільшення температури він розжарюється до черво-

ного кольору, потім до білого й, нарешті, починає світитися блакитним 

кольором (тобто, якщо нагрівання відбувається до точки випарювання,  

а потім пар нагрівається до ~ 20 000°К, то пікове випромінювання буде 

ультрафіолетовим; оку колір пари здасться синім). 

Як приклад, на рис. 1.14 наведено розподіл енергії випромінювання 

чорного тіла залежно від температури. 
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Рис. 1.14. Розподіл енергії випромінювання чорного тіла 

залежно від температури 

 

Колірна температура – це зручний спосіб позначення кольоровості 

природного й штучного світла (однак її не треба плутати з тепловою 

температурою джерела світла). Під колірною температурою слід розуміти 

характеристику джерела світлового випромінювання, що визначає його 

спектральний склад. 

Шкала колірної температури починається з величини 1 000 °К і не 

має верхньої межі (рис. 1.15). За кожної температури джерело випромінює 

потік різних за довжиною хвиль, але деякі з них домінують, що й визначає 

колір. Завдяки цьому колір випромінюваного світлового потоку в багатьох 

випадках можна виразити в одиницях колірної температури.  
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Рис. 1.15. Шкала колірної температури 

 

Більшість приборів штучного освітлення мають колірну температуру 

від 2 000 °К до 6 000 °К. За більш високої температури в денному світлі 

переважають короткі хвилі, отже, блакитні тони. 

У природі колір знаходиться в проміжку від 1 900 °К (для слабкого 

світла свічки) до 7 500 °К (для яскравого денного світла). Щоб спостері-

гати за кольором в умовах виробництва, як промисловий стандарт вико-

ристовують температуру в 5 000 °К. 

В ідеальному розумінні зазначене означає, що кожен, хто працює  

з кольором, повинен мати можливість оцінити матеріали (які підлягають 

опрацюванню) за однакових умов освітлення. Наприклад, коли в декількох 

середовищах однакове освітлення, то колірний коректор у сервісному бюро 

і дизайнер у дизайн-студії мають можливість робити ідентичні пробні 

відтиски. 

Однак колірна температура не дає точного опису кольору. З метою 

усунення цього недоліку, було розроблено міжнародну систему CIEXYZ, 

побудовану на відомих еталонних (основних) кольорах. Вона надала мож-

ливість для математичного опису всіх видимих кольорів (рис. 1.16). 
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Рис. 1.16. Математичний опис видимих кольорів у системі CIEXYZ 
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Хоча система є тривимірною, але для зручності візуального сприй-

няття усі видимі кольори представляються усередині кривої на площині xy. 

На цій площині позначаються точки, що відповідають значенням координат 

кольоровості спектральних випромінювань від 380 нм до 770 нм. Крива 

отримала назву локуса (або колірної діаграми). Усередині локуса пере-

бувають усі реальні кольори, зовні – нереальні кольори, більш насичені, 

ніж спектральні.  

Колірну діаграму використовують, зазвичай, для зображення колір-

ного охвата ока (всі видимі кольори), а всередині неї – колірні охвати 

різного устаткування.  

Відповідно до експериментально установлених характеристик сере-

дньостатистичного спостерігача в 1931 р. CIE визначила криві додавання 

основних кольорів (рис. 1.17).  
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Рис. 1.17. Стандартні криві додавання кольорів 

 

У цій системі певне співвідношення основних кольорів відповідає 

кожній з довжин хвиль видимого спектра. 

Представленні подібним чином (на основі математичного опису) 

кольори вимірюються за допомогою залучення спеціального обладнання 

(денситометрів, колориметрів, спектрофотометрів та інших пристроїв) на 

основі використання денситометричних і колориметричних методів опра-

цювання кольорів. 

 

Висновки та узагальнення 

 

Колір є багатогранним явищем, яке необхідно комплексно дослід-

жувати з позицій фізики, фізіології, психології та метрології кольору. 
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У якості основних властивостей кольору необхідно розглядати: тон, 

відтінок, хроматичність, насиченість, яскравість, контрастність.  

Першим систематизував кольори І. Ньютон, отримавши коло із семи 

спектральних кольорів: червоний, жовтогарячий, жовтий, зелений, голу-

бий, синій, фіолетовий. 

Характер колірного сприйняття пов'язаний зі спектральним складом 

діючого на око світла й з властивостями зорового апарата людини.  

 

Теоретичні запитання 

 

1. Дайте визначення поняття "колір", ураховуючи різнобічні аспекти 

його розгляду. 

2. Розкрийте змістовне навантаження кожної з властивостей хрома-

тичних кольорів. 

3. Поясніть різницю між світлотним і хроматичним колірними контрас-

тами та наведіть відповідні приклади. 

4. Чим відрізняється тон від відтінку? 

5. Охарактеризуйте такі категорії: "гарячі", "холодні", "теплі", "прохо-

лодні", "світлі", "темні", "приглушені" кольори та специфіку їх використання 

за трьома напрямами – листівка, етикетка і плакат. 

6. Що таке "густина кольору"? Розташуйте відповідно до збільшення 

густини кольори: зелений, білий, фіолетовий, червоний, синій, жовтий, 

жовтогарячий.  

7. Опишіть еволюційні зміни представлення колірних моделей. 

8. Дайте визначення поняття "колірна модель". 

9. Охарактеризуйте найбільш відомі колірні моделі. 

10. Що розуміють під сприйняттям кольору? 

11. Наведіть приклади взаємозв'язку кольору та форми. 

12. Які кольори є спектральними? 

13. Від чого залежить характер колірного відчуття? 

14. Поясніть сутність теорії колірного зору. 

15. Опишіть процес фізіологічного утворення кольору, націленого 

на одержання зорового образу об'єкта. 

16. Що розуміють під світловою чутливістю та світловим потоком? 

Наведіть відповідні формули. 

17. Що таке колірна температура? 
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2. Гармонія колірних сполучень 

 

Основна ідея 

 

Розглянуто теорії і класифікації організації колірних сполучень, 

вивчено методи сполучення кольорів, визначено фактори, що впливають 

на сприйняття кольору, а також досліджено психологічну складову 

кольору. 

 

Ключові поняття: теорії, класифікації, колірні стилі, методи 

сполучення кольорів, колірні схеми, психологія кольору. 

 

Основні питання 

2.1. Теоретичні основи організації колірних сполучень. 

2.2. Колірні системи. 

2.3. Психологія кольору. 

2.4. Сполучення і шрифт. 

 

Цілі вивчення 

 

Метою є дослідження сутності теорій й класифікацій, що є основою 

організації гармонійних колірних сполучень; вивчення колірних схем і мето-

дів сполучення кольорів; дослідження психології кольору через множину 

факторів, що впливають на його сприйняття. 

Інформація, подана далі, надає студентові можливість сформувати 

такі компетентності: 

 

знання: 

нормативних теорій і структурного представлення колірних сполучень; 

базових колірних комбінацій та напрямів колірного стилю; 

колірних систем, схем і методів сполучення кольорів; 

психології сприйняття кольору (об'єктивних і суб'єктивних факторів 

пливу; 

особливостей сприйняття кольорів у різних країнах; 

уміння: 

створювати гармонійні сполучення кольорів за допомогою застосу-

вання нормативних теорій та класифікацій; 
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будувати гармонійні комбінації кольорів у певних колірних стилях; 

приймати рішення з вибору схеми та методу сполучення кольорів;  

застосовувати знання щодо психології кольору під час побудови 

гармонійних колірних сполучень; 

комунікації: 

надання допомоги в побудові колірної гармонії за допомогою вико-

ристання геометричних фігур; 

консультації представників підприємств щодо доцільності обрання 

для продукції певного колірного стилю та базової комбінації кольорів; 

рекомендації співробітникам підприємств щодо формування особисто-

орієнтованого колірного представлення і асоціацій; 

автономність і відповідальність: 

самостійний вибір найбільш доцільної нормативної теорії для побу-

дови гармонійного сполучення кольорів; 

підготовка декількох варіантів можливих колірних рішень у рамках 

різних стилів та базових комбінацій і вибір найбільш доцільного;  

професійна підготовка осіб, що займаються побудовою гармонійних 

колірних сполучень. 

 

Вступ 

 

У процесі побудови гармонійного колірного сполучення необхідно 

базуватися на відповідній теорії або класифікації, реалізуючи певний 

метод сполучення кольорів (метод використання прилеглих кольорів, метод 

використання протилежних кольорів, метод використання природних 

сполучень кольорів, метод використання кольору різного ступеня насичено-

сті). Реалізація гармонійного колірного сполучення в конкретному колірному 

стилі надає змогу підвищити якість його візуальної прийнятності для 

певної продукції. Оперування же психологічними властивостями кольорів, 

які обираються для гармонійного колірного сполучення, підвищує особисто-

орієнтоване спрямування колірного подання та колірних асоціацій на 

споживачів. 

 

2.1. Теоретичні основи організації колірних сполучень  

 

Коли йдеться про колірну гармонію, то люди оцінюють враження від 

взаємодії двох або більше кольорів. Для задоволення оку потрібна ця 



33 

загальна колірна зв'язка, і тільки в цьому випадку сприйняття кольору 

досягає гармонічної рівноваги. 

Серед нормативних теорій гармонійних сполучень кольорів найбільш 

цікавими є: 

1. Теорія Рудольфа Адамса. У 1865 р. Р. Адамс винайшов хроматич-

ний спектр, що складався із кола з 24 секторами, і містив шість ступенів 

світлоти. 

Основні принципи колірної гармонії Р. Адамса: 

а) у гармонії мають бути помітними принаймні первинні елементи 

різноманіття колірної області: червоний, жовтий і блакитний (синій); 

б) різноманіття тонів повинне досягатися через різноманітність світлого 

і темного і через зміни в кольорі; 

в) тони повинні знаходитися в рівновазі так, щоб жоден із них не ви-

ділявся. Цей момент охоплює якісні стосунки і складає колірний ритм; 

г) у великих комбінаціях кольори повинні за порядком слідувати один 

за одним так, щоб природний зв'язок у міру їх спорідненості мав місце, як 

у спектрі або веселці. У дотриманні тонів виражається рух мелодії колірної 

єдності; 

д) чисті фарби слід застосовувати економно через їх яскравість і лише 

в тих частинах, на які око в першу чергу має бути направлено. 

2. Теорія Альберта Манселла. Багато теоретиків кольору намага-

лися виводити свої теорії й системи на базі яких-небудь моделей. Так 

А. Манселл винайшов колірне тіло (див. рис. 1.8), на основі якого він склав 

колірний атлас із 10 таблиць. А. Манселл визначив три типи гармонійних 

сполучень: 

а) однотонні гармонії, що засновані на одному колірному тоні різної 

світлоти (наприклад, червоний з основного восьмисекторного колірного 

кола, розбілений червоний і червоний із затемненого колірного кола); 

б) гармонії родинних кольорів колірного кола (наприклад, червоний 

і жовтогарячий); 

в) гармонії взаємодоповнюючих кольорів (наприклад, жовтий  

і фіолетовий, жовтогарячий і синій). 

3. Теорія Вільгельма Освальда. Теорія ґрунтувалась на допущенні, 

що всі кольори, які містять рівну домішку білого або чорного, є гармо-

нічними, а з насичених гармонійні ті, що розташовані один від одного 

через рівну кількість інтервалів.  

4. Теорія В'ячеслава Максимовича Шугаєва. Теорія базується на 

дослідженнях Манселла й Бецольда. Вона заснована на колірному колі, 
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що будується на чотирьох основних кольорах – жовтому, червоному, 

синьому, зеленому. Автор пропонував чотири види колірних сполучень: 

а) сполучення споріднених кольорів (наприклад, жовтий, оранжево-

жовтий, жовтогарячий); 

б) сполучення споріднено-контрастних кольорів (наприклад, від 

жовтого до фіолетового за спектром); 

в) сполучення контрастних (взаємодоповнювальних) кольорів 

(наприклад, синій-жовтогарячий, червоний-зелений); 

г) сполучення нейтральних кольорів щодо спорідненості й контрасту 

(наприклад, жовтий, червоний, синій). 

Шугаєв виявив 120 можливих гармонійних сполучень для 16- част-

кового кола за умови трьох проміжних кольорів, тобто трьох інтервалів між 

головними кольорами. Він стверджував, що гармонійне сполучення можна 

одержати, якщо: 

1) у кольорах, що гармонують, присутня рівна кількість головних кольо-

рів (наприклад, жовто-жовтогарячий, жовто-зелений); 

2) кольори однакові за світлотою, тобто в них присутня рівна кіль-

кість білого або чорного пігменту; 

3) кольори однакові за насиченістю, вони мають однакову силу кольору 

відносно один одного (наприклад, жовтогарячий-синій). 

5. Класифікація колірних гармоній Брюкке. Німецьким фізіологом 

Брюкке були запропоновані такі види гармоній: 

ізохромія – композиція, виконана в одному колірному тоні (наприклад, 

на базі червоного кольору);  

хомеохромія – композиція в межах малого колірного інтервалу (на-

приклад, жовтий, жовтогарячий і жовто-жовтогарячий); 

мерохромія – композиція, де кольори підлеглі одному головному (на-

приклад, червоному, тоді це будуть жовтогарячий, пурпурний і фіолетовий); 

пойкілохромія – композиція, заснована на методі повного дроб-

лення колірних мас. Їй притаманна велика розмаїтість кольорів, у цьому 

разі всі кольори мають однакову значущість. 

6. Класифікація колірних гармоній за Б. М. Тепловим. Автором 

були запропоновані такі види гармоній: 

однотонна – побудована на одному головному кольорі або групі спо-

ріднених кольорів (наприклад, жовтий, оранжево-жовтий, жовтогарячий –  

у них у різних кількостях присутній жовтий колір); 

полярна – побудована на взаємодоповнювальних кольорах (наприк-

лад, червоний із зеленим, жовтогарячий із синім); 
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триколірна – побудована на протиставленні трьох основних кольорів 

(наприклад, жовтого, червоного, синього); 

багатобарвна – у ній за умови великої розмаїтості кольорів не можна 

виділити головний (складна в застосуванні). 

7. Теорія гармонійних сполучень за системою В. Козлова. В основі 

колірного кола з 24 колірних секторів лежать чотири основні кольори: 

жовтий, червоний, синій і зелений. Між ними існують проміжні кольори,  

які сприймаються як результат змішування основних кольорів спектра 

(рис. 2.1). Важливо зазначити, що частина сучасних учених, які займаються 

теорією кольору, будують колірне коло на основі чотирьох кольорів, мо-

тивуючи це тим, що суміш синього й жовтого кольору не дає чистого 

зеленого кольору, тому зелений вони виводять в групу основних кольо-

рів спектра. 
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Рис. 2.1. Структурне представлення кольору за системою В. Козлова 

 

Автор пропонував чотири види колірних сполучень (гармоній): 

а) однотонові гармонії; 

б) гармонії споріднених кольорів; 

в) гармонії споріднено-контрастних кольорів; 

г) гармонії взаємодоповнювальних кольорів. 

Варто розглянути кожен із видів гармоній більш докладно. 

Основу гармонійних однотонових сполучень кольорів становить один 

колірний тон, що є присутнім у кожному з них і надає їм спокійний, урівно-

важений характер. 

Гармонія споріднених кольорів ґрунтується на наявності в них домі-

шок тих самих головних кольорів. До споріднених у колірному колі належать 

усі проміжні, між двома основними, кольори, включаючи тільки один з тих, 

що їх утворюють. Вони підрозділяються на чотири групи: жовто-червоні, 

жовто-зелені, синьо-червоні, синьо-зелені (рис. 2.2). 
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Рис. 2.2. Приклад створення колірних гармоній споріднених кольорів 

 

У системі колірних кіл споріднено-контрастні кольори розташовуються 

в двох суміжних чвертях:  

теплі: жовто-червоні й жовто-зелені (рис. 2.3 а); 

холодні: синьо-зелені й синьо-червоні (рис. 2.3 б); 

теплі: жовто-зелені й холодні: синьо-зелені (рис. 2.3 в) – змішана 

гармонія; 

теплі: жовто-червоні й холодні: синьо-червоні (рис. 2.3 г) – змішана 

гармонія. 

Пояснення до рис. 2.3 (на прикладі варіанта 2.3 а): оскільки є загаль-

ний жовтий колір одночасно в жовто-червоній і жовто-зеленій комбінаціях – 

вони споріднюються, але присутність чистого червоного й чистого зеленого 

робить комбінацію контрастною, тому вона й вважається споріднено-

контрастною комбінацією. 
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Рис. 2.3. Приклад створення гармоній  

споріднено-контрастних кольорів 
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Більш гармонічні кольори, які розташовуються в колірному колі на 

кінцях вертикальних і горизонтальних хорд. Між такими парами існує 

подвійний зв'язок, вони складаються з однакової кількості об'єднувального 

головного кольору й однакових кількостей кольорів, що контрастують. Це 

жовто-зелений (Ж–З) і жовтогарячо-жовтий (ЖГ–Ж), жовтогарячо-черво-

ний (ЖГ–Ч) і пурпурно-червоний (П–Ч). 

Теорія – це фундамент, на основі якого відбувається побудова гар-

монійних сполучень кольорів. Як же цим користуватися практично? 

Слід розглянути процес створення гармонійних колірних сполучень 

на прикладі групи гармоній споріднено-контрастних кольорів (тобто розгля-

нути нову нормативну теорію гармонійних колірних сполучень, що ґрун-

тується на використанні образів-моделей геометричних фігур). 

Можна одержувати колірні гармонії, вписуючи в колірне коло гео-

метричні фігури: трикутники, прямокутники тощо (рис. 2.4 – 2.6). 

Процес побудови колірної гармонії за допомогою використання рів-

ностороннього трикутника (див. рис. 2.4): у колірне коло вписується 

рівносторонній трикутник, в якого одна зі сторін паралельна горизонталь-

ному або вертикальному діаметру. У вершині, що протистоїть цій стороні, 

перебуває колір, взаємодоповнювальний головному, що входить до складу 

пари споріднено-контрастних кольорів. У колірному колі таких рівносто-

ронніх трикутників чотири. 

 
 Рис. 2.4. Складання гармоній    Рис. 2.5. Складання гармоній 

споріднено-контрастних кольорів споріднено-контрастних кольорів 

  за допомогою рівностороннього за допомогою прямокутного 

 трикутника  трикутника 
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Рис. 2.6. Складання гармоній споріднено-контрастних кольорів 

за допомогою чотирикутника 

 

Процес побудови колірної гармонії за допомогою використання 

прямокутного трикутника (див. рис. 2.5): у колірне коло вписується пря-

мокутний трикутник, в якого сторони, що дають прямий кут, паралельні 

діаметрам (вертикальному й горизонтальному). У результаті гіпотенуза 

з'єднує пару взаємодоповнюючих кольорів, а колір у прямому куті буде 

споріднено-контрастним щодо до даної пари. У колі таких трикутників 

також чотири. Приклад гармонії: гармонія жовто-зеленого, жовто-жовто-

гарячого й синьо-фіолетового; в ній гіпотенуза з'єднує пару контрастних 

кольорів: жовто-жовтогарячий і синьо-фіолетовий, а колір жовто-зелений, 

що перебуває в прямому куті трикутника буде споріднено-контрастним 

парі даних кольорів. 

Процес побудови колірної гармонії за допомогою використання 

чотирикутника (див. рис. 2.6): у колірне коло вписується чотирикутник, 

сторони якого паралельні діаметрам кола. Це може бути прямокутник і 

квадрат. Сторони чотирикутника зв'язують двома споріднено-контрастними 

кольорами, а по діагоналях розташовуються взаємодоповнюючі кольори. 

Останнім різновидом колірних гармоній у системі В. Козлова є гар-

монія взаємодоповнювальних кольорів. Для її побудови необхідно, взявши 

вихідний колір, за колірним колом визначити відповідний йому взаємо-

доповнювальними. Третій колір може бути визначений з тіньового ряду 

кожного із цих кольорів. 
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Як видно з теорії В. Козлова, назви груп гармонійних сполучень 

кольорів подібні тим, що запропонував В. М. Шугаєв, але кольори, що скла-

дають колірні гармонії, докорінно відрізняються. Підхід до побудови гар-

монійних колірних сполучень, що ґрунтується на використанні образів-

моделей геометричних фігур є доцільним і для застосування в колірному 

колі з іншою кількістю секторів (рис. 2.7). 

 

 
 

Рис. 2.7. Побудова гармонічних сполучень у 12-секторному 

колірному колі на основі використання геометричних фігур 

 

Застосування підходу використання геометричних фігур для 12-сек-

торного колірного кола дозволяє зробити такий висновок: усі пари додат-

кових кольорів, усі сполучення трьох кольорів у 12-секторному колірному 

колі, які пов'язані один з одним через рівносторонні або рівнобедрені 

трикутники, квадрати й прямокутники, є гармонічними. Жовто-червоно-синій 

утворять тут основний гармонічний тризвук. Якщо ці кольори в системі 

12-секторного колірного кола з'єднати між собою, то утворюється рівно-

сторонній трикутник. Жовтий, червоно-фіолетовий і синьо-фіолетовий 

кольори поєднує фігура рівнобедреного трикутника. Гармонічне співзвуччя 

жовтого, червоно-жовтогарячого, фіолетового й синьо-зеленого об'єднані 

квадратом. Прямокутник же дає гармонізоване сполучення жовто-жовто-

гарячого, червоно-фіолетового, синьо-фіолетового й жовто-зеленого.  

жовтий 

жовто-жовтогарячий 

жовтогарячий 

червоно-жовтогарячий 

червоний 

червоно-фіолетовий 

фіолетовий 

синьо-фіолетовий 

синій 

синьо-зелений 

зелений 

жовто-зелений 
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Зв'язка геометричних фігур, що складається з рівностороннього  

й рівнобедреного трикутника, квадрата й прямокутника, може бути розмі-

щена в будь-якій точці колірного кола. Ці фігури можна обертати в межах 

кола, заміняючи, таким чином, трикутник, що складається з жовтого, 

червоного і синього, трикутником, що поєднує жовто-жовтогарячий, червоно-

фіолетовий і синьо-зелений або червоно-жовтогарячий, синьо-фіолетовий 

і жовто-зелений. 

Особливість саме 12-секторного кола полягає в тому, що воно дає 

повний спектр (послідовність кольорів в спектрі така ж, як у веселці або 

в природному спектрі). Створений за принципом порядкового зростання 

спектр дозволяє побачити колірний баланс і гармонію (рис. 2.8). 

 

 
 

Рис. 2.8. Колірний спектр 

 

Сегменти спектра підрозділяються на первинні, вторинні й третинні 

кольори, їх відтінки й тони. Коло фіксує три первинні кольори (червоний, 

жовтий і блакитний/синій), які вважаються чистими, тому що не містять 

інших кольорів. Первинні (primary) кольори утворюють рівнобедрений 

трикутник усередині кола. Вторинні (secondary) кольори одержують 

змішанням первинних між собою: жовтий і червоний дають жовтогаря-

чий, червоний і синій – пурпурний/ліловий, а синій і жовтий – зелений. 

Отримані вторинні кольори (жовтогарячий, фіолетовий і зелений) розташо-

вуються між кожним із первинних кольорів і також утворюють трикутник. 

Третинні (tetriary) кольори отримують шляхом комбінацій первинних  

  



41 

і вторинних кольорів. Відомо шість третинних кольорів: червоно-жовтога-

рячий, жовто-жовтогарячий, жовто-зелений, синьо-зелений, синьо-фіоле-

товий і червоно-фіолетовий.  

Дані три групи кольорів у рамках субтрактивного синтезу ще називають 

основними, додатковими й похідними. Однак комбінація "червоний, жов-

тий, блакитний/синій" не є комбінацією основних кольорів. 

Для зручнішого використання складових колірного спектра було за-

пропоновано перетворити його до вигляду спеціальної таблиці – таблиці 

кольорів. Завдяки їй відкривається можливість вибору збалансованих  

й ефективних комбінацій гармонійних колірних сполучень. 

Таблиця кольорів – це поданий у формі таблиці колірний спектр. 

Рядки утворені послідовністю тонів кожного з кольорів спектра. Кольори, 

тони й відтінки пронумеровані від 1 до 96. Кольори від 97 до 106 складають 

ахроматичний ряд від світло-сірого до чорного. 

Базові колірні комбінації й стилі 

Рано чи пізно перед проблемою вибору кольору постають усі. Якщо 

основний колір обраний, то як підібрати додаткові? Як створити гаму есте-

тично привабливу й навантажену одночасно? Що за послання передає колір? 

Для кращої орієнтації у виборі людям потрібна допомога експертів. 

Споживачам необхідне керівництво під час вибору колірних рішень, які 

будуть гармонійно сполучатися з їх мисленням, очікуваннями, способом 

життя. Хоча багато рішень щодо вибору того або іншого кольору відбува-

ються під впливом емоцій, що виникають у результаті миттєвого зорового 

сприйняття, все частіше стали вдаватися до використання продуманих 

колірних гам. 

Існують 10 еталонних базових колірних комбінацій: 

ахроматична комбінація (використовуються білий, чорний і сірий 

кольори); 

аналогова комбінація (використовуються будь-які з послідовних гам, 

будь-які її тони та відтінки); 

контрастна комбінація (колір сполучається з гамою, розташованою 

праворуч або ліворуч від доповнення); 

додаткова комбінація (використовуються діаметрально протилежні 

кольори спектра); 

монохроматична комбінація (використовується одна гама в комбінації 

з одним або всіма її тонами та відтінками); 
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нейтральна комбінація (використовується гама, що була приглушена 

або нейтралізована додаванням її доповнення або чорного кольору); 

роздільно-додаткова комбінація (складається з однієї гами та двох 

гам по обидві сторони її доповнення); 

первинна комбінація (складається з чистих гам червоного, жовтого 

та блакитного); 

вторинна комбінація (складається з жовтогарячого, фіолетового  

та зеленого); 

третинна комбінація (складається з однієї із двох комбінацій: червоно-

жовтогарячої, жовто-зеленої та синьо-фіолетової або синьо-зеленої, жовто-

жовтогарячої та червоно-фіолетової). 

Будувати конкретну комбінацію необхідно в рамках відтворення пев-

ного стилю поліграфічної продукції. Для показу стилю продукції підбира-

ють певні колірні комбінації, використовуючи одно-. дво- або триколірні гами. 

Виокремлюють такі напрями колірного стилю: власний, багатий, ро-

мантичний, життєрадісний, природний, дружелюбний, м'який, привітний, 

динамічний, елегантний, тенденційний, свіжий, традиційний, освіжаючий, 

тропічний, класичний, надійний, спокійний, царствений, магічний, носталь-

гічний, енергійний, приглушений, професійний, чистий, графічний.  

Слід розглянути, наприклад, тенденційний стиль: його колірні комбі-

нації можуть приємно шокувати – такий підхід використовують для показу 

в дорогих модних журналах напрямів сучасної молодіжної моди. Підхід 

базується на використанні у якості домінантного кольору – кольору лікеру 

(шартрез). Комбінації жовто-зеленого або шартрезу в парі з їх найкращим 

доповненням – червонясто-ліловим кольором сприймаються як шикарні. 

Кожному з названих стилів притаманна своя колірна специфіка.  

Їх цікаві колірні комбінації можуть змусити людину раптово зупинити 

погляд на конкретному об'єкті, поглянути на нього з нової, несподіваної 

точки зору. Підкреслити оригінальність стилю можна доповненням обраної 

комбінації спеціальним ефектом, що характеризується матовістю, відбит-

тям та сяйвом, світлонепроникністю й фосфорицентністю – новітні напрями 

в дослідженні кольору для впакування продукції. 

На сьогодні спеціальні флуоресцентні й металеві ефекти можуть 

змінити прийняте сприйняття кольору. Ці мерехтливі колірні покриття 

захоплюють і відбивають колір, викликаючи хвилюючі відчуття (прикладом 

використання цього є вітальні листівки).  
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2.2. Колірні системи 

 

Особливості структурної побудови та використання системи 

розташування кольорів 

Для введення в систему колірного конструювання варто розглянути 

12-секторне колірне коло, що дає систему розташування кольорів. Зібравши 

воєдино первинні, вторинні й третинні кольори, буде отримано колірне 

коло (див. рис. 2.7).  

Технологія побудови 12-секторного колірного кола:  

1) три основних кольори першого порядку розміщуються в рівносто-

ронньому трикутнику так, щоб жовтий був вгорі, червоний праворуч унизу 

й синій – унизу ліворуч; 

2) даний трикутник вписується в коло й на його основі вибудовується 

рівносторонній шестикутник. У рівнобедрені трикутники, що утворилися, 

поміщаються три змішані кольори, кожен з яких складається із двох основ-

них кольорів, таким чином, утворюються кольори другого порядку: 

жовтий + червоний = жовтогарячий;  

жовтий + синій = зелений;  

червоний + синій = фіолетовий. 

Усі кольори другого порядку повинні бути змішані досить ретельно. 

Вони не повинні схилятися до жодного зі своїх компонентів; 

3) потім на деякій відстані від першого кола окреслюється інше. 

Отримане між ними кільце ділиться на дванадцять рівних частин, розмі-

щаючи основні й складові кольори за місцем їх розташування й зали-

шаючи під час цього між кожними двома кольорами порожній сектор. 

У ці порожні сектори вводяться кольори третього порядку, кожен із 

яких створюється завдяки змішанню кольорів першого й другого порядку 

таким чином: 

жовтий + жовтогарячий = жовто-жовтогарячий; 

червоний + жовтогарячий = червоно-жовтогарячий;  

червоний + фіолетовий = червоно-фіолетовий; 

синій + фіолетовий = синьо-фіолетовий;  

синій + зелений = синьо-зелений; 

жовтий + зелений = жовто-зелений.  

Таким чином, виникає правильне колірне коло із дванадцяти кольорів, 

у якому кожен колір має своє незмінне місце, а їх послідовність має той 

же порядок, що й у природному спектрі. 
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Найпростіший спосіб підбору кольорів у колірному колі – уявити собі 

над колом рівнобедрений трикутник. Кольори, які виявляться під верши-

нами – потенційні кандидати на використання. Цей тип підбору кольорів 

називається тріадною схемою. 

Трійка лінійно незалежних кольорів називається тріадою. 

Існує чотири різних тріадних схеми, з якими можна працювати.  

У процесі цього ці кольори, працюючи разом, утворюють гармонійну комбі-

націю кольорів (рис. 2.9).  
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Рис. 2.9. Варіанти підбору кольорів за тріадною схемою 

 

Але тріадами не варто обмежуватися. Можна вибрати й комплемен-

тарні кольори, тобто ті кольори, що розташовані в колі прямо навпроти 

один одного – наприклад, червоний і зелений. Вони називаються комп-

лементарними або доповнювальними (рис. 2.10). 
 

 
 

Рис. 2.10. Варіант підбору кольорів за комплементарною схемою 

 

Унаслідок того, що розміщені поруч, вони роблять один одного яс-

кравішими й жвавішими. Завдяки своїй специфічності (тепла гама) пер-

шим сприймається червоний, а потім – зелений. Таким чином вони ніби 

віддаляються один від одного. Глядач прагне скоригувати свої враження. 

зелений 

червоний 
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Око розрізняючи червоний і зелений формує відношення окремого ритму, 

провокуючи ефект руху. Ця робота ока сприймається людиною диском-

фортна, тому застосовувати однаково домінуючі контрастні кольори потрібно 

обережно. Але рекомендується застосовувати окремі контрастні колірні 

плями для стимулювання уваги. Якщо все-таки потрібно сполучити комп-

лементарні кольори, то рекомендується скористатися тоновими розділь-

никами (білим, сірим, чорним), застосувавши їх у вигляді підложки або 

контуру. Тонові роздільники сполучаються з усіма кольорами і є позитивним 

тоновим переходом між дисонуючими контрастними кольорами. Також 

можна застосувати колірні роздільники, використовуючи відтінки даних 

кольорів. 

Існують і більш складні схеми: 

1) можна взяти дві пари комплементарних кольорів – це називається 

подвійний комплемент (double complement). Прикладом такої комбінації 

є: жовтий і пурпурний/ліловий, та синій і жовтогарячий;  

2) іншою схемою є альтернативний комплемент (alternate 

complement), коли комбінується тріада кольорів із кольором, комплемен-

тарним одному з кольорів тріади. Прикладом такої комбінації є: зелений, 

червоно-пурпурний, червоний і жовтогарячий; 

3) також існує розщеплений комплемент (split complement), коли 

береться колір, його комплементарний колір і два прилягаючих до нього 

кольори; 

4) останньою схемою є тетрада, коли беруться чотири кольори, що 

розташовані прямо навпроти один одного. Тобто обирають один первинний, 

один вторинний і два третинних кольори. 

На рис. 2.11 показані приклади перерахованих вище схем.  
 

подвійний

комплемент
альтернативний

комплемент

розщеплений

комплемент

тетрадаподвійний

комплемент
альтернативний

комплемент

розщеплений

комплемент

тетрада

 

Рис. 2.11. Варіанти підбору кольорів за схемами 

комплементу та тетради 
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Описані схеми використовують для підбору комбінацій кольорів, що 

контрастують. Однак існують два типи схем, де використовуються спорід-

нені кольори, – монохроматична (monochromatic) та подібнісна (analogous). 

Монохроматична схема використовує один колір і всі його відтінки  

й варіації (рис. 2.12 а). У разі правильного використання ця схема дає 

зображенню, композиції акуратний, чистий вигляд. Подібнісна схема кольо-

рів використовує кольори, які розташовані по сусідству один з одним на 

колірному колі (рис. 2.12 б).  
 

   
 
 

Рис. 2.12. Варіант підбору кольорів за монохроматичною 

та подібнісною схемами 

 

Методи сполучення кольорів 

Можливі такі методи сполучення кольорів: 

метод використання прилеглих кольорів;  

метод використання протилежних кольорів (метод контрастності);  

метод використання природних сполучень кольорів;  

метод використання кольору різного ступеня насиченості.  

Метод використання прилеглих кольорів: маються на увазі прилеглі 

кольори на колірному колі. Метод базується на використанні подібнісної 

колірної схеми. 

Метод використання протилежних кольорів: маються на увазі проти-

лежні один одному кольори на колірному колі. Такий метод досить часто 

використовують дизайнери, наприклад, у рекламі для створення акцен-

тів, оскільки протилежні кольори дуже контрастні щодо один одного. Метод 

базується на використанні комплементарної схеми, схем подвійного, аль-

тернативного, розщепленого компліментів, тріадних схем і схеми тетради. 

Метод використання природних сполучень кольорів: несподівані при-

родні колірні рішення є основною (беруться за еталон), на якій базуються 

спеціалісти з кольору під час побудови подібних до природних колірних 

а б 
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комбінацій. Метод базується на використанні сполучення різних типів схем 

підбору кольорів. 

Метод використання кольору різного ступеня насиченості: добре 

виглядають у сполученні кольори одного кольору, але різних відтінків. 

Подібний спосіб підкреслює важливі елементи й надає відчуття легкості 

зображенню. Метод базується на використанні монохроматичної схеми. 

Таким чином, підбір колірного рішення є одним із важливих компо-

нентів у поліграфії, дизайні, формуванні фірмового стилю, логотипа, ети-

кетки, обкладинки, зображення на сторінці, на іншому задрукованому мате-

ріалі тощо. Головне в цьому складному питанні – це те, що колірна гама 

не повинна стомлювати або акцентувати на собі занадто багато уваги. 

Інакше під час побудови гармонійних колірних сполучень обмежуються 

знаннями, вміннями, навичками, здатностями, фантазією, смаком розроб-

лювача, дизайнера й напрацьованим досвідом роботи. 

 

2.3. Психологія кольору 

 

Фактори, що впливають на сприйняття кольору, можна розподілити 

на об'єктивні та суб'єктивні. 

До об'єктивних факторів належать такі: 

характеристика джерела світла. Ураховують такі складові, як спек-

тральний склад, співвідношення червоної, зеленої й синьої складових; 

інтенсивність або яскравість джерела; 

характеристика передавального середовища: скла, повітря, води 

тощо (з позиції ступеня поглинання/пропущення/відбиття світла); 

характеристика самого об'єкта або суб'єкта, тобто з якого мате-

ріалу виготовлений, темного або світлого тону, поглинає або відбиває 

світло визначеної довжини хвилі; 

характеристика й структура приймача: людських очей, фотоапа-

рата, денситометра тощо; 

висвітлення, що є ключовим фактором для правильного кольоро-

відтворення; 

колір навколишніх об'єкт елементів, сусідні кольори; 

перспектива сприйняття. 

Слід розглянути суб'єктивну сторону психологічного сприйняття 

кольору. 
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Колір впливає на фізіологічні процеси людини й на його психологіч-

ний стан. Знаючи особливості кожного кольору, можна сформувати певний 

образ, викликати певні емоції, асоціації.  

Відтінків існує безліч, однак у кожної людини є улюблені, вибір яких 

пов'язаний, як стверджують психологи, з особливостями окремої особис-

тості. Тому під час вибору колірної гами потрібно опиратися й на перед-

бачуваний психологічний портрет середньостатистичного глядача, 

що є (або буде) споживачем продукції. 

Колір треба підбирати залежно від цільової групи. Необхідно вра-

ховувати психологію кольору, що виникає в результаті емоційної реакції 

внаслідок переваг групи залежно від віку, статі, національності, місця 

проживання тощо.  

Необхідно розглянути суб'єктивні фактори: 

1) стать. Чоловіки сприймають кольори не так, як жінки. Вони, в основ-

ному, віддають перевагу монохроматизму, комбінаціям схожих кольорів. 

Серед хроматичних кольорів особливо популярні відтінки блакитного або 

природні відтінки, тоді як жінки віддають перевагу складним гамам;  

2) вік. Чим старше покоління, тим більше їх приваблюють чисті тони 

(за твердженням експертів "Колор Маркетинг Груп" з віком зменшується 

здатність розрізняти відтінки), вони намагаються оточувати себе м'якими, 

спокійними тонами. 

Так, наприклад, кваліфіковані дизайнери використовують під час 

розроблення дизайну сайта для молодої аудиторії більш яскраві, помітні 

кольори, тоді як для старших/дорослих людей – повинні використовува-

тися більш помірні, спокійні й стримані кольори. 

Дослідження довели, що досліджувані люди молодшого віку частіше 

обирали яскраві й світлі кольори, ніж літні люди. Це ж стосується,  

у цілому, чоловіків порівняно з жінками. Однак для випробуваних у віці від 

45 до 54 років виявилася зворотна тенденція – жінки цього віку віддавали 

перевагу яскравим кольорам майже у два рази частіше, ніж чоловіки. 

У процесі обґрунтування свого колірного вибору, наприклад, діти не 

спираються на предметні асоціації кольору, а виходять із враження від 

нього. Яскраві кольори їх радують й приваблюють, погляд дитини сам 

тягнеться за таким кольорами. Причому, слід зазначити, що вплив черво-

ного, жовтого й інших яскравих кольорів не дратує дітей молодшого віку, 

а навіть заспокоює, дозволяє дитині почувати себе комфортно. 
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Наприклад, виконуючи завдання намалювати щось "гарне", "приємне" 

діти чотирьох років, як показано в роботі В. С. Мухіної (1981 р.), найчас-

тіше використовували світлі, яскраві фарби – жовту, червону, жовтогарячу, 

блакитну, смарагдово-зелену. Колірне сприйняття гарного у дітей всіх країн 

подібне: кольори в більшості випадків теплі й обов'язково чисті – такий 

вибір кольору для зображення гарного у дітей; 

3) фізичний стан. У стресовому стані у людини різко загострюється 

сприйняття кольорів, у той час як у разі загальної стомленості – навпаки, 

притупляється; 

4) час. Кількість сприйнятих людиною відтінків кольору залежить від 

часу розгляду зображення. Чим довше людина вдивляється в зображення, 

тим більше відтінків кольору й деталей зображення вона здатна розріз-

нити (однак у разі довгого роздивляння зображення накопичується втома 

й погіршується загальний фізичний стан); 

5) характер. Колір, якому людина віддає перевагу, багато може 

розповісти про її характер та емоційний склад. Одним із небагатьох 

використовуваних у психології понять, що відносяться до сфери характеру, 

є поняття "екстраверсії-інтроверсії", введене К. Юнгом (1924 р.). Кількість 

кольорів, яким віддають перевагу інтроверти, в два рази менша, ніж  

у екстравертів. Щодо кольорів, то червоний, жовтий, жовтогарячий – кольори 

екстраверсії (тобто імпульсу, поверненого назовні), а синій, фіолетовий, 

зелений – кольори інтроверсії (тобто імпульсу, поверненого всередину). 

На підставі переваги того або іншого кольору можна зробити вис-

новок про психологічні особливості людини:  

білий: цьому кольору може віддати перевагу людина з будь-яким 

характером, він нікого не відштовхує;  

чорний:  колір непевності, що символізує похмуре сприйняття життя. 

Постійний вибір чорного свідчить про наявність якогось кризового стану 

й характеризує агресивне неприйняття світу або себе; 

сірий: улюблений колір розважливих і недовірливих натур, які довго 

думають, перш ніж прийняти яке-небудь рішення. Це люди – спостерігачі, 

а не діячі. Вони стримані й не люблять приймати рішень, відкладають їх 

наскільки дозволять обставини. Це також нейтральний колір, що обирають 

ті, хто боїться занадто голосно заявити про себе. Якщо ж цей колір не 

подобається, то це показник імпульсивного, легковажного характеру; 

червоний: якщо це улюблений колір, то така людина смілива, це 

вольовий, владний тип, запальний, динамічний і товариський. До того ж – 
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альтруїст. У людей, яких цей колір дратує – комплекс неповноцінності, 

страх перед сварками, схильність до самоти, стабільності у відносинах. 

Відраза, ігнорування червоного відображає органічну слабкість, фізичне 

або психічне виснаження. Червоний колір найбільше пасує підліткам; 

коричневий: вибирають ті, хто твердо й упевнено став на ноги, 

любить друзів і відданий їм. Люди, які мають слабість до нього, цінують 

традиції, родину. Для них чимале значення має почуття комфорту. Перевага 

коричневого відображає, насамперед, прагнення до простих інстинктивних 

переживань, примітивних почуттєвих радощів. Разом із тим вибір цього 

кольору як основного вказує на певне фізичне виснаження. У нормі, поряд 

із чорним, коричневий колір відкидається найбільш часто; 

жовтий: символізує спокій, невимушеність у відносинах із людьми, 

інтелігентність. Коли він є улюбленим, це означає товариськість, цікавість, 

сміливість, легку пристосовність і одержання задоволення від можливості 

подобатися. Ці люди життєрадісні й повні оптимізму; якщо в них щось не 

виходить – намагаються змінити своє життя. Вони непередбачені й мають 

безмежну допитливість. Коли ж колір неприємний, то йдеться про людину 

зосереджену, песимістично налаштовану, з якою важко зав'язати знайомство;  

синій: колір спокою та розслаблення. Якщо він подобається, то це 

говорить про скромність і меланхолію; такій людині часто потрібно відпо-

чивати, вона швидко утомлюється, їй надто важливі почуття впевненості, 

доброзичливості навколишніх. Байдужність до цього кольору говорить 

про легкодумство у сфері почуттів, хоча й прихованих під маскою ввічли-

вості. Вибір синього кольору як основного відображає фізіологічну й психо-

логічну потребу людини в спокої, а заперечення його означає, що людина 

уникає розслаблення. Під час захворювання або перевтоми потреба  

в синьому кольорі збільшується; 

зелений: той, хто віддає йому перевагу, любить почувати себе  

в безпеці; він марнує час і сили на інших, а в суперечках аргументовано 

відстоює свою точку зору. Такі люди бояться чужого впливу, шукають спосіб 

самоствердження, тому що для них це життєво важливо. Той, хто його не 

любить, боїться життєвих проблем, взагалі всіх труднощів. Зелений колір 

містить приховану потенційну енергію, відображає ступінь вольової напруги, 

тому люди, що віддають превагу зеленому кольору, прагнуть до само-

впевненості й упевненості взагалі. Люди ж ексцентричні, що досягають 

поставлених завдань не цілеспрямованою вольовою активністю, а за допо-

могою емоцій, відкидають зелений колір як "несимпатичний". Зелений 
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колір відкидають і люди, що перебувають на межі психічного й фізичного 

виснаження;  

жовтогарячий: улюблений колір людей, що володіють гарною інту-

їцією, мрійних натур. Той, хто віддає йому перевагу, полюбляє спілку-

вання й багатолюддя, відрізняється життєрадісністю та імпульсивністю; 

рожевий: колір говорить про необхідність любити й бути добріше. 

Ті, кому він подобається, можуть розхвилюватися із найнезначнішого при-

воду. Ці люди чутливі, милі й доброзичливі й не проти повернутися до 

пори романтичної юності, мріють про любов. У людей же найбільш праг-

матичних цей колір викликає роздратування; 

фіолетовий: колір символізує властиві людині інфантильність  

і сугестивність, потребу в підтримці, опорі. Вибір або заперечення даного 

кольору є своєрідним індикатором психічної зрілості. Ці люди недовірливі, 

а тому полюбляють напускати на себе загадковість; 

6) переваги. Колірні переваги можуть свідчити (з певним ступенем 

ймовірності) про характер людини, їх особисті та ділові якості. Істотним 

тут є "аура" особистості. 

Наприклад, можуть існувати такі колірні переваги:  

світловолосі, блакитноокі люди з рожевою шкірою обличчя, як правило, 

працюють з дуже чистими кольорами та великою кількістю чітко помітних 

тонів; їх колірна гама може бути більш блідою або більш яскравою; 

люди із чорним волоссям, темною шкірою й темно-коричневими 

очами головну роль у сполученнях відводять чорному кольору, а чисті 

кольори дають у супроводі чорного; 

люди з рудими волоссям і рожевою шкірою воліють працювати інтен-

сивними кольорами (жовтий, червоний і синій). 

Як правило, люди, яких відносять до інтелектуальної еліти, уникають 

у повсякденному житті особливо яскравих відтінків, віддаючи перевагу 

спокійним, пастельним тонам; 

7) мислення. Йдеться не про інформаційний, а про енергетичний 

бік колірного впливу, і тим самим не про зміст розумового процесу, а про 

його динамічні характеристики. У різних колірних середовищах людині 

"думається" по-різному: колірний вплив може або перешкоджати, або 

сприяти вирішенню завдання, ухваленню покупцем рішення щодо прид-

бання певної продукції. Слід розглянути на прикладі друкованої літератури: 

для шкільної, студентської аудиторії не рекомендується фарбування 
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темними, "холодними" тонами. Подібні кольори викликають гальмування 

й знижують ефективність розумової діяльності. Навпаки, кольори "активної 

сторони" поліпшують розумову діяльність, підвищують її продуктивність; 

8) емоції. Коли говорять: "почорнів від горя"; "почервонів від гніву", 

"позеленів від злості", "посірів від страху", то не сприймають ці вирази бук-

вально, а інтуїтивно позв'язують емоційні переживання людини зі здатним 

виразити їх кольором. Психічно здорова людина як доросла, так і дитина, 

починаючи з чотирьох років, може "закріплювати" за певним кольором 

певні емоції. Наприклад, жовтий (подив), зелений (подив та зацікавленість), 

сірий (стомленість, смуток), червоний (гнів, радість) та ін. 

У 1947–1948 рр. була виявлена помітна зміна колірної чутливості 

(порогів кольоророзрізнення) залежно від емоційного стану людини. Пози-

тивні емоції, наприклад радість, виявилися пов'язаними з підвищенням 

чутливості до червоного та жовтого й зі зниженням – до синього і зеленого. 

У разі переживань негативних емоцій спостерігалася зворотна картина: 

чутливість до синього та зеленого зростала, а до жовтого й червоного 

знижувалася. Зазначені зміни колірної чутливості відзначалися не тільки 

під час актуальних переживань емоцій, але й під час спогадів про приємну 

або неприємну події. Дослідження підтвердило зв'язок між емоційними 

відчуттями і кольором. 

Ще однією цікавою з позиції наявності даного взаємозв'язку є робота 

В. Н. Ворсобіна (1980 р.). У ній вивчалася динаміка колірних переваг 

дошкільників залежно від пережитих ними емоцій. У випадках переживання 

дітьми емоцій радості значно збільшувалася перевага червоного, жовтого 

і жовтогарячого кольорів і зменшувалася – зеленого і блакитного (аналіз 

проводився за колірними сполученнями). Під час переживання емоції страху 

діти рідше віддавали перевагу сполученню червоний – синій – фіолетовий, 

а частіше – зелений – блакитний. Автор роботи прийшов до висновку, що 

ставлення в дітей даного віку до червоного кольору досить специфічно 

для диференціації емоцій радості й страху, а сам метод вибору колірних 

сполучень несе більшу інформацію про емоційний стан дітей, ніж вибір 

окремих кольорів. 

Одним із факторів, що впливають на емоційне переживання людини, 

є форма предмета або плями, що несе даний колір. Враження, що ви-

роблене кольором, тісно пов'язане із предметною структурою об'єктів 

(рис. 2.13). 
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Рис. 2.13. Підпорядкованість кольору формі 

 

Форма й колір повинні підтримувати один одного.  

Там, де колір і форма погоджені у своїй виразності, їх вплив 

на глядача подвоюється. 

Продукція, вплив якої визначається головним чином кольором, повинна 

підкоряти форму в її композиції кольору. Як для трьох основних кольорів, 

так і для трьох основних форм (квадрата, трикутника й кола) повинні бути 

знайдені властиві їм виразні характеристики: 

квадрат: йому відповідає червоний колір як колір матерії. Вага й непро-

зорість червоного кольору погоджуються зі статикою й важкою формою 

квадрата; 

трикутник: до трикутників відносять усі форми діагонального харак-

теру, як наприклад, ромби, трапеції, зигзаги і їх похідні. Трикутник – символ 

думки і його невагомий характер дозволяє порівнювати його в області 

кольору з ясно-жовтим; 

коло: символ постійно рухливої духовності. У древньому Китаї плану-

вання храмів будувалося на основі кола, у той час як палац земного 

імператора зводився на основі квадратних форм. До кола зараховуються 

всі вигнуті форми колоподібного характеру, такі, як еліпс, овал, хвиле-

подібні форми параболи і їх похідні. Безперервному руху кола в області 

кольору відповідає синій колір. 

Якщо для кольорів другого порядку підшукати відповідні їм форми, 

то для жовтогарячого – це буде трапеція, для зеленого – сферичний три-

кутник і для фіолетового – еліпс.  

Таким чином, існує підпорядкованість певного кольору відповідної 

йому формі. 

Особисто-орієнтоване спрямування колірного подання й колірні 

асоціації 

Одержання особисто-орієнтованого подання забезпечується за рахунок 

здійснення цілеспрямованого процесу формування певних (потрібних) 

асоціацій у споживачів продукції.  
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Правильно підібрані кольори можуть як привернути увагу до зобра-

ження, так і відштовхнути від нього. Можна викликати радість, інтерес, тугу, 

страх, нудьгу всього лише зміною тону. Шляхом використання колірної 

комбінації можна зробити графічний дизайн притягуючим, а звичайний 

постер – спогадом про минуле. 

Явище колірних асоціацій полягає в тому, що колір збуджує ті або 

інші емоції, відчуття, тобто впливом кольору збуджуються інші органи 

почуттів, а також уява, пам'ять про бачене або пережите.  

Колірні асоціації можна класифікувати в такий спосіб:  

вагові (легкі, важкі, повітряні, невагомі...); 

температурні (гарячі, теплі, холодні, полум'яніючі, льодові...);  

дотикальні (м'які, тверді, колючі, ніжні...);  

просторові (виступаючі, відступаючі, близькі, далекі...);  

акустичні (тихі, голосні, дзвінкі, музичні, свистячі, гавкаючі...);  

смакові (солодкі, смачні, гіркі, сухі...);  

вікові (дитячі, молодіжні, старечі...);  

сезонні (весняні, літні, зимові, осінні...);  

етичні (мужні, сентиментальні, сміливі...);  

емоційні (веселі, смутні, нудні, спокійні, драматичні, трагічні...);  

культурні (які нагадують колорит яких-небудь явищ культури – від 

живопису знаменитих художників до виробів кулінарного мистецтва).  

Під час психологічного впливу кольору йдеться про почуття пережи-

вання, які людина випробовує під впливом конкретного кольору. Так, на-

приклад, червоний і жовтогарячий викликають прилив енергії, фіолетовий 

та темно-сірий – пригнічують, зелений та блакитний – загальмовують тощо. 

Неважко побачити, що майже будь-який прикметник українською 

мови може характеризувати колір. Так, наприклад, "жовтий" – персиковий, 

золотавий, пісковий, солом'яний, лимонний, вершковий, слонової кістки, 

тілесний, кремовий, палевий, чайної троянди, виноградний, банановий.  

Різні кольори можуть асоціюватися з особистісними характерис-

тиками людей; іншими словами, людина приписує кольору властивості, 

якими він (за визначенням) не володіє: 

синій – чесний, справедливий, незворушний, сумлінний, добрий, 

спокійний;  

зелений – черствий, самостійний, незворушний;  

червоний – чуйний, рішучий, енергійний, напружений, метушливий, 

дружелюбний, упевнений, товариський, дратівливий, сильний, чарівний, 

діяльний;  
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жовтий – говіркий, безвідповідальний, відкритий, товариський, енер-

гійний, напружений;  

фіолетовий – несправедливий, нещирий, егоїстичний, самостійний;  

коричневий – поступливий, залежний, спокійний, сумлінний, роз-

слаблений;  

чорний – непривабливий, мовчазний, упертий, замкнутий, егоїсти-

ний, незалежний, ворожий, відлюдний; 

сірий – пасивний, млявий, невпевнений, несамостійний, слабкий.  

Багато діячів мистецтв відчували "звучання" кольору або "фарбування" 

звуку. Серед них – композитори Скрябін, Римський-Корсаков, Дебюссі, 

поети й письменники Рене Гіль, В. Набоков, В. Хлебніков й ін.  

Так, наприклад, Римському-Корсакову здавалося, що у свій особливий 

колір пофарбовані різні музичні тональності:  

до мажор –- у білий, ре мажор – у жовтий, мі мажор – у синій, фа 

мажор – у зелений. 

У Рене Гіля букви (звучання букв) отримали таке фарбування:  

"у" – від чорного до рудого, "о" – червоний, "а" – рожевий, "е" – від 

рожевого до блідо-золотого, "ю" – золотий, "и" – блакитний. 

Людина несвідомо асоціює деякі предмети, об'єкти, поняття з певними 

кольорами.  

Будь-які асоціації нерідко досить прості (червоний – вогонь, кров; 

жовтий – сонце й т. д.). Складність полягає у тому, що тому самому абс-

трактному поняттю відповідають різні кольори. Так, поняття "любов": любов 

матеріальна (білий), до Бога (синій), до себе (жовтий), до коханого 

(червоний), до друга (зелений).  

Варіювання насиченістю змінює асоціацію кольору: червоний – любов, 

а отриманий з додаванням білого рожевий – ніжність; з додаванням 

чорного отриманий бордовий – аморальність.  

Колірна гама може вражати, заспокоювати або зачаровувати. 

Вплив кольору можна розподілити на фізіологічний (терапевтичний), 

психологічний та естетичний. Цими факторами обумовлені колірні 

асоціації й символіка кольору. Прикладом фізіологічного та терапевтич-

ного впливу кольорів є те, що вони застосовуються для лікування захво-

рювань. Наприклад, синій колір застосовується для лікування ендокринної 

сфери, нирок, легенів, верхніх дихальних шляхів, захворювань ока; ефек-

тивний для лікування дитячих інфекцій, коклюшу, жовтяниці; особливо 

значний вплив цього кольору на нервову систему. Синім світлом лікують 

безсоння, шизофренію, істерію, маніакально-депресивний психоз, епілепсію.  
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Таким чином, під час розроблення колірного рішення оформлення 

продукції (вигляду її етикетки, упаковки тощо), наприклад, що буде спря-

мована на лікування конкретного захворювання, необхідно використо-

вувати призначені для цього кольори, щоб розташувати споживача на 

покупку й не завдати шкоди рекламній кампанії товару. 

З позиції психологічного впливу кольори мають таке змістовне наван-

таження (слід розглянути, як приклад, деякі з них): 

а) червоний колір підходить для підкреслення агресивності, актив-

ності; для вираження пристрасті, бажання, жорстокості (колір крові); для 

підкреслення розкоші, багатства (особливо в сполученні із чорним).  

Даний колір найкраще використовувати для виділення невеликих 

деталей оголошення/каталогу, це відразу привертає до себе увагу, у той 

час як надмірне його використання здатне викликати у споживача агре-

сивність і навіть роздратування предметом реклами; 

б) жовтий колір підходить для передачі радісного настрою, оптимізму. 

Це колір золота, тому у багатьох він асоціюється з успіхом, багатством  

і розкішшю. 

Даний колір найкраще використовувати для реклами товарів типу 

"хай-тек"; колір буде вдалий у рекламі дитячих товарів, послуг туристич-

них компаній, а також рекламних і PR-агентств; 

в) жовтогарячий колір підходить, якщо необхідно підкреслити сучас-

ність, динамічність і оптимізм. Багато компаній, які обирають основною 

рисою свого бренда сучасність, вибирають жовтогарячий як "фірмовий" 

колір. Особливо поширено це серед операторів стільникового зв'язку. 

Для створення яскравого плаката жовтогарячий фон – банальний, однак, 

практично ідеальний варіант. Жовтогарячий дуже добре виглядає в спо-

лученні із блакитним. Даний колір найкраще використовувати в рекламі 

медикаментів, дитячих товарів, а також послуг у сфері охорони здоров'я 

й освіти; 

г) зелений колір підходить для передачі життя в усіх її біологічних 

проявах і зв'язку із природою. Даний колір найкраще використовувати  

в рекламі медикаментів, водоочисних систем, стоматологічних клінік і аптек, 

ветеринарних лікарень, центрів здоров'я й охорони навколишнього сере-

довища. Він може бути як теплим, так і холодним. Це найприродніший  

і "найживіший" колір. У цьому й полягає його основне призначення  

в дизайні, поліграфії – передавати зв'язок об'єкта, предмета, явища із 

природою; 
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д) блакитний колір заспокоює й прохолоджує. Подібний ефект 

пояснюється асоціаціями з холодною водою й льодом. Однак він інколи 

викликає почуття відчуженості. Колір символізує спокій та благополуччя, 

викликає повагу, довіру, надію та створює відчуття цілісності; 

е) синій використовується, щоб підкреслити спокій і чистоту. Так, 

майже всі якісні засоби, що чистять, мають або синій, або блакитний 

колір і це не випадково. Вчені довели, що саме ці кольори асоціюються  

в більшості людей із чистотою. Даний колір найкраще використовувати 

для деталей у каталозі або рекламному проспекті – відразу привертає  

до себе увагу й, на відміну від червоного, ніколи не викличе негативних 

емоцій. Варіювання насиченості та яскравості чисто синього кольору дає 

більшу гаму відтінків (але, через особливості CMYK системи саме синій 

гірше за все відображається під час друку); 

є) рожевий є кольором апетиту. Він дуже інтенсивно використовується 

в харчовій промисловості. Діапазон використання цього кольору може 

бути найширшим: від реклами парфумерної продукції, товарів для жінок  

і дітей до послуг шлюбних агентств і сімейних центрів; 

ж) фіолетовий колір підходить для створення містичного настрою,  

підкреслення загадковості, зосередженості. Колір рекомендується викорис-

товувати, якщо рекламується товар, за допомогою якого підкреслюється 

його креативність. Він здатний створювати відчуття тісноти, обмеженості 

простору, а також дуже швидко стомлює й призводить до зниження ак-

тивності. Це дуже важкий для сприйняття колір, у природі він (у чистому 

вигляді) практично не зустрічається; 

з) чорний колір належить до "класики", створюючи певний стиль. 

Цей колір тією чи іншою мірою може сполучатися з усіма іншими кольорами. 

Це колір розкоші, особливо в сполученні із червоним. У наших традиціях 

прийнято відносити його до жалобного кольору. Він сприяє самозануренню, 

допомагає від усього відгородитися, замкнутися й сконцентруватися.  

У чорному приходить відчуття самітності й ізоляції від навколишнього світу. 

Саме тому даний колір у поліграфічній рекламі краще не використовувати. 

Ця рекомендація, зрозуміло, не поширюється на шрифти й таблиці, саме  

у відношенні до них, за рідкісним винятком, краще не експериментувати; 

и) білий колір завдяки асоціації із прозорим повітрям викликає 

почуття легкості, волі; символізує чистоту, добро, істину, ясність. Часто 

використовується під час створення фону. Сам по собі білий колір не 

несе ніякої інформації, але з усіма іншими кольорами добре компонується, 
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створюючи світліші тони. Використання даного кольору в друкованій 

рекламі здатне створити нейтральний ефект – коли споживачеві реклами 

просто повідомляється інформація про товар, без установлення яких-

небудь акцентів і пріоритетів. 

Психологія сприйняття кольору 

Психологічний вплив на людину надають не тільки окремі кольори, 

але й колірні сполучення. За ступенем погіршення сприйняття вони розта-

шовуються таким чином:  

синій на білому; 

чорний на жовтому; 

зелений на білому; 

чорний на білому; 

зелений на червоному; 

червоний на жовтому; 

червоний на білому; 

жовтогарячий на чорному; 

чорний на пурпурному; 

жовтогарячий на білому; 

червоний на зеленому. 

Психофізіологічний вплив колірних сполучень залежить від більшої 

або меншої насиченості кольорів, розміру колірних плям, відстаней і на-

прямків, звідки впливають кольори. Так, колір розташований по вертикалі, 

сприймається легким, по діагоналі – динамічним, по горизонталі – стій-

ким. Якщо напруга кольору внизу – композиція природна й стійка; вгорі – 

неприродна, така, що тисне; з будь-якого краю – нестійка (рис. 2.14). 

 
 

Рис. 2.14. Вплив напруги кольору 

 

Певні кольори володіють більшою ("активні") або меншою ("пасивні") 

силою емоційного впливу. Концентрація активного кольору в правому верх-

ньому куті активізує композицію, все збільшує у розмірі. У лівому нижньому 

куті – створює ілюзію пасивності й зорового стиснення, руху назад. 
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Порівняльний аналіз сприйняття кольорів у різних країнах 

Люди різних культур сприймають колір по-різному внаслідок націо-

нальних традицій, культурних особливостей та ін. Погляди на колір навіть 

близьких людей не збігаються. 

Не тільки різні люди реагують на той самий колір по-різному, але й цілі 

народи. Це пов'язано із традиціями, у яких виховувалася нація. Наприклад, 

у європейських країнах білий – це колір чистоти й невинності, а в деяких 

східних народів даний колір є кольором жалоби. 

Відношення до кольору в кожній країні своє, існує навіть своя націо-

нально-культурна специфіка, яку необхідно враховувати, займаючись роз-

робленням колірного рішення, наприклад, для рекламної продукції для 

представника тієї або іншої країни. 

У цілому, чим ближче до Сходу, тим більше значення надається 

символіці кольору. Так, у Китаї червоний колір означає доброту й відвагу, 

чорний – чесність, а білий, на відміну від загальноприйнятого європейцями 

символу чистоти й святості, асоціюється з підлістю й облудністю. В Азії 

до білого кольору ставляться з більшою повагою, ніж на Заході. Жовтий 

колір, більш ніж де-небудь, шанують у Таїланді – причини цього криються 

в релігії. А в країнах із посушливим кліматом зелений колір вважають 

кольором сили. 

Один із найхарактерніших способів осмисленого підходу до вико-

ристання кольору можна простежити в основі символізму – геральдиці  

й вексилології (науки про прапори). Герби й прапори зобов'язані бути 

наочними, пізнаваними й нести закодовану інформацію. За частотою вико-

ристання у сучасних прапорах застосовуються: червоний, білий, синій, 

жовтий, чорний. Аналогічна ситуація виникає під час розроблення фірмо-

вого стилю й торговельних марок підприємств. Обране колірне рішення 

повинне символізувати пріоритети даної компанії або продукції. У разі 

правильного вибору кольорів і їх сприятливого подання у споживачів акти-

візується бажання придбати рекламований товар.  

Дизайнери й поліграфісти, використовуючи свої знання способів 

впливу різних кольорів, впливають на споживацький контингент. Вони 

допомагають виробникам за допомогою кольорів переконати спожи-

вачів купити певний товар. 

Слід розглянути приклади суперечливого значення кольорів: 

червоний колір: парадний, святковий колір краси й здоров'я (для 

України, Росії); знак попередження й стоп-сигнал (в усьому світі); колір 

доброти й відваги (для США, Китаю); 
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жовтий колір: тепло, веселощі (для України), знак смерті (для 

Сирії), ознака розпачу (для Бразилії), влада (для Китаю), колір боягузів, 

негідників і єретиків (у міфології), процвітання (для США);  

блакитний колір: вірність (для США), жалоба (для Китаю); 

зелений колір: надія (для США), найбільш популярний (для Австрії), 

колір смерті (для Єгипту), колір процвітання і благополуччя (для Індії); 

чорний колір: символізує складність й надзвичайність ситуації (для 

США), жалоба (для західних країн), колір веселощів (для Японії), чесніть 

(для Китаю); 

білий колір: підлість, облудність (для Китаю), жалоба (для Японії); 

фіолетовий колір: жалоба (для Китаю), сум (для Індії). 

Колірне рішення повинно викликати конкретні (позитивні) емоції, тому 

не слід забувати про специфіку колірного сприйняття людей, що обумов-

лена національно-культурним фактором. 

 

2.4. Сполучення і шрифт 
 

Текст обов'язково повинен бути читабельним, але необов'язково 

чорним. Досить, щоб він був у контексті з іншими кольорами й не затьма-

рювався ними. 

Під кольором шрифту (type color) у поліграфії розуміють загальний 

відтінок блоку тексту. У світлих шрифтів типу Helvetica Light світлий колір, 

оскільки наноситься дуже мало фарби; насичені ж шрифти типу Cooper 

або Arial Black виглядають набагато темніше, тому що фарби наноситься 

більше. Але колір шрифту залежить не тільки від гарнітури, на сприйняття 

впливають й інші фактори: міжбуквенний інтервал (кернінг) і міжрядковий 

інтервал (інтерліньяж).  

Крім контрастності, для зорового сприйняття шрифту важливий ще 

колір, яким друкуються літери. Не рекомендується зловживати багато-

кольоровістю під час вибору шрифтів. Бувають, звичайно, випадки, коли 

наявність великої кількості кольорів виправдана (наприклад, на сайтах, 

призначених для дітей). Але, звичайно, надлишок кольорів свідчить про 

непрофесіоналізм. 

Основні фактори 

Під час здійснення вибору того або іншого колірного рішення роз-

роблювач вирішує два завдання: 

1) завдання вибору кольору об'єкта (тексту або малюнка); 

2) завдання вибору кольору фону. 
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У рамках кожного із завдань, силу впливу кольору визначають два 

фактори: яскравість та розмір колірної площини. 

Яскраві кольори можуть викликати стомлення очей, тому що для 

точного фокусування хвиль різних кольорів на сітківці кришталик повинен 

змінювати свою форму. Переведення погляду з об'єкта одного кольору 

на об'єкт іншого кольору викликає необхідність зміни форми кришталика, 

що здійснюється спеціальними м'язами. Насичені кольори змушують  

ці м'язи працювати інтенсивніше, що й приводить до втоми. 

Використання насичених кольорів може викликати помилкове сприй-

няття глибини різних об'єктів. Це пов'язано з тим, що об'єкти, пофарбовані 

в різні насичені кольори, перебуваючи на однаковій відстані від спосте-

рігача, сприймаються ним як такі, що перебувають на різних відстанях. 

Використання насичених кольорів викликає асоціацію "плавання" пофар-

бованих різним чином об'єктів, перед площиною, наприклад, екрана, або 

за нею. Іншою причиною використання яскравих, насичених кольорів є те, 

що вони відволікають увагу від інших об'єктів. 

Цікавою особливістю зору є те, що у разі зменшення площі, що займає 

певний колір, кількість відтінків, які око здатне розрізняти, зменшується,  

і більшість кольорів починають виглядати тьмяними й темними. 

За традицією рекомендується вибирати висококонтрастні кольори 

для фону й переднього плану, наприклад, чорний текст на білому фоні 

або навпаки. Передбачається, що поряд з іншими прийомами це підвищує 

легкість для читання. Особливості розміщення: 

1) темні кольори завжди "придушують" світлі. Якщо напис білого 

кольору розмістити на чорному фоні, то він буде здаватися "тонше" за тих 

же самих параметрів шрифту; 

2) сильні колірні ефекти можливі лише у великих і жирних шрифтах. 

Дрібні й світлі шрифти нівелюють колірний ефект (червоний блякне до 

рожевого, жовтий розчиняється у білому й т. д.). 

Вибір конкретного сполучення кольорів тексту й фону визначається 

такими факторами: 

особливостями сприйняття окремих кольорів і комбінацій корис-

тувачем; 

колірними перевагами користувачів; 

колірними очікуваннями користувачів. 

Важливим є й питання, що стосується колірних очікувань. Традиційно 

червоний колір слугує для залучення уваги до деяких критичних моментів, 

зелений – для індикації успішно виконаних дій і процесів, які перебува-
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ють у стані виконання. Таким чином, використання цих кольорів у книгах 

повинне відповідати їх традиційному використанню в інших сферах. Наприк-

лад, виділення червоним кольором може попереджати про помилковий 

вибір деякої дії. 

Використання темних символів на світлому фоні значно зменшує час 

рішення завдань. Серед кращих комбінацій можна зазначити такі: чорні 

символи на червоному, жовтому, блакитному й білому фонах. У групу 

"поганих" сполучень включений зелений текст на жовтому або білому фонах, 

жовтий на чорному або білому, синій на зеленому або жовтому, бла-

китний на білому й білий на блакитному. У ході використання суцільного 

чорного фону може виникнути ілюзія різної відстані до символів різних 

кольорів, які перебувають на даному фоні.  

Рекомендації до використання колірних рішень під час оформлення 

поліграфічної продукції:  

зі збільшенням кількості об'єктів на сторінці кількість кольорів, які 

використовуються у виданні, повинна зменшуватися; 

для забезпечення чіткості подання навчального матеріалу необхідно 

підбирати найбільш контрастні комбінації сполучень кольорів; 

у рамках зони периферійного зору (наприклад, для плакатів) необ-

хідно використовувати білий колір; 

для оформлення однієї сторінки підручника необхідно використову-

вати не більше семи різних кольорів; 

необхідно використовувати однакові колірні рішення в рамках усього 

оброблюваного матеріалу (наприклад, книги). 

Типи колірних контрастів 

Виокремлюють сім типів колірних контрастів: 

1) контраст колірних зіставлень (жовтий, червоний і синій кольори 

володіють значно вираженим колірним контрастом. Рекомендується вико-

ристовувати незатемнені кольори першого й другого порядку); 

2) контраст світлого й темного (білий і чорний кольори є найбільш 

значним виразним засобом для позначення світла й тіні); 

3) контраст холодного і теплого (наприклад, тіньовий-сонячний); 

4) контраст додаткових кольорів (наприклад, пари додаткових 

кольорів: жовтий – фіолетовий, жовтогарячий – синій, червоно – жовтога-

рячий, синьо – зелений і т. д.); 

5) симультанний контраст (це явище, за якого людське око під 

час сприйняття якого-небудь кольору негайно ж вимагає появи його 

додаткового кольору, і якщо такого нема, то симультанно, тобто одночасно, 
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породжує його самого. Цей факт означає, що основний закон колірної 

гармонії базується на законі про додаткові кольори. Симультанно по-

роджені кольори виникають лише як відчуття й об'єктивно не існують); 

6) контраст колірного насичення (слова "контраст насичення" фік-

сують протилежність між кольорами насиченими, яскравими й бляклими, 

затемненими); 

7) контраст колірного поширення (характеризує розмірні співвід-

ношення між двома або декількома колірними площинами. Його сутність 

полягає у протиставленні між "багато" й "мало", "великий" і "малий" тощо). 

Окремо існує й поняття крайового контрасту, за якого рівномірно 

пофарбована поверхня здається по краях світлішою або темнішою, якщо 

вона межує із більш темною або світлою поверхнею. 

 

Висновки та узагальнення 

 

Серед найбільш цікавих нормативних теорій та класифікацій побу-

дови гармонійних сполучень кольорів доцільно виокремити такі: теорія 

Рудольфа Адамса, теорія Альберта Манселла, теорія Вільгельма Освальда, 

теорія В'ячеслава Максимовича Шугаєва, класифікація колірних гармоній 

Брюкке, класифікація колірних гармоній Б. М. Теплова, теорія гармонійних 

сполучень В. Козлова. 

Процес побудови колірної гармонії може відбуватися за допомогою 

використання образів-моделей геометричних фігур. 

До базових колірних комбінацій відносяться такі: ахроматична, ана-

логова, контрастна, додаткова, монохроматична, нейтральна, роздільно-

додаткова, первинна, вторинна, третинна. 

До напрямів колірного стилю належать такі: власний, багатий, роман-

тичний, життєрадісний, природний, дружелюбний, м'який, привітний, дина-

мічний, елегантний, тенденційний, свіжий, традиційний, освіжаючий, 

тропічний, класичний, надійний, спокійний, царствений, магічний, нос-

тальгічний, енергійний, приглушений, професійний, чистий, графічний. 

Методи сполучення кольорів розподіляються на: метод використання 

прилеглих кольорів, метод використання протилежних кольорів (або метод 

контрастності), метод використання природних сполучень кольорів, метод 

використання кольору різного ступеня насиченості.  

Фактори, що впливають на сприйняття кольору розподіляються на 

об'єктивні та суб'єктивні. 
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Теоретичні запитання 

 

1. Які існують нормативні теорії представлення колірних сполучень? 

2. Наведіть класифікацію колірних гармоній Брюкке. 

3. Наведіть класифікацію колірних гармоній Б. М. Теплова. 

4. Розкрийте змістовне навантаження теорії В. М. Шугаєва. 

5. Розкрийте змістовне наповнення теорії В. Козлова. 

6. Розкрийте сутність підходу використання геометричних фігур під 

час побудови гармонійних колірних сполучень. Наведіть приклади. 

7. Наведіть усі напрями колірних стилів. 

8. Опишіть змістовне навантаження базових колірних комбінацій. 

9. Дайте визначення понять "первинні", "вторинні", "третинні" кольори. 

10. Що таке тріада? Наведіть графічне представлення. 

11. Що таке "подвійний комплемент", "альтернативний комплемент" 

та "розщеплений комплемент"? Наведіть їх графічне представлення. 

12. Що розуміється під "монохроматичною" та "аналоговою" схемами 

кольорів? Наведіть їх графічне представлення. 

13. Опишіть методи сполучення кольорів та наведіть відповідні 

(тобто використовувані в рамках кожного з методів) колірні схеми. 

14. У чому полягає сутність технології побудови 12-секторного колір-

ного кола? 

15. Опишіть психологічні особливості кольорів. 

16. Охарактеризуйте всі суб'єктивні фактори, що впливають на 

сприйняття кольору. 

17. У чому сутність особисто-орієнтованого подання колірного рі-

шення? 

18. Які є різновиди колірних асоціацій? 

19. Розкрийте змістовне навантаження типів колірного контрасту. 

20. Проведіть порівняльний аналіз суперечливого сприйняття кольо-

рів у різних країнах світу. 

 

3. Адитивні та субтрактивні системи 

цифрового представлення кольору 

 

Основна ідея 
 

Присвячено аналізу видів синтезу кольору, розгляду цифрових моде-

лей подання кольору та розкриттю специфіки кількісного опису кольору. 
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Ключові поняття: адитивний синтез кольору, субтрактивний синтез 

кольору, моделі подання кольору, колірні вимірювання, математичне 

перетворення. 

 

Основні питання 

3.1. Теоретичні основи організації систем цифрового подання кольору. 

3.2. Математика кількісного опису кольору. 

3.3. Математичне перетворення. 

 

Цілі вивчення 

 

Метою є дослідження процесу синтезу кольору, опис цифрових 

моделей подання кольору, розкриття особливостей здійснення процесу 

кількісного опису кольору та математичних перетворень.  

Інформація, подана далі, надає студентові можливість сформувати 

такі компетентності: 

знання: 

специфіки кольороутворення; 

систем цифрового подання кольорів; 

правил складання кольорів; 

специфіки представлення колірних охоплень різних пристроїв; 

математики кількісного опису кольорів; 

уміння: 

здійснювати адитивний та субтрактивний синтез кольору; 

досліджувати та обирати колірні моделі; 

здійснювати колірні вимірювання та математичні перетворення; 

комунікації: 

надання допомоги у визначенні кольору, що формується в резуль-

таті поглинання і відбиття кольорів; 

консультації представників підприємств щодо доцільності певних 

математичних перетворень; 

автономність і відповідальність: 

прийняття рішення щодо обрання найбільш доцільної цифрової 

колірної моделі; 

професійна підготовка осіб, що займаються вимірюванням кольору 

на основі визначення його колірних координат. 
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Вступ 
 

Множинність моделей подання кольору викликає необхідність їх 

ґрунтовного аналізу з метою виявлення найбільш доцільної для роботи  

з кольором або з колірними властивостями. Серед цифрових систем 

(моделей), що підлягають розгляду, були виділені такі: RGB, CMYK, HSV 

(HSB, HSL), Lab, Index Color, Grayscale. 

Урахування того, що колір на конкретному пристрої визначається  

в рамках певного колірного охоплення, в розділі розкривається питання 

стосовно колірних вимірювань та наводиться загальна характеристика 

процесу прямого та зворотного математичного перетворення (як основа 

здійснення переходу між системами цифрового представлення кольору).  
 

3.1. Теоретичні основи організації систем  

цифрового представлення кольору 
 

Основи адитивного та субтрактивного синтезу кольору 

На друкованому відтиску мають місце два види змішання: адитивне 

(рис. 3.1) (об'єднання різноколірних растрових точок, які розташовані поруч, 

оком спостерігача) і субтрактивне (рис. 3.2) (послідовне накладення 

растрових точок для різних фарб). 
 

 
 

Рис. 3.1. Адитивний синтез кольору із застосуванням трьох 

основних  випромінювань: червоного, зеленого та синього 
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Рис. 3.2. Субтрактивний синтез кольору із застосуванням трьох 

основних фарб: блакитної, пурпурної та жовтої 

 

Під час адитивного методу відчуття кольору досягається за допо-

могою оптичного додавання кольорів, а під час субтрактивного – вираху-

ванням кольорів або змішанням фарб. У першому випадку змішання 

основних кольорів (червоного – R, зеленого – G та синього – B) дає 

відчуття білого – W кольору, а в другому – змішання додаткових до 

основних кольорів (блакитного або синьо-зеленого) – C, пурпурного – M 

та жовтого – Y) дає відчуття чорного – B кольору.  

Використовуючи монітор, маємо справу з адитивним RGB-синтезом. 

Субтрактивний CMY-синтез кольору спостерігається у разі послідовного 

накладення фарб на задруковані ділянки (у цьому разі яскравість кольору 

зменшується з товщиною фарбового шару). 

Для одержання потрібних кольорів застосовуються світлофільтри, 

пофарбовані в додатковий до основного колір: блакитний, пурпурний або 

жовтий. Зазначені світлофільтри поглинають промені основних кольорів, 

відповідно червоний, зелений і синій, і пропускають промені інших 2/3 

спектра (табл. 3.1  та рис. 3.3). 

 

http://ru.wikipedia.org/wiki/%D0%A1%D0%B2%D0%B5%D1%82%D0%BE%D1%84%D0%B8%D0%BB%D1%8C%D1%82%D1%80
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Таблиця 3.1 
 

Кольороутворення в результаті поглинання та відбиття кольорів 
 

Колір Поглинання Відбиття Результат 

C Світло-червоний Зелений і світло-блакитний Cyan 

M Світло-зелений Червоний і світло-блакитний Magenta  

Y Світло-блакитний Червоний і світло-зелений Yellow  

M + Y Зелений і світло-блакитний Світло-червоний Red  

C + Y Червоний і світло-блакитний Світло-зелений Green  

C + M Червоний і світло-зелений Світло-блакитний Blue  
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Рис. 3.3. Графічне зображення процесу кольороутворення 

 

Коли на білий матеріал, що відбиває, наносять блакитний, пурпур-

ний і жовтий пігменти, кожен із них поглинає або віднімає з падаючого 

білого світла протилежний колір.  

Блакитна, пурпурна й жовта фарби наносяться на папір окремими 

шарами. Прозора властивість цих фарб забезпечує ефект змішування,  

а ілюзія різних кольорів і тонів створюється за рахунок варіювання щіль-

ності барвників. Варіювання щільності барвників створює той же ефект, 

що й варіювання інтенсивності випромінювання червоного, зеленого й си-

нього люмінофорів на екрані монітора. 

Поєднання основних і додаткових кольорів дає фотографічне 

колірне коло, тобто, графічне подання взаємозалежності кольорів, 

застосовуване в поліграфії, фотографії й інших областях, пов'язаних із 

одержанням, аналізом і синтезом кольору. Приклади фотографічних 

колірних кіл наведено на рис. 3.4 а – рис. 3.4 в. 
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а) стандартне фотографічне колірне коло

б) фотографічне колірне коло

фірми Kodak

в) фотографічне колірне коло

фірми NORITSU

а) стандартне фотографічне колірне коло

б) фотографічне колірне коло

фірми Kodak

в) фотографічне колірне коло

фірми NORITSU

 

а) стандартне фотографічне колірне коло 
а) стандартне фотографічне колірне коло

б) фотографічне колірне коло

фірми Kodak

в) фотографічне колірне коло

фірми NORITSU

а) стандартне фотографічне колірне коло

б) фотографічне колірне коло

фірми Kodak

в) фотографічне колірне коло

фірми NORITSU

 

а) стандартне фотографічне колірне коло

б) фотографічне колірне коло

фірми Kodak

в) фотографічне колірне коло

фірми NORITSU

а) стандартне фотографічне колірне коло

б) фотографічне колірне коло

фірми Kodak

в) фотографічне колірне коло

фірми NORITSU

 

б) фотографічне колірне коло в) фотографічне колірне коло  

фірми Kodak фірми NORITSU 

 

Рис. 3.4. Приклади фотографічний колірних кіл 

 

Таке графічне подання взаємозалежності кольорів дозволяє легко 

визначити, які кольори треба скласти в рівних кількостях для одержання 

третього кольору. Існують такі правила складання кольорів: 

перше правило: один основний або додатковий колір утворюється 

додаванням двох сусідніх кольорів на колірному колі (тобто, будь-який 

колір може бути отриманий під час додавання двох сусідніх кольорів). 

Наприклад, червоний (R) колір утворюється додаванням у рівних кілько-

стях жовтого (Y) і пурпурного (M) – двох сусідніх кольорів на колірному 

колі (рис. 3.5 а); 

друге правило: у разі додавання в рівних кількостях двох кольорів, 

розташованих на протилежних секторах колірного кола, відбувається їх 

взаємна компенсація й формування нейтральної щільності (N) або сірого 

кольору (Gray – Neutral Density). Наприклад, варто розглянути додавання 



70 

червоного (R) і блакитного (C) кольорів у рівних кількостях. Ці кольори 

перебувають на протилежних секторах колірного кола, у результаті від-

будеться компенсація колірного фарбування й формується нейтральна 

щільність або сірий колір (рис. 3.5 б).  

 

 
а) перше правило  б) друге правило 

 

Рис. 3.5. Приклади дії правил складання кольорів 

 

Виникає природне запитання: "Не простіше було б взяти й представити 

в колірній моделі не основні, а всі можливі кольори?" Звичайно, ні! Дати опис 

кожного кольору окремо дуже складно, особливо зараз, коли на екрані моні-

тора є можливість бачити не сотні, не тисячі, а чотири мільярди кольорів  

і колірних відтінків. Тому дуже складно описати кожен колір окремо. У такий 

спосіб колірні моделі – це майже зроблений спосіб для опису кольорів 

особливо в комп'ютерних технологіях і поліграфії. Чому ж майже? Справа 

в тому, що не будь-який колір можна представити у вигляді комбінації 

основних. Це є основною проблемою колірних моделей. Крім того, колір, 

що поглинається і випромінюється, описують по-різному. 

Для зручності візуального сприйняття всі видимі кольори представ-

ляються у системі CIEXYZ усередині кривої на площині xy. На площині xy 

позначаються точки, що відповідають значенням координат кольоровості 

спектральних випромінювань від 380 нм до 770 нм. Всередині даної колір-

ної діаграми зображуються колірні охоплення різних пристроїв. Колірне 

охоплення монітора відповідає моделі RGB, а принтера, друкарської 

поліграфічної машини – моделі CMYK (рис. 3.6). 
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Рис. 3.6. Колірні охоплення пристроїв 

 

Колірне охоплення монітора зображують у вигляді трикутника. 

Оскільки утворення кольору в цих пристроях засновано на принципі ади-

тивного синтезу трьома основними кольорами (R, G, B), то досить нанести 

координати кольоровості цих кольорів на діаграму xy, з'єднати знайдені 

точки прямими лініями й одержати трикутник, усередині якого будуть 

лежати всі відтворені цим пристроєм кольори. 

У процесі друге колірне охоплення набуває форми шестикутника 

(утворення кольору в пристроях друку засновано на принципі субтрактив-

ного синтезу). У шестикутнику, крім точок, що відповідають фарбам синтезу 

жовтої, пурпурної й блакитної, наносяться точки, що відповідають кольору по-

парних накладень: жовта + блакитна = зелена; жовта + пурпурна = червона; 

блакитна + пурпурна = синя. Точки, з'єднані прямими, утворюють область 

колірного охоплення. 

Схематична побудова колірного охоплення для адитивного (RGB) і 

субтрактивного (CMY) синтезів подана на рис. 3.7. 
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тується на можливостях червоного, зеленого й 
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Рис. 3.7. Колірне охоплення для процесів адитивного (RGB)  

і субтрактивного (CMY) синтезів 

 

Таким чином, під колірним охопленням слід розуміти область на 

колірній діаграмі, що охоплює всі кольори, які можуть бути відтворені за 

допомогою конкретного процесу (синтезу кольору на екрані монітора, 

друку на принтері, спеціальній поліграфічній машині тощо). Колірне охоп-

лення дає нам уявлення про те, наскільки добре конкретна колірна модель 

представляє кольори. 

Представлення кольору у вигляді комбінації невеликої кількості трьох 

складових називається колірною моделлю. 

Різні види моделей мають різні колірні охоплення. У цьому й поля-

гають їх основні переваги або недоліки. Незважаючи на досить велику 

кількість колірних моделей, варто детальніше розглянути ті, які найбільш 

часто використовуються в програмних продуктах, що застосовуються  

у поліграфії під час цифрового оброблення графічних зображень. 

Опис цифрових моделей представлення кольору 

Колірна модель RGB  

Ця модель описує випромінювані кольори. Вона заснована на трьох 

основні (базових) кольорах: червоному (red), зеленому (green) і синьому 

(blue). Інші кольори виходять сполученням базових. Кольори такого типу 

називаються адитивними, тобто в такій колірній моделі здійснюються пра-

вила додавання кольорів. Кожен основний колір може мати 256 градацій 
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яскравості (від 0 до 255), що відповідає восьми бітовому режиму. У RGB 

міститься 2563 або 16 777 216 кольорів. 

Модель є збалансованою, тобто додавання трьох основних кольорів 

із однаковою яскравістю дають відтінок сірого. Білий колір утворюється  

в результаті додавання хвиль червоного, зеленого й синього діапазонів. 

Просторовий вигляд моделі наведено на рис. 3.8. 
 

 
Рис. 3.8. Просторове представлення моделі RGB 

 

Пояснення: модель представляється у вигляді тривимірної системи 

координат. Кожна координата відображає внесок кожної складової у резуль-

туючий колір у діапазоні від нуля до максимального значення. У резуль-

таті формується куб, усередині якого й "перебувають" всі кольори, 

утворюючи колірний простір RGB. 

У трьох кутах куба розташовані чисті кольори (тобто чисті вихідні 

колірні випромінювання): червоний, зелений і синій. В інших трьох кутах 

їх повні сполучення: жовтий, блакитний і пурпурний. Між чорним і білим 

кольорами проведена діагональ, що зображує градацію сірого. Саме в цій 

моделі кодує зображення сканер і відображає рисунок екран монітора.  

У точці, що є початком координат всі складові дорівнюють нулю (тобто 

випромінювання відсутнє), а це рівнозначне темряві, тобто це точка чор-

ного кольору. Друга точка, де всі складові мають максимальне значення, 

дає білий колір. На лінії, що з'єднує ці точки (по діагоналі), розташо-

вуються ахроматичні кольори (сірі відтінки): від чорного кольору до білого. 

Цей процес відбувається тому, що всі три складові однакові й розташо-

вуються в діапазоні від нуля до максимального значення. Такий діапазон 
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інакше називають сірою або ахроматичною віссю. У комп'ютерних тех-

нологіях найчастіше використовуються 256 градацій (відтінків) сірого.  

Модель застосовується: для опису кольорів у зображеннях, приз-

начених для моніторів, мультимедійних і телевізійних екранів, цифрових 

відеомагнітофонів, web-вузлів, ряду моделей цифрових принтерів, тому 

що ці пристрої мають вбудовану підтримку RGB  та ін. 

Зауваження: багато відтінків, створених колірною системою RGB, 

не вдається передати під час друку. Тому нерідко фарби рисунка після 

друку виявляються бляклими. Перехід із RGB у CMYK здійснюється через 

спеціальні програмні фільтри, де враховуються всі майбутні установки 

друку: система основних тріадних фарб, коефіцієнт розтискування точки, 

баланс фарб, спосіб генерації чорного кольору, а також максимальний 

рівень фарби й інших установок. 

Колірна модель CMY  

Колірна модель CMY (на практиці – CMYK) є основною в поліграфії. 

Модель CMY, на відміну від RGB, описує кольори, що поглинаються, 

оскільки після друку зображення людина бачить тільки відбитий колір. 

Кольори, що використовують біле світло, віднімаючи з нього певні ділянки 

спектра, й називаються субтрактивними. Саме такі кольори й використо-

вуються в моделі CMY. Вони утворюються шляхом вирахування з білого 

адитивних кольорів моделі RGB. Таким чином, основними кольорами  

в CMY є блакитний (cyan: білий мінус червоний), пурпурний (magenta: 

білий мінус зелений) і жовтий (yellow: білий мінус синій). 

Так, наприклад, коли біле світло, що містить усі кольори, падає на 

поверхню, на яку нанесені чорнило блакитного кольору, людина бачить 

блакитний колір, оскільки поверхня блакитного кольору поглинає червоний, 

а зелений і синій відбиваються від нього. Для того, щоб одержати 

червоний колір під час використання фарб CMY, необхідно використо-

вувати пурпурну й жовту фарби. Пурпурний колір приведе до поглинання 

зеленого, а жовтий – синього, тому буде відбитий тільки червоний колір, 

що і розрізнить око людини (див. рис. 3.3). 

Модель є незбалансованою, тому на практиці замість CMY використо-

вується CMYК. Комбінація чорнил тільки блакитного, жовтого й пурпурного 

кольорів виявляється "брудною для друку". Замість того, щоб під час 

відбиття білого світла побачити чорний колір, людина бачить брудно-

сірий. Для усунення подібної проблеми додаються чорнила чорного кольору. 

У поліграфії було прийнято називати додатковий чорний – ключовим 
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кольором (key color), звідси скорочення "К" (був узятий саме індекс "К",  

а не "B", щоб не створювати додаткової плутанини із синім (blue) кольором). 

Таким чином, чорний колір забезпечується спеціальним чорним барвником, 

а не змішанням всіх трьох барвників. Три перші фарби використовуються 

для одержання всіх кольорів і відтінків зображення. Чорна ж застосо-

вується для тіньових зон зображення – як додатковий компонент. Такий 

прийом надає можливість одержання чорного кольору під час чотири-

колірного друку. 

Просторовий вигляд моделі CMY наведено на рис. 3.9. 

 

 
 

Рис. 3.9. Просторове представлення моделі CMY 

 

Пояснення: модель CMY аналогічна RGB, у якій переміщений початок 

координат. У CMY колірне охоплення більш вузьке, ніж у RGB, тому під час 

конвертації із RGB в CMY втрачається частина кольорів. Насиченість 

кольору вимірюється у відсотках, тому кожен колір має 100 градацій яс-

кравості. 

Модель застосовується: для опису кольорів у зображеннях, які дру-

куються.  

Зауваження: однак, якщо CMY можна зв'язати з певною колірною сис-

темою, то CMYK уже не можна, тому що вона надлишкова: кольори від 

білого до чорного утворюються як змішанням основних барвників CMY, 

так і зміною концентрації додаткового – K.  
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Якщо зображення споконвічно представлене у кольорах RGB-моделі, 

а його необхідно надрукувати, то потрібно перетворити кольори в CMYК-

модель, тобто виконати процес кольороподілу. 

Кольороподілом називається процес розкладання кольорового 

зображення з режиму RGB на чотири складові фарби CMYК, що потім 

з'єднуються під час друку, утворюючи багатокольорове зображення. 

На практиці кольорове зображення одержують у такий спосіб: із чорно-

білих кольороподілених негативів звичайним фотографічним шляхом 

друкують чорно-білі кольороподілені позитиви, що піддають фарбуванню 

в додатковий колір до кольору світлофільтра даного негатива, і потім 

пофарбовані позитивні зображення сполучають за їх обрисами на білій 

паперовій підложці або на прозорій плівці. У підсумку одержують кольо-

рове зображення, кольори якого наближаються до оригіналу. 

Незважаючи на згадану простоту цього процесу (наприклад, у Adobe 

Photoshop для переходу в модель CMYK досить викликати команду 

Image → Mode → CMYK), технологічний бік цього переходу часто зали-

шається для користувача "за кадром". А кольороподілом потрібно управ-

ляти. Наприклад, задавши два різних рівні генерації чорної фарби, можна 

одержати два різних під час друку зображення, які будуть зовсім однаково 

виглядати на екрані. Кольороподіл відбувається щоразу, коли друкується 

який-небудь файл або здійснюється перехід у процесі роботи в графіч-

ному редакторі з початкової робочої колірної моделі в CMYK. Кольороподіл 

є дуже складним процесом, тому якість готового зображення багато в чому 

залежить від досвіду оператора, правильного калібрування всієї системи 

й майстерності друкаря. 

Зауваження: між моделями RGB і CMY (CMYK) немає однозначної 

відповідності, тобто деякі відтінки кольору однієї моделі не можуть бути  

в принципі відтворені в іншій моделі й навпаки. Саме цим викликана необ-

хідність калібрування устаткування (сканера, монітора й принтера) на 

предмет відповідності кольорів. Зміст та особливості здійснення процесу 

калібрування розглядаються далі. 

Підводячи підсумки із приводу колірних моделей RGB і CMYK слід 

зазначити, що вони є апаратно залежними. Якщо йдеться про RGB, то 

залежно від застосованого у конкретному моніторі люмінофора будуть 

відрізнятися значення базових кольорів. Щодо CMYK, де йдеться про 

типографські фарби, особливості друкарського процесу тощо, то однакове 

зображення може по-різному виглядати на різній апаратурі. Тому основним 

http://ru.wikipedia.org/w/index.php?title=%D0%9D%D0%B5%D0%B3%D0%B0%D1%82%D0%B8%D0%B2_%28%D1%84%D0%BE%D1%82%D0%BE%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D1%8F%29&action=edit
http://ru.wikipedia.org/w/index.php?title=%D0%9F%D0%BE%D0%B7%D0%B8%D1%82%D0%B8%D0%B2_%28%D1%84%D0%BE%D1%82%D0%BE%D0%B3%D1%80%D0%B0%D1%84%D0%B8%D1%8F%29&action=edit
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завданням під час роботи з кольоровими зображеннями є одержання 

передбачуваного кольору. Саме це й спричинило інтенсивне використання 

колірної моделі Lab. 

Колірна модель Lab 

Колірна модель Lab описує усі видимі кольори й може бути вико-

ристана для опису кольорів у зображеннях без апаратної прив'язки. 

Lab є апаратно незалежною моделлю, призначеною для визначення 

кольору без урахування індивідуальних особливостей (профілю) пристрою 

(монітора, принтера, друкованої машини тощо). 

Це триканальна модель, у якій колір визначається однією кількісною 

характеристикою (потужністю випромінювання, яскравістю, світлотою)  

і двома якісними характеристиками, але не у вигляді окремих монохро-

матичних випромінювань, а половинками інтервалу спектра випроміню-

вань видимого світла. Тобто в моделі будь-який колір визначається світ-

лотою (Luminance) і двома хроматичними компонентами: параметром а, 

що змінюється в діапазоні від зеленого до червоного, і параметром b, що 

змінюється в діапазоні від синього до жовтого. Тобто яскравість у цій моделі 

повністю відділена від кольору. Це робить модель зручною для регулю-

вання контрасту, різкості й інших тонових характеристик. 

Lab використовує прямокутні координати на базі двох перпендику-

лярних осей: жовтий – синій та зелений – червоний. 

Геометричним образом моделі Lab є куля. 

Просторовий вигляд моделі Lab наведено на рис. 3.10.  

 

 
 

Рис. 3.10. Просторове представлення моделі Lab 
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Пояснення: за допомогою символу "*" позначено розроблення сис-

теми спеціалістами CIE, тому що існують ряд Lab, що відрізняються від 

CIE Lab за масштабом. За допомогою "  " Hue – зміну тону кольорів. 

Колірне охоплення Lab дуже широке: воно містить RGB і CMYK,  

і інші кольори, що не можуть бути представлені у двох попередніх моделях. 

Під час конвертації в Lab усі кольори зберігаються.  

Модель застосовується: під час переведення зображення з однієї 

колірної моделі в іншу, між пристроями й навіть між різними платформами 

(що дуже важливо для поліграфії). Крім того, саме в цій моделі зручніше 

за все проводити деякі операції з поліпшення якості зображення. 

Програма Adobe Photoshop використовує цю модель як посередник 

під час будь-якого конвертування з моделі в модель. Точніше модель 

CIE Lab прийнята фірмою Adobe для мови PostScript Level 2. 

Колірна модель HSB 

Дана колірна модель найбільш проста в розумінні. Крім того, вона 

може бути застосовна і для адитивних, і для субтрактивних кольорів.  

Модель HSB представляє колір у вигляді тону (Hue), насиченості 

(Saturation) і яскравості (Brightness). Вона ж відома як модель HSL (тон, 

насиченість і інтенсивність – Luminance). HSB є альтернативою CIEXYZ. 

У процесі цього тон – це власне колір, насиченість – відсоток доданої 

до кольору білої фарби (це параметр кольору, що визначає його чистоту. 

Якщо по краю колірного кола розташовуються максимально насичені 

кольори (100 %), то залишається тільки зменшувати їх насиченість до міні-

муму (0 %). Зменшення насиченості кольору означає його розбілення. 

Колір зі зменшенням насиченості стає пастельним, бляклим, розмитим. 

На моделі всі однаково насичені кольори розташовуються на концентрич-

них окружностях, тобто можна говорити про однакову насиченість, наприк-

лад, зеленого та пурпурного кольорів, і чим ближче до центра кола, тим 

усе більш розбіленими виходять кольори), яскравість – відсоток доданої 

чорної фарби (зменшення яскравості кольору означає зачорніння кольору). 

Модель добре погоджується зі сприйняттям людини: колірний тон  

є еквівалентом довжини хвилі світла, насиченість – інтенсивності хвилі,  

а яскравість – кількості світла. 

Це триканальна колірна модель. Будь-який колір у HSB утворюється 

додаванням до основного спектра чорної або білої фарби. Геометричний 

образ моделі HSB, як і попередньої моделі Lab, – куля. 

Просторовий вигляд моделі HSB наведено на рис. 3.11.  
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Рис. 3.11. Просторове представлення моделі HSB 

 

Модель HSB не є строгою математичною моделлю. Опис кольорів 

в ній не відповідає кольорам, які сприймаються оком. Справа в тому, що 

око сприймає кольори як такі, що мають різну яскравість. Наприклад, 

спектральний зелений має більшу яскравість, ніж спектральний синій.  

У HSB усі кольори основного спектра (канали тону) вважаються такими, 

що володіють 100 % яскравістю. Насправді це не відповідає дійсності. 

Хоча модель HSB декларована як апаратно-незалежна, насправді 

в її основі лежить RGB. Модель HSB є варіантом (аналогом) моделі RGB 

і також базується на використанні базових кольорів, але відрізняється 

системою координат.  

Модель HSB має велике колірне охоплення. Вона має перед RGB  

і CMYК таку перевагу: модель відповідає природі кольору, добре узгод-

жується з моделлю сприйняття кольору людиною й не залежить від прис-

трою репродукування кольору – описує всі видимі кольори. 

Основним недоліком моделі є необхідність перетворення в модель 

RGB для відображення на екрані монітора або в модель CMYK для одер-

жання поліграфічного відтиску, а будь-яке перетворення з моделі в модель 

не обходиться без втрат кольоровідтворення. 

Модель застосовується: для зручного вибору кольору, однак для 

опису кольорів у зображеннях вона не застосовується, тому що неможливо 
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всі три характеристики даної моделі закласти в прийнятий стандартний 

восьмибітовий режим редагування зображень. 

Колірна модель HLS 

Модель HLS (Hue – тон, Lightness – посвітління/інтенсивність, 

Saturation – насиченість) є варіантом моделі HSB. У цих моделях колірні 

параметри "відтінок" і "насиченість" є загальними. Розходження полягає 

в заміні нелінійного компонента Brightness (яскравість) на лінійний компо-

нент Lightness (посвітління/інтенсивність), що змінюється в діапазоні від 

0 до 100 %. Ця модель також альтернативна моделі RGB. 

Колірна модель Index Color  

Модель Index Color (індексований колір) заснована на принципі вико-

ристання восьмибітного кольору. Застосовується, насамперед, в Інтернеті 

через різне відображення кольорів на різних типах комп'ютерів, моніторів 

і браузерів. Усі відтінки у файлі діляться на 256 можливих варіантів, кож-

ному з яких присвоюється номер. Далі на основі отриманої палітри кольорів 

будується таблиця, де кожному номеру комірки приписується колірний 

відтінок у значеннях RGB. 

Щоб уникнути некоректності передачі кольору рекомендується корис-

туватися так званими Safe Web Color Pallete – безпечними колірними 

палітрами для web (це набори кольорів, які однаково відображаються  

в різних браузерах). До форматів файлів, що використовують тільки індек-

совані палітри, належить GIF. 

Колірна модель Grayscale 

Під час роботи з колірною моделлю Grayscale колір переводиться 

до свого сірого аналога за інтенсивністю. Інтенсивність – єдина характе-

ристика цієї моделі. Колірна модель Grayscale становить ту ж індексовану 

палітру, де замість кольору пікселям призначена одна з 256 градацій сірого. 

 

3.2. Математика кількісного опису кольору 

 

Колірні вимірювання 

У 1931 р. міжнародна комісія зі стандартизації, відома як Міжнародна 

освітлювальна комісія (СIЕ), запропонувала систему вимірювання кольору, 

що і застосовується з того часу із невеликими змінами. Ця система має 

ряд переваг, однак найбільш важлива полягає в тому, що в математичних 

моделях кольору відсутні негативні величини. Це значно зменшує кількість 
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помилок під час запису рівнянь. Позбутися від негативних величин можна 

тільки підбором гіпотетичних, нереальних основних кольорів. Щоб легше 

зрозуміти цей момент, варто звернути увагу на те, що хоча гіпотетичних 

кольорів насправді реально не існує, на колірній діаграмі (простір локусу) 

їм відповідають цілком конкретні точки. 

І що це дає на практиці? Це дуже зручно, тому що всі вимірювання 

проводять на реальних основних кольорах, а потім результати за допо-

могою обчислень перетворять у відповідні коефіцієнти для гіпотетичних 

кольорів.  

Сутність систем CIE така: вибравши як три основні базові кольори 

будь-які три лінійно незалежних кольори спектра й з'єднавши їх прямими 

лініями, буде одержано трикутник. Математична модель системи CIE ліній-

на, отже, проста, але й з обмеженою точністю. Через кривизну ліній локусу, 

на яких лежать спектральні кольори, деякі кольори завжди будуть випа-

дати із цього трикутника й у відповідних колірних рівняннях позначатися 

негативними величинами. Із цієї причини СIЕ обрала як основні гіпоте-

тичні кольори й розташувала їх по осях X, Y і Z таким чином, щоб вся 

область між бічними сторонами й "пурпурної" прямої лежала усередині 

трикутника XYZ. 

Вимірювання проводять на існуючих основних кольорах, а потім шля-

хом нескладних перетворень їх перераховують. Основна перевага такої 

системи полягає у тому, що вимірювання можна проводити з використан-

ням будь-яких основних кольорів, але якщо потім перетворити їх у систему 

стандартних кольорів, то вимірювання, проведені в різних лабораторіях, 

можна зіставляти одне з одним. Вибір основних кольорів системи СIЕ 

XYZ приводить до одержання стандартної діаграми кольоровості СIЕ.  

У дійсності всю систему кількісного вимірювання кольору СIЕ можна 

графічно представити як набір величин трьох параметрів – колірний тон, 

насиченість і яскравість (світлота), які визначають і реальні кольори.  

Необхідно чітко розрізняти, що колірні моделі (RGB, CMY, CMYK) 

описують спосіб відтворення колірних відчуттів, а колірні системи (HSV, 

XYZ, Lab) – вимірювання цих відчуттів. Дані RGB і CMYK є апаратними 

даними, вони мало що говорять про колірні відчуття без прив'язки до 

конкретного апарата. Щоб домогтися збігу кольорів, отриманих на різних 

апаратах і за допомогою різних колірних моделей, є тільки один кількісний 

спосіб – домогтися рівності їх колірних координат.  
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Колірні вимірювання становлять предмет колориметрії. У результаті 

колірних вимірювання визначаються три числа, тобто, колірні коорди-

нати (КК), що повністю визначають колір. 

Основою математичного опису кольору в колориметрії є експери-

ментально встановлений факт, що будь-який колір можна представити  

у вигляді суми певних кількостей трьох лінійно незалежних кольорів. 

Три обраних лінійно незалежних кольори називають основними 

кольорами, вони й визначають колірну координатну систему (ККС). Тоді 

три числа, що описують даний колір, є кількостями основних кольорів  

у суміші, колір якої зорово не відрізняється від даного кольору. Це і є КК 

даного кольору. 

Експериментальні результати, які закладають в основу розроблення 

ККС, одержують під час усереднення даних спостережень великою кіль-

кістю спостерігачів, тому вони не відображають точно властивостей колір-

ного зору якого-небудь конкретного спостерігача, а належать до так званого 

середнього стандартного колориметричного спостерігача. 

Унаслідок того, що віднесені до стандартного спостерігача в певних 

незмінних умовах, стандартні дані змішання кольорів і побудовані на них 

колориметричні ККС описують фактично лише фізичний аспект кольору, 

не враховуючи зміни кольоросприйняття ока під час зміни умов спосте-

реження. 

Коли КК якого-небудь кольору відкладають на трьох взаємно перпен-

дикулярних координатних осей, цей колір геометрично представляється 

точкою в тривимірному, так званому колірному просторі або ж вектором, 

початок якого збігається з початком координат, а кінець – із даною точкою 

кольору. Точкове й векторне геометричне трактування кольору рівноцінні 

й обидва використовуються під час опису кольорів. 

Точки, що представляють усі реальні кольори, заповнюють деяку 

область колірного простору. Але математично всі точки простору рівно-

правні, тому можна умовно вважати, що й точки поза областю реальних 

кольорів представляють деякі кольори. Таке розширення тлумачення 

кольору як математичного об'єкта приводить до поняття нереальних 

кольорів. З цими кольорами можна здійснювати математичні операції так 

само, як і з реальними кольорами. 

Якість кольору, що не залежить від абсолютної величини колірного 

вектора, називають його кольоровістю. Кольоровість якого-небудь кольору 
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визначається не з його КК, а співвідношенням між ними, тобто положенням 

у колірному просторі прямої, проведеної з початку координат через точку 

даного кольору. Положення точки кольоровості в колірному трикутнику 

визначається двома координатами кольоровості, кожна з яких дорівнює 

частці від ділення однієї з КК на суму всіх трьох КК. Двох координат 

кольоровості досить, тому що за визначенням сума її трьох координат 

дорівнює 1. Точка кольоровості вихідного (опорного) кольору, для якої три 

колірні координати рівні між собою (кожна дорівнює 1/3), міститься в центрі 

ваги колірного трикутника. 

Під час графічної побудови залежностей кількостей основних кольорів 

від довжини хвилі виходять функції довжини хвилі, які називаються кри-

вими додавання кольорів. За кривими додавання можна розрахувати 

кількості основних кольорів, необхідні для одержання суміші, зорово не 

відмінних від кольору випромінювання складного спектрального складу. 

Для цього колір складного випромінювання представляють у вигляді суми 

чистих спектральних кольорів, що відповідають його монохроматичним 

складовим.  

Можливість подібного представлення заснована на одному з експе-

риментально встановлених законів змішування кольорів, відповідно 

до якого КК кольору суміші дорівнюють сумам відповідних координат 

кольорів, що змішуються. Таким чином, криві додавання характеризують 

реакції на випромінювання трьох різних приймачів випромінювання. Кожній 

з можливих ККС відповідає своя група з трьох кривих додавання, причому 

всі групи кривих додавання пов'язані між собою лінійними співвідношен-

нями. Приклад відображення кривих додавання для ККС СIЕ RGB наве-

дений на рис. 3.12. 

Пояснення: на рис. 3.12 а показаний колірний трикутник х, у. На ньому 

наведена лінія спектральних кольоровостей, лінія пурпурних кольорово-

стей, колірний трикутник (R) (G) (В) системи СIЕ RGB, лінія кольоро-

востей випромінювання абсолютно чорного тіла й точки кольоровостей 

стандартних джерел освітлення СIЕ А, В, С і D. Через Е позначена вихідна 

(опорна) кольоровість, що перебуває в центрі ваги колірного трикутника 

системи. 

Вихідна кольоровість – це кольоровість рівноенергетичного білого 

кольору Е, тобто кольору випромінювання з рівномірним розподілом інтен-

сивності по всьому видимому спектру. 
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а) вигляд ККС СIЕ RGB 
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б) криві додавання ККС СIЕ RGB 

 

Рис. 3.12. Представлення кривих додавання в ККС СIЕ RGB 

 

Однак криві додавання системи СIЕ RGB (див. рис. 3.12 б) мають 

негативні ділянки (негативні кількості основних кольорів) для деяких 

спектральних кольорів, що незручно під час розрахунків. Тому поряд із 

системою RGB у 1931 р.  прийняла іншу ККС – систему XYZ, у якій були 

відсутні недоліки (негативні ділянки системи RGB) і значно спрощені 

розрахунки (рис. 3.13). 
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Рис. 3.13. Криві додавання ККС СIЕ XYZ 

 

Основними кольорами (X), (Y), (Z) системи XYZ є нереальні кольори, 

обрані так, що криві додавання цієї системи (див. рис. 3.13) не мають 

негативних ділянок, а координата Y дорівнює яскравості спостережу-

ваного пофарбованого об'єкта (для денного зору). Система XYZ широко 

використовується в колориметрії. Її основним недоліком є те, що вона не 

відображає кольоророзрізнювальних властивостей ока, тобто однакові 

відстані на графіку кольоровостей X, Y у різних його частинах не відпо-

відають однаковому зоровому розходженню між відповідними кольорами 

за однакової яскравості. 

Було запропоновано багато формул для підрахунку кількості колірних 

розходжень (порогів кольоророзрізнення dE) між різними кольорами.  

У 1960 р. СIЕ рекомендувала графік u, v, отриманий в 1937 р. Д. Л. Мак-

Адамом шляхом видозміни графіка, запропонованого Д. Б. Джаддом. Для 

підрахунку числа порогів кольоророзрізнення dE між різними кольорами 

за рекомендацією СIЕ використовується емпірична формула Г. Вишецького, 

що має такий вигляд: 
 

 2

21

2

21

2

21
) W-W(+) V-V(+)U -U(=EΔ ,  (3.1) 

при W =25Y1/3 – 17, 

U =13W (u – u0), 

V = 13W (v – v0), 

де u0, v0 – кольоровість опорного білого кольору; 

Y– коефіцієнт відбиття в даній точці об'єкта, вимірюється в %. 
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Таким чином, основною метою процесу вимірювання кольору  

є визначення його КК у деякій ККС. 

Коли колір представлений спектральним розподілом випромінювання 

(що випускається джерелом, або відбитого чи пропущеного предметом), 

то для знаходження його ЦК потрібно використовувати криві додавання 

як функції, що зважують та оцінюють це випромінювання.  

Таке оцінювання може виконуватися двома шляхами: 

перший шлях: спектрофотометричний метод колірних вимірювань 

полягає у вимірюванні спектрального розподілу енергії випромінювання 

й наступному розрахунку КК під час перемножування знайденої функції 

спектрального розподілу на три функції додавання й інтегрування добутків. 

Тоді КК X, Y, Z визначаються у такий спосіб: 
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λd)λ(x)λ(ρ)λ(E=X , 
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380

λd)λ(y)λ(ρ)λ(E=Y , (3.2) 

760

380

λd)λ(z)λ(ρ)λ(E=Z , 

де Е – функція спектрального розподілу джерела; 

ρ – функція спектрального відбиття або пропущення предмета; 

)(x λ , )(y λ , )(z λ  – функції додавання. 

 

Інтегрування проводиться в діапазоні довжин хвиль видимого випро-

мінювання від 380 нм до 760 нм. Ураховуючи те, що підінтегральні спек-

тральні функції, звичайно, незручні для інтегрування, інтегрування заміню-

ють підсумовуванням через інтервал λd  (від 5 нм до 10 нм); 

другий шлях: колірні вимірювання на основі кривих додавання 

базуються на аналізі випромінювання за допомогою трьох приймачів світла, 

характеристики спектральної чутливості яких збігаються із кривими дода-

вання. Кожен такий світлоелектричний перетворювач виконує дії перемно-

жування двох спектральних функцій і інтегрування добутків. У результаті 

цього на його виході електричний сигнал дорівнює одній із КК. Подібні 

кольоровимірювальні прилади називаються фотоелектричними (або 

об'єктивними) колориметрами. Вони оцінюють результуюче випроміню-

вання, ураховуючи, як виборче відбиття (або пропущення) несамосвітних 
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предметів, так і освітлення, тобто прилад "бачить" те, що бачить око. Якщо 

прилад призначений для роботи із кривими додавання x , y , z , то найбільш 

важко сформувати двогорбу криву x  (див. рис. 3.13). Звичайно, кожна  

з її гілок формується окремо – тоді прилад містить чотири канали 

(світлофільтри). Іноді в колориметрах використовують інші ККС, всі криві 

додавання в якій одногорбі.  

Опис ідеальних фарб 

Вимога до ідеальних основних друкованих фарб здійснюється тільки 

тоді, коли їх спектральні криві відповідають П-подібним. У цьому разі 

значення спектральних величин перебувають між 0 та 1 і не повинні бути 

більше двох стрибків функції. П-подібні спектральні криві всіх трьох фарб 

повинні ідеальним чином примикати одна до одної. Ділянки ж переходів 

П-подібних кривих необхідно вибирати таким чином, щоб одержати макси-

мально можливий колірний діапазон за суцільними барвистими шарами.  

Різні експерименти показали, що перший ідеальний перепад повинен 

бути між 489 нм і 495 нм, а другий – між 574 нм і 575 нм. Відповідні спек-

тральні розподіли зображені на рис. 3.14.  

Основні фарби, що відповідають перерахованим вимогам, називають 

також ідеальними або оптимальними фарбами. Якщо зазначити на u', 

v'-діаграмі (буде мати місце відображення не в X, Y-сиcтемі, а в u', v'-

системі; ці відображення рівнозначні, тому що можуть бути однозначно 

перетворені одне до одного) координати кольоровості ідеальних основних 

фарб і синтезовані ними субтрактивні кольори першого порядку (червоний, 

зелений, синій), то виявиться, що кольори основних фарб лежать точно 

на лініях, що з'єднують точки змішаних кольорів. Ахроматична точка (Е) 

виходить сполученням основних і змішаних кольорів, які лежать один на-

проти одного. Змішання в однакових співвідношеннях кількостей основних 

фарб дає ідеальний нейтральний сірий колір. 

Розташування й величина трикутника на u', v'-діаграмі характеризують 

колірне охоплення для ідеальних основних фарб (рис. 3.15). 

Нейтральний сірий колір не можна одержати однаковими кількостями 

основних кольорів, а значення RGB не можна перевести в значення CMY 

простим перетворенням. На практиці виявилося, що певна комбінація не-

рівних частин основних фарб у стандартизованому офсетному друці дає 

нейтральний сірий колір. Наприклад у плоскому офсетному друці відносні 

площі растрових точок кольороподілених фотоформ для відносно темно-
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сірого кольору складають: блакитна – 70 %, пурпурна – 60 %, жовта – 

60 % або для більш світло-сірого кольору: блакитна – 24 %, пурпурна – 

18 %, жовта – 18 %. Ці дані враховуються як характерні колориметричні 

властивості реальних друкованих фарб, що корисні для контролю специ-

фічного параметра – балансу за сірим. Звичайно, ці дані не можна безпо-

середньо переносити на інші тріади й способи друку, що було б можливо 

під час використання ідеальних фарб.  
 

 
 

Рис. 3.14. Спектральний розподіл для "ідеальних" фарб 

 

Оптимальне використання основних (тріадних) фарб узагальнено 

повинне задовольняти таким вимогам: 

спектральні властивості, що належать до відбиття або поглинання 

основних фарб, повинні максимально наближатися до властивостей 

ідеальних фарб; 

колірні координати основних фарб повинні вибиратися так, щоб 

одержати, можливо, найбільше колірне охоплення; 

Короткохвильовий колір, 
блакитний 

Довжина 
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Колір коротких 
та довгих хвиль 
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Рис. 3.15. Координати кольоровості ідеальних основних фарб 

і кольорів, отриманих під час їх субтрактивного змішування 

 

рівні кількості основних фарб повинні давати у разі адитивного  

й субтрактивного змішування кольору під час друку ахроматичні тони, які 

б максимально наближалися до нейтрального сірого (за умови ідеально 

білого задрукованого матеріалу); 

кольори, одержувані в результаті змішання першого порядку (додат-

кові), повинні перебувати в колірному колі якнайближче до середини 

відрізків, що з'єднують точки кольорів основних фарб у колірному колі 

(колірному просторі). 

 

3.3. Математичне перетворення 

 

У експерименті CIE частину чистих спектральних кольорів зрівняти 

не вдалося, в результаті чого в колірній координатній системі CIE RGB 

деякі кольори мали негативні координати, що було дуже незручним під 

час здійснення математичних розрахунків. Тому була запропонована інша 

колірна координатна система, отримана математичним перерахуванням 

з вихідної CIE RGB. Ця система одержала назву CIE XYZ за трьома коор-

динатними осями – XYZ. Негативних значень у цій системі вже не було. 

Однак дана система не відображала кольоророзрізнювальних влас-

тивостей зору, що мінімальні на периферії колірного охоплення людини 

(у зоні насичених кольорів) і максимальні в області нульових кольоровостей 
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(сірих тонів). Тобто однакові відстані в CIE XYZ не відповідали однаковому 

зоровому розходженню між відповідними кольорами за умови однакової 

яскравості. Це призвело до нерівномірності (нелінійності) колірної коорди-

натної системи.  

Повністю розв'язати цю проблему не вдалося дотепер, однак CIE 

розробив більше однорідні колірні шкали (моделі) – CIE L*a*b* і CIE L*u*v. 

Із двох моделей більш широко застосовується модель CIE L*a*b*. 

Модель CIE L*u*v 

Перетворення координат у просторі CIELUV проводиться за допо-

могою лінійних рівнянь так, що перехід до координат u' і v' є простим. До 

схеми перетворень включається складова яскравості – Y. У результаті для 

повного опису колірних координат у CIELUV утворюється трійка L*, u*, v*, 

значення яких розраховуються таким чином:  
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Колірне розходження в CIELUV визначається за формулою Евкліда: 

 

2*2*2* vΔ+uΔ+LΔ=Δ . (3.4) 

 

Модель CIE L*a*b* 

Добре збалансована структура колірного простору моделі L*a*b* 

заснована на тому, що колір не може бути одночасно зеленим і червоним 

або жовтим і синім. Отже, для опису атрибутів "червоний/зелений"  

і "жовтий/синій" можна скористатися тими самими значеннями. Коли колір 

представляється у просторі моделі CIE L*a*b*, величина L* позначає 

світлоту, a* – величину червоної/зеленої складової, а b* – величину 

жовтої/синьої складової.  

CIE L*a*b* найбільш широко застосовується для всіх математичних 

розрахунків, що ведуться на комп'ютерах під час роботи з кольором.  
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Зауваження: всі операції з кольором в програмі Adobe Photoshop  

й взагалі на всій платформі Windows відбуваються тільки в системі 

CIE L*a*b*.  

Координати L*, a*, b* можна обчислити з координат XYZ так: 
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Однак у результаті перетворення колірного простору CIELAB вия-

вилося неможливим представити колірний тон і насиченість двомірною 

діаграмою кольоровості (за аналогією з колірним трикутником CIE). Це при-

вело до того, що в колірному колі (на противагу u', v'-діаграмі або колірному 

трикутнику) неможливо раціонально зобразити межі спектральних кольорів. 

Тому з колірного кола CIE LAB простим перетворенням була утворена 

форма відображення кольору LCH. У цьому разі насиченість C* (Chroma) 

і колірний тон h*(hue) були визначені зі значень a* і b* за формулою (3.6). 
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Система CIE LCH використовувала циліндричні координати: світлоту, 

насиченість та кут повороту – колірний тон. По осі світлоти, так само як  

у CIE L*a*b*, значення змінюються від 0 до 100. До плоскості кольоровості 

мають відношення насиченість і колірний тон (кут повороту). Насиченість – 

це лінійна координата, що показує ступінь віддалення точки від осі світ-

лоти (змінюється у діапазоні значень від 0 до 100. Чим ближче до 100, тим 

більш насиченіше колір). Колірний тон – кутова координата (змінюється 

у діапазоні значень від –180 до +180). 

На даний момент інформація щодо зображення зберігається пере-

важно як дані LAB, а редагування здійснюється в просторі LCH. 

 

Висновки та узагальнення 

 

У разі адитивного синтезу відчуття кольору досягається за допомогою 

оптичного додавання кольорів, за умови субтрактивного – вирахуванням 

кольорів або змішуванням фарб. 
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Для зручності візуального сприйняття всі видимі кольори представ-

ляються у системі CIEXYZ усередині кривої на площині xy. 

Колірне охоплення монітора відповідає моделі RGB, а принтера, 

друкарської поліграфічної машини – моделі CMYK. 

Під колірним охопленням варто розуміти область на колірній діаграмі, 

що охоплює всі кольори, які можуть бути відтворені за допомогою кон-

кретного процесу (синтезу кольору на екрані монітора, друку на принтері, 

спеціальній поліграфічній машині й т. д.). 

У результаті колірних вимірювання визначаються три числа, тобто 

колірні координати, що повністю визначають колір. 

За умови графічної побудови залежностей кількостей основних кольо-

рів від довжини хвилі виходять функції довжини хвилі, які називаються 

кривими додавання кольорів. 

Метою процесу вимірювання кольору є визначення його колірних 

координат у деякій колірній координатній системі. 

 

Теоретичні запитання 

 

1. Охарактеризуйте два види змішування. 

2. Дайте визначення поняття "колірна діаграма". Наведіть її схема-

тичне представлення. 

3. Дайте визначення поняття "колірний охват". Наведіть його схема-

тичне представлення та поясніть специфіку відображення охватів. 

4. Опишіть такі моделі цифрового представлення кольору: RGB, 

CMYK та Index Color. Наведіть їх графічне представлення. 

5. Поясніть особливості застосування моделей RGB, CMYK, Index Color.  

6. Опишіть такі моделі цифрового представлення кольору: HSV 

(HSB, HSL), Lab та Grayscale. Наведіть їх графічне представлення. 

7. Поясніть особливості застосування моделей HSV (HSB, HSL), 

Lab та Grayscale. 

8. Дайте визначення основних понять, на яких базується процес 

колірного вимірювання (колірні координати, колірна координатна система, 

якість кольору та ін.). 

9. Опишіть, чим відрізняються реальні кольори від нереальних  

у рамках математичного представлення кольору.  

10. Надайте графічне представлення кривих додавання кольорів та 

опишіть їх змістовне навантаження. 
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11. Наведіть зміст закону змішання кольорів. 

12. Охарактеризуйте особливості побудови кривих додавання ЦКС 

МКО XYZ.  

13. Наведіть і поясніть розрахункову формулу для визначення числа 

колірних розходжень між різними кольорами. 

14. Опишіть два шляхи знаходження колірних координат для випадку 

представлення кольору спектральним розподілом випромінювання. Наве-

діть відповідні розрахункові формули. 

15. Охарактеризуйте процес прямого та зворотного математичного 

перетворення. Наведіть відповідні формули. 

 

4. Графічні формати файлів 

 

Основна ідея 

 

Присвячено опису основних форматів файлів і розгляду особливо-

стей стиснення зображень. 

 

Ключові поняття: формат файлів, характеристика, колірна таблиця, 

стиснення зображень, квантування кольору. 

 

Основні питання 

4.1. Характеристика та структура основних форматів файлів. 

4.2. Особливості стиснення зображень. 

 

Цілі вивчення 

 

Метою є розгляд форматів файлів з позиції вирішення компромісу 

між колірною якістю файла зображення та його розміром; дослідження 

особливостей процесу стиснення зображень. 

Інформація, подана далі, надає студентові можливість сформувати 

такі компетентності: 

 

знання: 

характеристик і структури основних форматів файлів (GIF, PNG, 

JPEG і TIFF); 
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особливостей стиснення зображень;  

специфіки здійснення процесу квантування кольору; 

основних етапів стиснення за схемою JPEG. 

уміння: 

обирати формат для збереження колірної якості файла зображення; 

визначати елементний склад графічних форматів, що впливає на 

колірну якість; 

використовувати технології стиснення (з втратами та без); 

досліджувати процес стиснення зображення; 

комунікації: 

надання допомоги у виборі найбільш доцільного формату для зобра-

ження, що дозволяє зберегти його колірну якість та одночасно мінімізу-

вати його розмір; 

надання допомоги у виборі найбільш доцільної технології стиснення; 

автономність і відповідальність: 

ухвалення рішення про доцільність застосування певних графічних 

форматів для збереження результатів опрацювання зображень. 

 

Вступ 

 

Вивчення питань стосовно характеристик та структури форматів 

файлів GIF (специфікації GIF87а та GIF89а), PNG, JPEG та TIFF на основі 

визначення змістовного навантаження таких елементів, як дескриптор 

зображень, колірна таблиця, блок даних зображення тощо, допомагають 

прийняти найбільш доцільне рішення з вибору такого формату для файла 

зображення, який дозволяє зберегти колірну якість та одночасно мінімізу-

вати розмір даного файла. Це складне завдання, що потребує розгляду 

специфіки кольору в рамках основних форматів файлів. 

Під час вибору формату для зображення треба також ураховувати 

технологію стиснення, закладену у певний формат. Це веде до необхідності 

розгляду технологій стиснення (з втратами та без) та дослідження того, 

як відбувається квантування кольору та дискретне косинусне перетворення 

(на прикладі JPEG). 
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4.1. Характеристика та структура основних форматів файлів 

 

Досить гостро стоїть питання обсягу графічних елементів друкованих 

та електронних видань. З одного боку, наочність і ефективність видання 

багато в чому залежать від якості графічних елементів, у першу чергу, від 

розрішення й глибини кольору пікселів зображення. Тому зрозуміле праг-

нення розроблювачів використовувати багатоколірні графічні зображення. 

З іншого боку, графічні файли великого обсягу вимагають і великого 

часу, наприклад, для завантаження зображення в браузер (важливо для 

електронних видань) й ін. Тому одним із основних завдань є відшукання 

належного балансу між художністю, інформативністю й обсягом видання 

(тобто виникають вимогами до компактності файлів).  

Під час роботи із зображеннями головною метою стає досягнення 

компромісу між потрібною якістю зображень і розмірами файлів, що містять 

ці зображення. Це веде до необхідності обґрунтованого вибору форматів, 

який можна зробити тільки виходячи з їх структурних і функціональних 

особливостей. 

Слід розглянути такі основні графічні формати, як GIF, PNG, JPEG  

і TIFF. 

Растровий формат GIF 

Файловий растровий формат GIF (Graphics Image Format) був запро-

понований для протоколу передачі кольорових зображень у глобальних 

мережах. Цей формат використовується для зберігання декількох растро-

вих зображень в одному файлі. 

Формат GIF дозволяє зберігати растрові дані в пікселах із глибиною 

кольору від 1 до 8 біт. Зображення записуються із застосуванням ко-

лірної моделі RGB. Формат дозволяє зберігати зображення розміром до 

64 000 пікселів, вибирати 256 кольорів у 64-мільйонній палітрі, забез-

печує швидке розпаковування під час перегляду, ефективне стиснення  

й апаратну незалежність. Рекомендують використовувати формат для ма-

леньких і фонових рисунків. Він не підтримує альфа-каналів і масок. Один  

із кольорів даного формату можна зробити прозорим, через нього буде 

видно об'єкти, що знаходяться нижче (корисно для web). 

GIF – один із невеликої кількості форматів, що використовують ефек-

тивний алгоритм стиснення, який майже не поступається програмам-

архіваторам. Для стиснення інформації використовується алгоритм LZW 

(метод запатентований у 1981 р., що дозволяє здавити розміри файлів 
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для зображень із великими площами однакового кольору або повторю-

ваними рисунками, не погіршуючи якості). Іншими словами, GIF-файли 

не потрібно архівувати, тому що це рідко дає відчутний виграш в обсязі.  

GIF підтримує обмін не тільки графікою, але й мультимедійними 

даними, тому його можна вважати анімаційним. 

Ще однією особливістю формату GIF є те, що розроблювачі змінили 

порядок проходження даних у файлі. Передане зображення рисується 

зверху вниз зі зміною чіткості й детальності. Таким чином, зображення 

стає чіткішим й детальнішим у міру надходження інформації з мережі. Для 

цього файл зображення формується під час запису так, щоб спочатку 

йшли всі рядки пікселів з номерами, кратними восьми (перший прохід), 

потім чотирьом (другий прохід), потім двом, і, нарешті, останній прохід – 

усі рядки, що залишилися, з непарними номерами. Кожен наступний про-

хід заповнює "пропуски" у попередніх, наближаючи зображення до вихід-

ного стану. 

Існують дві специфікації GIF. Перша належить до формату GIF87a, 

у якому передбачається запис множини зображень, друга – до формату 

GIF89a, що орієнтований на зберігання як текстових, так і графічних даних 

в одному файлі. 

GIF87a – первісна версія формату GIF, що була випущена в травні 

1987 р. Вона передбачає такі можливості GIF-файла: 

1) чергування: спочатку завантажується тільки "кістяк" зображення, 

потім, у міру завантаження, воно деталізується. Це дозволяє на повільних 

лініях не вантажити весь графічний файл цілком для того, щоб одержати 

про нього уявлення; 

2) стиснення за алгоритмом LZW, що забезпечує найменший обсяг 

файла; 

3) розміщення декількох зображень в одному файлі, що дозволяє 

визначити логічну екранну область для виведення зображень. 

Надалі цей стандарт був розширений специфікацією GIF89a, що має 

ще такі додаткові можливості: 

1) включення в графічний файл коментарів (не відображаються на 

екрані, але можуть бути прочитані програмою, що підтримує GIF89a); 

2) керування затримкою перед зміною кадрів, що включає керування 

видаленням попереднього зображення, що може бути залишено, замінено 

на колір фону або на те, що було перед ним, а також визначення прозо-

рого кольору. 
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Загальна структура файлового формату GIF87a подана на рис. 4.1. 

 

 
 

Рис. 4.1. Структура файлового формату GIF87a 

 

Пояснення: кожен файл починається із заголовка (ідентифікатора) і 

дескриптора логічного екрана, після яких може йти глобальна колірна 

таблиця. Кожен із цих розділів має постійний зсув від початку файла. Будь-

яке зображення, записане у файлі, містить власний локальний дескрип-

тор зображення, локальну колірну таблицю (необов'язкову) і блок даних 

зображення. Останнім полем є символ завершувач, що вказує на кінець 

даних GIF. 

Заголовок має довжину шість байтів і застосовується для іден-

тифікації файлу GIF. Заголовок включає сигнатуру заголовка (signature)  

і версію формату (version) GIF. Поле signature має довжину три байти  

і містить як ідентифікатор обов'язкові символи "GIF". Файл не буде розпіз-

наний додатком як файл зображення GIF, якщо він не починається із цих 

Заголовок і дані 
колірної таблиці 

Заголовок 

Дескриптор логічного екрана 

Глобальна колірна таблиця 

Зображення 1 

Локальний дескриптор зображення 

Локальна колірна таблиця 

 

Дані зображення 

Зображення 2 

Локальний дескриптор зображення 

Локальна колірна таблиця 

 

Дані зображення 

Зображення n 

Локальний дескриптор зображення 

Локальна колірна таблиця 

 

Дані зображення 
 

Завершувач 
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трьох байтів. Поле version також має довжину три байти і вказує версію 

файла GIF (87a або 89а). 

Дескриптор логічного екрана (рис. 4.2.) містить дані про ширину  

й висоту відображуваного екрана в пікселях, інформацію про екран  

і колірну таблицю, індекс кольору фона й коефіцієнт стиснення пікселів. 

 

ширина

екрана

висота

екрана

фон

Біти № Байта

ширина

екрана

висота

екрана

фон

ширина

екрана

висота

екрана

фон

Біти № Байта

 

 

Рис. 4.2. Структура дескриптора логічного екрана 

 

Поля ширина й висота (один – чотири байти) визначають міні-

мальну роздільну здатність екрана для відтворення зображення. Якщо 

пристрій відображення не здатний підтримувати зазначене розширення, 

то для правильного відтворення зображення треба масштабувати. 

Значення pixel визначає кількість кольорів у даному зображенні.  

Глобальна колірна таблиця. Ця таблиця є необов'язковою й реко-

мендується для зображень, де потрібна точна передача кольорів. На 

існування цієї таблиці вказує поле М у байті п'ятого дескриптора екрана. 

Якщо глобальна таблиця кольорів присутня, то її визначення слідує без-

посередньо за дескриптором екрана. Кожен елемент колірної таблиці 

складається із трьох байтів, значення яких описують відносну інтен-

сивність червоного, зеленого й синього кольорів для кожного пікселя 

зображення. Структура блоку колірної таблиці наведена на рис. 4.3. 
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Рис. 4.3. Структура блока колірної таблиці 

 

Одержуване значення коду кольору кожного пікселя під час висвіт-

лення зображення буде відповідати найближчому доступному кольору  

з колірної таблиці дисплея. Наприклад, білий колір може бути представ-

лений як (255, 255, 255), чорний як (0, 0, 0), жовтий як (180, 180, 0) і т. д. 

Якщо глобальна колірна таблиця відсутня, то кожне зображення по-

винне мати власну локальну колірну таблицю, що заміняє глобальну 

колірну таблицю. Якщо ні глобальної, ні локальної колірних таблиць немає, 

то колірна таблиця може задаватися за замовчуванням. 

Дані зображення. Кожне зображення у файлі GIF записується окремо, 

зі своїми Дескриптором зображення й Локальною колірною таблицею. 

Локальний дескриптор зображення містить такі компоненти: 

ідентифікатор дескриптора зображення; 

положення зображення по осі X і по осі Y; 

ширину та висоту зображення; 

інформацію про зображення й дані колірної таблиці. 

У розділі "інформації про зображення" визначаються прапори, що вка-

зують на присутність локальної таблиці для пошуку кольорів і визначення 

послідовності висвітлення пікселів. З позиції теорії кольору, нас цікавить 

тільки прапор локальної колірної таблиці (біт 0) і розмір елемента локальної 

колірної таблиці (біти 5 – 7). Значення прапора локальної колірної таблиці 

дорівнює "1", якщо для даного зображення існує локальна колірна таблиця. 

Якщо значення даного прапора дорівнює "0", то локальна колірна таблиця 

відсутня й замість неї варто використовувати глобальну колірну таблицю. 

GIF зберігає кодовані дані зображення у вигляді послідовностей 

підблоків даних. Більшість підблоков мають довжину 255 байт. 
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інтенсивність синього 

. . . 

1 
2 
3 
4 
5 

6 

№ Байта 
7   6   5   4   3   2   1   0 

Біти 
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Для фіксації процесу закінчення файла зображення GIF використо-

вується один байт даних, що розглядається як символ-"завершувач". Він 

сприймається як сигнал закінчення процесу оброблення зображення. 

Структура файлового формату GIF89a: стандарт GIF був розши-

рений специфікацією GIF89a, що додала формату нові функціональні 

можливості. Файл GIF89a складається із блоків, розташованих у певній 

послідовності. Виокремлюють блоки трьох типів: 

1) керуючі блоки: заголовок, опис логічного екрана (задається розмір 

поля екрана, в якому відображається файл), керування графічними роз-

ширеннями (може містити вказівку на локальну палітру, розташування на 

логічному екрані, затримку й спосіб видалення зображення; впливає 

тільки на наступний за ним блок зображення), ознака кінця – визначає, як 

будуть оброблятися зображення;  

2) блоки зображення: зображення, опис палітри – містять дані для 

самого зображення; 

3) спеціальні блоки: коментарі, прикладні розширення – не впливають 

на зображення, але обробляються прикладними програмами. 

Однією з головних переваг даного формату є те, що він дозволяє 

довільно задавати кількість кольорів або розмір палітри, що використо-

вується у зображенні. Інші формати, як правило, мають лише стандартні 

градації глибини кольору: 2, 16, а потім відразу 256, 215 (режим high color) 

і 224 (режим true color). GIF же може мати будь-яку кількість кольорів від 

2 до 256, і якщо в зображенні використовується, наприклад, 64 кольори, 

то для зберігання кожного пікселя буде використано рівно шість бітів. 

До недоліків належить обмежена кількість використовуваних кольорів 

(до 256). Іноді потрібна більша палітра кольорів, тому доводиться апрокси-

мувати вихідне зображення кольорами усіченої палітри. У цьому випадку 

використовується метод апроксимації, що одержав назву дифузія. У цьому 

разі області, які в оригіналі були залиті однорідним кольором, після пере-

творення заповнюються сумішшю пікселів різних кольорів, розкиданих за 

випадковим законом. Кожен відсутній у палітрі колір передається піксе-

лями двох найближчих до нього кольорів нової палітри. У результаті зо-

браження здобуває характерну зернисту, шорстку фактуру. Часто дифузія 

є єдиним способом, що дозволяє хоч як-небудь адекватно передати 

вихідні кольори за допомогою палітри, на якій цих кольорів немає. 

Растровий формат PNG 

Файловий растровий формат PNG (Portable Network Graphic) – це 

формат, орієнтований на фахівців в області комп'ютерної графіки. Він 
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розроблений як альтернатива формату GIF, але за основними можли-

востями його перевершує.  

Формат PNG дозволяє зберігати зображення, бітова глибина яких 

досягає 16 біт/піксел (у шкалі сірого кольору) або 48 біт/піксел (в true-color-

зображеннях). Цей формат забезпечує поетапне відображення даних, 

зберігання інформації про прозорість.  

PNG і GIF89a мають загальні ознаки: 

забезпечують стиснення даних зображення без втрат;  

підтримують зберігання індексованих зображень, що містять до 256 

кольорів; 

забезпечують поетапне відображення із черезрядковим розгорненням; 

підтримують прозорість основного кольору. 

Разом із тим формат PNG наділений більш широкими функціональ-

ними можливостями порівняно з форматом GIF: 

більш висока швидкість поетапного відображення із черезрядковим 

розгорненням; 

зберігання true color-зображень глибиною до 48 біт/піксел; 

зберігання зображень у шкалі сірого кольору глибиною до 16 біт/пиксел; 

гама-індикатор; 

CRC-метод виявлення руйнування потоку даних; 

стандартний інструментарій для реалізації програм читання й запису 

PNG. 

Разом із тим формат PNG не володіє: 

можливістю запису декількох зображень, як GIF; 

можливістю зберігання анімаційних послідовностей. 

Дані PNG-зображень завжди зберігаються в стисненому вигляді. 

Для стиснення застосовується один із варіантів методу Deflate (алгоритм 

Deflate, створений Філом Кацем, використовується в утиліті архівації файлів 

pkzip). Цей метод стиснення даних без втрат має високу швидкість 

кодування/декодування, добре документований і поширюється безкош-

товно. Deflate є різновидом методу стиснення LZW. У Deflate для стиснення 

використовується алгоритм Хаффмана. 

Графічний формат JPEG 

Абревіатура файлового формату JPEG походить від назви комітету 

із стандартів Joint Photographic Experts Group (Об'єднана група експертів 

із фотографії), що входить до складу Міжнародної організації зі стандар-

тизації (ISO). У 1982 р. ISO сформувала групу експертів із фотографії (PEG), 
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поклавши на неї обов'язки щодо проведення досліджень в області передачі 

відеосигналів, нерухливих зображень і текстів. 

У 1986 р. були початі дослідження методів стиснення кольорових і 

напівтонових даних. Застосовувані під час цього методи стиснення кольо-

рових даних дуже нагадували ті, які досліджувалися групою JPEG. Тому 

в 1987 р. було ухвалене рішення об'єднати ресурси цих груп для спільної 

роботи над єдиним стандартом. Обидві групи об'єднали в комітет, що пови-

нен був провести дослідження й випустити стандарт стиснення даних, 

що одержав назву JPEG. 

JPEG є методом, що дозволяє стискати дані великих повно-кольорових 

багатоградаційних зображень (наприклад, кольорових фотографій) із гли-

биною від 6 до 24 біт/піксел з досить високою швидкістю й ефективністю. 

Він дозволяє досягти високих коефіцієнтів стиснення. Однак максимальне 

стиснення графічної інформації пов'язане з певною втратою інформації. 

Фактично JPEG означає алгоритм стиснення, а не конкретний формат 

подання графічної інформації. Практично будь-яку графічну інформацію 

можна стиснути за таким алгоритмом. Формат файлів, що використовують 

алгоритм JPEG, формально називають JFIF (JPEG File Interchange Format). 

На практиці дуже часто файли, що використовують JPEG-стиснення, 

називають JPEG-файлами. 

Схема JPEG була спеціально розроблена для стиснення кольорових 

і напівтонових багатоградаційних зображень, фотографій, складної графіки. 

Користувач може "відрегулювати" якість кодувальника JPEG, викорис-

тавши параметр, що іноді називають Q-фактором (його типовий діапазон 

від 1 до 100). За умови значення фактора = 1 створюється стиснене зобра-

ження найменшого розміру, але поганої якості; у разі значення фактора = 100 

виходить стиснене зображення більшого розміру й кращої якості. Опти-

мальне значення Q-фактора залежить від змісту зображення й підбира-

ється індивідуально. 

На основі JPEG-методу стиснення побудовані численні формати, 

наприклад формат TIFF/ JPEG.  

JPEG є TrueColor-форматом, тобто може зберігати зображення із 

глибиною кольору 24 біт/піксел. Такої глибини кольору досить для практично 

точного відтворення зображень будь-якої складності на екрані монітора. 

У випадку перегляду кольорового зображення на екрані монітора з вели-

кою глибиною кольору, наприклад, 32 біт/піксел (така глибина кольору, 

як правило, використовується у видавничій діяльності) воно практично 

не відрізняється від зображення із глибиною кольору 24 біт/пиксел. 
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Зауваження 1: JPEG має більший ступінь стиснення зображень, ніж 

GIF, але не може зберігати декілька зображень в одному файлі.  

Зауваження 2: JPEG орієнтований, насамперед, на реалістичні зобра-

ження, тобто зображення фотографічної спрямованості, і якість стиснення 

значно погіршується під час оброблення зображень із чітко обкресленими 

лініями й межами кольорів. Графічна анімація, чорно-білі ілюстрації, доку-

менти, а також типова векторна графіка, як правило, JPEG стискуються 

теж погано. 

Зауваження 3: JPEG використовує схему стиснення із втратами, 

що зменшує обсяг файла за рахунок якості зображення. Схема стиснення 

заснована на відкиданні інформації, що важко помітити візуально (невеликі 

зміни кольору погано розпізнаються оком). 

Растровий формат TIFF 

Растровий формат TIFF (Tagged Image File Format) був створений 

для подолання труднощів переносу графічних файлів з IBM-сумісних ПК 

на ПК Macintosh і назад. Специфікація TIFF була випущена Aldus Corporation 

в 1986 р. 

Формат використовується в основному для друку. TIFF характери-

зується великими обсягами одержуваних файлів, тому він використову-

ється переважно під час введення інформації зі сканерів і в електронних 

версіях друкованих видань. 

Історична довідка: TIFF 4.0 (квітень 1987 р.) міг підтримувати оброб-

лення нестиснених кольорових RGB-зображень. TIFF 5.0 (серпень 1988 р.) 

дозволяв зберігати кольорові зображення з палітрою й підтримувати алго-

ритм стиснення LZW. TIFF 6.0 (червень 1992 р.) розширив можливості під-

тримкою кольорових зображень моделей СМУК і методу стиснення JPEG. 

Даний формат вважають таким, який добре стискає. Він підтримує 

кілька схем стиснення; в TIFF 5.0 була додана схема стиснення LZW 

звичайно, використовувана під час роботи з кольоровими зображеннями, 

а в TIFF 6.0 – метод JPEG застосовуваний для стиснення багато-града-

ційних кольорових і напівтонових зображень. У TIFF застосовується також 

схема стиснення PackBits RLE використовувана інструментальними засо-

бами Macintosh. 

На сьогодні TIFF – формат, підтримуваний більшістю графічних 

програм створення й оброблення зображень, програмними пакетами для 

верстання. Він має здатність до розширення, що дозволяє записувати 

растрові зображення з будь-якою глибиною кольору. 

Подання структури формату файла TIFF наведено на рис. 4.4. 
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Рис. 4.4. Структура TIFF-файла 

 

Файли TIFF складаються із трьох розділів: заголовка файлу зобра-

ження (Image File Header – IFH), директорії файла зображень (Image File 

Directory – IFD) і растрових даних (Тег). З них необхідними є тільки IFH і IFD.  

Файл TIFF, що містить декілька зображень, буде містити стільки ж 

директорій файла й розділів растрових даних (по одному для кожного 

зображення).  

Заголовок завжди розташовується в перших вісьмох байтах кожного 

файла TIFF. Усі інші дані файла створюються з використанням інфор-

мації IFD. Директорія файла зображення й пов'язаний з нею растр скла-

дають субфайл TIFF. 

У специфікації TIFF 6.0 термін "тег" замінений терміном "поле". Тепер 

на весь 12-байтовий запис даних вказує термін "поле", а термін "тег" пере-

визначений для вказівки тільки на число, що ідентифікує це поле. Зобра-

ження, записані у форматі TIFF 6.0, можуть бути організовані й у вигляді 

смуг, і у вигляді фрагментів. 

Специфікація TIFF пропонує концепцію основних типів зображень: 

дворівневе, напівтонове, кольорове з палітрою й повнокольорове.  

TIFF підтримує два способи зберігання колірних даних: TIFF-P та 

TIFF-R.  

Зберігання колірних даних за першим способом (TIFF-P) подібне до 

GIF й базується на використанні колірної палітри для зображення. Під 

час цього дані про зображення зберігаються як коди. 

Цей спосіб забезпечує ефективність зберігання, але обмежує палітру 

256 кольорами. Колірна палітра створює свої елементи з 48-бітової палітри 

(основна структурна одиниця TIFF – двобайтове слово, отже, по 16 кольорів 

надано кожної з колірних площин моделі RGB: червоній, зеленій і синій). 

Зберігання колірних даних за другим способом (TIFF-R) спрямоване 

на використання для визначення повних RGB-зображень. Елемент растра 

Заголовок IFH 
(8 байтів) 

Директорія IFD: 

 
Тег (поле) 0 
Тег (поле) 1 

… 

Дані Тега 0  

… 
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представляється трьома восьмибітовими RGB-значеннями, що забезпе-

чує більше 16 млн. кольорів. 

Таким чином, під час вибору конкретного формату файла необхідно 

виходити з досягнення певного компромісу (виходячи з кінцевої мети ро-

боти) між якістю зображення й розміром отриманого файла. 

 

4.2. Особливості стиснення зображень 
 

Оскільки кольорові зображення, зазвичай, вимагають більше 1 Мб 

для свого стиснення, більшість форматів файлів містить технологію стис-

нення. Технології стиснення засновані на повторюваності окремих ділянок 

усередині даного зображення для пошуку еквівалентного представлення, 

що займає менший обсяг. 

Виокремлюють дві технології стиснення: 

1) технологія стиснення із втратами (тобто після стиснення-розпа-

кування (мається на увазі JPEG формат) утворюється зображення, що 

близько до оригіналу, але не збігається з ним повністю); 

2) технологія стиснення без втрат (тобто, якщо взяти зображення, 

стиснути його, а потім відновити, то зображення, що вийшло, буде іден-

тично оригіналу з точністю до біта). 

Квантування кольору 

Яким чином можна відобразити 24-бітове зображення формату JPEG 

на пристрої виведення, що підтримує тільки вісім бітів/піксел? І яким чином 

можна перетворити файл JPEG у формат GIF, що підтримує максимум  

8 бітів/піксел?  

Відповідь дає процес квантування кольору, що полягає в зменшенні 

кількості кольорів, що використовуються у зображенні. Процес базується 

на технології усередненого квантування. 

Послідовність дій за даною технологією:  

1) створюється тривимірна сума частот використання кожного колір-

ного значення пікселя; 

2) будується кубічна область, що містить всі дані про частоту появи 

кожного з кольорів; 

3) куб ділиться на дві прямокутні області так, щоб кожна частина 

містила половину значень частот (рис. 4.5 а); 

4) процес виконується рекурсивно, ділячи прямокутні області навпіл, 

використовуючи різні колірні осі доти, доки не вийде 256 блоків приблизно з 

однаковою частотою (приклад проміжного розподілу показаний на рис. 4.5 а). 
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а) ділення на дві прямокутні області б) ділення на 256 блоків 

 

Рис. 4.5. Технологія усередненого квантування кольору 

 

Перетворення файлів (на прикладі JPEG) 

Процес стиснення за схемою JPEG містить ряд етапів (рис. 4.6). 
 

 
 

Рис. 4.6. Структура JPEG-перетворення 

Зображення 

Дискретизація 

Дискретне 

косинусне 

перетворення (DCT) 

Квантування 

Кодування 

Хаффмана 

Файл JPEG 

Дані пікселів перетворюються з колірного 
простору RGB в колірний простір YCbCr 

Зображення JPEG стискається в блоки 8 x 8 
пікселів, названих одиницями даних. 
DCT перетворює значення одиниць даних у 
суму косинусних функцій 

У процесі JPEG-стиснення зображення 
відбувається відкидання коефіцієнтів DCT, що 
є несуттєвими для відновлення зображення, 
досить близького до оригіналу 

Кодуються коефіцієнти дискретизації DCT, у 
процесі цього виключаються серії 0-х значень. 
Для JPEG цей етап називається кодуванням 
ентропії 

червоний 

синій 

зелений 

синій 

червоний 

зелений 
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Алгоритми стиснення, що базуються на DCT, стали основою різних 

методів стиснення. Ці алгоритми базуються не на пошуку однакових 

атрибутів пікселів (як у LZW), а на різниці між ними. 

JPEG здатний забезпечити високий ступінь стиснення за умови 

мінімальних втрат даних. Схема JPEG ефективна тільки під час стис-

нення багатоградаційних зображень, в яких розходження між сусідніми 

пікселями, як правило, досить незначні. Практично JPEG добре працює 

тільки із зображеннями, що мають глибину хоча б 4 або 5 біт/піксел на 

колірний канал. 

Основні етапи стиснення за схемою JPEG: 

1) перетворення зображення в оптимальний колірний простір 

(наприклад, з RGB у колірний простір YCbCr, де Y – яскравість, Cb і Cr 

визначають кольоровість: Cb задає синявість зображення, а Cr – задає 

його червоність);  

2) дискретизація компонентів кольоровості усередненням груп пікселів; 

3) застосування DCT для зменшення надмірності даних зображення: 

ключовим компонентом роботи алгоритму є DCT. 

DCT – різновид перетворення Фур'є, що має пряме й зворотне пере-

творення. Графічне зображення можна розглядати як сукупність просто-

рових хвиль, причому осі х і y збігаються із шириною й висотою картинки, 

а по осі z відкладається значення кольору відповідного пікселя зображення. 

DCT дозволяє переходити від просторового представлення картинки 

до її спектрального представлення й назад. Впливаючи на спектральне 

представлення картинки, що складається з "гармонік", тобто відкидаючи 

найменш значущі з них, можна балансувати між якістю відтворення й сту-

пенем стиснення. 

DCT перетворить матрицю пікселів розміром N x N у матрицю час-

тотних коефіцієнтів відповідного розміру. У вихідній матриці низькочас-

тотні компоненти розташовані ближче до лівого верхнього кута, а високо-

частотні – праворуч і внизу. Це важливо тому, що більшість графічних 

образів на екрані комп'ютера складається з низькочастотної інформації. 

Високочастотні компоненти не так важливі для передачі зображення. Таким 

чином, DCT дозволяє визначити, яку частину інформації можна без-

болісно відкинути, не вносячи серйозних перекручувань у картинку. 

DCT є перетворенням інформації без втрат і не здійснює ніякого 

стиснення. Навпаки, воно підготовлює інформацію для етапу стиснення 
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із втратами або округлення (округлення – процес зменшення кількості 

бітів, необхідних для зберігання коефіцієнтів матриці DCT за рахунок 

втрати точності); 

4) квантування кожного блоку коефіцієнтів DCT із застосуванням 

вагових функцій, оптимізованих з урахуванням візуального сприйняття лю-

диною (рівень квантування визначається глибиною кольору, тобто кількістю 

кодових комбінацій, що використовуються для кодування кольору. Так 

відбувається квантування кольору); 

5) кодування результівних коефіцієнтів (даних зображення) із засто-

суванням алгоритму Хаффмана для видалення надмірності інформації. 

Декодування JPEG здійснюється у зворотному порядку. 

 

Висновки та узагальнення 

 

Під час роботи із зображеннями важливо досягти компромісу між 

потрібною якістю зображень і розмірами файлів, що містять ці зображення. 

Це веде до необхідності обґрунтованого прийняття рішення щодо вибору 

форматів. Таке рішення повинно ґрунтуватися на дослідженні специфіки 

структурної побудови форматів, їх особливостей та технологій стиснення, 

що закладені у формати. 

Технології стиснення зображень поділяються на технології з втра-

тами та технології без втрат. 

Процес квантування кольору полягає в зменшенні кількості кольорів, 

які використовуються у зображенні. 

 

Теоретичні запитання 

 

1. Охарактеризуйте файловий растровий формат GIF (загальна ха-

рактеристика, особливості, специфікації, структурні елементи, переваги 

та недоліки формату). 

2. Які існують специфікації GIF-файлів? 

3. Охарактеризуйте файловий растровий формат PNG (загальна 

характеристика, порівняльна характеристика з GIF89a, функціональні мож-

ливості формату, особливості процесу стиснення інформації). 

4. Охарактеризуйте файловий графічний формат JPEG (загальна 

характеристика, особливості формату, переваги та недоліки формату). 
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5. Охарактеризуйте файловий растровий формат TIFF (загальна 

характеристика, особливості формату, особливості процесу стиснення 

інформації, узагальнена структура TIFF-файла, способи зберігання колір-

них даних). 

6. У чому полягає сутність процесу квантування кольору?  

7. Розкрийте змістовне навантаження всіх етапів здійснення процесу 

стиснення зображення на прикладі розгляду структури JPEG-перетворення. 

8. У чому полягає сутність процесу дискретного косинусного пере-

творення? 

9. Поясність зміст алгоритму Хаффмана. 

10. Наведіть та опишіть методи стиснення, що використовуються 

форматами GIF, PNG, JPEG та TIFF. 
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Розділ 2. Цифрове опрацювання зображень  

та синтез кольору в процесах друкарського 

кольоровідтворення 
 

5. Вимірювання та управління кольором 

у кольорометричних системах 
 

Основна ідея 

 

Присвячено розгляду особливостей здійснення процесів вимірювання 

кольору та керування кольором на основі використання колірних профілів 

і параметрів системи керування кольором. 

 

Ключові поняття: колориметрія, колориметричні системи, вимі-

рювальне обладнання, колірний профіль, система керування кольором, 

профілювання, програмна кольоропроба. 

 

Основні питання 

5.1. Теоретичні основи вимірювання кольору. 

5.2. Керування кольором. 

 

Цілі вивчення 

 

Метою є дослідження специфіки здійснення колірних вимірювань 

та особливостей настроювання й використання системи керування кольором. 

Інформація, подана далі, надає студентові можливість сформувати 

такі компетентності: 

знання: 

основ вимірювання кольору; 

характеристик кольоровимірювальних приладів; 

особливостей роботи системи керування кольором; 

специфіки калібрування та профілювання обладнання; 

особливостей роботи з колірними профілями; 

специфіки процесу взяття програмної кольоропроби; 

уміння: 

працювати з системою керування кольором; 

створювати, підключати та перетворювати колірні профілі; 



111 

створювати політики керування кольору; 

калібрувати та профілювати обладнання; 

брати програмну кольоропробу; 

комунікації: 

допомога в процесах калібрування та профілювання обладнання; 

консультації представників підприємства щодо здійснення настрою-

вання параметрів системи керування кольором; 

автономність і відповідальність: 

прийняття рішення щодо обрання доцільної колірної політики; 

самостійний вибір найбільш доцільної конфігурації параметрів системи 

керування кольором. 

 

Вступ 

 

У процесі роботи з кольором одним із проблемних питань є дослід-

ження його якості у ході відтворення на екрані монітора або під час друку. 

Для отримання інформації щодо якості кольору необхідно здійснити його 

вимірювання на основі використання певних кольоровимірювальних при-

ладів (колориметрів, денситометрів тощо).  

Для забезпечення високої якості відображення кольору на різних 

моніторах та під час друку необхідно попередньо настроїти систему керу-

вання кольором та використовувати відповідні політики у процесі опрацю-

вання кольору зображення та його відображенні. У цьому разі потрібно 

знати, як створити, підключити, перетворити та використати колірні профілі 

в різних колірних просторах, які параметри треба задіяти в системі керу-

вання кольором та як отримати інформацію (на основі грамотного вико-

ристання програмної кольоропроби) щодо зміни кольору, в разі викорис-

тання різних колірних просторів. Розгляду даних питань і присвячений 

даний розділ навчального посібника. 

 

5.1. Теоретичні основи вимірювання кольору 

 

Вчення про вимірювання кольору має назву метрологія кольору 

або колориметрія.  

У процесі вимірювання кольору основним завданням є визначення 

координат кольору, оскільки всі інші величини обчислюють за їх зна-

ченням. Координати кольору можуть бути або визначені безпосередньо 
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за допомогою трифарбних колориметрів або компараторів кольору, або 

обчислені на підставі спектрів дифузного віддзеркалення або пропускання.  

Колориметрія використовує два способи кількісного опису кольорів: 

1. Визначення їх колірних координат і, тим самим, суворих чисельних 

характеристик, за якими їх можна не тільки описати, але й відтворити. 

Системи вимірювання кольору називаються кольорометричними. Сукуп-

ність нормованих умов вимірювання кольору складає кольориметричну 

систему.  

Перша стандартна колориметрична система була прийнята в 1931 році 

на VIII сесії Міжнародної комісії з освітлення – МКО (у літературі замість 

МКО часто використовується позначення CIE – від французької назви 

Commission Internationale de L'Eclairage). Як три лінійно незалежні кольори 

були вибрані такі монохроматичні випромінювання: червоний R; зелений G, 

синій В (система RGВ). 

Необхідно, щоб умови вимірювання, від яких залежать результати, 

були постійними, прийнятими за норму. Значення колірних координат вимі-

рюваного кольору залежать від багатьох факторів: кольоровість основних 

кольорів, рівень яскравості об'єкта, одиниці кількостей основних кольорів, 

розміри фотометричного поля й ін. 

На сесії МКО в тому ж 1931 року була прийнята ще одна система.  

Її складові кольори були більш насиченими, ніж спектральні. Оскільки 

таких кольорів у природі немає, то вона отримала назву XYZ. Дана коло-

риметрична система була отримана штучно, шляхом перерахунку з колір-

них координат RGB. 

У даний час робочою є колориметрична система XYZ. У ній зазвичай 

виражають результати вимірювань, а система RGB виконує допоміжну, 

інколи контрольну функцію. 

2. Знаходження в деякому наборі еталонних кольорів зразка, тотож-

ного даному. Сукупність зразків складає систему, що називається системою 

специфікації. 

Прилади для вимірювання кольору "сприймають" колір так само, як 

і зоровий апарат людини: шляхом прийому й фільтрації відбитих від об'єкта 

й перетворених у такий спосіб світлових хвиль різної довжини. Прилад 

зіставляє відбите світло з певною довжиною хвилі як певне числове 

значення.  

Значення можна інтерпретувати: 

через величину оптичної щільності або інтенсивності – для цього 

слугує денситометр (рис. 5.1 а); 
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через тривимірні координати кольору – для цього призначений 

колориметр (рис. 5.1 б);  

через спектральні дані – для цього призначений спектрофото-

метр (рис. 5.1 в). 

 

    

 

а) денситометр б) колориметр 

 

 
 

в) спектрофотометр 

 

Рис. 5.1. Кольоровимірювальні прилади 

 

Кольоровимірювальні прилади всіх трьох типів приписують кольору 

певні числові значення, які згодом можна проаналізувати й інтерпрету-

вати в термінах припустимих відхилень і контрольних обмежень. 

Денситометр – це фотоелектричний пристрій, що заміряє і обчислює, 

який відсоток від відомого обсягу світла відбивається від об'єкта (або 
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проникає через об'єкт). Цей прилад застосовується, насамперед, у полі-

графії, додрукарській підготовці й фотографії для визначення інтенсивно-

сті кольору, що заміряється. 

Колориметр також заміряє інтенсивність світлового потоку, але на 

відміну від денситометра він розбиває світло на його RGB компоненти 

(приблизно так само, як це робить людське око, кольоровий монітор або 

сканер). Потім він визначає числові значення, що відповідають дослід-

жуваному кольору в колірному просторі CIE XYZ або в одному з його 

похідних – CIE L*a*b* або CIE L*u*v*. Дані вимірювання потім інтерпре-

туються візуально – будується графічне представлення колірного простору. 

Спектрофотометр заміряє спектральні дані, тобто кількість світлової 

енергії, відбитої від об'єкта, відразу в декількох інтервалах, розташованих 

уздовж усього видимого спектра. У результаті виходить складний набір 

даних – серія величин, які візуально інтерпретуються у вигляді спектральної 

кривої. Спектрофотометр збирає найбільш повну колірну інформацію про 

колір. Потім цю інформацію шляхом декількох стандартних обчислювальних 

операцій можна перевести в кольориметричні або денситометричні дані.  

Найбільш точними й універсальними є саме спектрофотометри. 

Колірні вимірювання базуються на теоретичному підґрунті, в основі 

якого лежать відповідні закони. У 1853 р. Грассманом були сформульовані 

три такі закони додавання кольорів: 

закон тривимірності: будь-який колір однозначно виражається 

трьома, якщо вони лінійно незалежні. Лінійна незалежність полягає в тому, 

що не можна одержати ніякий із зазначених трьох кольорів додаванням 

двох інших; 

закон безперервності: стверджує, що під час безперервної зміни 

випромінювання колір суміші також змінюється безперервно. Немає такого 

кольору, до якого неможливо було б підібрати безпосередньо близький; 

закон адитивності: колір суміші основних випромінювань залежить 

тільки від їх кольорів, а не від їх спектрального складу. Із закону випливає 

факт адитивності колірних рівнянь, тобто, якщо кольори декількох рівнянь 

описані колірними рівняннями, то колір виражається сумою цих рівнянь. 

Ці три закони можна звести до одного – основного кольоромет-

ричного закону: світлоадаптоване трихроматичне око оцінює падаюче 

на нього випромінювання за трьома не залежними одна від одної спек-

тральними функціям впливу (додавання) лінійно й постійно, причому син-
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тезує ці окремі впливи в нерозривний сумарний вплив, що називається 

"стимулом".  

Щодо фактора "кольоровість основних кольорів" слід зазначити, що 

в основі будь-якої кольориметричної системи перебувають кольоровості 

кольорів тріади. Основні випромінювання вибираються так, щоб вони від-

повідно до першого закону Грассмана були лінійно незалежні. Цій вимозі 

відповідають випромінювання синього, зеленого й червоного кольорів. Для 

вимірювання кольору можна скористатися різними тріадами, однак прак-

тично їх кількість обмежена. Це пов'язано з тим, що колориметрія висуває 

до основних кольорів не тільки вимогу лінійної залежності, але й інші, 

наприклад, можливість більшої насиченості відтворених кольорів.  

Із фактором "рівень яскравості об'єкта" пов'язана контрастна чутли-

вість ока. Тому дві ділянки різних кольорів, що розрізняються за умови однієї 

яскравості, можуть виявитися нерозрізнені у разі іншої, коли чутливість ока 

знижується. Отже, умови кольориметричних вимірювань доцільно норму-

вати так, щоб рівень яскравості поля був оптимальним щодо чутливості ока. 

Кожен із цих факторів впливає на процес вимірювання й повинен 

бути врахований спеціалістами, що здійснюють даний процес. 

 

5.2. Керування кольором 

 

Система керування кольором  

Як досягти того, щоб фотографічний оригінал зберігав передачу 

кольору у друкарському відтиску? Справа не тільки в розходженнях 

колірних охоплень пристроїв (рис. 5.2), складових технологічного 

ланцюжка, але й у різних способах відображення кольорів. Усі сканери, 

цифрові камери й монітори є RGB-пристроями, тобто працюють із 

адитивними кольорами, а принтери й друкарські машини – із 

субтрактивними. Із цієї причини досягти абсолютно точної відповідності 

відображення кольорів на моніторі й принтері неможливо, але можна до 

цього наблизитися.  

На кожному етапі технологічного ланцюжка необхідно здійснювати 

управління кольором: "сканування – макетування – кольороперетворення – 

кольоропроба – кольороподіл – друк". 

Коректне відтворення кольорів забезпечує система управління 

кольором (Color Management System (CMS)), що допомагає зробити 

колір передбачуваним під час передачі між пристроями. 
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Рис. 5.2. Колірні охоплення пристроїв, що беруть учать 

у процесі відтворення кольору оригіналу 

 

CMS – це сукупність програмних і апаратних засобів, розроблених 

для узгодження розходжень відтворення кольору сканерами, моніторами, 

принтерами й друкарськими машинами, щоб гарантувати стабільне від-

творення кольору протягом даного процесу (тобто кольори оригіналів 

точно представляють кольори, отримані на відтиску). 

CMS дозволяє перетворити колірні простори, задіяні на різних етапах 

підготовки друкованої продукції з метою узгодження кольорів. 
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Щоб CMS успішно працювала, їй необхідно "знати", як передають 

кольори всі пристрої в технологічному ланцюжку (наприклад, від сканера 

до принтера), тому що на практиці кожен пристрій відтворює колір 

посвоєму. Ураховуючи це, можна сказати, що колір, який бачить людина, 

залежить від відтворювального пристрою, тобто, кожен пристрій має 

свій особливий колірний простір.  

Індивідуальні дані про пристрої збираються в колірний профіль. 

CMS використовує профілі, щоб перетворити колірний простір одного 

пристрою у колірний простір іншого пристрою. Завдання вимірювання 

колірних характеристик пристроїв вирішує калібрування. Його резуль-

татом є побудова колірних профілів (або просто профілів) пристроїв. 

Профіль становить таблицю, в якій кольори, відображувані (або ті, 

що реєструються) пристроєм, описані в єдиній колірній моделі. Зрозуміло, 

що ця модель повинна містити колірні охоплення всіх можливих пристроїв, 

тобто практично збігатися з колірним охопленням людського ока (мається 

на увазі модель Lab. Саме вона або її аналоги й використовуються для 

опису колірних охоплень усіх пристроїв, задіяних у підготовці друкованих 

видань). 

Профіль пристрою містить інформацію про те, як воно представляє 

кольори. Тобто опис колірного простору і є колірним профілем. 

Колірні простори різних пристроїв перетинаються між собою, але 

ніколи не збігаються повністю (див. рис. 3.7). Це означає, що кольори, 

відтворені одним пристроєм, можуть виявитися недоступними для іншого. 

Якщо це продемонструвати прикладом, то доцільно порівняти якість 

зображення з позиції аналізу колірного простору, що наведений у файлах 

конкретних профілів (рис. 5.3). Так, у файлі профілю "sRGB" – введені 

кольори, що може відобразити монітор, а у файлі профілю "SWOP TR001 

CHROMiX mdGCR300" ті, що може відобразити конкретний пристрій виве-

дення. З аналізу значень колірних координат (для цього обрана система 

CIE XYZ) зрозуміло, що під час переведення зображення в модель CMYK 

із застосуванням файла профілю "TR001 CHROMiX mdGCR300" відбува-

ється зміна кольорів зображення (візуально зображення тьмяніє). Тому 

дуже важливим є процес узгодження кольорів між різними пристроями, 

що відбувається із застосуванням системи CMS. 



118 

 
 

Рис. 5.3. Приклад зміни кольоровості зображення залежно від 

застосовуваного пристрою (використовуваного файла профілю) 

 

Важливо також, що опис колірного простору, який міститься у файлі 

профілю, може мати різне представлення в рамках різних колірних моде-

лей (Lab, Yxy, Luv). Приклад, що демонструє розбіжності колірного пред-

ставлення файла профіля sRGB IEC61966-2.1 у рамках колірних моде-

лей Yxy, Luv наведений на рис. 5.4. 
 

       
а) колірні охоплення на основі  б) колірні охоплення на основі  

 моделі Yxy   моделі Luv 
 

Рис. 5.4. Приклад розбіжностей колірного представлення файла 

профіля sRGB IEC61966-2.1 в моделях Yxy, Luv 
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Профіль зберігається у файлі з розширенням icm, який потім слід 

встановити в систему управління кольором.  

Апаратнонезалежний колірний простір, до якого приводяться охоп-

лення пристроїв (PCS, Profile Connection Space), складає ядро системи 

управління кольором. 

Таким чином систему управління кольором формують: 

1) апаратнонезалежна колірна модель PCS, щодо якої будуються 

профілі конкретних пристроїв. У більшості випадків це колірна модель Lab; 

2) профілі пристроїв ICС (International Color Consortium), де зазначені 

всі характеристики представлення кольору конкретним пристроєм. 

Розрізняють профілі пристроїв введення (сканера, цифрової камери), 

профілі монітора й пристроїв виведення (принтера, друкованої машини 

тощо). Кожен пристрій має власний профіль; 

3) модулі управління кольором СММ (Color Management Modules), 

які власне інтерпретують дані про колір та інформацію профілів і фор-

мують інструкції з корекції для кожного із пристроїв.  

СММ виконує спеціальні колірні перетворення: перетворює колір  

з колірного охоплення одного пристрою в колірний простір іншого відпо-

відно до обраного методу. Існують чотири стандартні методи: Perceptual, 

Relative Colometric, Absolute Colometric, Satuartion.  

Метод колірного перетворення визначає спосіб відображення 

заданого колірного обхвату іншим процесом або пристроєм виводу. Різниця 

між методами з'являється, коли виконується перетворення широкого колір-

ного простору в більш вузьке (відбувається стиснення простору і як резуль-

тат зміна кольорів – рис. 5.5). 

 

 
 

Рис. 5.5. Візуалізація методів колірного перетворення 

 

Управління кольором можна показати такою схемою (рис. 5.6). 
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Рис. 5.6. Управління кольором у CMS 

 

Пояснення: система одержує дані із пристрою введення в моделі 

RGB. Вони перетворюються CMM в апаратнонезалежний формат у моделі 

Lab з урахуванням виправлень, одержуваних із профілю пристрою вве-

дення. Під час виведення на монітор дані у незалежній моделі перетворю-

ються СММ знову в RGB на основі профілю монітора. Виведення на принтер 

передбачає перетворення в CMYK з урахуванням профілю принтера. 

Як було згадано, передача кольору не однакова для всіх пристроїв 

кожного типу. Вона розрізняється не тільки в межах конкретної моделі 

пристрою, але навіть для окремих екземплярів даної моделі. Із цієї причини 

варто будувати індивідуальний колірний профіль для кожного пристрою, 

задіяного в технологічному ланцюжку. Більш того, колірні параметри окре-

мого екземпляра залежать від часу експлуатації (наприклад, старіє люмі-

нофор електронно-променевої трубки). Тому профіль не можна побудувати 

"раз і назавжди", його необхідно періодично обновляти. Побудова індиві-

дуальних профілів вимагає спеціальної вимірювальної апаратури (спек-

трофотометрів, денситометров і колориметрів) і відповідного програмного 

забезпечення.  

Програмне забезпечення (звичайно додається до апаратури) на основі 

даних вимірювань здійснює побудову колірних профілів. До найбільш 

популярних програм можна віднести Heidelberg ColorOpen, Agfa ColorTune, 

Kodak ColorFlow, які можуть будувати колірні профілі всіх типів за 

наявності необхідної апаратури. 
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Щоб установити колірний профіль досить клацнути на його файлі 

правою кнопкою мишки й у контекстному меню, що відкривається, вибрати 

команду "Установити профіль". Файл профілю буде встановлений і розмі-

щений у папці Color, що перебуває в системній папці Windows. 

Зауваження: щоб кольори зображень правильно передавалися всіма 

пристроями, необхідно забезпечити кожен із них колірним профілем,  

в якому зображення створене або відредаговане. Тільки в цьому випадку 

CMS може адекватно трактувати кольори зображення й стежити за їх 

правильністю на будь-якому пристрої виведення. 

Таким чином, необхідною умовою роботи CMS є побудова та впровад-

ження колірних профілів у зображення, що створюються або підлягають 

редагуванню. 

 

Профілювання  

Профілювання – це процес створення профілів сканера, монітора 

й принтера (тобто, побудова характеристик пристроїв). 

Калібрування і профілювання монітора дозволяють добитися 

таких переваг:  

1) за рахунок виставляння коректної колірної температури усуваються 

побічні колірні відтінки;  

2) збільшується колірний обхват; 

3) стає точнішим перенесення кольорів (у процесі калібрування прог-

рамне забезпечення виводить на екран тестові шкали. Колориметр заміряє 

колір на екрані і програма розраховує відхилення від ідеального перене-

сення кольорів. На підставі заміряних параметрів створюється профіль моні-

тора, який потім використовується під час виведення зображення на екран. 

Завдяки цьому кольори, що відображуються на моніторі стають близькими 

до ідеальних; 

4) покращується деталізація (у процесі калібрування встановлюються 

коректні значення яскравості чорної і білої точок. Завдяки цьому можна 

побачити більше деталей як у тінях, так і в яскравих областях зображення); 

5) забезпечується постійність зображення в часі (з часом у монітора мі-

няються деякі параметри, які роблять вплив на зображення, що виводиться:  

зниження світлової емісії (вигорання) люмінофорів у трубках ЕЛТ-

моніторів; 

зниження електронної емісії катодів (старіння електронних гармат); 

зміна колірності светофільтрующих елементів в РК-моніторах; 
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зміна колірної температури лампи підсвічування в РК-моніторах; 

"просідання" яскравості лампи підсвічування в РК-моніторах. 

Під час регулярного калібрування можна підтримувати якісне зобра-

ження на моніторі протягом всього терміну служби;  

6) з'являється можливість погоджувати за кольором декілька моніторів; 

7) можна наблизити зображення до відбитку. 

 

Керування кольором в Photoshop 

Усі настроювання системи управління кольором зосереджені в діало-

говому вікні Color Settings (параметри кольору). Окремо визначаються 

параметри просторів RGB, CMYK і Grayscale.  

Процес настроювання робочих колірних просторів (знаходяться  

в області Working Spaces (робочі простори)) здійснюється в діалоговому 

вікні Color Settings. У даному вікні визначаються РП для RGB і CMYK.  

Зауваження 1: під час підготовки зображень для друку рекоменду-

ється використовувати Adobe RGB (1998 р.). Установлений за замовчу-

ванням простір палітри RGB (sRGB IEC 61966-2.1) є не дуже вдалим 

колірним простором для професійної роботи з фотографіями. Даний 

колірний простір не підходить для сучасного web-дизайну й непридатний 

для роботи з фотографіями, особливо в тих випадках, якщо зображення 

підготовляються для друку у журналах, брошурах, рекламних буклетах, 

каталогах тощо. 

Зауваження 2: якщо зображення призначене для друку, то необхідно 

обов'язково впроваджувати в нього колірний профіль. Його відсутність 

виправдана тільки в документах, орієнтованих на перегляд на екрані. 

Під час відкриття зображень Photoshop перевіряє наявність упровад-

жених колірних профілів. Подальші дії програми визначаються політикою 

управління кольором (Color Management Policies), що задається користу-

вачем (рис. 5.7): 

1) Off (відключено) – не потрібне управління кольором; 

2) Preserve Embedded Profiles (зберігати впроваджені профілі) – 

залишити профілі такими, якими вони є; 

3) Convert to Working Space (конвертувати в робочий простір) – усі 

зображення, що відкриваються, треба перетворити в робочий колірний 

простір відповідної колірної моделі. 
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Рис. 5.7. Політика управління кольором 

 

У Photoshop політика роботи із профілями задається окремо для колір-

них моделей RGB і CMYK, а також напівтонових зображень у відповідних 

списках групи Color Management Policies діалогового вікна Color Settings. 

Буває, що необхідно приймати індивідуальні рішення щодо зобра-

жень, які відкриваються. Для цього необхідно встановити прапорці Ask 

When Opening (запит під час відкриття) для випадків Profile Mismatches 

(розбіжність профілів) і Missing Profiles (відсутність профілю) (див. рис. 5.7).  

Перший з них змушує Photoshop видати запит щодо зображень,  

в яких упроваджений профіль не збігається із профілем робочого колірного 

простору (рис. 5.8).  

 

 
 

Рис. 5.8. Вікно повідомлення для випадку, якщо впроваджений 

профіль не збігається з профілем робочого колірного простору 
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Другий прапорець забезпечує видачу запиту (рис. 5.9), якщо зобра-

ження, що відкривається, взагалі не має впровадженого профілю.  

 

 

 

Рис. 5.9. Вікно повідомлення для випадку, якщо зображення  

не має впровадженого профілю 

 

Під час копіювання зображень через системний буфер копіюються 

й асоційовані з ними профілі. У разі встановленого прапорця Ask When 

Pasting (запит під час вставки) видається запит про перетворення колір-

ного простору зображення, що вставляється в Photoshop. 

Зроблені установки можна зберегти у файлі для подальшого викорис-

тання (Save вікна Color Settings), а потім завантажити файл із установками 

(кнопка Load). Збережені настроювання є загальними для додатків Adobe. 

 

Перетворення профілів в Photoshop  

Якщо під час відкриття файла зображення не було приведене до 

РП Photoshop, то необхідно виконати конвертацію (активізувати команду 

Convert to Profile (конвертувати в профіль)) (рис. 5.10).  

У діалоговому вікні в групі Source Space (вихідний простір) зазна-

чений профіль, асоційований із зображенням на даний момент. Цільовий 

профіль необхідно вибрати зі списку Profile (профіль) групи Destination 

Space (цільовий простір). 
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Рис. 5.10. Вікно перетворення одного колірного простору в інший 

 

У групі Conversion Options (настроювання перетворення) задаються 

такі основні параметри:  

1) у списку Engine (система) наведені модулі управління кольором, 

наявні на конкретному ПК (в основному, буде вибір між Adobe (АСІ)  

і Microsoft (ICM), але якщо були встановлені інші системи управління 

кольором, наприклад, Kodak Precision CMS, вони також будуть фігурувати 

в списку). Установка модуля АСІ забезпечує найкращі результати із прис-

троями PostScript.  

Зауваження: у всіх програмах, з якими працює користувач, повинна 

застосовуватися та сама система управління кольором, інакше вигляд 

зображень в них може дещо відрізнятися; 

2) в списку Intent (перетворення) задається спосіб приведення колір-

ного охоплення вихідного колірного простору до цільового. Оскільки частина 

кольорів вихідного простору може не мати еквівалентів у цільовому, то 

рекомендується використовувати варіант Perceptual (перцептивний), що 

враховує відносне сприйняття кольорів оком людини.  

Кольоропроба 

Порівняно точний і зручний спосіб контролю кольору всіх стадій полі-

графічного процесу – кольоропроба. Вона є своєрідним еталоном, на 

який орієнтуються всі – від дизайнера до друкаря. 

Розрізняють такі види кольоропроб: 

1) аналогова кольоропроба: кольорові пігменти аналогової проби під-

бираються так, щоб її колірне охоплення було якнайближче до колірного 
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охоплення деякого усередненого друкованого процесу. У цьому разі різні 

види паперів і різні види друку імітуються за рахунок використання різних 

видаткових матеріалів, що компенсують різницю в розтискуванні. Таким 

чином, виробники кольоропробного устаткування пропонують враховувати 

розходження друкованих машин, офсетних фарб і паперів; 

2) цифрова кольоропроба: для її одержання необхідне професійне 

устаткування (це не роздруковування на принтері), наприклад, прободру-

карський верстат: друк здійснюється на тиражному папері з тиражної дру-

кованої форми. Однак прободрукарські верстати наявні тільки в обмеженої 

кількості друкарень і внаслідок незручності використання поступово витіс-

няються цифровими пристроями; 

3) програмна кольоропроба: дозволяє проімітувати колір на екрані 

монітора з позиції його вигляду під час друку на конкретному обладнанні 

(рис. 5.11). 
 

 
 

Рис. 5.11. Вікно для взяття програмної кольоропроби 

 

Технологія отримання програмної кольоропроби: 

а) відкрити необхідний файл; 

б) включити режим програмної кольоропроби (View → Proof Colors); 

в) провести на екрані монітора імітацію кольору інших пристроїв 

(імітований пристрій виведення задається в списку Proof Setup (настрою-

вання кольропроби)). 

За змінами кольоровості зображення можна спостерігати за умови 

включеного прапорця Preview. 
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Таким чином, програмна кольоропроба є зручним і легким у реалі-

зації способом отримання представлення про зміну кольоровості зобра-

ження на конкретному пристрої виведення. 

 

Висновки та узагальнення 
 

Колориметрія використовує два способи кількісного опису кольорів: 

визначення їх колірних координат (чисельних характеристик) та знаход-

ження в деякому наборі еталонних кольорів зразка, тотожного даному. 

Виокремлюють такі основні прилади, призначені для вимірювання 

кольору: денситометр, колориметр, спектрофотометр. 

Color Management System – це сукупність програмних і апаратних 

засобів, розроблених для узгодження розходжень відтворення кольору 

сканерами, моніторами, принтерами й друкарськими машинами, щоб гаран-

тувати стабільне відтворення кольору в плині всього даного процесу. 

Систему управління кольором формують: апаратнонезалежна колірна 

модель PCS, профілі пристроїв ICС, модулі управління кольором СММ. 

Опис колірного простору і є колірним профілем. 

Метод колірного перетворення визначає спосіб відображення заданого 

колірного охвату іншим процесом або пристроєм виводу. Методи підроз-

діляються на такі: Perceptual, Relative Colometric, Absolute Colometric, 

Satuartion. 

 

Теоретичні запитання 
 

1. Дайте визначення колориметрії. 

2. Наведіть способи кількісного опису кольорів. 

3. Дайте визначення поняття "кольорометрична система".  

4. Що таке "система специфікацій"? 

5. Охарактеризуйте різновиди вимірювального устаткування.  

6. Наведіть змістовне навантаження основних законів додавання 

кольорів. 

7. Наведіть визначення поняття "систем управління кольором".  

8. Опишіть елементи, що формують систему управління кольором 

та наведіть і поясніть схему системи управління кольором. 

9. Дайте визначення поняття "профіль". 

10. Опишіть призначення модуля управління кольором. 

11. Поясніть змістовне навантаження процесу профілювання. 
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12. Опишіть специфіку та особливості організації процесу управління 

кольором у Photoshop. 

13. Які існують політики управління кольором? 

14. Що таке індивідуалізація у процесі управління кольором? 

15. Опишіть відмінні риси політик управління кольором для випадку, 

якщо вихідне зображення не має вбудованого профілю. 

16. Опишіть відмінні риси політик управління кольором для випадку, 

якщо вихідне зображення має вбудований профіль. 

17. У чому полягає сутність процесу перетворення профілів? 

18. Дайте визначення поняття кольоропроби, назвіть основні види 

кольоропроб та опишіть технологію взяття програмної кольоропроби. 

 

6. Комп'ютерне кольоровідтворення 

 

Основна ідея 

 

Присвячено аналізу сутності процесу кольоровідтворення, вивченню 

особливостей здійснення кольорокорекції тонових одноколірних та кольо-

рових оригіналів, дослідженню специфіки здійснення комп'ютерного кольо-

роподілу. 

 

Ключові поняття: тонова та колірна корекції, інструментарій, ме-

тоди, плашкові кольори, кольороподіл.  

 

Основні питання 

6.1. Загальна характеристика процесу комп'ютерного кольоровід-

творення. 

6.2. Проблема відтворення відтінків. 

6.3. Особливості та специфіка здійснення комп'ютерного кольоро-

поділу. 

 

Цілі вивчення 

 

Метою є вивчення технологій тонової та колірної корекції, вирішення 

проблеми відтворення відтінків, дослідження специфіки комп'ютерного 

кольороподілу.  
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Інформація, подана далі, надає студентові можливість сформувати 

такі компетентності: 

знання: 

характеристики процесу комп'ютерного кольоровідтворення; 

специфіки здійснення тонової та колірної корекції зображень; 

інструментарію та правил роботи з ним; 

особливостей вирішення проблеми відтворення відтінків;  

специфіки здійснення кольороподілу зображення та способів на-

строювати параметрів кольороподілу; 

уміння: 

здійснювати кольорокорекцію тонових одноколірних та кольорових 

зображень; 

працювати з плашковими кольорами; 

виконувати комп'ютерний кольороподіл зображення; 

комунікації: 

рекомендації щодо вибору інструментарію для здійснення кольоро-

корекції зображень;  

професійна допомога в усуненні проблеми відтворення відтінків та 

роботи з плашковими кольорами; 

автономність і відповідальність: 

самостійний вибір доцільної технології оброблення зображень; 

прийняття рішення щодо вибору каталогу плашкових кольорів. 

 

Вступ 

 

Важливим етапом підготовки зображень для використання у елек-

тронних та друкованих виданнях є підготовка їх засобами спеціалізова-

ного програмного забезпечення, у якості якого буде виступати Photoshop 

як типова програма з підготовки та опрацювання (тонова та колірна корекція) 

графічних зображень.  

Наведено особливості процесу кольорокорекції тонових одноколір-

них та кольорових оригіналів (специфіка, закономірності, інструментарій, 

методи) та досліджено проблему відтворення відтінків (розглянуто систему 

Pantone, подано приклади каталогів плашкових кольорів і технології їх вико-

ристання).  

Також розкрито особливості здійснення процесу комп'ютерного 

кольороподілу. 
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6.1. Загальна характеристика процесу комп'ютерного 

кольоровідтворення 

 

Процес кольорового відтворення (або репродукування) у видавничо-

поліграфічній справі складається із чотирьох стадій:  

1) зчитування з оригіналу інформації про колір кожного мікроеле-

мента зображення і її подання у вигляді трьох величин, що відповідають 

світловим потокам, що пропускаються (відбиваються) в трьох зонах 

видимого спектра – червоній, зеленій та синій. Ця стадія називається 

аналітичною;  

2) перетворення зображення у форму, придатну для наступного від-

творення на відтиску. Ця стадія містить перетворення колірного простору 

(з RGB в CMYK, Pantone, Hexachrome або іншу модель), відображення 

колірного простору оригіналу в простір відтиску із градаційним колірним 

перетворенням, що забезпечує психологічно точне відтворення кольору. 

Ця стадія називається градаційною й колірною корекцією та пере-

творенням; 

3) реєстрація (запис) виділених складових (кольороподілених зобра-

жень). Запис здійснюється на фотографічному матеріалі, на магнітних 

носіях, на формних матеріалах (пластинах) або на формних циліндрах  

(у глибокому друці, під час цифрового друку, в DI-технології). Сюди ж нале-

жать необхідні технологічні перетворення: растрування, корекція неліній-

ності пристрою запису й т. д. Ця стадія називається перехідною або 

стадією виготовлення друкованих форм; 

4) власне друкування зображення на матеріальному носії (папері 

пластику тощо) і одержання відтиску (репродукції). Тут здійснюється накла-

дення й сполучення кольороподілених зображень, пофарбованих у від-

повідні кольори застосовуваного синтезу й формування зображення на 

відтиску. Ця стадія визначена як синтез кольорового зображення на 

відтиску або друкування.  

Більшість оригіналів мають проблеми з яскравістю, контрастом і кольо-

ром. Такі зображення необхідно коригувати. 

Під кольорокорекцією слід розуміти зміну колірного змісту зобра-

ження оригіналу відповідно до вимог замовника, технологічного процесу 

й інших причин або виправлення фотоформ, отриманих у результаті 

кольороподілу. 
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Загальний вид зображення залежить від збалансованості яскравості 

та кольорів. Баланс досягається інструментами тонової й колірної корекції 

(необхідно розглянути їх на прикладі реалізації у Photoshop). 

Специфіка тонової корекції 

Понятійний апарат. Погрішності в освітленні й контрасті називаються 

тоновими, а процес виправлення даних погрішностей – тоновою корек-

цією. Градації яскравості називаються тонами (в зображенні пікселі мають 

різну яскравість). Частина повного діапазону яскравості, що використо-

вується в зображенні називається тоновим діапазоном (чим ширше тоно-

вий діапазон, тим глибше кольори і якісніше деталізація зображення). 

Дане завдання вирішує корекція світла, тіней і діапазону середніх тонів.  

Одним із основних інструментів аналізу тонового діапазону зобра-

ження є гістограма – графік розподілу пікселів за градаціями яскравості. 

Вона призначена для одержання інформації про тоновий діапазон, але 

не для виконання корекції. 

Тоновий баланс припускає розподіл точок зображення по всьому 

інтервалу яскравостей, пророблення деталей на всіх ділянках діапазону 

яскравостей. 

Операції тонової корекції зручно робити в колірній моделі Lab, 

оскільки в ній яскравість пікселів відокремлена від їх кольору, і зміни тонів 

ніяк не позначаються на кольорах зображення. 

Розрізняють два види тонової корекції: 

1) груба корекція – здійснюють інструментом для редагування яс-

кравості й контрастності зображення (Brightness/Contrast – яскравість/ 

контрастність); 

2) тонка корекція – здійснюється інструментами для корекції розпо-

ділу яскравостей на трьох і більше ділянках тонального діапазону (Levels 

та Curves).  

Основне правило, що повинне виконуватися для коректної передачі 

кольору – баланс за сірим. 

Специфіка колірної корекції 

Адекватна передача кольорів у зображенні забезпечується колірною 

корекцією на основі використання інструментів Curves і Levels (або спе-

ціалізованих). У процесі роботи з окремими кольорами й тоновими інтерва-

лами зображення використовуються інструменти Hue/Saturation, Selective 

Color (вибірковий колір), а також Auto Contrast, Auto Color, для настрою-

вання балансу кольорів – інструмент Color Balance і т. д. 



132 

Специфіка роботи із кольором полягає в тому, що здійснюваний на 

окремий колірний компонент вплив відбивається на всіх інших, тому го-

ловним принципом колірної корекції є настроювання балансу кольорів. 

Впливати на співвідношення колірних компонентів можна різними спосо-

бами. Тут доречна аналогія з вагами: у разі зрівноважування чашок можна 

додавати вагу на занадто легку чашку або знімати частину ваги із занадто 

важкої. 

Користуючись простою схемою колірного кола (рис. 6.1), можна 

успішно здійснювати кольорокорекцію. 

 

 
 

Рис. 6.1. Спрощена схема колірного кола 

 

Закономірності, що випливають із схеми: 

1) кольори, що лежать на колірному колі навпроти один одного (лінія, 

що з'єднує їх, проходить через центр кола), взаємозалежні, тобто змен-

шення вмісту одного кольору веде до збільшення вмісту протилежного 

кольору і навпаки. Наприклад, збільшуючи вміст зеленого кольору (green) 

можна зменшити вміст пурпурного (magenta). Такі кольори називаються 

додатковими; 

2) вміст певного кольору можна змінити за рахунок впливу на сусідні 

зі змінюваним кольори і навпаки. Наприклад, щоб підсилити пурпурний 

колір (magenta), необхідно підсилити червоний (red) і синій (blue) кольори; 

3) поєднуючи "по-перше" і "по-друге", щоб збільшити вміст певного 

кольору, потрібно зменшити вміст кольорів, сусідніх із протилежним  

і навпаки. Наприклад, для ослаблення пурпурного (magenta) досить підси-

лити блакитний (cyan) і жовтий (yellow) кольори.  
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Інструментарій 

Для корекції необхідно використовувати ряд основних засобів: рівні, 

криві, тон/насиченість, вибірковий колір. Дані засоби називаються профе-

сійними засобами корекції.  

Засоби Levels і Curves призначені для корекції розподілу яскра-

востей (тональних рівнів) в окремих колірних каналах зображення або  

в композитному каналі (змінюються всі канали одночасно). За допомогою 

даних засобів можна зручно задавати чорну й білу точки зображення  

й зміщати тональні рівні. 

Засіб Curves потужніший, ніж Levels, тому що дозволяє зміщати то-

нальні рівні всього діапазону, а Levels виконує зсув тільки півтонів (яскраво-

стей середніх рівнів). З іншого боку, засіб Levels більш зручний для визна-

чення чорної й білої точок, тому що робиться це під час відображення 

гістограми. 

Зауваження: для рішення завдання кольорокорекції – краще спільне 

використання Levels і Curves: спочатку за допомогою Levels потрібно 

визначати чорні й білі точки для кожного колірного каналу, потім за допо-

могою Curves редагувати розподіл тональних рівнів для кожного колірного 

каналу шляхом визначення необхідних градаційних кривих. 

Перед початком корекції за каналами, необхідно дослідити зобра-

ження на предмет розподілу тональних рівнів у кожному каналі (Image → 

Histogram). У зображенні з добре збалансованими кольорами і яскравостями 

гістограми кожного каналу займають широкий тональний діапазон із цен-

тром ваги, який прагне до середини діапазону. Якщо гістограми каналів не 

займають весь тональний діапазон і зосереджені в різних піддіапазонах, 

то це означає, що в зображенні не вистачає контрасту й воно не збалан-

соване за кольорами (потрібна корекція). 

Правила роботи з Curves: 

1) у RGB-корекції послідовно регулюються градаційні криві для всіх 

каналів і увага приділяється колірній компоненті, з якою пов'язана проблема 

в зображенні (blue – для холодних; а red і green – для теплих кольорів).  

У цьому разі підвищення рівня кривої дає посилення колірного компонента 

у відповідному тональному діапазоні, а зниження – ослаблення; 

2) у CMYK-корекції спочатку визначається основна колірна компо-

нента (R, G, B), з якою зв'язана проблема в зображенні й потім настрою-

ються два колірних канали кольорів, що доповнюють, а після регулюється 

канал протилежного кольору; 
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3) чим крутіше ділянка градаційної кривої, тим більший контраст буде 

мати ділянка зображення, яскравості якої потрапляють у тональний піддіапа-

зон, що відповідає цій крутій ділянці, а чим більш полога ділянка кривої, 

тим менше контраст у відповідній ділянці зображення. 

Корекція в RGB засобами Levels і Curves дає можливість прямо 

управляти базовими кольорами зображення. Корекція в CMYK цими ж 

засобами дає можливість управляти базовими RGB компонентами побічно 

за рахунок використання протилежних кольорів (фарб). 

Процес кольорокорекції повинен базуватися на чіткій теоретичній 

основі, ключові моменти якої наведені на рис. 6.2. 
 

 
 

Рис. 6.2. Теоретичний інструментарій (база) кольорокорекції 
 

Слід розглянути основні методи кольорокорекції на прикладі 

моделі CMYK. 

У цій моделі за колір відповідають канали cyan, magenta і yellow,  

а black – за глибину тіней. Існує велика кількість способів домогтися потріб-

ного результату, основними з яких є:  

метод вирахування: кольорокорекція виконується шляхом зменшен-

ня вмісту надлишкового кольору. Його необхідно визначити із співвідношень 

для пам'ятних кольорів за еталонами (шкалами колірного охоплення, 

віялами Pantone) або візуально. Недоліком методу є освітлення зображення 

Відповісти на стандартні питання: 
1. У якій колірній моделі працювати? 
2. Коли і як виконувати кольороподіл? 
3. Якими інструментами користуватися? 
4. Яким буде алгоритм роботи із зображенням? 
5. Які прийоми  кольорокорекції  використовувати?  

Основні моменти кольорокорекції: 
деталі; 
контраст; 
баланс світлотіні; 
баланс кольорів; 
насиченість кольорів; 
акцент у зображенні; 
точний колір; 
технологічні вимоги 

Визначити мету роботи  
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через зменшення сумарного відсотка фарб, однак, його можна компен-

сувати за допомогою сумарної кривої CMYK; 

метод доповнення: протилежний першому методу й призводить 

до затемнення зображення. Цей метод не такий зручний як перший, тому 

що спрямований на коригування двох кольорів із тріади, а перший – тільки 

одного. 

Ще одне важливе поняття про "забруднюючі" кольори – допомагає 

орієнтуватися у виборі каналу для корекції. Найбільш "чистими", яскравими 

кольорами є дуплекси – кольори, що складаються тільки із двох основних 

тріадних фарб (відтінки зеленого, синього, червоного). Саме з дуплексів  

і основних тріадних фарб створюються яскраві "дитячі" ілюстрації (рис. 6.3). 
 

 
 

Рис. 6.3. Приклад "забруднюючого" кольору 
 

Пояснення: якщо аналізується зображення, на якому відображається 

поле із зеленою травою, то у кольорі зелені "забруднюючою" фарбою  

є magenta. Віднімання її наближає колір до дуплекса, що робить зобра-

ження чистим та яскравим.  

Зауваження: мистецтво управління кольором полягає в збалансо-

ваному відніманні "забруднюючих" кольорів та грамотному підборі кон-

трасту в їх каналах. 

Однак зовсім віднімати "забруднюючі" кольори не можна, тому що 

вони є формоутворювальними (рисуючими), тобто за рахунок тіней 

передають форму й фактуру поверхні.  
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Починати освоювати кольорокорекцію легше в моделі CMYK, тому 

що канали повністю незалежні, а вигляд зображення на каліброваному 

моніторі досить точно збігається з його відтиском під час друку. Однак 

існують деякі особливості в передачі кольору певних відтінків. 
 

6.2. Проблема відтворення відтінків 
 

Недоліком моделі CMYK є вузькість колірного охоплення: багато 

відтінків кольору з високою насиченістю (кислотні) неможливо відтворити 

за допомогою сучасних тріадних фарб. Це змушує інженерів шукати інші 

шляхи розширення колірного охоплення, наприклад, кольороподілом на 

шість фарб HexaChrom (у цій моделі крім основних cyan, magenta, yellow 

і black, використовуються додаткові green і orange). 

Таким чином, під час друку CMYK-фарбами відтворюються далеко 

не всі відтінки. Тому для більш точної передачі якого-небудь відтінку в 

поліграфії застосовують так звані плашкові або прості (Spot) кольори, 

отримані шляхом попереднього простого змішування фарб у змішувачі. 

Наприклад, так друкується золотий або срібні кольори. 

Існує кілька систем плашкових кольорів. Найпоширенішою з них  

є система Pantone (випускаються каталоги плашкових кольорів, що допо-

магають користувачеві підібрати потрібний відтінок, а потім, скористав-

шись цифровим кодом кольору, замовити потрібну фарбу). 

Найбільш популярними каталогами плашкових кольорів є (рис. 6.4): 

Pantone Coated (плашки для глянсового паперу); 

Pantone Uncoated (плашки для звичайного паперу). 

Колір можна вибирати й візуально у вікні Color Picker, але він не 

буде точно відповідати друкованому, тому краще колір обирати за 

колірним каталогом, а потім цифрами задавати його у вікні вибору. 
 

 
 

Рис. 6.4. Приклад каталога плашкових кольорів 
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CMYK-каталогом для точного задавання кольору потрібно корис-

туватися тільки під час роботи з CMYK-зображеннями, що перебувають  

у просторі друкованого пристрою. Інакше наступні перетворення колірних 

просторів призведуть до змін CMYK-цифрових значень кольорів. 

У випадку друкарського виведення необхідно користуватися катало-

гом Pantone Process Coated. Даний стандартний каталог містить CMYK-

кольори. Спочатку колір обирається за колірним віялом із однойменною 

назвою Pantone Process Coated (роздрукована версія каталогу), а потім 

задається в Photoshop за іменем або за CMYK відсотками (рис. 6.5). 
 

 
 

Рис. 6.5. Задавання кольорів із каталогу Pantone Process Coated  
 

Існує дві версії віял: 

1) Pantone Process Coated DS (стандарт SWOP);  

2) Pantone Process Coated ES (стандарт EURO). 

Користуватися необхідно тим віялом, що краще відповідає процесу 

друку. Технологія: для задавання кольорів із каталогу Pantone Process 

за іменами потрібно перемкнути вікно Color Picker у режим Custom color  

і вибрати відповідний каталог; далі досить ввести номер кольору на кла-

віатурі (для швидкого пошуку кольору). Контролювати значення кольору 

можна за допомогою палітри Info. 

Основні помилки застосування колірних бібліотек Pantone: 

1. Часто в брендбуках можна побачити таблиці відповідностей кольорів 

RGB, CMYK і Pantone. Це некоректно, оскільки будь-яка відповідність 

цифрових значень правильна в окремих випадках, а саме під час пере-

кладу кольору з використанням того або іншого профілю ICC. У разі зміни 
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профілю кольоровідчуття буде інше. Тому до таблиці відповідностей 

потрібно додати і профіль, з урахуванням якого колір переведений. 

Зауваження 1: без ICC/ICM профіля перевести колір із системи в сис-

тему без втрати відповідності кольоровідчуття неможливо. Відмовляючись 

від використання CMS у редакторі, розробник відмовляється від вибору 

відповідності і втрачає можливість коли-небудь отримати колір, схожий 

на оригінал. Система продовжує показувати кольори, обходячи один  

з пунктів CMS. 

Зауваження 2: деякі графічні пакети (їх виробники) намагаються абс-

трагуватися від стандартних значень, запропонованих на віялах Pantone  

і коректно перекласти пантони в координати цільового колірного простору, 

переганяючи колір спочатку в Lab. CMYK або RGB значення розрахову-

ються тільки з урахуванням профілю, тому вони будуть дійсні виключно 

для нього. Найбільш коректно це робить програма Pantone Color Manager. 

Програма враховує профіль вихідного пристрою і показує, які пантони 

можуть бути точно відтворені на ньому, а які ні. 

Зауваження 3: переведення Pantone CMYK приблизний, оскільки базові 

кольори бібліотеки Pantone знаходяться поза зоною CMYK. Особливо це 

стосується відкритих базових кольорів. Кольори, що лежать в зоні CMYK, 

можуть бути коректно відтворені тріадою, але це буде окремий випадок  

з урахуванням профілів. 

2. Віяла Pantone розроблялися для стандартизації та уніфікації кольо-

рів для коректного перенесення. Помилково у всіх сенсах мати таблиці від-

повідностей найближчим координатами CMYK або RGB. Це спостеріга-

ється в сучасних графічних редакторах, які не враховують профілі прис-

троїв для відтворення. 

Зауваження 4: одні і ті ж процентовки під час змішування фарб будуть 

різними у разі використання різних виробників фарб. 

Зауваження 5: одні і ті ж процентовки CMYK будуть відображатися 

по-різному залежно від того, через який профіль розробник дивиться колір 

на моніторі. 

3. Користувач, який звик бачити, наприклад, Pantone 315 CVC в одному 

ПЗ зеленуватим дивується, чому той же самий пантон відображається  

в іншому ПЗ голубуватим і де шукати його аналог у нових бібліотеках. 

Зауваження 6: застарілі системи не оновлюються і наприклад, 

Pantone 315 CVC і Pantone 315 C – є двома різними кольорами тільки тому, 

що віял CVC більше не випускають, а ті віяла, що були випущені раніше, 

"відходять" від поточних кольорів. 
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4. Користування бібліотеками пантонов допустимо тільки в цілях 

локальних відповідностей, тобто вказати колір на віялі і змішати його на 

надточних вагах для друку з базових кольорів, або замовити готовий 

пантон у спеціальних магазинах. Ні про які відповідності з монітором не 

може бути й мови, якщо це не спеціалізована система, що працює з абсо-

лютними Lab-значеннями пантонов (така, як Pantone Color Manager). 

5. Не варто замовляти в друк ті чи інші пантони не впевнившись, 

що друкарня має віяло і не змішає його з CMYK-фарб. 

6. Не варто приймайти замовлення на друк відповідним пантоном, 

не переконавшись, що замовник вибрав його не за монітором, а за віялом. 

7. Фахівець ніколи не буде вказувати в віяло, наприклад, Pantone 

Solid Coated, якщо йдеться про СМУК. Для СМУКа більше підійшов би 

Process Coated/Uncoated. 

8. Варіантів обчислити колір за тим, як його бачить замовник на 

моніторі, немає. Тільки віяло з фарбами виробництва Pantone і їх значень 

Lab можуть бути синхронізовані однозначно, для будь-яких інших обчислень 

існують змінні, що враховуються в профілях. 

9. Більш правильно зберігати значення пантонів для демонстрації 

на екрані монітора в Lab, але кольори Lab відображаються на моніторі 

користувача урізано, не враховуючи особливості фізичних параметрів  

і налаштування монітора. В ідеалі охоплення монітора повинне повністю 

перекривати охоплення пантонів. 

10. Щоб побачити на моніторі правильний колір у будь-якій з систем, 

його треба відкалібрувати. 

 

6.3. Особливості та специфіка здійснення 

комп'ютерного кольороподілу 
 

Поділ кольорового зображення на окремі фарби (компоненти) нази-

вається кольороподілом. 

Кольороподілене зображення – це одноколірне зображення, отри-

мане на екрані монітора видавничої системи або на твердому носії (на 

лавсановій плівці, фотоплівці або формному матеріалі) після поділу на 

окремі кольори багатоколірного зображення оригіналу в процесі кольоро-

поділу. 

Кольоропередача – це психологічно точне відтворення на відтиску 

кольорів і колірних відтінків оригіналу під час порівняння зображень оригі-

налу й відтиску в однакових умовах освітленості. 
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Кольороподіл полягає в одержанні індивідуальних форм для кожної 

друкованої фарби. Розрізняють такі два випадки кольороподілу: 

найпростішим випадком кольороподілу є використання плашкових 

кольорів, коли кожен із них виводиться на окрему плівку; 

більш загальним випадком є кольороподіл повнокольорових доку-

ментів, де для представлення всіх кольорів використовуються чотири фарби 

моделі CMYK, які називаються також тріадними. Отже, повнокольорові 

документи виводяться за допомогою фотоскладального автомата на чотири 

плівки, що відповідають базовим кольорам цієї моделі. Кожен колір рас-

труєтся окремо з різними кутами нахилу растрової сітки. 

Кольороподіл в Photoshop 

У разі найбільш типового випадку друку тріадними фарбами – це 

форми для блакитної, пурпурної, жовтої й чорної фарб. У Photoshop роль 

форм виконують напівтонові колірні канали. Результат їх сполучення  сприй-

мається як кольорове зображення. Точно так же накладення цих каналів, 

видрукуваних відповідними фарбами на аркуші паперу, формує кольо-

ровий відбиток. 

Таким чином, у термінах Photoshop, кольороподіл є перетворення 

зображень у колірну модель CMYK з будь-яких інших моделей. У резуль-

таті утворюється зображення із чотирма колірними каналами, що відпо-

відають фарбам поліграфічної тріади. Згодом ці канали виводяться окремо 

на фотоскладальному автоматі, що раструє їх під різними кутами із заданої 

лініатурою. На виході утворюються чотири плівки, готові для експонування 

з них офсетних форм. 

Photoshop дозволяє настроювати параметри кольороподілу двома 

різними способами:  

1) за колірним профілем пристрою виведення; 

2) введенням усіх параметрів кольороподілу. 

Слід розглянути перший спосіб, що дає гарні результати й не потре-

бує знання тонкостей типографського процесу. 

Робочий профіль CMYK у діалоговому вікні Color Settings саме й задає 

параметри кольороподілу відповідно до обраного поліграфічного стандарту. 

Відповідно до цього профілю виконується перетворення зображень у мо-

дель CMYK з будь-яких інших колірних моделей. 

Таким чином, основне завдання установок параметрів кольоропо-

ділу зводиться до вибору правильного профілю (рис. 6.6). 
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Рис. 6.6. Процес вибору профілю 

 

Стандартні профілі побудовані з урахуванням типу паперу й друко-

ваної машини. Так, профілі до назви яких входить слово Coated, призна-

чені для крейдованого паперу, a Uncoated – для звичайного паперу без 

покриття. Профілі, у яких фігурує слово Sheetfed відповідають листовій 

подачі паперу, а інші – рулонній. Під час вибору профілю необхідно вра-

ховувати дані параметри. Тому дуже важливо заздалегідь довідатися  

у її технолога або друкаря, якими фарбами буде здійснюватися друк  

у друкарні, де розміщене замовлення. У більшості випадків – це стандарт 

Euroscale. Хоча деякі друкарні працюють і з фарбами американського стан-

дарту офсетного друку SWOP. 

Після того, як установлений правильний профіль, потрібно вказати 

ще один, але досить важливий параметр (рис. 6.7). Йдеться про величину 

розтискування точок, що задається в списках Gray (півтони) і Spot (плашкові). 
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Тут визначається розтискування для напівтонових зображень і зображень, 

розділених на плашкові кольори (для кольорових зображень цей пара-

метр уже врахований в обраному профілі). 
 

 
 

Рис. 6.7. Процес установки додаткових параметрів 

 

Наявність усього декількох стандартних профілів для кольороподі-

лених зображень полегшує перенесення зображень між різними комп'ю-

терами, але може виявитися недостатнім для характеристики різноманіт-

них умов друку. Крім того, може знадобитися, наприклад, вивести те саме 

кольороподілене зображення на струменевий принтер, потім на кольоро-

пробний і, нарешті, на фотонабірний автомат. Зрозуміло, кожен із них має 

власний колірний профіль. Photoshop враховує цю можливість спеціаль-

ними настроюваннями друку. 

Слід розглянути другий спосіб, в основі якого лежить процес створення 

замовленого профілю. 

Для створення замовленого (користувальницького) CMYK-профілю 

використовується команда Custom CMYK, що знаходиться в списку CMYK 

діалогового вікна Color Settings. 

Основними параметрами установки є такі: 

1. Inc Colors (настроювання фарби). Фарби для вітчизняного офсету 

використовуються зараз в основному європейські, а це в програмі нази-

ваються Eurostandard і SWOP. Кожен тип фарби градуюється за трьома 

категоріями, що визначають для друку, на якому папері призначена фарба: 

Coated – папір повинен бути крейдований, глянсовий; Uncoated – некрей-

дований папір; Newsprint – газетний. Перед кольороподілом (переведен-

ням у CMYK) необхідно змінити настроювання на Coated, Newsprint або 

Uncoated (рис. 6.8);  
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Рис. 6.8. Зміна настроювання паперу 

 

2. Dot Gain (розтискування фарби). 

Розтискування – це небажане збільшення щільності (відсотка) фарб 

під впливом убирання їх у папір і як наслідок фізичне й оптичне збіль-

шення растрових елементів. 

Зорово це сприймається як ущільнення (затемнення) зображення.  

Потрапляючи на папір, фарба розтікається, убирається й придав-

люється циліндром друкованої машини. Таким чином, растрова точка збіль-

шується в розмірі. У результаті зображення може значно затемнюватися. 

Для компенсації даного небажаного ефекту застосовується компенсація 

розтискування. У поле Dot Gain вводиться величина розтискування (рис. 6.9). 

 

 
 

Рис. 6.9. Зміна настроювання розтискування 
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Існує два способи компенсації розтискування: 

а) Standart – визначає відсоток збільшення 50-відсоткової точки растра; 

б) Curves – визначає різні відсоткові значення збільшення растрової 

точки для різних тонів, дозволяє задавати різні розтискування для різних 

фарб CMYK. Для точної компенсації розтискування необхідно в друкова-

ному відтиску для використовуваних фарб і паперу виміряти збільшення 

растрової точки різних розмірів і задати ці значення у вікні Dot Gain Curves 

(рис. 6.10). 

 

 
 

Рис. 6.10. Задавання значень збільшення растрової точки для Cyan 

 

Зауваження: найбільш значуще це відбувається в зоні півтону – 

50 %. Цей параметр варто використовувати як настроєчний. 

3. Separation Type (тип кольороподілення). Справа в тому, що темні 

тріадні кольори можна представити як суму сірої (нейтральної) і кольорової 

складової. 

Існує два типи (ще називають методами) кольороподілу (рис. 6.11): 

а) GCR – нейтральна складова кольору заміщується на відповідний 

відсоток чорної фарби. Метод дає можливість зменшити ймовірність неба-

жаного колірного зрушення під час друку й заощаджує дорогі кольорові 

барвники; 

б) UCR – навпаки, глибокі тіні виходять за рахунок змішання великого 

відсотка кольорових фарб, а чорний має допоміжну роль. Рівень генерації 

чорного задає криву, за якою Photoshop і вибирає відсоток заміщення 

кольорових барвників чорним.  
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Рис. 6.11. Вибір типу (методу) кольороподілу 

 

Обидва методи припускають, що в середніх і темних тонах замість 

деякої кількості CMY-фарб буде використовуватися відповідна деяка 

кількість чорної фарби. Це забезпечує обмеження загальної кількості 

фарб у тінях і більш точну передачу деталей. Звичайно, має сенс вико-

ристовувати тип кольороподілу GCR, тому що він дає більш широкий 

діапазон настроювань параметрів кольороподілу. 

4. Black Generation (інтенсивність генерації). Визначає інтенсивність 

чорної фарби залежно від тонів. Найчастіше використовуються два варі-

анти Light і Medium (рис. 6.12).  

 

 
 

Рис. 6.12. Вибір значення для інтенсивності генерації  

чорного кольору 

 

Light Generation визначає чорний в основному тільки в темних тонах 

і трохи в середніх, а Medium Generation визначає чорний як у середніх, так 

і в темних тонах. Для темних зображень краще використовувати варіант 

Light, а для світлих і нормальних – Medium; 
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5. Black Ink Limit (максимальна кількість чорної фарби в тінях) 

та Total Ink Limit (максимальна кількість всіх фарб CMYK у тінях). 

Значення даних параметрів визначаються кількістю паперу й типом 

друкованої машини. Цю інформацію необхідно уточнювати в друкарні. 

 

Висновки та узагальнення 

 

Під кольорокорекцією слід розуміти зміну колірного змісту зображення 

оригіналу відповідно до вимог замовника, технологічного процесу й інших 

причин або виправлення фотоформ, отриманих у результаті кольороподілу. 

Основне правило, що повинне виконуватися в рамках тонової кор-

рекції, – баланс за сірим. 

Специфіка роботи із кольором полягає в тому, що здійснюваний на 

окремий колірний компонент вплив відбивається на всіх інших, тому голов-

ним принципом колірної корекції є настроювання балансу кольорів. 

Для більш точної передачі якого-небудь відтінку в поліграфії засто-

совують плашкові або прості кольори, отримані шляхом попереднього про-

стого змішування фарб у змішувачі. Найбільш популярними каталогами 

плашечних кольорів є: Pantone Coated та Pantone Uncoated. 

Кольороподілене зображення – це одноколірне зображення, отримане 

на екрані монітора видавничої системи або на твердому носії. Photoshop 

дозволяє настроювати параметри кольороподілу двома різними спосо-

бами: за колірним профілем пристрою виведення та введенням усіх пара-

метрів кольороподілу. 

 

Теоретичні запитання 

 

1. Опишіть місце дисципліни в рамках загального процесу кольоро-

вого відтворення. 

2. Дайте визначення таким поняттям: "колірний режим" та "кольоро-

корекція". 

3. Опишіть специфіку організації процесу тонової корекції. 

4. Які існують інструментальні засоби тонової корекції?  

5. Що таке "тоновий діапазон"? 

6. Як звучить основне правило тонової корекції? 

7. Сформулюйте основний принцип колірної корекції. 

8. Опишіть специфіку організації процесу колірної корекції. 
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9. Які існують інструментальні засоби здійснення процесу колірної 

корекції? 

10. Сформулюйте правила роботи з Curves. 

11. Опишіть теоретичний інструментарій (базові елементи) кольоро-

корекції. 

12. Які існують методи кольорокорекції? 

13. Поясніть, як вирішується проблема відтворення відтінків (на прик-

ладі системи Pantone). 

14. Дайте визначення процесу кольороподілу та його змісту. 

15. Опишіть способи настроювання параметрів кольороподілу. 

16. Як створити замовлений (користувальницький) профіль? 

17. Що таке розтискування? Які є способи його компенсації? 

 

7. Друкарське кольоровідтворення 

 

Основна ідея 

 

Присвячено розгляду специфіки друкарського кольоровідтворення 

та чинників, що впливають на якість даного процесу. 

 

Ключові поняття: друкарське кольоровідтворення, контролювання 

кольору, визначення відхилень. 

 

Основні питання 

7.1. Загальна характеристика процесу друкарського кольоровідтво-

рення. 

7.2. Контролювання кольору в процесі тиражу. 

 

Цілі вивчення 

 

Метою є розкриття особливостей процесу друкарського кольоро-

відтворення та відповідних денситометричних вимірювань. 

Інформація, подана далі, надає студентові можливість сформувати 

такі компетентності: 

знання: 

характеристики процесу друкарського кольоровідтворення; 

особливостей денситометричного вимірювання; 
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уміння: 

здійснювати друкарське кольоровідтворення зображень; 

обґрунтовувати доцільність здійснення колірних вимірювань та кон-

тролювати колір у процесі тиражу; 

комунікації: 

професійна допомога в урахуванні параметрів, що повинні бути 

врахувати в процесі друкарського кольоровідтворення; 

автономність і відповідальність: 

самостійне контролювання кольору в процесі тиражу; 

професійна підготовка осіб, що займаються денситометричними 

вимірюваннями. 

 

Вступ 

 

Для отримання якісного результату в процесі друку необхідно 

здійснювати відповідний денситометричний контроль за параметрами, 

що впливають на якість кольору на задрукованому матеріалі (папері, 

картоні та ін.). У якості таких параметрів є: оптична щільність друкарських 

фарб, форма растрової точки, розтискування тощо. 

Розкрито питання, що стосуються здійснення колірних вимірювань  

і контролю кольору в процесі тиражу. 

 

7.1. Загальна характеристика процесу  

друкарського кольоровідтворення 

 

Якість процесу друкарського кольоровідтворення залежить від під-

готовки, виконаної на додрукарській стадії, способу друку, обладнання, 

що застосовується, властивостей матеріалів, що використовуються для 

виготовлення друкованої продукції (в першу чергу, від характеристик паперу 

й фарб). Якість кінцевого друкованого продукту залежить і від післядру-

карського оброблення. 

Якість відтиску (одно- або багатофарбового) або друкарського 

відтиску, що містить растрове, штрихове зображення й текст одночасно, 

визначається точністю кольоро- й тонововідтворення, точністю суміщення 

в багатокольоровому друці й властивостями поверхні віддрукованого 

зображення усієї друкованої полоси (або листа). 
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З позиції теорії кольору, на якість друкарського кольоровідтво-

рення впливають такі фактори: координати кольору, оптична щільність, 

форма растрової точки, розтискування (фарбосприйняття), двоїння, рів-

номірність розподілу фарби на поверхні. 

 

7.2. Контролювання кольору в процесі тиражу 

 

З позиції можливості здійснення контролювання кольору в процесі 

тиражу інтерес становлять денситометричні вимірювання, що засновані 

на оцінювання товщини фарбового шару. Денситометром визначаються 

не тільки оптичні щільності, а також параметри растрового друку, такі, як 

розтискування й відносний контраст друку. Той факт, що за допомогою 

вимірювань можливо визначити фарбосприйняття (захват) фарби мате-

ріалом має дуже велике значення в технології багатофарбового друку. 

У багатофарбових машинах фарбоподача в кожній друкарській секції 

повинна регулюватися окремо. У растровому зображенні має місце накла-

дання декількох фарб, тому візуальне й інструментальне оцінювання 

окремих фарб на самій репродукції складні. На сигнал, вимірюваний від 

однієї фарби, впливають інші фарби, що обмежує точність вимірювань. 

Тому поряд з основним зображенням на обрізаному полі друкованої сторінки 

прийнято друкувати колірні шкали, вимірювальні поля яких відповідають 

певним фарбам (рис. 7.1). 

 

 

 

Рис. 7.1. Контрольна шкала друкарського процесу з полями  

для вимірювання кольору 

 

Такі контрольні шкали набули широкого застосування на практиці і 

наносяться по всій ширині друкарського листа, у цьому разі окремі поля 

розташовуються так, що відповідають зонам подачі фарби. 

Щільність полів шкал на відтиску контролюються за допомогою 

денситометра. За значенням щільностей легко можуть бути визначені 

зміни в подачі фарби. 
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Оптична щільність (D) визначається таким логарифмічним співвід-

ношенням: 
 

 D = log 1/β  = log Io/I, (7.1) 

де коефіцієнт відображення β  дорівнює відношенню інтенсивності світла I, 

відбитого від фарбового шару, до відбиття Io від ділянки незадрукованого 

паперу. Зі збільшенням товщини фарбового шару коефіцієнт відбиття β  

зменшується. Для того, щоб отримати дані вимірювань, пропорційні вимі-

рюванню товщини фарбового шару, під час розрахунку оптичної плат-

ності спочатку знаходять зворотну величину (1/β ), а потім обчислюють  

її логарифм. 

 

На рис. 7.2 наведені характерні для багатофарбової офсетної репро-

дукції криві зміни щільності фарбового шару реальних  друкарських фарб 

залежно від його товщини. 
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Рис. 7.2. Оптична щільність друкарських фарб  

за різної товщини фарбового шару 

 

За допомогою денситометрів можна вимірювати як сухі, так і ще сирі 

фарбові шари. Для останніх характерна відносно гладка, глянцева поверхня. 

Під час висихання фарбовий шар деякою мірою набуває нерівномірної 

шорсткої структури поверхні паперу й втрачає первинний глянець. Якщо 



151 

провести вимірювання спочатку по сирому, а потім по сухому шару, то 

результати вимірювань будуть різні (величина вимірюваної щільності по 

сирому вища, ніж по сухому шару). 

Для того, щоб компенсувати таку неузгодженість, на оптичному 

шляху встановлюють два лінійних поляризаційних фільтри з площинами, 

що схрещуються. Із світлових хвиль, що поширюються на всі сторони 

поляризаційні фільтра пропускають хвилі тільки одного напряму. Частина 

поляризаційних променів, що пройшли через перший поляризаційний 

фільтр, дзеркально відображується фарбовим шаром. Другий поляри-

заційний фільтр повернутий щодо першого на 900, тому дзеркально 

відображені світлові промені ним не пропускаються (рис. 7.3).  

 
 

Рис. 7.3. Дія поляризаційних фільтрів, що виключає дзеркальне 

відображення гладких поверхонь у разі зміни оптичної щільності 

 

Дзеркально відображене світло таким чином з вимірювань виклю-

чається. Але, якщо промені світла проникають у фарбовий шар і відби-

ваються або від нього або від задрукованого матеріалу, вони втрачають 

свою поляризацію. А отже, ці промені частково пройдуть через других 

поляризаційний фільтр і потраплять на фотоприймач. 

Таким чином, за рахунок виключення частини світла, що дзеркально 

відображається від шару сирої фарби, досягають приблизної рівності 

результатів вимірювань "по сирому" та "по сухому". Іншими словами, сирий 

папір 

напрямок розсіювання 

напрямок коливання 
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шар невисохлої фарби з великим глянцем дає такі ж показники, як, якби 

він був уже сухим. Завдяки поглинанню поляризаційного фільтра на фото-

приймач потрапляє зменшена відображена складова, що приводить до 

більш точних вимірюваних значень. 

Достовірна кольропередача растрового зображення дуже критична 

до зміни розміру растрових точок, оскільки ці відхилення приводять до 

зрушення в тоно- й кольропередачі. Має місце множина факторів, що 

впливають на градаційну передачу під час растрування, і тому (з метою 

стандартизації) вони повинні контролюватися. 

У репродукційному процесі найпростішою контрольованою величи-

ною градаційної передачі є відносна площа растрових точок на полях 

колірних контрольних шкал (див. рис. 7.1). 

Відносна площа растрових точок (FD) на відтиску (тобто площа, 

занята покритими друкарською фарбою растровими точками на полі 

контрольної шкали) також може бути виміряна денситометром. Величина 

FD (у відсотках) розраховується за рівнянням Мюрея – Девіса із значень 

інтенсивності світла, відображеного від плашкового фарбового шару і рас-

трового поля, як:  
 

 %100
β-1

β-1
=F

V

R

D
, (7.2) 

де Rβ  – відображення растрового поля; 

Vβ  – відображення плашкового шару. 

 

У цьому разі припускається, що фарбовий шар на растрових точках 

і плашках має однакову товщину. Підставляючи виміряні значення оптичної 

щільності у формулу (7.2.), відносну площу растрової точки обчислюють 

за такою формулою: 
 

 %100
10-1

10-1
=[%]F

VD-

R-D

D
,  (7.3) 

де DR – оптична щільність плашки; 

DV  – оптична щільність растрового поля. 

У процесі денситометричного оцінювання оптичної щільності рас-

трових полів вимірювальні значення відповідають не геометричній від-

носній площі растрових точок (тобто співвідношенню площ, зайнятих 

растровими точками і незадрукованим папером), а оптично ефективної 
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задрукованої площі. Різниця між геометричною та оптично ефективною 

задрукованою площею виникає через те, що, як під час розгляду, так і під 

час денситометричних вимірювань частина світла, що падає на пробіли, 

розсіюється в товщині паперу і, потрапляючи під растрову точку, 

поглинається її фарбовим шаром (рис. 7.4). 

 
 

Рис. 7.4. Поглинання світла, що поступає від пробілу ділянкою 

пофарбованої поверхні паперу 

 

У процесі оцінювання репродукційного процесу з урахуванням влас-

тивостей використовуваних матеріалів відносна площа растрових елементів 

відтиску стає найважливішою вимірювальною величиною й основною 

кількісною характеристикою. 

Під час розтискування збільшення растрових точок (Z) розрахову-

ють із відносної площі растрових точок на фотоформі (FF) як оригіналу для 

виготовлення друкованих форм і їх кінцевої відносної площі на відтиску 

(FD), отриманої на задрукованому матеріалі в процесі друку. Розрахункова 

формула має такий вигляд: 
 

 Z [%] = FD[%] - FF [%]. (7.4) 
 

Так, якщо відносна площа точки, наприклад, по блакитній фарбі 

(рівною 55 %) утворюється за допомогою вимірювання щільностей плашки 

і поля тонової шкали з відносною площею растрової точки фотоформи 40 %, 

то приріст відносної площі точки до відомого її розміру (40 %) на фото-

формі складає 15 %. Приріст, зазвичай, позитивний, оскільки гумове полот-

но збільшує точку під час її передавання на папір. Припускається, що 

відносна площа під час переходу від фотоформи до друкованої форми 

папір 

фарба 
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змінюється незначно. Зміна градації, що відбувається, повинна бути 

врахована у процесі кольороподілу та виготовлення фотоформ. 

У стандартизованому позитивному копіювальному процесі виготов-

лення друкарських форм растрові точки з фотоформи копіюються на дру-

карську форму з декілька зменшеними розмірами. Зв стандартних умов 

ведення процесу друку площі растрових точок знову збільшуються. На 

рис. 7.5 проілюстрована типова градаційна крива друкарського процесу. 

Розтискування в значному ступені залежить від властивостей поверхні 

паперу та її вбираючої здатності, реологічних властивостей фарб, декеля, 

тиску під час друку й ін. 

 

 
 

Рис. 7.5. Градаційна крива друкарського процесу та розтискування 

 фотоформа (FF) 

 відтиск (FD) 

 Z [%] 

 розтискування 
 10 %        15 %            10 %      0 % 

 30 %        55 %            90 %    100 % 

20 %       40 %           80 %    100 %  
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Під час розроблення стандартів офсетного друку були нормовані 

значення розтискування від фотоформи до відтиску. Ці дані щодо розтис-

кування стали для працівників поліграфічних підприємств тими нормами, 

якими вони користуються для обґрунтованого вибору матеріалів, регу-

лювання параметрів обладнання та контролювання кольору в процесі 

його друкарського кольоровідтворення. 

 

Висновки та узагальнення 

 

На якість друкарського кольоровідтворення впливають такі чинники: 

координати кольору, оптична щільність, форма растрової точки, розтис-

кування (фарбосприйняття), двоїння, рівномірність розподілу фарби на 

поверхні. 

Денситометром визначаються не тільки оптичні щільності, а також 

параметри растрового друку, такі, як розтискування й відносний контраст 

друку. 

За допомогою денситометрів можна вимірювати як сухі, так і ще 

сирі фарбові шари. 

Достовірна кольропередача растрового зображення критична до зміни 

розміру растрових точок, оскільки ці відхилення призводять до зрушення  

в тоно- й кольропередачі. 

 

Теоретичні запитання 

 

1. Які чинники необхідно враховувати в процесі друкарського кольоро-

відтворення? 

2. Як ураховуються особливості структури та властивостей паперу? 

3. Як ураховуються особливості обладнання? 

4. Як визначаються припустимі відхилення? 

5. Поясніть роль і місце денситометричних вимірювань під час здійс-

нення контролю кольору друкованої продукції (книг, журналів тощо) в процесі 

тиражу. 

6. Як робити вимірювання діапазону оптичної щільності зразка? 

7. Як визначається ступінь розтискування? 

8. Як вимірювати відсоток растрової точки? 

9. Яким чином здійснюється регулювання балансу за сірим? 

 



 156 

Розділ 3. Лабораторний практикум 

ЛАБОРАТОРНА РОБОТА  №1 

(Частина 1)  

Графічний процесор ADOBE PHOTOSHOP.  

Основні елементи інтерфейсу програми 

 

Мета роботи: отримати навички роботи з програмою Adobe Photoshop. 

Навчитися створювати і зберігати файли, вивчити опції збереження і створення 

файлів. Вивчити основні формати файлів і їх властивості. Ознайомитися з па-

неллю інструментів Adobe Photoshop. 

Обладнання і програмне забезпечення: Photoshop cs2, процесор Intel 

Pentium 4, Microsoft Windows XP з пакетом Service Pack 3, 1 Гб ОЗУ, монітор з 

1024x768 (рекомендується 1280x800), відеокарта з підтримкою OpenGL 2.0, і 

16-розрядних кольорів, 256 Мб відеопам’яті.   

 

Теоретична частина 

Програма Adobe Photoshop створена для роботи зі всіма видами растрової графіки, 

сфера застосування якої достатньо широка і охоплює все від поліграфії до інтернету. 

Photoshop коректно і швидко конвертує будь-які зображення у всі відомі формати растрової 

графіки без втрати якості, чудово працює як додаток для сканування фотографій і сумісний зі 

всіма видами сканерів. Це дуже зручно, оскільки отримане зображення ви можете тут же і 

відредагувати, не перетягуючи його в інші програми. Також тут можна ретушувати будь-які 

зображення, наприклад, старі фотографії. В останніх версіях у зв'язці з Photoshop йде про-

грама Adobe ImageReady, яка відкриває багато можливостей для оптимізації розміру файлу, 

що актуально для Web-графіки. Також вона дозволяє значно полегшити підготовку анімова-

них зображень, використовуючи усі можливості Photoshop. Програма дозволяє робити навіть 

сторінки Інтернет, насичені графікою, з подальшою їх оптимізацією. Photoshop може розумі-

ти і векторну графіку. Правда, це не є його візитною карткою, але створити будь-який склад-

ний і точний векторний контур або шлях він може, що буває дуже зручно для створення ко-

лажів і анімації. 
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Основні елементи інтерфейсу програми 

Рядок меню 

 

1. File (Файл) - створення і відкриття, збереження об'єкту, імпорт, експорт, на-

стройки програми, список з декількох останніх файлів, що редагувалися в програмі. 

2. Edit (Правка) - Відміна, повторення дій, копіювання і вставка об'єкту у файл, за-

ливка, обведення по контуру, трансформація об'єкту. 

3. Image (Зображення) - настройка режиму палітри (RGB, CMYK, Grayscale), яск-

равості і контрасту, мікшування кольорів, а так само зміна розміру зображення і йо-

го обертання. 

4. Layer (Шар) - робота з шарами, ефекти. 

5. Select (Виділення) - різні види виділень і їх трансформація. 

6. Filters (Фільтри) - набір фільтрів і плагінов, які дозволять добитися ці-

кавих ефектів в роботі. Ви можете використовувати як вбудовані фільтри, так і пос-

тавити додаткові. 

7. View (Вигляд) - робота з розміром зображення, передперегляд, вирів-

нюючі лінійки, розграфлення поля файлу. 

8. Window (Вікно) - відображення вікон властивостей інструментів, зов-

нішній вигляд робочого столу Photoshop, швидкий перехід до згорнутого файлу. 

9. Help (Допомога) - допомога по роботі з програмою, інформація про 

фільтри, настройка гамми. 

 

Панель інструментів. 

Панель поділена на декілька груп інструментів. 

1) До перших чотирьох груп відносяться окремі інструменти. На кнопках деяких з 

них в нижньому правому кутку є невеликий чорний трикутник. Він указує на наявність під-

меню з різними варіантами цього інструменту.  

2) Нижче на панелі розміщена палітра кольорів. Досить клацнути по колірному квад-

рату і перед вами відкриється вся палітра кольорів: звичайна, для web і пантони. Тут же мо-

жна дізнатися числові коди кольорів за шкалою RGB або CMYK. Налагодити палітру під 

web дуже просто. Потрібно просто поставити галочку внизу вікна, поряд з написом: "Only 

Web Colors". І палітра відобразить кольори, які коректно відображатимуться будь-яким брау-

зером (без спотворень). Тут же можна подивитися код, що відповідає цьому кольору. Також 
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існує палітра вибраних кольорів. Вона знаходиться в одному з вікон властивостей, розташо-

ваних за замовчуванням праворуч від робочого столу програми. 

3) Під палітрою кольорів ми бачимо дві кнопки - Правка в стандартному режимі і 

Правка в режимі швидкої маски. Швидка маска включає режим швидкого маскування, в 

якому можливе редагування меж виділення за допомогою інструментів малювання. 

4) Ще нижче знаходяться три кнопки, що впливають на розмір вікна зображення. 

Стандартне вікно, Повний екран з меню і Повний екран. 

5) Остання кнопка на панелі швидко перенесе вас в Adobe ImageReady. Це зручно, 

коли ви займаєтеся анімацією в Photoshop і вам треба швидко перейти в цей редактор, де ви 

зможете зробити легко і просто анімацію зображення і після оптимізувати його для web. 

• Рядок стану 

 

 

Тут міститься основна інформація про файл, з яким ви працюєте і інформація про 

комп'ютер, яка має відношення до роботи з Photoshop. Розглянемо деякі елементи цього ряд-

ка: 

1. Масштаб. Тут відображається поточний масштаб у відсотках. За замовчуванням - 

100%. Один піксель екрану монітора відповідає одному пікселю зображення. 

2. Інформаційне поле. Зліва від масштабу. Тут міститься інформація про графічний 

файл, над яким ви працюєте, або інформація про комп'ютер, яка відноситься до роботи про-

грами. 

3. Меню інформаційного поля (Чорний трикутник). У нього входять - Розміри доку-

ментів, Ефективність, Хронометраж і розміри робочих дисків. 
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Хід роботи 

Створення і збереження файлів. Зміна розмірів і форми зображення 

Завдання 1 

Створіть нові файли з перерахованими параметрами: 

Name Preset 
Width / 

Height 
Resolution Color Mode 

Background 

Content 

file_01 Custom 355/355 72 RGB 
Background 

color 

file_02 1024x768 1024/768 36 LAB White 

file_03 640x480 640/480 72 Grayscale Transparent 

 

Завдання 2 

Збережіть створені файли (завдання 1.1) з наступними параметрами. У разі відкриття 

при збереженні діалогових вікон введіть інформацію стовпця 3. 

File name Format 

Опції діалогових ві-

кон 

 

file_01 під им’ям 

file_1 
PSD  

file_02 під ім'ям file_2 BMP 
File Format – 

Windows; Depth –8 bit 

file_03 під ім'ям file_3 JPEG 

Quality – 10; Format 

Options – Progressive; Scans – 

3 

 

Завдання 3 

Закрийте файли file_1, file2, file_3. 

 

Завдання 4 

1. Відкрийте файл file_1. 

2. Збережіть його як копію. 

 

Завдання 5 

1. Вивчіть інтерфейс програми Photoshop. 

2. Запишіть назви основних елементів інтерфейсу. 
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3. Вивчіть палітри програми (пункт меню Window). Запишіть призначення кожної па-

літри. 

 

Завдання 6 

1. Відкрийте файл Dune.tif який знаходитися в папці Samples програми Adobe 

Photoshop. 

2. Збережіть його під різними розширеннями, заповнивши таблицю. (У графі «опції 

збереження» необхідно описати діалогові вікна, пункти меню). 

 

Формат збереження Опції збереження 
Розмір файлу після  

збереження 

PSD   

JPEG   

GIF   

PNG   

BMP   

 

Зміна розмірів зображення 

Завдання 7.  

1. Завантажити програму Photoshop. 

2. Відкрити файл dune.tif (Знаходиться в папці \Adobe\Samples). 

3. Розкрити меню Image (Зображення) і вибрати з нього команду Image Size (Розмір 

зображення). Відкриється діалогове вікно Image Size (Розмір зображення). 

4. Ввести в поле Resolution (Роздільна здатність) значення роздільної здатності зобра-

ження, рівне 120 pixels/inch (пикселей/дюйм). При зміні значення роздільної здатності шири-

на і висота зображення автоматично змінюються. 

5. Підтвердити перетворення, натиснувши клавішу Ok. 

6. Відмінити перетворення, використовуючи палітру History. Відкрити меню Window 

(Вікно), в якому вибрати команду Show History (Показати історію). Вибрати в палітрі другий 

пункт- Open (Відкрити). 

7. Розкрити меню Image (Зображення) і вибрати з нього команду Image Size (Розмір 

зображення). Відкриється діалогове вікно Image Size (Розмір зображення). 

8. Відключити прапорець Constrain Proportion (Використовувати пропорцію). 
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9. Встановити прапорець Resample Image (Перерахунок розмірів зображення) і ввести 

в групі Pixel Dimensions значення ширини, рівне 600 pixels (пікселів) і висоти, - 350 pixels 

(пікселів). 

10. Підтвердити перетворення, натиснувши клавішу Ok. 

11. Відмінити перетворення, використовуючи палітру History. Відкрити меню Window 

(Вікно), в якому вибрати команду Show History (Показати історію). Вибрати в палітрі другий 

пункт- Open (Відкрити). 

12. Розкрити меню Image (Зображення) і вибрати з нього команду Image Size (Розмір 

зображення). Відкриється діалогове вікно Image Size (Розмір зображення). 

13. Встановити прапорець Constrain Proportion (Використовувати пропорцію). 

14. Ввести в групі Pixel Dimensions значення ширини, рівне 600 pixels, а значення ви-

соти буде встановлено автоматично. Звернути увагу, що при зміні ширини і висоти значення 

дозволу зображення Resolution (Дозвіл) не змінюється. 

15. Підтвердити перетворення, натиснувши клавішу Ok. 

16. Продемонструвати результат викладачеві. 

17. Закрити документ dune.tif без збереження. 

18. Завершити роботу з програмою Photoshop. 

 

Зміна розмірів полотна 

Завдання 8. 

1. Завантажити програму Photoshop. 

2. Відкрити файл dune.tif. 

3. У меню Image (Зображення) вибрати команду Canvas Size (Розмір полотна). 

4. Вибрати в групі New Size (Новий розмір) в додатковому списку значення зміни ро-

зміру полотна -percent (відсотки). 

5. Ввести нові значення розмірів в поля Height (Висота) = 120 і Width (Ширина) = 120. 

6. Підтвердити перетворення, натиснувши клавішу Ok. 

7. Відмінити перетворення, використовуючи палітру History. Відкрити меню Window 

(Вікно), в якому вибрати команду Show History (Показати історію). Вибрати в палітрі другий 

пункт - Open (Відкрити). 

8. У меню Image (Зображення) вибрати команду Canvas Size (Розмір полотна). 

9. У нижній частині діалогового вікна показана сітка, центральний осередок якої 

представляє поточне положення зображення. Змінити поточне положення полотна клацнув-

ши в лівому верхньому квадраті, щоб визначити розташування зображення на новому полот-

ні. 
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10. Вибрати в групі New Size (Новий розмір) в додатковому списку значення зміни 

розміру полотна - pixels (пікселі). 

11. Ввести нові значення розмірів в поля Height (Висота) = 600 і Width (Ширина) = 

500. 

12. Підтвердити перетворення, натиснувши клавішу Ok. 

13. Продемонструвати результат викладачеві. 

14. Закрити документ dune.tif без збереження. 

15. Завершити роботу з програмою Photoshop. 

 

Поворот полотна за допомогою команд групи Rotate Canvas 

Завдання 9. 

1. Завантажити програму Photoshop. 

2. Відкрити файл dune.tif. 

3. Відкрити меню Image (Зображення), а потім в опції Rotate Canvas (Поворот полот-

на) вибрати команду 180°. 

4. Підтвердити перетворення, натиснувши клавішу Ok. 

5. Відкрити меню Image (Зображення), а потім в опції Rotate Canvas (Поворот полот-

на) вибрати команду 90° CW. В результаті виконання цієї команди значення висоти і ширини 

поміняється місцями. 

6. Підтвердити перетворення, натиснувши клавішу Ok. 

7. Відкрити меню Image (Зображення), а потім в опції Rotate Canvas (Поворот полот-

на) вибрати команду Arbitrary (Довільно). При виборі цієї команди буде відкрито діалогове 

вікно. Задати поворот полотна на кут 45° за годинниковою стрілкою. 

8. Підтвердити перетворення, натиснувши клавішу Ok. 

9. Відмінити перетворення використовуючи палітру History. Відкрити меню Window 

(Вікно), в якому вибрати команду Show History (Показати історію). Вибрати в палітрі другий 

пункт - Open (Відкрити). 

10. Відкрити меню Image (Зображення), а потім в опції Rotate Canvas (Поворот полот-

на) вибрати команду Flip Horizontal (Дзеркальне відображення по горизонталі). 

11. Підтвердити перетворення, натиснувши клавішу Ok. 

12. Продемонструвати результат викладачеві. 

13. Закрити документ dune.tif без збереження. 

14. Завершити роботу з програмою Photoshop. 

 

Вивчення панелі інструментів 

Виділення прямокутником, овалом або прямою лінією. 
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Завдання 10.  

 

Marquee Tools  

 Виділення прямокутником  

 Виділення овалом  

 Виділення вертикальною або горизонтальною лінією  

 

Кероване виділення (Grop) створює прямокутну область з фіксованими 

вершинамі і відміченим центром, щодо яких надалі можна проводити точні 

настройки розміру і орієнтації 

 

Завдання 10.1. Використання інструменту виділення прямокутником. 

 

Скориставшись інструментом виді-

лення прямокутником, зробити з однієї 

фотографії дві. 

Для цього збережіть цю фотографію у 

себе на диску, відкрийте її в Photoshop і 

скориставшись інструментом виділення 

прямокутником виділіть ліву частину фо-

тографії і виберіть пункт меню Правка / 

Копіювати 

Тепер створіть новий файл. Вставте 

туди зображення з буфера обміну і збере-

жіть його. 

Аналогічні дії виконаєте з правою ча-

стиною фотографії. 

 

Зверніть увагу на 

те, що нові фотографії 

повинні бути одного роз-

міру. 
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Завдання 10.2. Використання інструменту виділення овалом. 

 

1. Збережіть цю фотографію у себе на диску. 

2. Виберіть інструмент виділення овалом і, утри-

муючи клавішу Alt, виділить частину портрета. 

3. Виконайте команду Правка /Копіювати 

4. Створіть новий файл і вставте туди скопійова-

не зображення. 

 

 

Загальноприйняті технічні прийоми: 

Виділення області у вигляді круга або квадрата: 

У процесі створення виділеної області натисніть і утримуйте клавішу Shift. 

Виділення області рівномірно на всі сторони від центральної точки: 

У процесі створення виділеної області натисніть і утримуйте клавішу Alt. 

Виділення області у вигляді круга або квадрата рівномірно на всі боки від цент-

ральної точки: 

У процесі створення виділеної області використовуйте комбінацію клавіш Alt + Shift. 

Виділення довільної області. 

Завдання 11. 

Інструмент Lasso дозволяє виділити в зображенні (або його частині) області довільної 

форми шляхом вказання їх меж. 

 

Lasso Tools  

 виділення "від руки" 

 виділення багатокутником, вказуванням його вершини 

 виділення "магнітом" (лінія сама згинається за курсором) 
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Завдання 11.1. Використання інструменту "виділення вручну".  

 

1. Збережіть цю фотографію на диску. 

2. Виберіть інструмент виділення "від руки" і 

виділіть рибу на фотографії. 

3. Виконайте команду Правка / Копіювати. 

4. Створіть новий файл і вставте туди скопійо-

ване зображення. 

5. Збережіть новий портрет на диску.  

Завдання 11.2. Використання інструменту виділення багатокутником. 

 

1. Збережіть цю фотографію у себе на диску. 

2. Виберіть інструмент виділення багатокутником й, 

визначенням вершин багатокутника (одинарним кла-

цанням миші) виділить рибу на фотографії (завер-

шення виділення - подвійне клацання миші). 

3. Виконаєте команду Правка / Копіювати. 

4. Створіть новий файл і вставте туди скопійоване 

зображення. 

5. Збережіть новий портрет на диску. 

 

 

Завдання 11.3. Використання інструменту виділення "магнітом".  

 

1. Збережіть цю фотографію у себе на диску. 

2. Виберіть інструмент виділення магнітом і об-

ведіть їм контур пінгвіна. Виконайте команду Прав-

ка /Копіювати. 

3. Створіть новий файл і вставте туди скопійова-

не зображення. 

4. Збережіть новий портрет на диску 
 

 

Виділення площі з подібними кольорами. 

Завдання 12. 
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Magic Wand Tool 

"чарівна паличка" 

Інструмент чарівна паличка дозволяє виділяти фрагменти зо-

браження, грунтуючись на близкості кольорів суміжних пікселів; при 

цьому він позбавить вас від необхідності копіткого ручного поперед-

нього окреслювання меж областей, що виділяються, за допомогою 

будь-якого інструменту виділення. 

 

Завдання 12.1. Використання інструменту виділення "чарівна паличка". 

 

1. Збережіть цю фотографію у себе на диску. 

2. Виберіть інструмент "чарівна паличка" і кла-

цніть нею по чорному фону. Ви побачите, що 

виділився ваш фон (паличка виділила всі суміж-

ні області чорного кольору). 

3. Виконайте команду Правка / Очистити (або 

натисніть клавішу Delete). Чорний фон буде ви-

далений. 

4. Збережіть новий портрет на диску. 

 

Переміщення чи рух об'єкту або зображення. 

Завдання 13. 

Move Tool   

рух виділеного об'єкту або шару 
 Переміщення виділеної області (об'єкту або шару) здій-

снюється за допомогою миші, при утриманні лівої кла-

віші. 
Hand Tool   

переміщає зображення у вікні. 

 

Завдання 13.1. Використання інструменту руху виділеного об'єкту або шару. 

 

1. Збережіть цей малюнок у себе на диску. 

2. Виберіть інструмент «чарівна паличка» і ви-

діліть кольоровий квадрат. 

3. За допомогою інструменту  перемістить 

його так, щоб побудувати піраміду з квадратів. 

4. Виконайте команду Виділити/Зняти виді-

лення. 

5. Повторіть ці дії з кожним з квадратів. 

6. Збережіть новий малюнок на диску.  
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Завдання 13.2. Використання інструменту переміщення зображення у вікні. 

Відкрийте будь-яке зображення і збільшіть його масштаб. Зручно збільшувати масш-

таб одночасним натисненням клавіш ctrl і +, а зменшувати ctrl і -. 

Зверніть увагу, що в рядку заголовка вікна показаний вибраний вами масштаб. Якщо 

ви обираєте крупний масштаб, то все зображення вже не видно у рамках вікна, і переміщати 

його можна за допомогою інструменту . 

 

Розпилювач фарби і малювання кистю. 

Завдання 14. 

Airbrush Tool 

розпилю-

вач фарби.  

Інструмент «аерограф» дозволяє фарбувати об'єкти (і малювати) без різких ко-

лірних переходів. Цей ефект подібний до малювання за допомогою аерозольно-

го балончика-розпилювача. При використанні цього інструменту можливо 

отримати значно м'якші штрихи і переходи, ніж при використанні інструменту 

Paintbrush. 

Paintbrush 

Tool 

малювання 

кистю.  

Інструмент «кисть» призначений для нанесення м'яких мазків. Імітує пензель 

художника. 

 

Завдання 14.1. Використання інструментів «розпилювач фарби» і «малювання 

кистю».  

 

На верхньому малюнку використано інструмент аерограф 

(розпилювач фарби), а на нижньому – інструмент малювання кистю. 

Очевидно, що на верхньому малюнку спостерігається більш плавний 

колірний перехід, тоді як на нижньому малюнку чітко виражена ме-

жа двох кольорів. 

Створіть в окремому файлі два зображення – одне за допомо-

гою кисті, інше за допомогою аерографа, так, щоб була очевидна 

відмінність між ними. 

 

Малювання ліній. 

Завдання 15. 

Pencil Tool   

малювання прямих ліній і ліній до-

Інструмент «олівець» дозволяє користувачеві ма-

лювати довільні лінії з жорсткими межами; перш за все 
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вільної форми він використовується у роботі з бітовими зображеннями. 

 

Завдання 15.1. Використання інструментів малювання прямих ліній і ліній дові-

льної форми. 

 

Як ви бачите, на верхній частині малюнка використаний ін-

струмент малювання прямих ліній. Він дозволяє малювати лінії 

будь-якої товщини, а також лінії з наконечником у вигляді стрілки. 

На нижній частині малюнка використаний інструмент малю-

вання ліній довільної форми (олівець). 

Створіть новий файл і потренуйтеся у використанні цих ін-

струментів. 

 

Градієнт. 

Завдання 16. 

Gradient Tool  

градієнт 
Заповнює область плавним переходом від одного кольору до іншого 

 

Завдання 16.1. Використання градієнтної заливки. 

 

Для того, щоб використовувати градієнтну заливку, треба: 

1. За допомогою інструментів виділення виділити область, 

для якої буде виконана заливка. 

2. Вибрати інструмент градієнтної заливки. 

3. При натиснутій лівій клавіші мишки провести через всю 

виділену область ( перекреслюючи виділену область у напрям-

ку заливки). Після того, як ви відпустите ліву клавішу, виділе-

на область буде заповнена градієнтною заливкою. 

4. Параметри градієнта можна міняти у додатковому вікні, 

яке з'являється на вашому екрані після того, як ви вибираєте 

інструмент градієнтної заливки. 

  

 

Змазування меж зображення. 

Завдання 17. 

Blur Tool 

- інструмент для змазування меж зображення (Blur); підвищення чіткості 
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(Sharpen); змазування по траєкторії (Smudge).  

 

Завдання 17.1. Використання інструментів для змазування меж і змазування по 

траєкторії. 

 

На правому зображенні ви бачите резуль-

тат використання інструментів для змазу-

вання меж зображення (Blur) - він застосова-

ний до джемпера; і змазування по траєкторії 

(Smudge) - він застосований до зачіски. 

Збережіть цю фотографію у себе на диску 

і виконайте аналогічні операції з нею. 

Збережіть нове зображення. 

 

 

Збільшення і зменшення яскравості зображення. 

Завдання 18. 

Dodge Tool 

 

Збільшує яскравість Dodge Tool; зменшує яскравість Bum Tool; змінює на-

сиченість кольорів Sponge Tool (губка). 

 

Завдання 18.1. Використання інструментів для збільшення і зменшення яскраво-

сті зображення. 

 

На правому зображенні видно результат 

застосування інструментів збільшення яск-

равості зображення (кішка) і збільшення 

якості зображення (фон). 

Збережіть ліву фотографію у себе на 

диску і виконайте з нею аналогічні дії. 

Збережіть отримане зображення на 

диску. 
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ЛАБОРАТОРНА РОБОТА  №1 

(Частина 2) 

Поняття об’єкта в ADOBE PHOTOSHOP.  

Основи малювання. 

 

Мета роботи: отримати навички роботи з програмою Adobe Photoshop. 

Навчитися створювати об’єкти: лінії, геометричні фігури, криві лінії. Навчити-

ся використовувати сітку, лінійку та направляючі. 

Обладнання і програмне забезпечення: Photoshop cs2, процесор Intel 

Pentium 4, Microsoft Windows XP з пакетом Service Pack 3, 1 Гб ОЗУ, монітор з 

1024x768 (рекомендується 1280x800), відеокарта з підтримкою OpenGL 2.0, і 

16-розрядних кольорів, 256 Мб відеопам’яті.   

 

Теоретична частина 

Кожен створюваний у програмі Adobe Photoshop документ спочатку складається тіль-

ки із тла (фону). Якщо говорити мовою аналогій, то фоновий шар можна зрівняти з полотном 

художника. Фоновий шар може бути білим, пофарбованим у поточні кольори заднього плану 

або прозорим. Ці параметри (характеристики) ви можете задавати щораз при створенні ново-

го зображення. Вручну ви можете додати в документ один або кілька шарів. Шари надають 

користувачеві можливість редагувати окремі елементи зображення незалежно один від одно-

го. Таким чином, ви можете змінювати й переміщати вміст будь-якого шару, не зачіпаючи 

при цьому об'єкти, розташовані на інших шарах.  

 

На вкладці Layers палітри шарів перелічені усі шари зображення, починаючи з верх-

нього; background-шар завжди розташовано у самому кінці таблиці. Коли ви клацаєте по зна-

чку Create new layer (створити новий шар), Photoshop визначає, скільки шарів уже задіяно в 
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зображенні, і автоматично присвоює новому шару наступний порядковий номер. Але такі 

назви шарів не завжди зручні. Якщо вам потрібно швидко ідентифікувати вміст шару, ви 

можете дати йому індивідуальне ім'я. Для цього потрібно створювати нові шари трохи більш 

довгим шляхом, а саме через меню палітри Layers (Шари), пункт New Layer (Новий шар).  

Можна також перейменувати вже створений шар, клацнувши двічі по його заголовку 

на палітрі Layers (Шари) що дасть вам доступ до діалогового вікна Layer Option (Параме-

три шару). Тут ви можете ввести нове ім'я в поле Name (Им’я).  

Якщо ви при натиснутій клавіші Ctrl укажете на будь-яку ділянку багатошарового зо-

браження правою кнопкою миші, то під курсором з'явиться інформація про всі лежачі під 

ним шари. Якщо при натиснутих одночасно клавішах Ctrl й Alt указати курсором миші на 

піктограму потрібного шару в палітрі шарів, то у вікні редагування цей шар буде повністю 

виділеним. Якщо при натиснутій клавіші Alt указати курсором миші на "око", що намальова-

но напроти піктограми будь-якого шару, то всі інші шари, крім відзначеного, стануть неви-

димими. Цей режим зручний, коли потрібно оперативно переглянути вміст тільки одного 

шару. Коли опція Preserve Transparency (Зберегти прозорість) не встановлена, то в прозо-

рій області шару зображення можна додавати кольори. При установці цієї опції прозорі об-

ласті будуть захищені, й редагувати можна тільки пофарбовані пікселі. Напівпрозорі пікселі 

збережуть свій рівень прозорості незалежно від застосовуваних команд. На вкладці Layers, 

ліворуч від імені шару, зображена зменшена копія його вмісту. Ці мініатюри постійно обно-

вляються у процесі редагування. 

Всі команди редагування застосовуються лише до активного у даний момент шару, 

що виділяється підсвічуванням, якщо на нього вказати курсором миші. Для того, щоб швид-

ко перемістити той або інший шар на один рівень нагору або вниз, досить при активному 

шарі нажати, відповідно, клавіші Ctrl +] або Ctrl +/.  

Використовуючи режими накладення, ви зможете більш вільно "грати" з текстом й 

іншими елементами зображення, домагатися спеціальних ефектів, за замовчуванням недо-

ступних, змінювати параметри прозорості й режимів накладення, не змінюючи при цьому 

графічного (фактичного) вмісту шарів. За допомогою команди Flatten Image ви можете об'є-

днати шари. Доти, поки ви не об'єднаєте шари, кожний з них буде залишатися незалежним 

структурним елементом зображення. Шари зберігаються у користувальницькому вигляді при 

збереженні у форматі Adobe Photoshop. Будь-які інші формати не підтримують шарів.  
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Хід роботи. 

1. Скляна сфера 

Ви можете створити сферу використовуючи лише 

стилі шару [Layer>Layer Style]. 

 

Для початку створіть шар і помістіть в нього круг - 

як ви бачите тут. 

 

Тепер застосуйте ефект внутрішнього світіння 

[Layer>Layer Style>Inner Glow] (з параметрами, 

як на малюнку). 
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Внутрішня тінь [Layer>Layer Style>Inner shadow]  

 

Рельєф [Layer>Layer Style>Bevel and Emboss]  

 

и тінь [Layer>Layer Style>Drop shadow] 
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Шар 1 (Layer 1) повинен вийти таким, як ви бачите 

на картинці. 

 

Виділіть коло і додайте новий шар. Потім йдіть в 

[Select>Modify>Contract]. Поставте там значення 

біля 5-10 пикселей. Тримайте натиснутою клавішу 

Alt і з допомогою Elliptical Marquee  зробіть виді-

лену область такої форми, щоб вона стала схожою 

на великий відблиск у верхній частині кулі. Запов-

ніть її світлим кольором і поставте значення прозо-

рості (Opacity) 8 - 10%. 

 

Застосуєте до цього шару ефект зовнішнього сві-

тіння [Layer>Layer Style>Outer Glow] з даними 

значеннями. 
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Створіть новий шар, зробіть виділення у вигляді 

маленького овалу за допомогою Elliptical Marquee 

Tool і поверніть його вліво. Заповніть білим кольо-

ром. Застосуйте зовнішнє світіння [Layer>Layer 

Style>Outer Glow] з такими ж значеннями і поста-

вте значення прозорості (Opacity) 50%. 

 

 

Створіть новий шар і зробіть виділення у вигляді 

вужчого і маленького овалу усередині попередньо-

го овалу. Заповніть білим і поверніть його так, як 

ви бачите на зображенні.  
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Застосуйте зовнішнє світіння [Layer>Layer 

Style>Outer Glow] для цього шару з такими зна-

ченнями, а прозорість (Opacity) залиште рівною 

100%. 

 

Скопіюйте ваш овал і вставте в новий шар. Засто-

суйте зовнішнє світіння [Layer>Layer Style>Outer 

Glow] для цього шару з такими значеннями а про-

зорість (Opacity) поставте рівною 20 - 30%. 

 

Тепер малюнок виглядає готовим. Ніяких фільтрів. 

Він створений, застосовуючи лише стилі шару і 

прозорість. 

 

 

Малюємо ліс 
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Створимо документ 500х400px (ctrl+n). Створимо но-

вий шар (ctrl+shift+n) і назвемо його fon. #2A690B. 

Беремо. круглу м'яку кисть (B), розміром приблизно 

500. Встановлюємо колір переднього плану #4F9F27. 

Кистю натисніть один раз в лівому верхньому кутку 

полотна. Це надалі буде свічення сонця через ліс. Те-

пер зменшуємо розмір кисті до 400 і ще раз натискає-

мо в кутку, але тепер уже кольором #D4F14D. Знову 

збільшуємо розмір кисті до 500, вибираємо колір пе-

реднього плану #163D03 і клікаємо в нижній правий 

кут. Результат повинен бути схожий на скріншот. 

 

Все, фон у нас є. Створимо новий шар і назвемо його 

Leaves, що означає листя. Беремо кисть (B) і встанов-

люємо її розмір 55, а колір переднього плану #385F16. 

Подивіться стандартні кисті, серед них ви знайдете 

листя, вибираємо цю кисть. Малюємо вгорі небагато 

листя. Потім беремо Burn tool (O): 
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Випалюємо верхній правий кут тим же листям розмі-

ром 55, колір значення не має. Потім вибираємо Dodge 

tool і висветлюємо листя біля сонця. 

 

Створюємо новий шар між шарами fon и leaves. На-

звемо його Grass. Беремо кисть у вигляді трави, з роз-

міром 70, кольором #A4D479 (для переднього плану) і 

#385F16 (для заднього плану). Малюємо лінію трави, 

не зачіпаючи нижній край нашої картини. 

 

Створюємо новий шар між шарами fon и leaves. На-

звемо його Grass. Беремо кисть у вигляді трави, з роз-

міром 70, кольором #A4D479 (для переднього плану) і 

#385F16 (для заднього плану). Малюємо лінію трави, 

не зачіпаючи нижній край нашої картини. 

 

Тепер робимо розмір кисті 112, колір #629633, 

#1B3405 й на тому ж шарі малюємо траву в нижній 

частині картини. 
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Картина майже готова. Додамо небагато сонячних 

променів. Між шарами Grass іLeaves створюємо ще 

один шар, який назвемо  light. Беремо Gradient tool (g). 

Робимо обидва кольори #FFFED5. Далі слідуємо уста-

новкам, показаним на скріншоте. 

 

 

 

Після того, як усе зроблено малюємо градієнт, як по-

казано на скріншоті. 

 

Тепер картина повинна виглядати так. 
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Зменшуємо прозорість до 20%. 

Робимо активним шар grass. Об'єднуємо шари (ctrl+E). 

Тепер фон і шар з травою у вас об'єднані. Йдемо (Filter 

> Render > Lens Flare...). Ставимо установки, як пока-

зано на скріншоті. 

 

 

 

 

Вимоги до звіту: 

1. Назва роботи. 

2. Мета роботи та завдання. 

3. Короткий реферат з теоретичної частини. 

4. Хід виконання роботи з результатами. 

5. Висновки. 

 

Контрольні запитання 

 

1. Які ви знаєте інструменти Photoshop для малювання?  

2. Яку інформацію відображає палітра info?  

3. Для чого використовуються шари в  Photoshop.  

4. Які інструменти використовуються для отримання градації кольору в зобра-

женні? 
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ЛАБОРАТОРНА РОБОТА  №2 

Колірна корекція зображень засобами Photoshop 

 

Мета роботи: Ознайомлення з основними інструментами Photoshop для 

колірної корекції зображення.   

Обладнання і програмне забезпечення: Photoshop cs2, процесор Intel 

Pentium 4, Microsoft Windows XP з пакетом Service Pack 3, 1 Гб ОЗУ, монітор з 

1024x768 (рекомендується 1280x800), відеокарта з підтримкою OpenGL 2.0, і 

16-розрядних кольорів, 256 Мб відеопам’яті.   

Завдання роботи: 

1. Здійснити корекцію зображення, використовуючи команду 

Variations. Ознайомитись теоретично та практично з основними можливостями 

команди Variations.  

2. Здійснити корекцію запропонованого викладачем зображення, ви-

користовуючи команди Color Balance і Hue/Saturation. Ознайомитись теоретич-

но та практично з основними можливостями команд Color Balance і 

Hue/Saturation.  

3. Здійснити корекцію запропонованого викладачем зображення, ви-

користовуючи команду AUTO COLOR CORRECTION . Ознайомитись теоретично 

та практично з основними можливостями команди AUTO COLOR CORRECTION.  

4. Здійснити корекцію запропонованого викладачем зображення, ви-

користовуючи інструмент EYEDROPPER . Ознайомитись теоретично та прак-

тично з основними можливостями інструмента EYEDROPPER .  

5. Здійснити корекцію запропонованого викладачем зображення, ви-

користовуючи інструмент Set Gray Point. Ознайомитись теоретично та практи-

чно з основними можливостями інструмента Set Gray Point .  

6. Здійснити корекцію запропонованого викладачем зображення, ви-

користовуючи фільтр Photo Filter. Ознайомитись теоретично та практично з 

основними можливостями фільтра Photo Filter.  
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7. Здійснити зміну кольорів у зображенні запропонованому виклада-

чем,  використовуючи інструменти Photoshop. 

Теоретична частина 

Однією з найважливіших проблем в поліграфії є проблема достовірного перенесення 

кольорів на всіх етапах роботи з кольоровими зображеннями. Основне завдання, яке вирі-

шують поліграфічні технології, — це високоякісний друк кольорових зображень, максима-

льно наближених по відтворенню кольорів до оригіналу. Досконалості немає межі, особливо 

коли це стосується відтворення кольору.  

Велику кількість оригіналів, що поступають у поліграфічне виробництво, складають 

саме багатоколірні оригінали. Кольорові оригінали – це кольорові зображення на площині 

(фотографії, малюнки, слайди, графіка, зокрема, комп'ютерна). Вони відіграють особливу 

роль в структурі будь-якого видання, особливо у виданнях, що несуть окрім інформаційного 

та естетичного, також і емоційне навантаження, наприклад, в рекламних або художніх ви-

даннях. Для репродукції таких оригіналів необхідно здійснити спеціальні перетворення, що 

забезпечують можливість їх поліграфічного відтворення, головними з яких є кольороділення 

і растрування (для тонових оригіналів). Усі ці перетворення призводять до спотворень, які 

позначаються на градаційних,  колірних  та інших властивостях результуючого зображення. 

В даній лабораторній роботі нас цікавитимуть лише колірні спотворення. Головним 

чином ці спотворення пов'язані з кольороділенням і називаються кольороподільними. Їх 

прийнято розділяти на дві  групи:  

• Спотворення, спричинені наявністю у фарб додаткових «шкідливих» спектра-

льних поглинань у виділеній частині спектру 

• спотворення, пов’язані з неповним, недостатнім поглинанням у виділеній час-

тині спектру 

• неточна передача градації на кольороподілених зображеннях 

• обмежений колірний охват поліграфічного відтворення 

Оскільки колірні спотворення зазвичай визначаються сукупністю кольороподільних і 

градаційних спотворень, то, в загальному випадку, одночасно застосовується і градаційна, і 

кольороподільна корекції. Метою градаційної корекції є зміна градієнтів кольороподілених 

зображень для забезпечення їх балансу, а кольороподільної – усунення спотворень, що вини-

кають через недосконалість фарб і світлофільтрів. 

Широке впровадження комп'ютерної техніки в технологічні процеси поліграфічного 

виробництва, особливо в додрукарські, призвело практично до повної відмови від систем 

повноформатної обробки. На даний час кольорокорекція здійснюється із використанням 

комп'ютерної техніки. Сучасні засоби програмного забезпечення для обробки образотворчої 
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інформації, що призначені для поліграфічної репродукції, усувають основні недоліки кольо-

роділення. Крім того, програмні засоби дозволяють розв’язувати завдання загального і лока-

льного освітлення або затемнення, зміни контрасту зображення, регулювання балансу кольо-

рів по нейтральних тонах, що мають колірне зміщення, зміни насиченості, колірного тону, і 

навіть завдання повної заміни кольору. 

Основні колірні моделі. 

В результаті дії на око потоків електромагнітного випромінювання у діапазоні довжин 

хвиль, в якому це випромінювання сприймається оком (видимий діапазон — довжин хвиль – 

від 380 до 760 нм) виникає колірне відчуття. Різні колірні відчуття викликають різнозабарв-

лені предмети, їх різноосвітлені ділянки, а також джерела світла і створюване ними освіт-

лення. У загальному випадку колір предмету обумовлений наступними чинниками: його за-

барвленням і властивостями його поверхні; оптичними властивостями джерел світла і сере-

довища, через яке світло розповсюджується; властивостями зорового аналізатора і особливо-

стями ще недостатньо вивченого психофізіологічного процесу переробки зорових вражень в 

мозкових центрах. 

При якісному опису кольору використовують три його суб'єктивних атрибути: колір-

ний тон, насиченість і світність. Найбільш важливим атрибутом кольору є колірний тон 

("відтінок кольору") - асоціюється в людській свідомості з обумовленістю забарвлення пред-

мету певним типом пігменту, фарби, фарбника (при субтрактивному змішуванні (друці).) 

Насиченість характеризує ступінь, рівень, силу прояву колірного тону. Цей атрибут в людсь-

кій свідомості пов'язаний з кількістю (концентрацією) пігменту, фарби, фарбника. Сірі тони 

називаються ахроматичними (безбарвними). Вважають, що вони не мають насиченості і роз-

різняються лише світністю. Світність свідомість зазвичай пов'язує з кількістю чорного або 

білого пігменту, рідше – з освітленістю. 

Колірний простір – графічне представлення розмірностей кольору. Будь-який колір 

або кольорове зображення можуть бути закодованими за допомогою 3-х основних моделей: 

RGB, CMYK і Lab. Кольорокорекція в різних колірних моделях має свої специфічні особли-

вості, тому спочатку розглянемо основи теорії про самі колірні простори.  

1. Колірний простір RGB. 

Для більшості сканерів рідною є трьохканальна модель яскравості RGB. Вона є логіч-

ним продовженням способу оцифрування зображення сканером. Три лінійки чутливих еле-

ментів за допомогою червоного, синього і зеленого фільтрів сприймають свою частину спек-

тру падаючого на них світла і перетворять його в електричний струм. За допомогою аналого-

цифрових перетворювачів електричний сигнал квантується і у вигляді двійкових цифр запи-

сується у файл на диск комп'ютера. Ця ж колірна модель використовується в електронно-

променевих трубках моніторів. У цій моделі колір складається з 3-х складових: червоної -
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Red, зеленої, - Green і синьої - Blue, тому ця модель називається адитивною (оскільки вона 

заснована на адитивному синтезі кольору – складанні потоків світла). 

До переваг цієї моделі можна віднести: 

- природність її апаратурної (сканером і монітором) реалізації - широкий колірний ох-

ват (можливість відображати різноманіття кольорів, що близьке до можливостей людського 

зору); 

-  доступність багатьох процедур обробки зображення (фільтрів) в програмах растро-

вої графіки, - невеликий (в порівнянні з моделлю CMYK) об'єм, займаний зображенням в 

оперативній пам'яті комп'ютера і на диску. 

До недоліків цієї моделі можна віднести: 

- корельованість колірних каналів (при збільшенні яскравості одного каналу інші зме-

ншують її) 

- можливість помилки представлення кольорів на екрані монітора по відношенню до 

кольорів, що отримуються в результаті кольороділення (переходу в модель CMYK).  

2. Колірний простір CMYK. 

На жаль, не можна створити фарб, аналогічних RGB, для друку. Вся річ у тому, що ці 

кольори працюють тільки "на просвіт", тобто через плівку-фільтр або люмінофор монітора. 

Альтернативний спосіб змішування кольорів (адитивний – субтрактивний («віднімання від 

білого») – змішування світлових потоків та змішування фарб). У друці все відбувається на-

впаки, тобто папір поглинає весь спектр за винятком того кольору, в який він пофарбований. 

Але створити фарби, що є абсолютно точно "протилежними" (додатковими) до кольорів RGB 

не вдається, тому довелось ввести четвертю додаткову фарбу – чорну для введення чорного є 

два важелі. Її завдання – підсилити поглинання світла в темних областях, зробити їх макси-

мально чорними, тобто збільшити тоновий діапазон друку. Неідеальна «протилежність» 

фарб приводить до того, що для отримання сірих нейтральних відтінків необхідно накладати 

тріадні фарби не в рівних пропорціях, як у випадку RGB, а з надлишком блакитного. Зазви-

чай його (Cyan) потрібно на 15-20% більше ніж пурпурного (Magenta) і жовтого (Yellow). Це 

наочно видно в графіці налаштування друкарських фарб Ink SetUp в PhotoShop. 

Тріадний напівтоновий друк здійснюється за допомогою технології кастрування, – 

коли відтінки кольору отримуються за рахунок зміни площі растрових елементів (амплітуднн 

растрування) або їх частоти на одиницю площі (частотне кастрування). 

Модель CMYK є субтрактивною, тобто чим більше накладається фарби, тим темні-

шими виходить колір. 

перевагою цієї моделі є: 

- незалежність каналів (зміна відсотку будь-якого з кольорів не впливає на інших); 
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- це природна модель для тріадного друку; лише її розуміють растрові процесори – 

RIP вивідних пристроїв (зображення RGB на плівках можуть вийти сірими лише на чорній 

фотоформі). 

Недоліками цієї моделі є: 

- вузький колірний охват, обумовлений недосконалістю пігментів і властивостями па-

перу; 

- не зовсім точне відображення кольорів CMYK на моніторі; 

- багато фільтрів растрових програм в цій моделі не працюють; 

- потрібний об’єм пам’яті, на 30% більший у порівнянні з моделлю RGB.  

3. Колірний простір HSB. 

У цій моделі кольори визначаються за допомогою трьох критеріїв, які люди розпізна-

ють інтуїтивно: колірного тону (Hue), насиченості (Saturation) і яскравості (Brightness). (У 

найраніших версіях програми Photoshop дійсно був колірний режим HSB. Він більше в ній не 

використовується, але HSB ще можна побачити, якщо у середовищі Photoshop тимчасово 

встановити палітру кольорів фірми Apple, виконавши для цього команду File-Preferences-

Genera (Файл-Установки-основні).) 

Колірний простір HSB представлений у вигляді циліндра. Колірний тон – це кольори 

колірного круга RGB/CMY. Якщо простір HSB представити у вигляді тривимірного цилінд-

ра, то видимий спектр кольорів розташовується по колу, де кожному кольору відповідає пев-

ний кут. Насиченість означає інтенсивність кольору. Наприклад, м'який пастельно-

оранжевий колір має слабку насиченість; яскраво-оранжевий, навпаки, сильно насичений. У 

циліндрі HSB кольори в центрі мають насиченість, рівну 0, яка створює один з сірих відтін-

ків. У міру переміщення до зовнішньої межі насиченість кольору наростає.  

Яскравість (колірна, а не світлова) означає інтенсивність кольору, або наскільки світ-

лим або темним він виглядає. При менших значеннях яскравості колір затемняється, ство-

рюючи те, що ви сприймаєте як темний відтінок.  

4. Колірний простір LAB. 

Ця модель найточніше описує параметри кольору, оскільки володіє найширшим охва-

том. Її часто використовують як внутрішню модель багатьох програмних продуктів, і з її до-

помогою в них здійснюється перехід з однієї колірної моделі в іншу. 

Перевагою даної моделі є те, що в ній інформація про колірність та яскравість розді-

лені і є незалежними. Це дає можливість змінювати тонові градаційні характеристики зобра-

ження, не торкаючи колірні. Використання фільтрів в каналі Lightness не спотворює колірну 

інформацію. 

Ще однією  перевагою системи Lab є її рівноконтрастність. Рівноконтрастність систе-

ми означає, що в будь-якому колірному діапазоні рівні колірні відмінності виражатимуться 
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рівними числовими величинами, що визначаються у даній системі (у всіх зонах пороги розрі-

знення будуть однакові).  

Хід виконання роботи 

 

1. Здійсніть корекцію зображення, використовуючи команду 

Variations. Ознайомтесь теоретично та практично з основними можливостями 

команди Variations.  

Команда Variations (для активізації якої потрібно вибрати команду Image -> 

Adjustments -> Variations (Зображення -> Корекція -> Варіанти)) — дуже корисний ін-

струмент Photoshop, з якого необхідно починати роботу, якщо ви хочете відкоректувати від-

тінки в зображенні. Ця команда нагадує кругові діаграми кольорів, які впродовж багатьох 

років використовувалися при друці фотографій. Команда Variations пропонує цілий ряд ва-

ріантів зображень, в яких змінюється співвідношення між певними парами доповнюваних 

кольорів (червоний і блакитний, зелений і пурпурний, синій і жовтий (рис. 1)).  

 

Рис.1. Діалогове вікно Variations. 

 

Поряд з кнопками OK і Cancel розташований ряд перемикачів, що дозволяють вибра-

ти критерій, на якому базуються отримувані варіанти: Shadows (Тіні), Midtones (Середні 

тони), Highlights (Світлі тони) або Saturation (Насиченість). При використанні команди 

Variations для колірної корекції рекомендується починати з середніх тонів і переходити до 

найсвітліших. Єдина проблема, пов'язана з використанням команди Variations, полягає в 

тому, що це шар, що не коректує, тому всі зміни застосовуються безпосередньо до пікселів 
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зображення. Для того, щоб запобігти змінам початкового зображення, завжди працюйте або з 

копією зображення, або з копією фонового шару. Початкове зображення, показане на рис. 2 

зліва, отримане в приміщенні при освітленні флуоресцентною лампою за допомогою цифро-

вої камери, налаштованої на денний баланс кольору, через що воно здається жовто-зеленим. 

Скориставшись командою Variations, отримано більш вдалий варіант фотографії (рис 2. 

справа).  

 

 

Рис.2. Початкове та оброблене зображення.  

 

1. Скористайтеся інструментом Eyedropper (Піпетка) і палітрою Info, щоб вивчити 

параметри області зображення, яка має бути нейтральною. Оскільки ви самі не були у цій 

кімнаті, як можна визначити, яке саме освітлення є для неї природним. Використовуйте вла-

сну візуальну пам'ять про подібну сцену, щоб задати відповідні нейтральні відтінки в зобра-

женні. На рис. 3 представлені наступні значення: 193 — для червоного, 214 — для зеленого і 

237 — для синього. 
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Рис.3. Використання палітри Info. 

 

Команда Variations — це інструмент візуальної оцінки. У палітрі Info не відобража-

ються значення до і після оцінки змін, тому не потрібно хвилюватись, якщо діалогове вікно 

Variations закрило всю робочу область.  

Більше значення для синього каналу в порівнянні із значеннями для інших каналів 

вказує на те, що зображення характеризується вираженим синім відтінком, а мале значення 

червоного — на те, що зображення також володіє блакитним відтінком. При належній корек-

ції значення RGB не повинні значно відрізнятися один від одного. 

2. Створіть копію фонового шару. Таким чином, ви зможете зберегти початкове зо-

браження при наступних експериментах.  

3. Виберіть команду Image -> Adjustments -> Variations і встановіть перемикач 

Midtones (Середні тони). Для того, щоб побачити, як команда Variations змінює протилеж-

ний колір, перетягніть повзунок під перемикачем Saturation (Насиченість) вправо. Приклад 

різних варіантів одного і того ж зображення приведений на рис.4.  
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Рис.4. Ступінь змін, що вносяться за допомогою команди Variations. 

 

4. Щоб вносити повільніші корективи, переміщуйте повзунок Strength (Ступінь) влі-

во, наприклад до одного положення вправо щодо значення Fine (Точно). Клацніть на варіан-

ті More Yellow (Більше жовтого), щоб звести до мінімуму синій відтінок. Щоб підкреслити 

отриманий ефект, клацніть на цьому варіанті ще один раз. В даному випадку для отримання 

результату, представленого на рис. 5, достатньо двох клацань на варіанті More Yellow і од-

ного клацання на варіанті More Red (Більше червоного) для зменшення блакитного відтін-

ку.  

 



 191 

 

Рис.5. Робота з діалоговим вікном Variations. Корекція середніх відтінків. 

 

5. Клацніть на кнопці OK і уважно розгляньте отримані результати, звернувшись до 

палітри Info (рис.6); в даному випадку отримані нейтральні відтінки, оскільки значення RGB 

рівні 224, 224, 224.  

 

Рис.6. Палітра  Info. 

 

 Дослідіть нейтральні області в зображенні, використовуючи інструмент Eyedropper, 

після чого зверніться до палітри Info, щоб переконатися у відсутності загального відтінку 

зображення.  

Особливості роботи з командою Variations: 
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• При роботі з діалоговим вікном Variations можна відмінити всі зміни, якщо 

клацнути на початковому варіанті зображення у верхньому лівому кутку вікна.  

• Внесені зміни можна зберегти, а потім завантажити при роботі з іншими зо-

браженнями.  

• Якщо ви відкрили вікно Variations вдруге, автоматично будуть застосовані 

зміни, задані останніми.  

• Команду Variations можна використовувати для отримання певних результа-

тів, таких як створення відтінку. Для цього досить клацнути на червоному і жовтому варіан-

тах і зменшити насиченість. 

 

2. Здійсніть корекцію запропонованого викладачем зображення вико-

ристовуючи команди Color Balance і Hue/Saturation. Ознайомтесь теоретично та 

практично з основними можливостями команд Color Balance і Hue/Saturation.  

 

1. Перевірте параметри зображення за допомогою інструменту Eyedropper і палітри 

Info. Використайте інструмент Color Sampler, щоб додати контрольні точки на одягу жінки, 

а також на стіні будівлі на задньому плані. Зверніть увагу, що контрольні точки, які мають 

бути нейтральними, містять синій відтінок (рис. 7).  

 

Рис. 7. Дві контрольні точки явно вказують на наявність синього відтінку. 

 

2. Додайте шар Color Balance, що коректує (Layer -> New Adjustment Layer -> Color 

Balance). 

3. За умовчанням, вибраний перемикач Midtones (Середні тони) і встановлений пра-

порець Preserve Luminosity (Зберегти свічення) — це дуже непогана відправна точка для 
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початку процесу кольорокорекції. Щоб зменшити відтінок синього, перемістіть повзунок 

Yellow-Blue (Жовтий–синій) вліво до значення -42 (рис. 8). Синій відтінок може бути схо-

жий на блакитній, тому є зміст збільшити значення червоного відтінку на 7 одиниць. Клац-

ніть на кнопці OK.  

 

 

Рис.8. Робота над середніми тонами в зображенні для усунення синього відтінку. 

 

4. Для зміни відтінку стіни додайте коректуючий шар Hue/Saturation (Layer -> New 

Adjustment Layer -> Hue/Saturation). Із списку Edit (Редагувати) виберіть значення Blues 

(Сині). Виберіть інструмент Eyedropper і клацніть ним на стіні. Ви побачите індикатори на 

градієнтній смузі в нижній частині діалогового вікна Hue/Saturation. Натисніть клавішу 

Shift і перетягуйте інструмент по стіні, щоб розширити діапазон відтінків, які слід змінити.  

5. Переміщайте повзунок Saturation вліво, поки на стіні не зникне непотрібний відті-

нок. Зверніть увагу, що значення в палітрі Info тепер відповідають нейтральним відтінкам.  

6. Додайте світло від цифрового спалаху, щоб освітлити тіні на обличчях. Виберіть 

команду Layer -> New -> Layer, виберіть із списку Mode значення Overlay і встановіть пра-

порець Fill with Overlay-neutral color (50% gray). Скористайтеся м'якою білою кистю з не-

прозорістю (Opacity) 20% для освітлення людей (рис. 10).  
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Рис. 9. Усунення синього відтінку із стіни за допомогою коректуючого шару 

Hue/Saturation. 

 

 

 

Рис. 10. Освітлення тіні у режимі накладення Overlay. 
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3. Здійсніть корекцію запропонованого викладачем зображення вико-

ристовуючи команду AUTO COLOR CORRECTION . Ознайомтесь теоретично та 

практично з основними можливостями команди AUTO COLOR CORRECTION.  

Засоби Auto Color Correction надають можливість швидко і легко виконати цілу низ-

ку завдань по налаштуванню балансу кольорів, що важливо при роботі із зображеннями, 

отриманими за допомогою цифрових фотоапаратів. Зазвичай не рекомендується використо-

вувати команди Auto Levels (Автоматичні рівні), Auto Contrast (Автоматичний контраст) 

і Auto Color (Автоматичний колір), які знаходяться в меню Image -> Adjustments, оскільки 

у вас не буде жодної можливості контролювати значення параметрів при зміні зображення, 

та при цьому не використовуються коректуючі шари (Layer -> New Adjustment Layer).  

Кнопка Auto є в діалогових вікнах Levels (Image -> Adjustments -> Levels) і Curves 

(Image -> Adjustments -> Curves). Клацання на цій кнопці дозволяє виконати стандартні дії 

з корекції зображення, незалежно від того, яким чином ви отримали до неї доступ. Оскільки 

розмір діалогового вікна Levels менший, працюватимемо саме з ним; при цьому можна поба-

чити велику частину зображення, отримуючи ті ж самі результати. Клацання на кнопці 

Options дозволяє відкрити діалогове вікно Auto Color Correction Options (рис. 11). Тут ви 

зможете вплинути на те, як здійснюватиметься корекція кольорів зображення.  

 

Рис. 11. Діалогове вікно Auto Color Correction Options можна відкрити з діалогових 

вікон Levels і Curves. 

 

У діалоговому вікні Auto Color Correction Options міститься шість параметрів, які 

дозволяють визначити, як саме здійснюватиметься корекція кольору в зображенні.  

Enhance Monochromatic Contrast (Поліпшити монохроматичний контраст). 

Photoshop “обрізає” всі колірні канали одночасно, використовуючи однакові значення пара-

метрів для кожного з них, внаслідок чого тіні стають темнішими, а яскраві відтінки — ще 
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світлішими. Використання цього параметра цілком аналогічне застосуванню команди Image 

-> Adjustments -> Auto Contrast або переміщенню білого і чорного повзунків у діалоговому 

вікні Levels на початок відомостей про зображення на композитній гістограмі RGB або 

CMYK.  

Enhance Per Channel Contrast (Поліпшити контраст по каналах). Photoshop “обрі-

зає” колірні канали окремо. Використання цього параметра цілком аналогічне переміщенню 

білого і чорного повзунків у діалоговому вікні Levels на початок відомостей про зображення 

на гістограмі RGB або CMYK для окремих колірних каналів. До таких же результатів при-

водить застосування команди Image -> Adjustments -> Auto Levels.  

Find Dark & Light Colors (Знайти темні і світлі кольори). Photoshop використовує 

найтемніші і світліші пікселі в зображенні як значення точки чорного і білого. До таких же 

результатів призводить застосування команди Image -> Adjustments -> Auto Color. Snap 

Neutral Midtones (Прив'язка до нейтральних середніх відтінків). Якщо цей прапорець 

встановлений, Photoshop знаходить в зображенні найбільш нейтральний відтінок і замінює 

його нейтральним сірим. До таких же результатів призводить застосування команди Image -

> Adjustments -> Auto Color.  

Target Color Clipping (Відрізіання кольорів). Встановіть процентні значення кольо-

рів, які програма Photoshop повинна ігнорувати. Наприклад, якщо для параметрів Shadows і 

Highlights встановити значення 0,02%, програма ігноруватиме 0,02% яскравих відтінків і 

тіней, перш ніж приступати до обчислень. Встановлене за умовчанням значення 0,5% вияв-

ляється дуже високим. Якщо вам необхідно, щоб при обчисленнях враховувалися кольори, 

відмінні від нейтральних, клацніть на зразку кольору, щоб відкрити діалогове вікно Color 

Picker, в якому ви зможете вибрати інший колір як яскравий або середній відтінок, а також 

тінь.  

Save as defaults (Зберегти як значення за умовчанням). Встановивши цей прапо-

рець, ви вкажете Photoshop на те, що задані значення параметрів необхідно використовувати 

за умовчанням після клацання на кнопці Auto в діалоговому вікні Levels або Curves. Звер-

ніть увагу на те, що якщо цей прапорець буде встановлений, задані вами значення параметрів 

в області Target Color Clipping за умовчанням застосовуватимуться після виконання коман-

ди Auto Levels, Auto Contrast або Auto Color. 

Команди автоматичної корекції. Для того, щоб отримати найбільш деталізоване зо-

браження при використанні команди Auto Color (Image -> Adjustments -> Auto Color), 

встановіть перемикач Find Dark & Light Colors і прапорець Snap Neutral Midtones та пе-

рекона’йтеся в тому, що встановлений прапорець Save as defaults. Задавши вибрані парамет-

ри як параметри за умовчанням, ви гарантуєте, що Photoshop застосовуватиме команду Auto 

Color після клацання на кнопці Auto в діалоговому вікні Levels або Curves. Клацніть на 
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кнопці OK. Якщо внесені зміни негативно позначилися на зображенні, скористайтеся коман-

дою Edit -> Undo, щоб відмінити зміни, проте задані вами параметри при цьому все одно 

залишаться в силі.  

Щоб ще більше вплинути на те, як саме діятиме команда Auto Color, знову відкрийте 

діалогове вікно Auto Color Correction Options, й задайте необхідні значення параметрів в 

групі Target Color Clipping, оскільки вказані за умовчанням значення 0,5% приводять до 

того, що тіні виявляються невиразними, а яскраві відтінки — розмитими. Почніть з того, що 

зменшите значення тіней до 0, а потім, використовуючи клавіші із стрілками, поступово збі-

льшуйте його з кроком 0,01%. Уважно спостерігайте за областями тіней і яскравих відтінків 

у зображенні; значення, менші, ніж задані за умовчанням, дозволяють отримати набагато 

більш природні тіні і яскраві відтінки (при цьому останні будуть яскраво-білими). 

За умовчанням середні відтінки відповідають бездоганному нейтральному сірому ко-

льору, проте при роботі з певними зображеннями цей варіант може виявитися далеко не най-

оптимальнішим. Ви зможете легко змінити значення відповідного параметра, причому, як і у 

разі інших параметрів, зробити це можна в інтерактивному режимі. 

На фотографії, представленій на рис. 12, собака трохи темний, а біле хутро володіє 

помітним синім (блакитним) відтінком через те, що під час зйомки був неправильно заданий 

баланс білого. Завдяки корекції кольору середніх тонів вдалося надати собаці природнішого 

вигляду (рис. 13).  

 

Рис. 12. Початкове зображення. 

 

Рис. 13. Зображення після корекції кольору середніх тонів. 
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1. Розмістіть контрольну точку на білому хутрі собаки. Задайте необхідний масштаб, 

щоб вибрати саме білий колір (рис. 14).  

 

Рис. 14. Розміщення контрольної крапки на білому хутрі собаки. 

 

2. Додайте коректуючий шар Levels (Layer -> New Adjustment Layer -> Levels) і кла-

цніть на кнопці Options (Параметри), щоб відобразити параметри, задані за умовчанням, які 

були описані вище. Зображення стане світлішим, завдяки чому буде більше помітним зага-

льний відтінок.  

3. Щоб зменшити синій (блакитний) відтінок, обов'язково встановіть прапорець Snap 

Neutral Midtones (Прив'язати до нейтральних середніх тонів), після чого клацніть на зра-

зку кольору середніх тонів в групі параметрів Target Colors & Clipping (Цільові кольори і 

втрата кольорів), щоб відкрити діалогове вікно Color Picker (Палітра кольорів). Оскільки 

блакитний відтінок найбільш помітний, клацніть в полі C% значень CMYK. Натискайте на 

клавіатурі клавішу із стрілкою вниз, щоб зменшити значення «блакитне». Після кожного на-

тиснення клавіші ви помітите, як зменшується блакитний відтінок. Зупиніться на значенні 

34%, оскільки при цьому блакитний відтінок стане практично непомітним. 

4. Клацніть в полі B значень RGB і натисніть клавішу відкриваючої круглої дужки - ( 

- до тих пір, поки не буде набуто значення 149. За допомогою інструменту Eyedropper ви-

значте значення в білій області на голові собаки. Ви отримаєте достатньо нейтральні значен-

ня (рис. 15).  
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Рис. 15. Зменшення значень блакитного і синього дозволило нейтралізувати загальний 

відтінок зображення. 

 

Вибіркове застосування автоматичних корекцій кольору. 

Оскільки засоби автоматичної корекції кольору оцінюють все зображення, результати 

їх застосування можуть виявитися достатньо несподіваними. Білі рамки або обгорілі краї 

(рис. 16) можуть зіпсувати отримані результати. Щоб уникнути цього, використовуйте тим-

часову маску для вибору областей застосовування засобів автоматичної корекції. Це дозво-

лить отримати хороші результати, як показано на рис. 17.  

 

 

Рис. 16. Початкове зображення. 
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Рис. 17. Зображення після застосування автоматичних корекцій кольору. 

1. Скористайтеся інструментом Marquee, щоб виділити важливу область зображення. 

В даному випадку це подружня пара (рис. 18).  

 

 

Рис.18. Виділення найбільш важливої області зображення. 

 

2. Додайте коректуючий шар Levels, який автоматично містить маску (Layer -> New 

Adjustment Layer -> Levels).  

3.Клацніть на кнопці Options і виберіть один з трьох доступних варіантів. Як показа-

но на рис. 19, комбінація Enhance Per Channel Contrast (Поліпшити контраст по каналах) 

і Snap Neutral Midtones дозволили отримати відмінні результати.  
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Рис. 19. Маска дозволяє застосовувати корекцію до найбільш важливої області зобра-

ження. 

 

4.Для того, щоб застосувати корекцію до всього зображення, перетягніть маску на 

значок корзини в нижній частині палітри Layers або клацніть на ній, натиснувши клавішу 

Shift, щоб тимчасово відключити (рис. 20).  

 

 

Рис. 20. Відключення маски. 

 

4. Здійсніть корекцію запропонованого викладачем зображення, вико-

ристовуючи інструмент EYEDROPPER . Ознайомтесь теоретично та практич-

но з основними можливостями інструмента EYEDROPPER .  

Використання інструментів Eyedropper діалогового вікна Levels або Curves для ви-

значення нейтральних відтінків білого, сірого або чорного – дуже ефективний спосіб вида-

лення загального відтінку зображення. На рис. 21 представлена характерна проблема, що 

виникає при зйомці сніжних пейзажів, — через яскравий сніг система помиляється, тому 

сцена виглядає темнішою і розмитою. Відкоректований варіант фото зображений на рис. 22.  
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Рис. 21. Початкове зображення. 

 

 

Рис. 22. Зображення після кольорокорекції. 

 

1. Перший крок полягає в ідентифікації колірного відтінку. Якщо ви працюєте з добре 

відкаліброваним монітором і здатні добре розрізняти кольори, то побачите, що сніг дуже си-

ній. Якщо ви не упевнені в перенесенні кольорів свого монітора, зверніться до палітри Info. 

Задайте для параметра Sample Size (Розмір зразка) інструменту Eyedropper значення 3 by 3 

Average (Середнє 3x3) на панелі параметрів, після чого побачите, які області зображення ви-

глядають нейтральними. Дане зображення містить значні області білого, проте всі зображен-

ня особливі. При розміщенні інструменту Eyedropper над нейтральним кольором, палітра 

Info дозволяє оцінити загальний відтінок зображення (рис. 23). Затіненому задньому плану 

відповідають наступні значення: 174 — для червоного, 182 — для зеленого і 206 — для си-

нього. В даному випадку більше значення синього для достатньо нейтрального зображення 

указує на те, що все зображення володіє синім відтінком.  
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Рис. 23. Значення RGB в палітрі Info. 

2. Додайте коректуючий шар Levels (Layer -> New Adjustment Layer -> Levels). Ви-

беріть білу піпетку (крайня права піпетка). Клацніть на яскравій ділянці снігу перед дверима, 

щоб задати нову точку білого. Зверніть увагу, що в палітрі Info значення червоного, зеленого 

і синього практично рівні, що вказує на те, що загальний відтінок практично усунений (рис. 

24). Вам слід експериментувати, поки не будуть знайдені найбільш оптимальні нейтральні 

точки в конкретному зображенні. Якщо вам не подобаються отримані результати, відмініть 

їх, натиснувши комбінацію клавіш Ctrl+Z. Також можна повернутися до початкового варіа-

нту зображення, клацнувши на кнопці Reset (Скидання) і одночасно натиснувши клавішу 

Alt.  

 

 

Рис. 24. Використання білої піпетки з діалогового вікна Levels для визначення нової 

крапки білого дозволило значно поліпшити колір і контрастність зображення. 
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Якщо натиснути клавішу Alt і перетягнути білий повзунок вліво, Photoshop вкаже, де 

саме знаходиться дійсна точка білого. Даний прийом застосовується і при визначенні точки 

чорного — досить перетягнути чорний повзунок вправо.  

3. Хоча основна частина відтінку усунена, а зображення стало яскравіше, воно все од-

но володіє холодним відтінком. Виберіть інструмент Set Gray Point (сіра середня піпетка) і 

клацніть нею на сірій огорожі в лівій частині зображення. Якщо зображення не містить поді-

бної зручної точки сірого, будь-яка біла будівля в тіні повинна володіти сірим відтінком. У 

даному зображенні точку сірого також можна розмістити поряд з найправішим вікном на 

другому поверсі.  

Порада: Якщо у вас відкрито діалогове вікно Levels, не забудьте про можливість пе-

реміщення по зображенню. Для збільшення масштабу можна використовувати комбінацію 

клавіш Ctrl++, а для зменшення — Ctrl+-. Крім того, при цьому можна використовувати 

смуги прокрутки. Якщо ви працюєте в стандартному екранному режимі, використовуйте 

комбінації клавіш Ctrl+Alt++ і Ctrl+Option+- для зміни розмірів вікна.  

4. При роботі з багатьма зображеннями корекції точки білого і сірого виявляється до-

статньо. Проте в даному випадку гістограма явно указує на те, що чорний повзунок можна 

перемістити вліво. Якщо поступити так само, контраст зображення значно покращиться (рис. 

25).  

 

Рис. 25. Переміщення чорного повзунка на початок гістограми дозволяє надати зо-

браженню набагато виразнішого вигляду. 

 

5. Визначивши положення точок білого і чорного, ще раз подивіться, як виглядає зо-

браження. Якщо зображення дуже темне або світле, перемістіть повзунок середніх тонів влі-

во, щоб освітлити його, або вправо, щоб затемнити.  

5. Здійсніть корекцію запропонованого викладачем зображення, вико-

ристовуючи інструмент Set Gray Point. Ознайомтесь теоретично та практично з 

основними можливостями інструмента Set Gray Point .  



 205 

Інструмент Set Gray Point, доступний в діалогових вікнах Levels і Curves, незамін-

ний для кольорокорекції старих зображень, які вицвіли або на яких з часом змістилися відті-

нки (рис. 26). Завдяки застосуванню інструменту Set Gray Point для зсуву нейтральних від-

тінків зображення почало виглядати набагато краще (рис. 27).  

 

 

Рис. 26. Початкове зображення. 
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Рис.27. Відкоректоване зображення.  

 

Тільки небагатьом людям відомо, якими кольорами характеризувалася відображена на 

фотографії сцена, проте, вдавшись до допомоги уяви, зображенню завжди можна надати реа-

лістичного вигляду. Подивившись на зображення, подумайте, що саме може характеризува-

тися нейтральним відтінком, — наприклад, асфальтова дорога. Це дозволить швидко позба-

витися від небажаного відтінку в зображенні.  

1.Додайте коректуючий шар Levels (Layer -> New Adjustment Layer -> Levels і клац-

ніть на асфальті інструментом Set Gray Point (рис. 28). При цьому можна клацати на інших 

ділянках зображення асфальту, а також на плащі, який тримає в руках дівчинка.  

 

Рис. 28. Використання сірої піпетки для визначення нейтральних областей. 

 

2. Перемістіть білий і чорний повзунки туди, де починаються фактичні дані гістогра-

ми (рис. 29). Як бачите, нейтральні області виявилися нейтральними, проте переміщення по-

взунків дозволило забезпечити коректне перенесення кольорів.  
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Рис. 29. Корекція колірних тонів в зображенні завдяки переміщенню чорного і білого 

повзунків. 

 

При роботі з діалоговим вікном Levels або Curves починати слід з сірої піпетки для 

видалення “наполегливих” відтінків або ж з білої, якщо точно знаєте, які саме області в зо-

браженні мають бути білими. Корекція світлих областей часто приводить до того, що темні 

області також виглядають коректно. Чим більше зображень ви обробите, тим більше корис-

ного досвіду набудете, а значить, зможете набагато швидше виконувати кольорокорекцію.  

6. Здійсніть корекцію запропонованого викладачем зображення, вико-

ристовуючи фільтр Photo Filter. Ознайомтесь теоретично та практично з осно-

вними можливостями фільтра Photo Filter.  

Іноді загальний відтінок зображення настільки виражений, що позбавитися від нього 

здається практично неможливо. Проте існує прийом, який дозволяє за допомогою коректую-

чого шару Photo Filter (Layer -> New Adjustment Layer -> Photo Filter буквально поверну-

ти значення Lab. Зараз спробуємо здійснити корекцію зображення, представлене на рис. 30.  
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Рис. 30. Зліва – початкове зображення. Справа – відкоректоване зображення.  

 

1. Додайте коректуючий шар Photo Filter (Фотофільтр). За умовчанням вибраний 

фільтр Warming Filter (85). Перемістіть повзунок Density (Густина) до значення 100 і обов'-

язково встановіть прапорець Preserve Luminosity (Зберегти свічення). Зображення тимча-

сово виглядатиме жахливо, проте після виконання декількох дій ситуація в корені зміниться 

(Рис. 31).  

 

Рис. 31. Використання коректуючого шару Photo Filter. 

 

2. Клацніть на зразку кольору в діалоговому вікні, щоб відкрити діалогове вікно Color 

Picker, і виберіть один з проблемних відтінків в зображенні. В даному випадку виберемо 

середні тони на шиї коня (рис. 32).  
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Рис. 32. Вибір відтінку. 

 

3. Працюючи із значеннями Lab, інвертуйте значення для каналів а і b в діалоговому 

вікні Color Picker, додавши або прибравши знаки “мінус” (замініть значення для каналу а з 

29 на -29, для каналу b з 35 на -35). В результаті невдалий відтінок буде замінений на проти-

лежний (рис. 33).  

 

Рис. 33. Інверсія колірних значень Lab. 

 

4. Додайте коректуючий шар Levels, після чого освітліть тіні на обличчі хлопчика 

(рис. 34).  
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Рис. 34. Освітлення тіней за допомогою коректуючого шару Levels. 

 

7. Здійсніть зміну кольорів у зображенні, запропонованому виклада-

чем, використовуючи інструменти Photoshop. 

Основні засоби Photoshop для заміни кольору — команда Replace Color (Замінити 

колір) (Image -> Adjustment) і інструмент Color Replacement (Заміна кольору). Вони ви-

конують практично одне завдання, проте команда Replace Color використовує діалогове вік-

но Color Range для вибору області, колір якої необхідно змінити, тоді як інструмент Color 

Replacement використовує кисть для визначення і одночасної зміни кольору області. У кож-

ного з цих засобів є переваги і недоліки, тому ваш вибір значною мірою залежить від того, 

наскільки складно виділити ділянку, колір якої необхідно змінити.  

Змініть колір автомобіля на рис. 35. Колір автомобіля близький до кольору неба, тому 

узгодження кольору автомобіля з кольором куртки, в яку одягнена жінка (рис. 36), буде до-

статньо цікавим завданням.  
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Рис. 35. Початкове зображення. 

 

Рис. 36. Кінцеве зображення.  

 

1. Відкрийте файл і створіть копію фонового шару. 

2. Колір автомобіля дуже близький до кольору неба. За допомогою інструменту 

Rectangular Marquee створіть, приблизно, виділену область навколо автомобіля (рис. 37), 

щоб не змінити колір автомобіля.  

 

Рис.37. Виділення області. 
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3. Виберіть команду Image -> Adjustments -> Replace Color. Відкриється діалогове 

вікно, дуже схоже на вікно Color Range, проте в нім також доступні повзунки для заміни 

кольору. В області перегляду відображаються лише виділені ділянки (рис. 38).  

 

Рис. 38. Діалогове вікно Replace Color. 

 

4. Вибравши інструмент Eyedropper, перетягніть його над синім автомобілем, пос-

тійно спостерігаючи за отриманою виділеною областю в діалоговому вікні. Якщо при цьому 

утримувати натиснутою клавішу Shift, то можна виділити якомога більше відтінків синього. 

Для того, щоб виключити з виділеної області непотрібні ділянки, клацайте на них, утримую-

чи натиснутою клавішу Alt, або скористайтеся інструментом Eyedropper із знаком “мінус”. 

Щоб включити у виділену область схожі відтінки синього, збільшіть значення параметра 

Fuzziness (Розкид), як показано на рис. 39.  

 

Рис. 39. Меню інструмента Eyedropper. 
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5. Виділивши необхідні кольори в зображенні, перейдіть до нижньої частини зобра-

ження, для того, щоб змінити колір. Використовуйте три повзунки або ж клацніть на зразку 

кольору Result (Результат), щоб відкрити діалогове вікно Color Picker. У будь-якому випа-

дку всі внесені зміни негайно відбиватимуться у вікні зображення. При цьому можна вико-

ристовувати інструмент Eyedropper для додавання нових відтінків. Перемістіть повзунок 

Hue (Колірний тон), щоб вибрати пурпурний відтінок, а також повзунок Saturation (Наси-

ченість), щоб зменшити інтенсивність кольору (рис. 40).  

 

Рис. 40. Використовуйте повзунки Hue, Saturation і Lightness для контролю над проце-

сом зміни кольору. 

 

6. Чим більше ви відхиляєтесь від початкового кольору, тим більше уваги слід приді-

ляти виділеній області. Якщо у виділеній області інші об'єкти містять сині відтінки, такі як 

наприклад джинси або вітрове скло, додайте маску (Layer -> Layer Mask -> Reveal All) і 

обробіть відповідні ділянки чорним кольором, щоб запобігти внесенню в них змін (рис. 41).  
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Рис. 41. створення маски. 

 

Зміна кольору в колірному режимі Lab. Редагування кольорів в режимі Lab володіє 

однією дуже важливою перевагою — при ньому не відбувається зміни яскравості зображен-

ня. Змінимо колір вивіски на автомобілі (рис. 42), завдяки чому вона стане гарнішою (рис. 

43).  

 

Рис. 42. Початкове зображення. 

 

Рис. 43. Зображення після зміни кольору вивіски.  
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1. Виберіть команду Image -> Duplicate (Зображення -> Створити дублікат). Перет-

воріть зображення в режим Lab, вибравши команду Image -> Mode -> Lab Color (Зобра-

ження -> Режим -> Lab). 

2. Виділіть вивіску за допомогою інструменту Polygon Lasso. Додайте шар коректую-

чий Curves. 

3. Перемістіть кінцеві точки кривої, щоб змінити колір вивіски. Якщо забезпечити 

прямолінійну форму кривих для каналів “a” і “b”, можна змінити колір, але отримати при 

цьому більш передбачені результати.  

  

 

 

Вимоги до звіту: 

1. Назва роботи. 

2. Мета роботи та завдання. 

3. Короткий реферат з теоретичної частини. 

4. Хід виконання роботи з результатами. 

5. Висновки. 

 

Контрольні запитання 

 

1. Які види колірних спотворень вам відомі?  

2. Які ви знаєте інструменти Photoshop для колірної корекції?  

3. Яку інформацію відображає палітра info?  

4. В яких випадках доцільно використовувати фільтр Photo Filter?  

5. Які інструменти використовуються для зміни кольору в зображен-

ні? 
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ЛАБОРАТОРНА РОБОТА  №3 

Вимірювання оптичної густини зразків поліграфічної про-

дукції за допомогою денситометра 

Мета роботи: Ознайомлення з будовою та принципом роботи денситоме-

тра. Вимірювання зональної оптичної густини поліграфічних зразків.   

Обладнання і матеріали: денситометр ДО-1М, зразки поліграфічної 

продукції, зразки для калібрування.   

Завдання роботи: 

1. Вивчити будову та принцип роботи денситометрів, що вимірюють оптичну 

густину відбитого випромінювання.  

2. Підготувати денситометр ДО-1М до роботи.  

3. Виміряти зональну оптичну густину запропонованого викладачем зразка по-

ліграфічної продукції. 

4. Відтворити досліджуванні кольори на екрані монітора. 

Теоретична частина 

В даний час питанням якості поліграфічної продукції приділяється велика 

увага в професійних друкарських виданнях як в Україні, так і за кордоном. Ви-

користання різних технологій і великої кількості різних моделей устаткування 

підвищує вимоги до процесу репродукції. Результат повинен найбільшою мі-

рою відповідати оригіналу, при цьому не важливо, чи використовувався речо-

вий оригінал або створене цифровим способом зображення. Для досягнення та-

кої відповідності необхідно здійснювати контроль на ключових стадіях цього 

процесу, і призначеними для цього засобами.  

Донедавна на поліграфічних підприємствах, у тому числі і достатньо ве-

ликих, була поширеною думка, що око друкаря є більш надійним приладом для 

контролю якості на всіх стадіях виробничого процесу, ніж  дорогі прилади. Але 

часи міняються, і виявляється, що залучення клієнта – це не просто забава, а 

дуже копітка робота, у якій основним аргументом є якість і ціна кінцевої про-

дукції.  
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Кажучи про якість будь-якої продукції, ми зазвичай маємо на увазі «хо-

роша». Але поняття «хороша» – абстрактне: комусь ця продукція підходить, 

комусь ні, хтось говорить, що зображення на відтиску «майже як живе», а 

хтось, порівнюючи з оригіналом, помічає серйозні проблеми з репродукцією 

кольорів. Все це суб'єктивні думки. Для вирішення суперечок необхідна об'єк-

тивна інформація, яку можуть дати лише інструментальні засоби.  

У переважній більшості організацій, що займаються поліграфічною дія-

льністю, проміжне зображення отримують на фототехнічному матеріалі, зокре-

ма на фототехнічній плівці. Всі стадії репродукційних процесів в поліграфії ви-

магають постійного контролю, тому після прояву фототехнічної плівки, запи-

саної на фотонабірному автоматі або знятої на фоторепродукційному апараті, 

необхідно оцінити, наскільки якісно були проведені ці роботи.  

Параметром, який може дати об'єктивні відомості про отримане зобра-

ження і можливість проведення з ним подальших копіювальних робіт, є оптич-

на густина (D) почорніння окремих ділянок зображення внаслідок дії світла і 

подальшої хімічно - фотографічної обробки. Під вимірюванням значення опти-

чної густини, у випадку роботи з прозорими матеріалами, зазвичай розуміють 

визначення її інтегральної величини, рівної десятковому логарифму від зворот-

ної величини, коефіцієнта пропускання матеріалу D=lg1/τ (де τ – коефіцієнт 

пропускання, виражає відносну частку енергії світла, що проходить через те або 

інше прозоре середовище певної товщини).  

При недостатній оптичній густині зображення на фотоматеріалі в процесі 

копіювання на формовий матеріал спостерігатимуться градаційні спотворення. 

Особливо сильно це відіб'ється на світлих ділянках. В той же час переекспону-

вання фотоматеріалу може призвести до так званого ефекту «затягування» рас-

трових точок, що спричинить значне збільшення оптичної густини в півтонах і 

тінях.  

В даний час прийнято вважати, що нормальна оптична густина платівки 

фотоматеріалу для процесів офсетного друку складає від 3,3 до 3,8 D (при фле-

ксографічному друці значення може досягати 4,2 – 4,5 D, при записі зображен-
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ня на фотонабірному автоматі і не менше 1,8 D при використанні фоторепроду-

кційного апарату). 

 

Денситометри на пропускання. 

 

 

Рис. 1. Типова схема  денситометра. 

 

Контроль якості зображення, що отримується на фотоформі, здійснюєть-

ся за допомогою денситометрів. Принцип роботи яких достатньо простий (зага-

льна класична схема внутрішньої будови показана на рис.1). Вимірювання за 

такою схемою здійснюються наступним чином: випромінювання від джерела, 

зазвичай лампи розжарювання (2), відбивається від рефлектора (1), повертаєть-

ся дзеркалом (3), проходить через фільтр (4), що затримує частину енергії, че-

рез діафрагму (6) певного діаметру, потрапляє на контрольовану ділянку фото-

технічної плівки (7), розташованої на візуальному столі денситометра (5). Далі 

ослаблений світловий потік проходить по світловоду (8) через інфрачервоний 

(9) або один з кольорових світлофільтрів (10) і потрапляє на фотоприймач (11). 

Раніше, в якості фотоприймачів використовувалися фотоелектронні помножу-

вачі, на даний час це кремнієві напівпровідникові елементи. 

В залежності від кількості світла, що пройшло через фотоматеріал, фо-

тоелемент модулює електричний імпульс, який аналізується логічним блоком в 

значення оптичної густини, а також відносні значення площі растрових елемен-

тів і так далі. Для установки денситометра на «0» здійснюють вимір прозорої 
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ділянки підкладки фотоматеріалу, яка також має свої оптичні властивості, що 

залежать від природи самої підкладки і режимів хімічно - фотографічної оброб-

ки (величина, що характеризує оптичні властивості підкладки, увійшла до 

практики під назвою оптичної густини вуалі). Загальний вигляд однієї з конс-

трукцій настільного денситометра представлений на рис. 2. 

 

1 — корпус денситометра; 

2 — прозорий наочний стіл; 

3 — об'єкт вимірювання; 

4 — вимірювальна головка; 

5 — вимірювальний важіль; 

6 — верхня кришка з цифровим дисплеєм. 

 

Рис. 2. Загальний вигляд однієї з конструкцій денситометра. 

 

 

Денситометр, що вимірює пропускання світла, можна використовувати і 

при роботі з кольоровими позитивними плівками, наприклад при вимірюванні 

оптичної густини слайдів. В цьому випадку принцип вимірювання залишається 

тим самим, але приймачем служить фотоелемент, який реєструє світловий потік 

за трьома змінними фільтрами (RGB — червоним, зеленим і блакитним). Мак-

симум спектральної чутливості синього, зеленого і червоного каналів знахо-

дяться в межах 440±5 нм, 530±5 нм, і 630±5 нм відповідно. При цих вимірю-

ваннях говорять про зональну оптичну густину, яка залежить від довжини хвилі 

відповідного випромінювання D=lg1/τ. В цьому випадку під інтегральною оп-

тичною густиною мається на увазі густина складного випромінювання з трьох 

складових. Слід зазначити, що використання денситометра в цій якості на су-

часних поліграфічних виробництвах вже давно не зустрічається, проте подіб-

ними пристроями оснащуються, наприклад, фотолабораторії, де працюють з 

кольоровими фотоплівками. 

Зазвичай при комплектації денситометрів світла, що проходить, фірми-

виробники включають набір трьох діафрагм діаметром 1, 2 і 3 мм. Використан-

ня діафрагм різних діаметрів дає можливість точно вимірювати оптичну густи-
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ну на фототехнічних плівках, записаних з різною роздільною здатністю, а отже 

призначених для друку з різною лініатурою поліграфічного растру. Для більшої 

лініатури зазвичай використовується більший діаметр, наприклад 3 мм, а для 

меншої лініатури – менший. Подібний підхід обумовлений статистичною віро-

гідністю попадання в полі діафрагми растрових елементів. У разі вимірювання 

текстових або інших штрихових елементів в більшості випадків використову-

ється щілинна діафрагма. 

Останнім часом денситометри на пропускання використовуються в осно-

вному для контролю або калібрування фотонабірних автоматів (ФНА). Проце-

дура калібрування відпрацьована вже давно, і всі без виключення фірми-

виробники фотонабірних автоматів і програмного забезпечення до них вклю-

чають в свої вироби спеціальні півтонові тестові шкали. Чим складніше конст-

рукція ФНА, тим більша кількість тестів в ній закладена. Використовуючи ці 

тестові шкали і денситометричне устаткування, користувач може контролювати 

і регулювати, наприклад, потужність джерела випромінювання при викорис-

танні різних фотоматеріалів або налаштовувати оптичну систему для роботи з 

різними значеннями роздільної здатності.  

У багатьох випадках, відкалібрувавши ФНА, користувач абсолютно забу-

ває про подальший контроль отриманих фотоформ. Проведення будь-яких ден-

ситометричних вимірювань пов'язане з виникненням різного роду помилок як з 

вини пристрою, так і з вини користувача або чинників, пов'язаних з фотомате-

ріалом. Для зменшення впливу цих чинників на проведення вимірювань техно-

логічними інструкціями були встановлені регламентуючі вимоги до фотоформ. 

Вони полягають у наступному: розміри зображення на фотоматеріалі повинні 

відповідати заданим геометричним розмірам оригіналу (допустиме відхилення 

±0,05 мм); мають бути відсутніми механічні пошкодження; штрихові і растрові 

елементи повинні мати строго обкреслені краї, оскільки розмитість призводить 

до нестабільності процесів копіювання; густина вуалі повинна складати менш 

0,02 D; зображення має бути візуально різким за всією площею фотоматеріалу, 

мати за всією площею однорідний ахроматичний (нейтрально-сірий) тон і роз-
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ташовуватися по центру листа фотоплівки (відстань від краю зображення до 

краю фотоплівки не менше 20 мм).  

Денситометри на відбивання. 

В деяких випадках в умовах друкарського виробництва необхідно конт-

ролювати оптичну густину фарби безпосередньо на самому відбитку. Це можна 

зробити, використовуючи інший тип денситометрів, – денситометри на відби-

вання.  

Застосування таких денситометрів передбачає можливість контролю не 

лише друкарського відбитку, але і безпосередньо друкарської форми. На відмі-

ну від денситометрів, що працюють з прозорими матеріалами, даний тип вимі-

рює коефіцієнт відбивання і перераховує його в зрозумілу користувачеві вели-

чину оптичної густини. У разі підвищення оптичної густини D зразка, зменшу-

ється відбивання світла, а отже, збільшується його поглинання D=lg1/τ (τ — ко-

ефіцієнт відбивання). 

 

Рис. 3. Загальний вигляд моделі ДО-1М. 

 

Відносна спектральна чутливість денситометра на відбивання визнача-

ється розподілом енергії в спектрі джерела випромінювання, спектральною чу-

тливістю фотоприймача, спектральним пропусканням світлопоглинаючого се-

редовища денситометра і спектральним пропусканням світлофільтрів. Для ден-

ситометрів, що випускались в СРСР (рис. 5 приведений загальний вид моделі 

ДО-1М), перераховані параметри повинні були відповідати ГОСТ 26661-85. У 

більшості ж зарубіжних приладів, що працюють з відбитим світлом, використо-

вуються фільтри, джерела світла і смуги пропускання фільтрів згідно німець-

кому стандарту DIN 16536.  

Денситометри, що працюють на відбивання, так само як і денситометри 

на пропускання, складаються з двох основних частин – оптико-механічної і ви-

мірювального електронного блоку. Основні відмінності – розташування освіт-
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лювача і приймача світла, використання більшої кількості світлофільтрів і за-

стосування різних алгоритмів при розрахунку вимірюваних величин. 

Оптико-механічна частина є фотометричною головкою, що сполучена 

світловодом з вузлом світлофільтрів, що зазвичай розташовані у вимірюваль-

ному блоці.  

Сучасні денситометри надають користувачеві широкі можливості по ви-

мірюванню різних величин, узгодження яких з галузевими стандартами показ-

ників друку приводить до нормалізації процесу синтезу кольору на відбитку й, 

отже, до підвищення якості кольорової друкарської продукції.  

З денситометрами на відбивання можна проводити вимірювання більшої 

кількості величин, ніж з денситометрами, що працюють з прозорими матеріа-

лами. А саме, можна кількісно визначати оптичну густину фарби; розтиск; роз-

мір растрових точок на відбитку і друкарській формі; відносний контраст дру-

ку; трепінг (часткове перекриття одного кольорового елемента іншим при елек-

тронному монтуванні кольорового матеріалу); помилку колірного тону; баланс 

«по сірому».  

Вимірювання будь-яких з перелічених вище величин, у більшості випад-

ків, складно проводити по зразках віддрукованого зображення, тому для оцінки 

якості отриманих зображень на відбитку застосовують спеціально розроблені 

контрольні шкали, що виготовляються за стандартами FOGRA. На даний час  

такі шкали використовуються майже всіма фірмами-виробниками денситомет-

ричного устаткування, і вони існують не лише в речовому вигляді для застосу-

вання на стадії копіювання фотоформ в контактно-копіювальних рамах, але і в 

електронному вигляді для розміщення на смузі видання в процесі верстки. 

В залежності від вимірювань, що проводяться, можуть використовуватися 

поляризаційні фільтри, застосування яких обумовлене зміною оптичній густини 

кольорового шару в процесі висихання. В умовах виробництва доводиться здій-

снювати оперативний контроль в процесі друку тиражу. Різниця ж поміряних 

значень до і після висихання кольорового шару може складати 0,1–0,2 одиниць 

оптичної густини.  
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Основною причиною такої різниці в густині сирого і сухого відбитків є 

неоднакові властивості їх поверхні. Сирий відбиток виходить глянсовим, а су-

хий – матовим, оскільки відбувається часткове проникнення фарби в пори і ча-

сткове висихання, які виявляють текстуру паперу. При цьому змінюється спів-

відношення розсіяного і досягаючого фотоприймача світла. 

Поляризаційні світлофільтри запобігають попаданню частини розсіяного 

світла від сухого відбитку на фотоприймач і тим самим перешкоджають змен-

шенню вимірюваної густини. 

Як правило, денситометри на відбивання, на відміну від денситометрів на 

пропускання, мають лише одне значення діафрагми. Це пов'язано з складністю 

будови оптичного тракту приладу, і в більшості випадків при необхідності здій-

снити заміну діафрагми доводиться перенастроювати всю систему.  

Для отримання коректних результатів необхідно постійно піклуватися 

про проведення різного роду тестових і профілактичних заходів. Одна з основ-

них умов правильної роботи денситометра – калібрування, що проводиться з 

певною періодичністю.  

Зазвичай цей процес здійснюється при установці, тестуванні і налашту-

ванні приладу на друкарський процес, у разі зміни типу запечатуваного матері-

алу, різкої зміни температури навколишнього середовища, а також з періодич-

ністю, встановленою фірмою-виробником.  

Для оперативного калібрування приладу фірми-виробники застосовують 

спеціальні шкали, так звані Density Calibration Reference, які містять певні поля 

для тріади фарб і поля з певним значенням білого або для різних видів паперу 

(крейдовані, некрейдовані і т. д.). Використовуючи їх, користувач налаштовує 

чутливість світлоприймачів під певні зовнішні умови.  

Виходячи із загальних принципів роботи і призначення, можна сформу-

лювати основні вимоги до сучасного денситометричного устаткування: просто-

та використання; портативність і можливість роботи без підключення до елект-

ричної мережі; наявність функцій діагностики; наявність певного набору вимі-

рюваних величин; точність вимірювань (значення зміряних величин при вимі-

рюванні одного і того ж поля повинні розрізнятися не більше ніж на 0,01 D).  
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На даний час для збільшення гнучкості приладів, а також з міркувань ма-

ркетингу фірми-виробники прагнуть включити якомога більше вимірюваних 

величин або, наприклад, інтегрувати в одному приладі можливості роботи з 

прозорими і непрозорими матеріалами. Одночасно, випускаються цілі серії 

приладів, які відрізняються один від одного включенням лише однієї або декі-

лькох функцій вимірювання. 

Хід виконання роботи 

1. Вивчити будову та принцип роботи денситометрів, що вимірю-

ють оптичну густину відбитого випромінювання.  

На сьогодні оптичну густину відбитого випромінювання виміряють за до-

помогою фотоелектричного денситометра ДФЕ-10, принципова схема якого 

наведена на рис. 4. 

Принципова схема денситометра ДФЕ-10 наведена на рис. 4.  

 

 

 

 

 

 

 

 

Рис. 4. Принципова схема денситометра ДФЕ-10. 

 

Джерело світла 6 живиться від мережі електричного струму через транс-

форматор. Його світловий потік розділяється на два пучки. Вимірювальний пу-

чок проходить через круговий оптичний клин 5, світловий отвір діафрагми 4, 

вимірюваний зразок 3 і попадає на поверхню вимірювального фотоелемента 2. 

Пучок порівняння послаблюється, пройшовши через два компенсаційні світло-

фільтри 7 і 8, освітлює поверхню порівняльного фотоелемента 9. Фотоелементи 

під’єднані до гальванометра 1 назустріч один одному. 
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Якщо на поверхню фотоелементів падають однакові світлові потоки, то 

фотоструми, які там виникають, є рівними, а їх різниця дорівнює нулю. Це від-

повідає нульовому положенню гальванометра. Рівність опромінення фотоеле-

ментів наступає тоді, коли перед вимірювальним фотоелементом розташовуєть-

ся найбільш щільна ділянка кругового оптичного клина. 

Освітленість поверхні вимірювального фотоелемента зменшується за ра-

хунок поглинання частини світлового потоку, який проходить через вимірюва-

ний зразок. У ланцюзі гальванометра з’явиться струм, який призведе до відхи-

лення стрілки гальванометра від нульового положення. Щоб повернути стрілку 

у нульове положення, необхідно зрівняти фотоструми, які виникають в обох 

фотоелементах. Для цього поворотом оптичного клину зменшують його густи-

ну 5 на величину густини вимірюваного почорніння. Клин повертається доти, 

поки стрілка повернеться в нульове положення, і по шкалі клина висвітлюється 

вимірювана густина. 

Оптична схема денситометра ДО-1М подібна до оптичної схеми ДФЕ-10. 

Денситометр ДО-1М призначений для вимірювання оптичних густин у відби-

тому світлі, діапазон вимірювань складає від 0,00 до 2,50 од. 

2. Підготувати денситометр ДО-1М до роботи.  

Для підготовки денситометра до роботи потрібно виконати наступні дії: 

1. Під’єднати прилад до мережі живлення 220 В. 

2. Прогріти прилад протягом 30 хв. 

3. Натиснути кнопку «С» на передній панелі денситометра. 

4. Провести калібрування денситометра. Встановити (ручкою переми-

кання світлофільтрів) у вимірювальний пучок візуальний світлофільтр. При 

цьому фотометрична головка фокусується на білий зразок №001. Притиснути її 

до зразка до упору; ручку «Установка» повернути за часовою стрілкою до 

крайнього положення; натиснути кнопку «0». Ручкою «Установка» встановити 

значення густини зразка 0,14. Встановити фотометричну головку на чорний 

зразок №002. Притиснувши до нього фотометричну головку, визначити його 

густину, вона повинна відповідати значенню 1,84. Покази висвічуються на ін-

дикаторній панелі денситометра. 



 228 

3. Виміряти зональну оптичну густину запропонованого виклада-

чем зразка поліграфічної продукції. 

Згідно з принципом роботи денситометрів, що вимірюють оптичну густи-

ну відбитого випромінювання, світло від нормованого джерела з певною колір-

ною температурою проходить через світлофільтри, які виділяють спектр конт-

рольованої на відтиску фарби, наприклад червоний фільтр виділяє блакитну 

складову, зелений — пурпурну, синій — жовту, а потім реєструється прийма-

чем. В результаті денситометричних вимірювань визначається кольороподілена 

оптична густина, яка зазвичай називається зональною густиною, а на цифрово-

му екрані денситометра відображаються значення густини досліджених фарб. 

4. Виміряти зональну оптичну густину запропонованого викладачем 

зразка поліграфічної продукції. 

В програмі Photoshop створити сторінку, фон якої відповідає виміряним 

значенням зональної оптичної густини. Порівняти результат, отриманий на ек-

рані монітора, з досліджуваним зразком.  

5. Вимоги до звіту: 

1. Назва роботи. 

2. Мета роботи та завдання. 

3. Короткий реферат з теоретичної частини. 

4. Хід виконання роботи з результатами. 

5. Висновки. 

Контрольні запитання 

6. Яке призначення денситометрів? 

7. Які типи денситометрів  вам відомі?  

8. Який принцип роботи денситометрів на відбивання?   

9. Як відбувається калібрування денситометра?  

10. Як проводиться вимірювання зональної оптичної густини? 

 

 

 



 229 

ПЕРЕЛІК РЕКОМЕНДОВАНОЇ ЛІТЕРАТУРИ 

 

1. Мартинюк В.Т. Основи додрукарської підготовки образотворчої 

інформації. Підручник. Книга 1. - Київ: Ватра, 2005. - 240 с. 

2. Шахрова М.М. Общий курс фотографии: Учеб. Пособие. – К.: Изд-

во Высшая школа, 1976.  

3. Чибисов К.В. Общая фотография: Учеб. Пособие. – М.: Изд-во Ис-

кусство, 1984. 

4. Ли Фрост. Черно-белая фотография. – М.: Изд-во Арт-родник, 2004. 



 230 

ЛАБОРАТОРНА РОБОТА № 4 
 

ВИМІРЮВАННЯ КОЛІРНОЇ ТА ІСТИННОЇ ТЕМПЕРАТУРИ ЛАМП 

РОЗЖАРЮВАННЯ МЕТОДОМ ЧЕРВОНО-СИНЬОГО 

ВІДНОШЕННЯ 

 

Мета роботи: визначити колірну та істинну температури лампи 

розжарювання методом червоно-синього відношення. 

 

Завдання: 

1. Вивчити основні закономірності теплового випромінювання. 

2. Зібрати за схемою установку і здійснити відповідні вимірювання. 

3. Визначити колірну та істинну температури лампи розжарювання. 

4. Розрахувати відносну частку випромінюваної світлової енергії η і 

побудувати графік η(U,В). 

5. Оцінити похибку визначення колірної температури. 

 

Теоретична частина 

 

Як джерела теплового випромінювання, всі тіла групуються у 3 класи: 

чорні, сірі та селективні. Чорні тіла мають коефіцієнт поглинання α = 1, а у 

сірих та селективних α < 1. Крива спектральної густини енергетичної 

світності сірого тіла Rλ(λ,Т) (крива 2, рис. 1) подібна до кривої для чорного 

тіла (крива 1, рис. 1), при рівності температур тіл, для реальних тіл є 

відмінності (крива 3, рис. 1).  

 

 
Рис. 1.1. Розподіл енергії випромінювання тіл: 

1 – абсолютно чорне тіло (АЧТ); 2 – сіре тіло; 3 – реальне тіло 
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Згідно з формулою Планка, спектральна густина об’ємної енергії 

порожнини Uv навколо частоти v у спектральному інтервалі dv 

визначається так: 
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Для спектральної густини яскравості чорного тіла в шкалі довжин 
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Для енергетичної густини світності маємо: 
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де h = 6,6256 х 10-31 Дж*с (Вт*с2) - постійна Планка, с = 2,998 х 108 м/с – 

швидкість світла, Т – абсолютна температура, к = 1,38054 х 10-23 Дж/К - 

постійна Больцмана. 

Для довжин хвиль, що задовольняють умову λТ<<hc/k, можна 

вважати експоненту 
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і формула Планка переходить у формулу Віна: 

















−= −

kT

hc
hcTB


 exp2),( 52

. (5) 

Закон зміщення Віна: 

Крива спектрального розподілу Вλ(λ,Т) при заданому значенні Т=соnst 

проходить через максимум. 

Зміщення цього максимуму вперше дослідив Він: 
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Максимальне значення яскравості в спектрі АЧТ визначається так: 
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У розрахунках доцільно використовувати формулу Планка у 

відносних координатах х і у: 
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Значення у характеризує відносний спектральний розподіл чорного 

тіла у відносних координатах. 

Згідно з формулою Планка, відносна частка випромінюваності η у 

спектральному інтервалі λ1 і λ2 визначається так: 
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Задача спрощується, якщо ввести допоміжну функцію  
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Чисельник можна записати у вигляді  
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і значення η буде знаходитись так: 

η=Z(x2)-Z(x1). (11) 

Теплове випромінювання реальних тіл 

Спектральна випромінюваність реальних тіл завжди менша за 1 і 

згідно із законом Кірхгофа залежить від спектрального коефіцієнта 

поглинання А(λ,Т). 

Оскільки реальні тіла завжди оточені іншими (не ізольовані один від 

одного), то випромінювання Rλ(λ,Т) буде складатися в загальному випадку 

із власної Rλ’(λ,Т) і відбитої Rλ”(λ,T). 

Для порівняння випромінюваностей реального тіла та АЧТ вводиться 

відношення: 
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Величину Σ(λ,Т) називають спектральним коефіцієнтом випромінюваності 

реального тіла. 
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де γ(λ,Т) – спектральний коефіцієнт чорноти реального тіла, А(λ,Т) –

поглинаюча здатність тіла (коефіцієнт поглинання). 

Еквівалентні температури 

У практиці вводиться кілька типів температур тіла, які пов’язані з 

певним способом порівняння випромінюваностей реального тіла та 

абсолютно чорного тіла. Такі температури називають еквівалентними. 

1. Енергетична (радіаційна) температура – Тр – це така температура  

абсолютно чорного тіла, при якій його повна випромінюваність дорівнює 

випромінюваності реального тіла при його дійсній (істинній) температурі Т. 

Завжди Тр< Т. Радіаційна температура вимірюється за допомогою 

радіаційного пірометра. 

2. Яскравісна температура – Тя – це така температура АЧТ, при якій його 

яскравість у вузькій області спектра Δλ (λ ≈ 665 нм) дорівнює яскравості 

реального тіла в цій же самій спектральній області при 

його дійсній температурі Т.  Вимірюється пірометром зі зникаючою 

ниткою. Тя< Т, але розбіжність між істинною температурою Т та Тя менша, 

ніж із Тр. 

3. Колірна температура – Тк – це така температура АЧТ, при якій відношення 

яскравостей двох спектральних ділянок λ1 і λ2 в околі малого спектрального 

діапазону 
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Вона вимірюється на основі формули Планка з використанням 

"червоно-синього відношення". 

Візуальні пірометри, що вимірюють Тк на основі даного відношення, 

як правило, використовують світлофільтри на таких довжинах хвиль: λ1 = 

467 нм і λ2 = 665 нм. 
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Порядок виконання роботи 

 

1. Зібрати лабораторну установку, користуючись такою схемою: 

 
 

2. Провести  вимірювання фотострумів для червоного (λ2 = 665нм) і синього 

(λ1 = 467нм) світлофільтрів досліджуваної лампи розжарювання (U = 140-

220В; через ΔU = 10В), а потім – для еталонної лампи для заданої напруги 

(220 В). 

3. Користуючись відомими значеннями спектральної енергетичної 

світності (яскравості) для еталонної лампи, розрахувати значення 

спектральних світностей (яскравостей) досліджуваної лампи за виразами: 
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1
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2
=eB мкВт/см3. 

4. Розрахувати червоно-синє відношення для використаних напруг 

досліджуваної лампи: 
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5. Визначити колірну температуру досліджуваної лампи 

розжарювання, користуючись формулою спектрального розподілу енергії 

сірого тіла в наближенні Віна згідно з виразом: 
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де с2=1,439·10-2м·К.  

 

6. Користуючись довідковими даними для коефіцієнта сірості 

вольфраму [1], визначити істинну температуру лампи розжарювання для 

використаних напруг (додаток 3.1) згідно з виразом: 
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7. Оцінити чинність використовування формули Віна, порівнюючи її з 

формулою Планка для червоно-синього відношення (відносна похибка 

відхилення формули Віна від формули Планка): 
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8. Користуючись законом зміщення Віна, визначити залежність 

максимуму розподілу спектральної яскравості для використаних напруг 

живлення лампи: 

;max
T

c
=  c’=2898 мкм·К. 

9. Користуючись формулою Планка у відносних координатах (див. 

додаток 3.2), розрахувати частку випромінюваної енергії 
−

−=
0

700400

F

F
  у 

спектральній області 400-700 нм. При розрахунках вважати, що вольфрам є 

сірим тілом (див. додаток 3.1). Побудувати графік η(U,B). 

10. Оцінити похибку визначення кольорової температури. Дані 

експерименту занести в таблицю:  

Ieλ1,mA Ieλ2,mA U,B Iλ1 Iλ2 Bλ1 Bλ2 b21 Tk, 0K T, 0K λmax η 
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Вимоги до змісту звіту 

1. Назва і номер роботи. 

2. Мета роботи і завдання. 

3. Перелік обладнання. 

4. Короткий реферат із теоретичної частини. 

5. Схема установки, що використовується. 

6. Таблиця з результатами вимірювань. 

7. Розрахунки шуканих величин. 

8. Графік відносної частки випромінюваної енергії η(U,B). 

9. Розрахунок похибок, визначення колірної температури. 

Контрольні запитання 

1. Яке випромінювання називається тепловим? Його особливості. 

2. Сформулюйте основні закони теплового випромінювання. 

3. Поняття абсолютно чорного тіла (АЧТ), сірого тіла. 

4. Поясніть зміст поняття "ультрафіолетова катастрофа". 

5. Визначення еквівалентних температур. 

Список літератури 

1. Гутуров М.М. Основы светотехники и источники света.— М.: 

Энергоатомиздат, 1983. – С. 53 - 64. 

2. Рвачев В.П. Введение в биофизическую фотометрию. – Львов: 

Издат-во Львов. ун-та,1966.— С. 49-70.  

Довідка 

Відносна похибка вимірювання червоно-синього відношення 

визначається за формулою: 
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де Δі – середнє квадратичне значення похибки вимірювань 

відповідного фотоструму.  

n

iiiiii
i

n

22

2

2

1 )(...)()( −++−+−
=  



 237 

Додаток3.1
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ЛАБОРАТОРНА РОБОТА №5 

 

Методики отримання кольорових 

растрових зображень  

 

Мета роботи: Ознайомлення з основними методиками отримання 

кольорових зображень. Отримання поняття про будову цифрових камер та 

сканерів.    

 

Завдання роботи: 

1. Ознайомитись теоретично та практично з основними колірними 

моделями растрових графічних файлів та з редактором растрових 

зображень Adobe Photoshop. 

2. Отримати кольорове растрове зображення слайду, використовуючи 

CCD-камеру (реєструє лише градації сірого) та світлофільтри 

(RGB). 

3. Отримати кольорове растрове зображення за допомогою чорно-

білого сканера (з оптичною роздільною здатністю 600 dpi, 300 dpi, 

30 dpi) та RGB-світлофільтрів. 

4. Оцінити візуально оригінал і результат, та пояснити причини 

наявних відмінностей.  

 

Теоретична частина 

 

1. Отримання растрових зображень цифровою камерою.  

Сучасна цифрова фотографія почала розвиватись внаслідок 

використання різних технологій, які мають одну спільну ознаку – запис 

зображення без застосування фотоплівки. В процесі отримання зображення 

цифровою камерою об’єкт проектується об’єктивом на світлочутливу 

поверхню (рис. 1). 
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Рис. 1. Формування зображення на світлочутливому 

елементі за допомогою об’єктиву. 

 

Зчитування інформації з світлочутливого елементу  може 

здійснюватися почергово точка за точкою (одноелементним 

фотоприймачем), порядково (лінійкою світлочутливих елементів), або по 

всій площині (матрицею світлочутливих елементів). Почергове сканування 

не має практичного застосування в цифровій фотографії, а метод 

порядкового запису використовується в сканерах.  

При записі кольорового зображення світловий потік за допомогою 

кольорових світлофільтрів розділяється по трьох каналах (RGB). Якщо 

приймач (рис. 2)  має три близько розміщені лінійки світлочутливих 

елементів (трьохлінійний світлочутливий елемент), то запис інформації про 

колір проходить одночасно по трьох колірних каналах. Камери, що 

працюють по типу порядкового сканування, вимагають постійних умов 

освітленості, а об’єкти, що записуються, повинні бути нерухомими в процесі 

запису. 
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Рис. 2. Сканування зображень трьома лінійками 

світлочутливих елементів. 

 

На відміну від лінійки, матриця світлочутливих елементів залишається 

в процесі запису нерухомою. Кольороподіл у випадках використання 

приймачів матричного типу може відбуватись різними методами: 

• кольороподіл по RGB-каналах в три окремих проходи; відповідні 

світлофільтри розміщуються на поворотній турелі; для отримання 

чорно-білого зображення використовується нейтрально-сірий 

світлофільтр (рис. 3).  

 

Рис. 3. Запис кольорового зображення за допомогою матричного 

світлоприймача. Кольороподіл здійснюється в окремих проходах. 



 241 

• одночасний запис кольорового зображення з використанням трьох 

матричних приймачів, призмової системи розділення світлового 

пучка та трьох світлофільтрів (рис. 4). 

 

Рис. 4. Запис кольорового зображення за допомогою трьох 

матричних приймачів, кольороподіл відбувається за допомогою 

призмової системи розділення світлового пучка. 

 

• запис кольорового зображення за допомогою матричного приймача; 

кольороподіл здійснюється за допомогою світлофільтрів мозаїчного 

типу, що розміщуються на поверхні матриці (рис. 5). 

 

Рис. 5. Запис кольорового зображення за допомогою за допомогою 

матричного приймача, кольороподіл відбувається за допомогою 

світлофільтрів мозаїчного типу. 
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Основною перевагою цифрової фотографії є те, що за допомогою 

цифрових методів здійснюється швидка обробка даних зображення, тобто 

дані обробки можуть бути переслані в комп’ютер одразу після 

фотографування. 

Ще одним з методів отримання растрового зображення є сканування. 

При скануванні інформація про колір зображення перетворюється в набір 

пікселів (pixel від PICture ELement) або таблицю, що складається  зі 

скінченної кількості квадратиків певного кольору (колір задається в 

числовому вигляді). Сканери бувають різних типів конструкцій з різними 

технічними характеристиками. 

Типи сканерів: 

• барабанні сканери (з горизонтальним, вертикальним чи 

нахиленим розміщенням барабану); 

• планшетні сканери (настільні сканери). 

Сканери барабанного типу (рис. 6) ранніх конструкції були 

приладами вводу інформації і розглядались лише як частина загальної 

системи електронної обробки зображень.  

 

Рис. 6. Барабанний сканер (ICG 360). 
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Для реєстрування RGB-колірних складових в барабанних сканерах 

використовуються фотоелектронні помножувачі (ФЕП), які забезпечують 

високу якість відтворення. ФЕП дозволяють реєструвати світловий потік, 

відбитий від оригіналу або пропущений оригіналом з розділенням його на 

три основні компоненти RGB-кольору. В якості джерел випромінювання в 

барабанних сканерах використовуються ксенонові або галогенові лампи. 

Випромінювання від джерела з допомогою волоконної оптики і лінзового 

конденсора фокусується на малій площі оригіналу. Світловий потік, що 

пройшов чи відбився від маленької ділянки оригіналу, потрапляє на 

світлочутливий приймач, який переміщується вздовж барабану, що швидко 

обертається (рис. 7). 

 

Рис. 7. Структура головки сканера. 

 

Випромінювання потрапляє в систему напівпрозорих дзеркал, що 

встановлені під кутом 45° до напрямку поширення. На кожному з 

напівпрозорих дзеркал частина світлового потоку відбивається, а частина 

проходить далі і потрапляє на наступне дзеркало. Відбите від дзеркал 

випромінювання проходить червоний, зелений і синій світлофільтри, а після 

цього потрапляє на  один з трьох підсилювачів світлового потоку (ФЕП). 
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Аналогово-цифрові перетворювачі (АЦП) здійснюють перетворення 

аналогового сигналу в цифрову форму. 

В планшетних сканерах  використовуються напівпровідникові 

прилади з зарядовим зв’язком (ПЗЗ). Передавальні характеристики цих 

приладів настільки високі, що планшетні сканери починають наближатись по 

якості до барабанних сканерів. 

Планшетні сканери обладнані лінійкою ПЗЗ, яка складається з 

декількох тисяч напівпровідникових елементів, що розміщені на одній 

мікросхемі. Оригінали розміщуються на прозорому склі й освітлюються 

флуоресцентним або галогеновим джерелом світла. В сканерах планшетного 

типу в процесі сканування джерело світла і світлочутливі елементи 

переміщуються. Рядок зображення, яке сканують за допомогою оптичної 

системи, проектується на світлочутливу поверхню елементів ПЗЗ і 

реєструється ними. 

 

Рис. 8. Планшетний сканер. 
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Хід виконання роботи 

 

1. Ознайомтесь з основними методиками отримання кольорових 

зображень. 

2. Ознайомтесь з будовою цифрових камер та сканерів. 

3. Отримайте кольорове растрове зображення слайду, використовуючи 

CCD-камеру (знімає тільки градації сірого) та світлофільтри (RGB). 

Для цього зберіть оптичну схему зображену на рис. 9. Оптичне 

випромінювання від джерела 1 (лампа розжарювання) потрапляє об’єкт-

оригінал 2 (кольоровий слайд). За допомогою лінзи 3 формується зображення 

оригіналу на CCD-камері 6. Діафрагма 4 слугує для контрольованого 

обмеження апертури. Досліджувані напівтонові сірі зображення записуються 

за допомогою CCD-камери в комп’ютер 7 із почерговим використанням 

кольорових фільтрів 5 (RGB-світлофільтри). 

 

Рис. 9. Оптична схема експерименту: 1 – джерело випромінювання; 

2 – об’єкт-оригінал (кольоровий слайд); 3 – зображаюча лінза; 

4 – діафрагма; 5 – світлофільтр; 6 – CCD-камера; 7 – комп’ютер. 

 

В ході вимірювань ви повинні записати в комп’ютер 3 напівтонові сірі 

зображення для трьох кольорових світлофільтрів. Далі потрібно відновити 

кольорове зображення шляхом поєднання чорно-білих зображень. 

Об'єднання трьох чорно-білих зображень є, по суті, поєднанням трьох 

колірних каналів зображення за допомогою програми Photoshop. 

Для відновлення кольорового зображення виконайте наступні дії: 
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• Відкрийте файли зображень, що підлягають поєднанню. 

• Виберіть вікно одного зображення, зробивши його активним 

документом. 

• Виберіть в меню палітри «Канали» команду «Поєднати канали».  

• Коли з'явиться вікно «Поєднати канали», виберіть у списку, що 

розкривається, колірний режим підсумкового зображення. Оскільки 

поєднуватися будуть канали червоного, зеленого і синього кольорів, 

вкажіть режим RGB. 

• Клацніть на кнопці «OK».  

• З'явиться нове вікно діалогу операції поєднання, за допомогою якого 

можна вказати колірні канали нового файлу. 

• Клацніть на кнопці «OK».  

Отримайте кольорове растрове зображення за допомогою чорно-білого 

сканера (з оптичною роздільною здатністю 300 dpi, 150 dpi, 50 dpi) та RGB-

світлофільтрів. Оцініть візуально оригінал і результат, та поясніть причини 

наявних відмінностей.  

Для цього розмістіть один з фільтрів на екрані сканера, а зверху 

розмістіть досліджуваний зразок (фотографія чи довільне кольорове 

зображення). Проскануйте зображення з різною оптичною роздільною 

здатністю (300 dpi, 150 dpi, 60 dpi).  Далі повторіть вказані дії для інших 

фільтрів. Слід звернути увагу на те, що в процесі зміни фільтра не відбулося 

зміщення досліджуваного зразка.     

При виборі досліджуваного зразка найкращим є слайд формату 5х6 см 

або 8х11 см оскільки слайди володіють високою роздільною здатністю. Після 

слайдів наступними по якості є фотографії. Найгіршим зразком вважається 

поліграфічний відбиток. Він має вузький діапазон оптичних густин, що 

залежить від типу паперу і технології друку. Крім того, паперовий зразок 

містить поліграфічний растр.  

В результаті сканування ви повинні записати в комп’ютер 9 

напівтонових сірих зображень для трьох кольорових світлофільтрів і трьох 
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різних оптичних роздільних здатностей сканера. Далі потрібно відновити 

кольорове зображення шляхом поєднання чорно-білих зображень. 

Об'єднання трьох чорно-білих зображень проводиться аналогічно, як в 

попередньому пункті.  

 

Вимоги до звіту: 

1. Назва, мета та завдання роботи. 

2. Короткий реферат з теоретичної частини. 

3. Хід виконання роботи з результатами. 

4. Висновки. 

 

Контрольні запитання 

1. Які методи отримання растрових зображень ви знаєте?  

2. Як може відбуватися зчитування інформації з світлочутливого 

елементу? 

3. Яка відмінність між лінійкою і матрицею світлочутливих елементів? 

4. Якими методами здійснюється кольороподіл у випадках 

використання приймачів матричного типу? 

5. Яку будову мають сканери барабанного і планшетного типу?  

 

Перелік рекомендованої літератури 

1. Мартинюк В. Т. Основи додрукарської підготовки образотворчої 

інформації. Підручник. Книга 1. –  Київ: Ватра, 2005. –  240 с. 

2.  Айсманн К. C., Палмер У. Н. Ретуширование и обработка 

изображений в Photoshop = Adobe Photoshop Restoration & Retouching. –  3-е 

изд. –  М.: Вильямс, 2007. –  560 с. 

3. Иванова Т.М. Компьютерная обработка информации. Допечатная 

подготовка (CD-ROM прилагается). – Санкт-Петербург: Питер, 2004. – 366 с. 

4. Буковецкая О.А. Основы допечатной подготовки. – М.: NT Press, 

2005. – 160 с.   
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ЛАБОРАТОРНА РОБОТА №6 

 

Калібрування і профілювання монітора  

 

Мета роботи: Ознайомитися з алгоритмом налаштування монітору. 

Обладнання і програмне забезпечення: монітор, калібратор 

Colormunki Display. 

Завдання роботи: 

1. Ознайомитись із загальними відомостями та принципом роботи 

Colormunki Display. 

2. Виконати калібрування монітору. 

3. Зробити висновки по даній лабораторній роботі, оформити звіт. 

 

Теоретична частина 

 

Калібрування монітора, що це таке? 

«Калібрування монітора» або «калібрація» – це спрощені вирази, більш 

правильно казати: калібрування і профілювання монітора. Для досягнення 

максимально точної кольоропередачі на екрані монітора виконується 

комплекс операцій: калібрування і профілювання. 

Використовується вимірювальний пристрій: колориметр i1Display PRO, 

або спектрофотометр ColorMunki Photo (інколи доводиться чути спрощений 

вираз – калібратор) та спеціальне програмне забезпечення: i1Profiler або 

ColorMunki Photo, або Argyll CMS. 

Навіщо потрібне калібрування монітора?  

Вперше подібна система з'явилася на комп'ютерах Macintosh і носила 

назву ColorSync. У всіх останніх операційних системах від Microsoft також 

використовується схожа система кольорокорекції під назвою ICM. Завдання 

у них абсолютно однакові – забезпечити на рівні операційної системи 
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автоматичне підстроювання кольору між різноманітними пристроями так, 

щоб відтворювані ними кольори були максимально схожими. Наприклад, при 

друці картинки на струменевому принтері правильно налаштована система 

повинна так змінити кольори початкової картинки, що посилається на 

принтер, щоб отримати всі з його можливостей відтворення кольорів, при 

цьому передавши їх максимально близько до оригіналу.  

Система управління кольором складається з «движка», що є своїм для 

кожної операційної системи або платформи, і колірного профілю пристрою, 

який може використовуватися на різних платформах. Ситуація ж з 

моніторами сильно відрізняється. Єдине, що стандартизує виробник на 

заводі, – кольори свічення люмінофора, нанесеного на трубку монітора. Крім 

того, виробник створює декілька заводських пресетів яскравості, 

контрастності і колірної температури. Але користувач завжди може змінити 

які-небудь налаштування, та і люмінофор з часом вигоряє, тому монітори 

колірними профілями або зовсім не забезпечуються, або забезпечуються, але 

сильно усередненими. Тому, щоб добитися хороших результатів при роботі з 

графікою, монітори необхідно налаштовувати. Процес налаштування 

монітора простіший і доступніший, ніж кольорокалібровка принтера або 

сканера, і може бути виконана «в домашніх умовах». Відразу хотілося б 

звернути особливу увагу, що калібрування монітора потрібне тільки тоді, 

коли користувач хоче серйозно працювати саме з графікою або дуже якісно 

переглядати вже готові ілюстрації. 

Засоби калібрування  

Для професійного калібрування необхідні спеціальні пристрої, що 

створюють максимально точний колірний профіль. Ціна таких пристроїв в 

кращому разі наближається до ціни монітора, а часто може в багато разів її 

перевищити. Існує багато програм, які дозволяють провести калібрування 

монітора без застосування складних апаратних засобів. Яким з них 

користуватися, ця справа кожного користувача. Всі вони працюють 
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приблизно за одним принципом, і, розібравшись з алгоритмом налаштування 

монітора в одній з них, можна буде робити це і з будь-якою іншою 

програмою.  

Програми для калібрування містять такі розділи: 

«Геометрія екрану»  (Geometry tools): 

Вписана в екран прямокутна сітка з колами в центрі і по кутах 

допоможе виявити геометричні спотворення екрану. Для цього вам належить 

пройти ряд тестів: подушкоподібність, розмір і положення, обертання, 

трапеція і паралелограм. Лівою кнопкою миші можна змінювати колір 

картинки, за допомогою правої – переходити від одного тесту до іншого. При 

налаштуванні розміру і положення простежте за тим, щоб коло в центрі 

екрану було ідеально рівне, а штрихова лінія майже ховалася під 

обрамленням екрану. Якщо штрихова лінія викривлена, переходьте до 

наступних пунктів (подушкоподібність, обертання, трапеція). У результаті 

регулювання сітка повинна рівномірно покривати екран, а коло в центрі і 

кола по кутах – мати правильну форму. Відхилення не повинні бути помітні з 

відстані ~ 30 см. 

«Яскравість і контрастність» (Brightness & Contrast):  

Перший параметр налаштовується наступним чином: збільшуйте 

яскравість, поки не стануть видні фон (тобто та частина екрана, яка повинна 

бути чорною) і всі темно-сірі прямокутники з позначками 1-9%. Тепер 

зменшіть яскравість, поки не стануть помітними тільки прямокутники з 

позначками більше 1-3%. При налаштуванні контрастності необхідно 

домогтися, щоб всі великі прямокутники були добре помітні, чітко 

виділялися один від одного і розрізнялися по інтенсивності. Якщо при роботі 

з іншими програмами ваші очі швидко втомлюються, то має сенс трохи 

зменшити контрастність у порівнянні з початковим налаштуванням. 

«Зведення променів» (Convergence):  
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На екран виводиться сітка, що складається з хрестиків трьох основних 

кольорів (червоний, зелений, синій). Колір кожного такого хрестика не 

збігається з кольором сусіднього. При ідеальному зведенні променів відрізок 

одного кольору повинен переходити в відрізок іншого кольору без зміщення, 

як по горизонталі, так і по вертикалі. На практиці частіше за все справи йдуть 

інакше: хрестики різних кольорів трохи зміщені по горизонталі й вертикалі 

відносно один одного (особливо це помітно на краях монітора). Погане 

зведення (відхилення більш ніж на 0.3 мм у центрі екрана і більш ніж на 0.4 

мм по краях) негативним чином позначається на якості зображення та втомі. 

Його можливими причинами можуть бути зовнішні магнітні поля.  

«Фокусування» (Focus): 

 Фокусування монітора безпосередньо пов'язано із зведенням променів, 

тобто при поганому зведенні обов'язково проявить себе погане фокусування. 

Нехтувати цим тестом не варто, так як незадовільне фокусування може 

виявитися також через неякісну тіньову маску або апертурні гратки. Оцінка 

фокусування зводиться до вивчення чіткості зразків квадратиків в центрі і по 

кутах екрана. Досягніть високої чіткості зображення, якщо таке регулювання 

доступне на вашому моніторі. В іншому випадку можна дещо зменшити 

розмір екрану і контрастність. 

«Роздільна здатність» (Resolution): 

Тут вам належить оцінити чіткість вертикальних і горизонтальних ліній 

зразка. Зміна товщини ліній виробляється лівою кнопкою миші, зміна 

напрямку – правою. Всі лінії повинні бути чітко видні (для більш точної 

оцінки скористайтеся лупою). Розмивання ліній по краях картинки може 

бути пов'язано з малою смугою пропускання, дешевою відеокартою, 

дефектами кабелів, що з'єднують монітор і комп'ютер, або нестандартним 

режимом роботи монітора.  

«Читабельність» (Readability): 
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Даний тест тісно пов'язаний з фокусуванням, зведенням променів і 

роздільною здатністю. Екран заповнюється дрібним текстом, і вам потрібно 

оцінити його читабельність. Текст повинен читатися без напруги для очей по 

всій площі екрану. 

«Муар» (Moire): 

 Цей тест дозволить вам визначити, чи забезпечує ваш монітор чітке 

зображення різних дрібниць. Для цього екран заповнюється складним 

орнаментом, що складається з дрібних деталей. Зображення не повинне 

містити розриви і нерівномірності в інтенсивності зображення. Щоб 

позбутися від муару, можна трохи збільшити контрастність, змінити розміри 

картинки, зменшити роздільну здатність.  

«Колір» (Color tools): 

 На екрані по черзі з'являються три основні кольори. Необхідно 

простежити, щоб тони були чистими без затемнених або більш світлих 

ділянок, тому що чистота кольору зазвичай не підлягає регулюванню. 

Однорідність або чистота кольору, яка визначається цим тестом, багато в 

чому залежить від тих же причин, що і зведення. Крім того, правильна 

передача кольору залежить від правильної роботи відеокарти.  

«Стабілізація зображення» (Screen regulation):  

Цим тестом перевіряється якість ланцюгів управління високою 

напругою на моніторі. У випадку недостатньо якісних ланцюгів управління 

зображення розширюється у його світлі частини. Цей ефект в тій чи іншій 

мірі спостерігається у всіх моніторах, але найгірша стабілізація у дешевих 

моделей. Для деякого зменшення цього ефекту можна трохи знизити 

яскравість і контрастність. 

Який засіб ми будемо використовувати для калібрування 

монітора? 

У даній роботі ми будемо використовувати калібратор Colormunki 

Display X-rite. 
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Невеликий чорний блискучий корпус, достатньої довжини USB шнур, з 

грузиком-противагою для кріплення на моніторі. Верхня дужка приладу 

обертається. В одному з положень дужки, будемо вважати його відкритим, 

перед нами лінза датчика калібрації, в закритому – лінза захищена самою 

дужкою, на якій розташований білий напівпрозорий круг, який служить для 

виміру яскравості розсіяного світла (освітленості робочого місця). Одночасно 

дужка виконує і захисну функцію, прикриваючи лінзу від пилу і випадкових 

подряпин в неробочому положенні. Дуже зручно і функціонально. На 

зворотньому боці приладу можна знайти гніздо для кріплення на штатив – 

може використовуватися для кріплення колориметра на стійці при 

профілюванні проекторів. 

Рис. 1. Калібратор Colormunki Display X-rite. 

 

Хід виконання роботи 

 

1. Відкрийте програму з диска, або завантажте останню версію 

безпосередньо з сайту X-Rite. 
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2. Підключіть ColorMunki Display до USB-порту, і все готово до роботи. 

Виробник рекомендує використовувати USB-порт на задній панелі 

комп'ютера, так як порти, вбудовані в монітори, клавіатури і хаби, можуть не 

давати потрібної потужності, і прилад може або просто не працювати, або 

працювати неправильно, видаючи колірне зрушення. 

 

Рис. 2. Вигляд  програми. 

 

3. Після запуску програми нам надається вибір: відкалібрувати монітор, 

або проектор. Створення профайла для проектора мало чим відрізняється від 

калібрування дисплея, і в якійсь мірі навіть простіше, змінюється тільки 

спосіб кріплення приладу. Замість того, щоб розташовувати його на дисплеї, 

ColorMunki кріплять або на стійку, використовуючи згадане вище штативне 

гніздо, або ставлять на що-небудь, використовуючи захисну дужку в якості 

підставки. Прилад розташовують таким чином, щоб він дивився своєї лінзою 

на проектоване проектором зображення. Причому розташовувати його треба 

на відстані, що не перевищує 3-х кратну висоту цього самого зображення. 

Ось і всі відмінності. Якщо у вас кілька моніторів, програма запропонує 

вибрати який ви хочете калібрувати. 

4. Рекомендується зайти в меню налаштувань і упевнитися, що там все 

встановлено як треба. 
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Tone Response Curve 

Гамма. Використовуйте стандартну 2.2. 

ICC Profile Version 

Версія генерується програмою профілів. Четверту версію підтримують 

далеко не всі програми, які мають підтримку CMS. Друга версія працює 

краще четвертої, якщо у вас не найновіше програмне забезпечення. 

 

Рис. 3. Меню налаштувань. 

 

Achieve display luminance value using video LUT 

Рекомендується включати цю опцію, якщо ваш монітор занадто 

яскравий навіть на мінімальних налаштуваннях. 

Enable ADC 

Automatic Display Control дозволяє програмі управляти дисплеєм 

безпосередньо, змінюючи потрібні налаштування через цифровий інтерфейс. 

 Technology Type 

Задає тип підсвічування монітора. Колориметр вміє працювати з LED і 

Wide Gamut моніторами, і можна явно вказати тип вашого монітора. Якщо 

сумніваєтеся, залиште стандартне CCFL. 

5. Далі можна вибрати простий (Easy) спосіб калібрації, або складніший 

(Advanced). Ми можемо вибрати баланс білого, під який буде створений 
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профіль. Рекомендується використовувати D65, що відповідає колірній 

температурі в 6500К і є опорною точкою для більшості сучасних LCD 

моніторів. D50 і D55 використовуються для пруф-друку в контрольованих 

умовах зовнішньої освітленості. Є ще значення "Native". У цьому випадку 

баланс білого виставляється на моніторі і програма його не вимірює. Друге, 

що потрібно вибрати, це яскравість під яку будете калібрувати монітор. 

Комфортне значення – близько 100 cd/m2. 

 

Рис. 4. Спосіб калібрації. 

 

6. Функції "Ambient Light Smart Control" і "Flare Correct" включають 

додаткові кроки, які будуть виконані пізніше на етапі створення профілю. 

Перша дозволяє внести поправки в генерований профіль, спираючись на 

рівень освітленості робочого місця, а друга оцінює вплив відбитого від 

монітора світла на контраст зображення. 
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Рис. 5. Додаткові функції. 

 

7. Якщо ви поставили відповідну галочку вище, то наступним кроком 

програма запропонує виміряти рівень освітленості робочого місця. Яскраве 

освітлення робить зображення на екрані більш темним і менш контрастним. 

Темне – навпаки. Дана функція дозволяє компенсувати генерований профіль 

щоб врахувати вплив яскравості зовнішньої освітленості, коректуючи 

контраст, насиченість і колірний відтінок монітора для найкращого 

результатату. 

 

Рис. 6. Функція "Ambient Light Smart Control". 
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8. Після натискання на Next, вам запропонують перевернути ручку на 

колориметрі в протилежне положення і розмістити прилад на екрані в 

вказане місце з жовтою окантовкою. Програма досить розумна, щоб 

розпізнати в якому становищі знаходиться дужка приладу. Розташуйте 

грузик за монітором, зрушуючи його, якщо знадобиться. Можна нахилити 

монітор трохи назад, якщо вважаєте, що контакт недостатньо щільний. Не 

бійтеся забруднити або подряпати монітор, поверхня колориметра не 

залишає ніяких слідів на екрані. 

 

Рис. 7. Розміщення приладу на екрані. 

 

9. Наступний крок – безпосереднє створення профілю монітора. 

Розташуйте прилад на дисплеї, натисніть кнопку. Програма розкриється на 

повний екран, змінить схему оформлення Windows на стандартну, 

відключаючи Aero, якщо у вас Windows 7. Проведе невеликий тест 

контрастності і яскравості монітора. Після чого вам буде запропоновано 

відрегулювати яскравість монітора, щоб він відповідав обраній раніше 

яскравості – 100 cd/m2. 
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10. Після закінчення всіх вимірів буде запропоновано вибрати ім'я і 

зберегти профіль. В установках дисплея він буде встановлений автоматично. 

Також можна вибрати проміжок часу, через який вам нагадають про те, що 

треба перекалібрувати монітор. Люди, що професійно працюють з кольором 

можуть робити це і кожен день, для інших 1-2 рази на місяць більш ніж 

достатньо. LCD монітори менш схильні до зрушень кольору ніж старі CRT 

монітори, тому їх можна не калібрувати дуже часто. Зрозуміло, тільки якщо 

ви постійно не змінюєте налаштування монітора, змінюючи яскравість, 

контрастність або інші параметри, що впливають на зображення. У цьому 

випадку бажано створити новий профіль. Нагадування також можна 

встановити через програму від ColorMunkiDisplayTray, що знаходиться на 

панелі завдань. 

 

Рис. 8. Створення профайлу. 

 

11. Передостаннім кроком вам запропонують подивитися результати 

виконаної роботи на кількох фотографіях-мішенях. Покажуть порівняння 

"До" і "Після". Тестову картинку можна вибрати з випадного меню. 

Порівняння відбувається між каліброваним і некаліброваних монітором. Не 

можна зробити порівняння з попереднім профілем. 
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Рис. 9. Порівняння зображень. 

12. Останнім кроком програма запропонує вам постійно стежити за 

зовнішньою освітленістю, і або автоматично вносити корекцію в профіль, або 

просто повідомляти вас про це. 

 

Звіт повинен містити: 

1. Послідовно виконану роботу з ілюстрованими діями. 

2. Висновки по даній лабораторній роботі. 

 

Контрольні запитання 

1. Що таке калібрування монітора? 

2. Для чого необхідно калібрувати монітори? 

3. Які існують засоби для калібрування моніторів? 

4. Як часто необхідно калібрувати монітори? 
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261 

 

2.  Айсманн К. C., Палмер У. Н. Ретуширование и обработка 

изображений в Photoshop = Adobe Photoshop Restoration & Retouching. – 3-е 

изд. – М.: Вильямс, 2007. – 560 с. 

3. Иванова Т. М. Компьютерная обработка информации. Допечатная 

подготовка (CD-ROM прилагается). – Санкт-Петербург: Питер, 2004. – 366 с. 

4. Буковецкая О. А. Основы допечатной подготовки. – М.: NT Press, 

2005. – 160 с.   

 



262 

 

Список використаної літератури  

 

1. Бондар І. О. Теорія кольору: навчальний посібник для студентів напряму 

підготовки 6.051501 "Видавничо-поліграфічна справа" / І. О. Бондар. – 

Х. : ХНЕУ ім. С. Кузнеця, 2016. – 164 с. 

2. Теорія кольору [Електронний ресурс] : методичні рекомендації до 

самостійної роботи для студентів спеціальності 186 "Видавництво та 

поліграфія" першого (бакалаврського) рівня / уклад. І. О. Хорошевська. 

– Харків : ХНЕУ ім. С. Кузнеця, 2020. – 48 

3. Рац А.П. Основы цветоведения и колористики. Цвет в живописи, 

архитектуре и дизайне: курс лекций. М. МГСУ, 2014. 128 с. 

4. Фрейзер, Брюс, Мэрфи, Крис, Фрэд. Реальный мир управления цвітом, 

искусство допечатной підготовки, 2-е узд.: Пер. с англ. – М.: ООО «И.Д. 

Вильямс», 2006. – 560 с. 

5. Гельмут Киппхан. Энциклопедия по печатным средствам информации. 

Технологии и способы производства / Гельмут Киппхан; Пер. с нем. – 

М.: МГУП, 2003. – 1280 с. 

6. Измайлов Ч. А., Соколов Е. Н., Чериоризов А. М. Психофизиология 

цветового зрения. – М.: Изд-во МГУ, 1989. – 206 с. 

7. Саттон Т. Гармония цвета: Полное руководство по созданию цветовых 

комбинация / Т. Саттон, Б. Вилен; Пер. с англ. В. П. Воропаева. – М.: 

ООО «Издательство Астрель»: ООО «Издательство АСТ», 2004. – 215 с. 

8. Дж.Миано. Форматы и алгоритмы сжатия изображений в действии. – М.: 

Издательство Триумф, 2003. – 336 с. 

9. Цифровое преобразование изображений: / Учеб. пособие для Вузов. Под 

ред. проф. Р.Е.Быкова. – М.: Горячая линия – Телеком, 2003. – 228. 

10. Нельсон Р.Э. Что полиграфист должен знать о красках: [пер. с англ.]. – 

М.: ПРИНТ-МЕДИА Центр, 2005.–328 с. 

11. Бондар І. О. Фактори впливу на сприйняття кольору поліграфічної 

продукції // Матеріали міжнародної конференції «Проблеми й 



263 

 

перспективи розвитку ІТ-індустрії», яка проходила 20 листопада 2009 р. 

у місці Харків. – Харків: ХНЕУ, 2009. – С. 228–230. 

12.  О'Квин Донни. Допечатная подготовка. Руководство дизайнера: Пер. с 

англ.: Учеб. пособие. – М.: Изд. дом “Вильямс”, 2003. – 592 с. 

13.  Маргулис Дэн. Photoshop для профессионалов: классическое 

руководство по цветокоррекции. Четвертое издание / Пер. с англ. – М. : 

ООО «Интерсофтмарк», 2003. – 464 с. 

14.  Маргулис Дэн. Photoshop LAB Color: загадка каньона и другие 

приключения в самом мощном цветовом пространстве / Пер. с англ. – М. 

: Интелбук, 2006. – 480 с. 

15. П. В. Яньшин. Цвет как фактор психологической регуляции / 

Прикладная психология. – 2000. – №4. – С. 14 – 27. 

16. Хейнз, Барри, Крамплер, Уэнди, Дугган Шон. Художественные приемы 

работы в Photoshop CS.: Пер. с англ. – М.: Издательский дом “Вильямс”, 

2005. – 552 с. 

 


